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Welcome to MicroGDS�11.

MicroGDS is a powerful, computer-aided design and draughting system
that makes it easy to transfer your creative and imaginative ideas into
two-dimensional and three-dimensional drawings and models.

MicroGDS is a registered trademark of Informatix Inc.

Informatix offer two MicroGDS products: MicroGDS Collaboration
and MicroGDS Entry Level. Both products share a comprehensive set
of features for meeting the needs of today’s CAD users, including:

� the ability to draw to any scale using real-world measurements

� an extensive set of styles and drawing effects to make your drawings
clear and attractive

� easy to use methods for creating and modifying data
� flexible and powerful tools for moving, editing, and deleting objects

� 3D geometry generation from 2D drawings

� the ability to work in multi-user mode so that a number of users can
access the same project data simultaneously
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� simple and effective techniques for exchanging data with other
Windows software

� the ability to read and write data in other formats, including XML,
DXF and DWG

� the ability to publish to numerous other formats, including PDF,
PNG, and DWF

� extensive customization facilities

You can also use MicroGDS modelling with Piranesi� to produce
exhibition-quality drawings. Piranesi is a unique three-dimensional
paint package that offers sophisticated painting techniques enabling you
to express your ideas using a whole range of artistic effects.

Piranesi is a product of Informatix Inc. You can find the Piranesi
homepage at www.piranesi.co.uk

It is recommended that you periodically check the Informatix website
for new product information, updates, and free downloads. You can find
the MicroGDS homepage at www.microgds.co.uk

��	
������##�(�
�����

MicroGDS Collaboration offers a full complement of features,
including the capability to work in a multi-user environment.
MicroGDS Collaboration also provides full 3D solid and surface
modelling, plus a sophisticated, photo-realistic renderer.

This product is ideal for users who wish to generate high quality
visualizations of 3D models, and work in both multi-user and
single-user environments.



Chapter 1: Introduction 3

��	
����!��
-�6�'�#

MicroGDS Entry Level offers similar features to MicroGDS
Collaboration, but has a reduced set of 3D functions and rendering
capabilities. This product is tailored for users who wish to work in both
multi-user and single-user environments, but require only basic
visualization capabilities.

3�����	
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The MicroGDS website is your online technical resource centre. You
can read the latest MicroGDS reviews, access all the product
information, download applications and tools, and access the
MicroGDS Gallery and User Forum. Visit the MicroGDS Gallery to
view a range of example images created using MicroGDS. The User
Forum lets you get in touch with other MicroGDS users around the
world. Use it to share your thoughts, ask questions, provide answers,
share images, and exchange tips and techniques. You can find the
official MicroGDS website at www.microgds.co.uk

You can also access the website directly from MicroGDS by clicking
MicroGDS Homepage on the MicroGDS Help menu.

It is recommended that you periodically check the MicroGDS website
for new product information, updates, and free downloads.

���	�����0�
��������
The MicroGDS version number is shown on the MicroGDS title bar.
You can check the MicroGDS website online to see if there are updates
to your copy of MicroGDS.

When an update or new version becomes available on the website, you
can choose to download and install it.

To check for updates, click Check for Updates on the MicroGDS Help
menu, then follow the instructions on the screen.
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This user guide presents selected concepts and procedures to enable you
to begin working with MicroGDS. The guide includes information
about creating and placing graphics, working with styles, working with
other file formats, and customizing MicroGDS.

It also contains information on working in a multi-user environment and
the advanced solid and rendering features in MicroGDS Collaboration.

�
����2�������0�����������

The guide is arranged in two parts:

� Part One: Working with MicroGDS 11
Explains the concepts and features that are applicable to both
MicroGDS products. It also describes how to work in a multi-user
environment.

� Part Two: Advanced 3D and rendering

Describes the advanced solid and rendering features available in
MicroGDS Collaboration.

5����
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Informatix provides documentation and services for learning how to use
MicroGDS and for solving problems.

��	
������	�&��������

The MicroGDS documentation consists of a user guide and a
comprehensive online Help system. The user guide is provided in PDF
format. 

� What’s new in MicroGDS 11
This document provides information on new and enhanced features
in MicroGDS 11. The document is provided in PDF format which
you can find on the MicroGDS website at www.microgds.co.uk

� Using MicroGDS

The user guide describes the fundamental concepts and how to use
the features in MicroGDS.

For full details of all the commands available in MicroGDS, refer to
the online Help.
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� MicroGDS Help

MicroGDS provides extensive online Help. Details of every
command and dialog box are included, along with procedures for
completing each task.

4		���������#����7�#�

To access the MicroGDS online Help system and use the full facilities
of Microsoft HTML Help, Microsoft Internet Explorer must be installed
on your computer.

� 3������������#����7�#���-���&

1 On the MicroGDS Help menu, click Help Topics.

The main Help window is displayed, showing the topic Overview of
MicroGDS.

2 Click the Contents, Index, Search, or Favorites tab to choose how
you would like to navigate to the required help topic.

3 To display help on a topic, double-click the topic name.

� 3������#�-�	����"�1�������'����#�

1 Press Shift+F1, or on the MicroGDS Help menu, click What’s This?

A question mark is attached to the mouse pointer.

2 Click the command or toolbar button you want help on.

� 3������#�-���#���������	�
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� press F1, or click the Help button on a dialog box

3
�������	��
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Informatix provides training courses that are designed to teach you how
to plan and draw in MicroGDS. The courses are structured to cover
basic foundation training, 3D, and advanced use. Please contact
Informatix for more information.
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1 On the taskbar, click the Start button and point to Programs.

2 Point to the folder that contains MicroGDS, then click MicroGDS.

You can also start MicroGDS by double-clicking a MicroGDS desktop
shortcut, or double-clicking one of the following MicroGDS file types:

� .MAN single-user document

� .MTF single-user template

� .STY style file

� .CV7 font file

� .CPJ multi-user project
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The layout of your window may be shown differently to the illustration,
depending on the MicroGDS product and version you are using.

Not all menus and toolbar buttons are available until you create or open
a document.

When you first use MicroGDS, the MicroGDS window displays:

� a menu bar
� a number of system toolbars
� the two status toolbars
� Document Organizer
� Mini Window Editor
� Properties window
� prompt bar
� information bar
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You can switch toolbars and windows on and off using commands on
the Window menu. The menu bar, prompt bar, and information bar are
always displayed.

�
�0�#��

As you work with MicroGDS, you will set up the MicroGDS window to
best suit you. You can move windows around, dock and resize
windows, customize toolbars and menus and so on. MicroGDS
remembers all these settings and stores them in a profile. This means
that when you next use MicroGDS, the layout will be exactly as you left
it. By default, you use the ‘current’ profile. However, you can create
additional profiles and choose which one to use from a list. For
example, you might set up your toolbars to suit specific work
environments, such as having separate 2D drawing and 3D design
profiles and then switch between them.

When you exit MicroGDS, the window layout is always saved to the
current profile. You can also save the layout to the loaded profile or to a
new profile using the Profile commands available from the Window
menu.

For more details about saving and loading profiles, see Chapter 17,
Customizing MicroGDS.

�	���������
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In the illustration the Properties window is undocked, but the other
items are docked. Docked items are placed in a side bar, at the top,
bottom, left, or right of the window. To dock a window or toolbar, drag
it to any side of the MicroGDS window, or double-click its border or
title bar. To undock an item, drag it away from the side bar or
double-click its border.

To move a window or toolbar to one side of the MicroGDS window
without docking it, press Ctrl when you drag.

When any resizable windows, such as the Document Organizer or Mini
Window Editor, are docked to the side of the MicroGDS window, a split
bar appears which you can use to resize the docking area. In addition,
when two of these windows are docked one above the other, a split bar
appears which you can use to resize the windows.

The window positions and sizes are saved in the current profile.
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At the top of the window is a standard Windows menu bar. The menu
bar provides commands to create and edit documents in MicroGDS.

A number of right-click shortcut menus are also available with
MicroGDS. Shortcut menus provide commands that apply specifically
to the area in which you are working.

You can change a current key assignment or assign a new shortcut key
to any MicroGDS menu command. For details, see Chapter 17,
Customizing MicroGDS.

3��#(�
�

Toolbars contain buttons that give you quick access to menu commands
and features.

You can use the status toolbars to change the settings for the current
session and the selected graphics.

� 3����� �������������#(�
�

1 Press Ctrl+T, or on the Window menu, click Profile, Customize.

The Customize dialog box is displayed:
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The Toolbars tab is the first tab on the dialog box and so is
automatically displayed.

2 For each toolbar that you want to show, select the corresponding
check box. For each toolbar that you want to hide, clear the check
box.

By default, toolbars are displayed horizontally. You can move the
toolbars to different positions on your screen and you can change their
orientation. Toolbars are saved in the current profile.

� 3��&�'�������#(�


� drag the toolbar by its gripper bar or by its border:

�	����	���	
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� press Shift when you drag the toolbar

Note that you cannot change the orientation of a status toolbar.

When you drag a toolbar away from the toolbar area or change its
orientation, it is undocked and its title bar is shown. For example:

If you dock a toolbar to one side of the MicroGDS window, its
orientation automatically changes to vertical or horizontal, as
appropriate.

You can customize toolbars by adding or removing items. You can also
create new toolbars and change the size of the buttons. In addition, you
can create flyout toolbars that enable you to access all the commands on
a toolbar, from a single button.
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Flyout toolbars show a small triangle on the bottom right of the button,
for example:

�������������	�������

To select the command that the flyout button represents, click the
button. To select a different command, press the mouse button on the
flyout toolbar button, then drag to the appropriate command. The
selected command becomes the flyout button on the toolbar.

Flyout toolbars provide a useful way of making many commands
available, without using too much screen space. For details on how to
create flyout toolbars, see Chapter 17, Customizing MicroGDS.

����������#(�
�

The two status toolbars show information about the active window and
about any currently selected graphics.

The default information displayed on Status bar 1 is:

Colour the current colour; the default is ByPhase

Line the current linestyle; the default is DEFAULT

Char the current charstyle; the default is DEFAULT

Light the current lightstyle; the default is NONE

Mat the current material; the default is DEFAULT

File name the path of the current document if the document
has been saved, otherwise this is Documentn
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Justification the justification buttons used for text; the default
is left justification

x y z the pressed buttons fix the corresponding
coordinates

The x, y, and z buttons are described in
Chapter 5, Entering positions.

The default information displayed on Status bar 2 is:

Scale the scale at which you are currently working; the
default is 1:1

Angle the set axes angle; the default is 0

Units the units of measurement in which you are
working; the default is millimetres (mm)

Places the number of decimals places displayed; the
default is 0

Profile the name of the profile in use; the default is
current

Layer the name of the current layer

Object, instance, or
assembly

the name of the current object, instance, or
assembly

Selected graphics the total number of selected graphics: objects or
primitives

The appropriate settings shown on the status toolbars are used when you
next create new graphics.

When you select graphics, the appropriate settings on the status toolbars
are updated to reflect the properties of the selected graphics. For
example, if you select a line primitive, the linestyle assigned to the
primitive is displayed in the Line box.

If the selected graphics are all different, their status is not displayed and
the appropriate box is blank. For example, if you select several line
primitives which have different linestyles, the Line box is blank. When
you deselect the graphics, the status returns to the previous value.
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A box is also blank if its information is not appropriate. For example, if
you select a line primitive, the Char box is blank since a line does not
have a charstyle.

You can change a characteristic of the selected graphics by choosing the
required value from the appropriate list, or in some cases, by typing the
required value.

You can add and remove status toolbar items, but you cannot create
flyout status toolbars with their contents. See Chapter 17, Customizing
MicroGDS for details about customizing your toolbars.

�	�&�����
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The Document Organizer provides a central point from where you can
work with the data in your documents. It displays a series of tabs, each
providing access to a specific type of data. For example, you can open
and rename window definitions (and views) from the Window
Definitions tab, and create and modify styles from the Styles tab.

The Document Organizer provides shortcuts to the equivalent menu
commands. Although you can use the menus and toolbars for most
operations in MicroGDS, it is expected that you will use the Document
Organizer for all your document management tasks.

More details are given in Using the Document Organizer on page 29.

���������� �!����


The Mini Window Editor enables you to work with phases in the active
window definition. The Mini Window Editor is a cut-down version of
the full Window Editor, providing quick access to some of the
frequently-used phase commands. You can, for example, use the Mini
Window Editor to create a new layer or change the colour in which
graphics in a phase are displayed.

The window editors are described in Chapter 4, Using layers and
phases.
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A particularly useful facility in MicroGDS is the Properties window.
You can use the Properties window to view extensive details about the
graphics currently selected. For example:

You can use the Properties window, for example, to see the colour and
linestyle of a line primitive, the name of the object in which the
primitive is stored, and the layer on which the object resides. You can
also change the value of any editable property (properties that are
read-only are shown shaded in the window).

The buttons at the top of the window enable you view the information
in different ways. You can also switch to query mode to view low-level
primitive details, such as the radius of an arc, the length of a line, and
the area of a circle.

The Properties window provides a central location from which to
change the properties of your drawing elements. Although you can use
the menu and toolbar equivalents to view and change the properties of
the selection, it is expected that you will work with the Properties
window active.

For more details, see Chapter 13, Getting information.
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Many commands require you to enter positions. To help you,
MicroGDS displays hints, prompts, the status of specific items, and
coordinate positions at the bottom of the MicroGDS window. For
example:

Information is shown from left-to-right about:

� the current command

Shows a summary of the command under the mouse pointer or the
action required to complete the next step in the command.

� the pointer position

Shows the current pointer position—in the current units and decimal
places—together with the nearest snapcode. This information is
dynamically updated as you move the mouse pointer across a
drawing. You can set your preferences to show only the last hit
position if you prefer. For details about setting preferences, see
page 22. For information about each individual preference, refer to
Help.

� the status of the Z=0 facility

The Z=0 button enables you to force graphics to be drawn on the
XY plane. For details about using the Z=0 facility, refer to Help.

� the status of the SETEDIT facility

The SETEDIT button enables you to set editing restrictions to
temporarily exclude graphics from being edited. For more details,
see Chapter 3, Working with primitives and objects.

� the status of hover highlighting

The Hover Highlight button provides feedback about the graphics
directly beneath the mouse pointer. Details are given in Chapter 3,
Working with primitives and objects.

� an animation when drawing is in progress

� the status of the grid

A grid can assist you when you are drawing and placing graphics.
When a grid is defined, you can switch it on and off using the Grid
button.

More details about the grid are given in Chapter 5, Entering
positions.
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� the status of dynamic snap guides

The Snap Guides button enables you to display dynamic snap guides
when constructing or editing graphics. Details are given in
Chapter 5, Entering positions.

� CAP if Caps Lock is on

� NUM if Num Lock is on

� whether there are any problems associated with an open document

If there are problems associated with any open document, an
exclamation mark on a yellow background is shown. You can use
the exclamation mark button to display a Problems dialog box which
you use to view and correct errors in open documents.

More details about warnings and errors are given in the later section
Opening a document on page 35 and also in relevant sections
throughout the guide.
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For some MicroGDS commands, MicroGDS displays a prompt bar at
the bottom-left of the window. The prompt bar is displayed, for example
for you to enter the radius for a circle:

Whenever you are required to specify a position, you can display the
prompt bar by typing coordinates instead of clicking in the window. The
prompt bar appears as soon as you start typing.

By default, the prompt bar is fixed at the bottom of the MicroGDS
window. You can choose to have a floating prompt bar which you can
move to a convenient position on your screen.

� 3��0#���������
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1 On the File menu, click Preferences.

2 On the General tab, select the Floating prompt bar check box.
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In MicroGDS, you use commands to draw, view, and modify graphics.
There are a number of ways you can access commands:

� you can access all commands from the menus

Note that some commands are available only from the Document
Organizer.

� you can access many commonly-used commands using the toolbars

� you can access some commands using buttons on the information
bar

� you can access some commands using shortcut keys

You can change the default shortcut assignments, and add or remove
a shortcut for any MicroGDS command. For details, see Chapter 17,
Customizing MicroGDS.

For example, to display the Window Editor, you can press F2, or on the
File menu, click Window, Edit, or on the File toolbar, click the Window
Editor button.

��&&����0���(�	�

When you select a command, you often see a graphical representation
of that command attached to the mouse pointer. For example, if you are
measuring the distance between two points in a window, the following
is shown:

For other commands, MicroGDS may require information from you.
For example, when you construct a polygon, you are prompted to enter
the number of sides.

Sometimes, you might need to undo a position during a command. For
example, if you are drawing a series of lines and you make a mistake
when specifying one of the points, you can undo the position. To undo a
position, press Backspace.

When you use a command, it either:

� remains active ready for you to use again

� or ends automatically once you have completed the task
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Where a command remains active, you can often change the command
parameters before re-using the command. For example, if you construct
an arc which has an angle of 45° and you now want to draw a second
arc which has an angle of 90°, you can press Enter to redisplay the
prompt bar and specify the new angle.

Note that some commands can be used while using another command.
For example, you can start the Line command and begin drawing a line,
use the Zoom Rectangle command to zoom to another area, and when
the zoom completes you are back to the Line command.

To end an active command when you have finished, press Esc.
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For many commands, you can repeat the last command. For example, if
you use Construct, Text to create and place a text primitive, you can use
the repeat command facility to immediately create another text
primitive.
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� press Enter
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You can undo commands that created, deleted, or modified graphics.
MicroGDS undoes the most-recent first and works back. Similarly, you
can reverse an undo.
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� press Ctrl+Z, or on the Edit menu, click Undo
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� press Ctrl+Y, or on the Edit menu, click Redo

You can undo and redo up to the undo buffer size set in your
preferences. Note that you cannot undo commands you made before
saving a document.
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You can customize MicroGDS by setting up a number of personal
preferences. Initially, all preferences are preset to the default MicroGDS
settings. You can modify settings using either the Preferences dialog
box or the Preference Files Editor. The Preferences dialog box gives
access only to your personal settings whereas the Preference Files
Editor may let you modify settings at other levels. For example, you
may be able to modify settings for all MicroGDS documents contained
in a specified folder (if you have the relevant access permissions to the
folder).

Note that any change to your personal settings is reflected in both
editors.

All settings are saved to xml files, stored in the appropriate locations.
You can see the location of a settings file in the Preference Files Editor.
For more details about the Preference Files Editor, see Chapter 17,
Customizing MicroGDS.
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� on the File menu, click Preferences

You may find that not all your personal preferences are available to you.
This is because a preference may be set as a policy a higher level.
Where a policy is in place, it cannot be overridden at any lower level.

Changes to your preferences are saved only in memory. To save
changes permanently, save your settings when you exit MicroGDS or
save the settings file using the Preference Files Editor. Note that if you
have any unsaved modified settings when you exit MicroGDS, you will
be prompted to save the changes.

The preferences that you can set up are described in the relevant
sections throughout this guide, and in the Help. Refer also to
Chapter 17, Customizing MicroGDS.
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MicroGDS drawings are stored in documents. A document
encompasses all the data for a drawing, that is, document windows,
layers, graphics, and so on.

In MicroGDS, you can work in single-user mode or in multi-user
projects. In single-user mode, each time you open or start a new
document, a new window is opened in which you can store the graphics
and related information (such as primitives, objects, and layers).
Single-user documents are stored in .MAN files.

In a multi-user project, the graphical data is stored in separate files
enabling several users to work on the data. For details, see Chapter 16,
Multi-user projects.

In MicroGDS, graphical data is stored on a series of layers. Each layer
can be considered as a transparent overlay. You can use layers to group
related graphics together. If you do not create any layers, all the
graphical data is held on a single default layer. The default layer, and
any layers that you create, are automatically allocated a phase. A phase
is a view onto the layer data, and enables you to choose the graphics
that are to be included, the colour in which they are displayed, and the
order in which they are to be printed. For more details, see Chapter 4,
Using layers and phases.

To access the layer data in a document, you use a window definition.
This provides a view onto the graphical data. In a single-user document,
the first window created in a document is initially the principal window.
This is the window that opens whenever you open the document. You
can create as many window definitions as you require, and set any other
window to be the principal window. Each window definition defines
which layers are to be referenced in the view, which graphics are
editable, visible, invisible, and hittable, the view extents, and the
projection.

Every window definition has at least one view associated with it. One of
these views is designated the default view for the window. Whenever
you create a new window definition, a default view (named View1) is
also created. You can create as many views onto a window definition as
you require and, similar to a window definition, set any other view to be
the default view of the window.
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For more details, see Working with window definitions on page 38 and
Working with multiple views on page 53.

Most graphics in a MicroGDS document have a style assigned. A style
defines the appearance of a graphic. For example, a line primitive has a
linestyle and a text primitives has a charstyle. Some graphics, such as
inserted raster images, do not have a style assigned. Styles that you
create in a document are saved in the MAN file. However, you can also
share standard or common styles by using style files. For details about
style files, see page 25.

You can also use graphics from other files in your documents. For
example, you can insert a raster image from a raster file or link an
object from another single-user document. In MicroGDS, you can set
up aliases to reference the physical locations of files that you want to
use in a document. For more details about aliases, see page 27.
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A template is a document with custom-designed properties and content
which you can use to create other documents. A template can contain
anything that can be stored in a MAN file, such as graphics, styles, and
window definitions. For example, you might create a template to define
a drawing frame or one that includes a company’s logo. Templates are
simply single-user documents that you save with the extension .MTF.
MicroGDS provides ready-made templates (a0.MTF through to
a4.MTF) that you can use.

You may also find it useful to set up a template to reference style files
(described next), or aliases which reference additional files that you can
access.

When you base a new file on a template, the template’s content is
copied to the new document. Templates are used only when you create a
new file; if the template is subsequently updated, existing documents
based on the template are not updated.

If you want to make changes to a template (a .MTF file), you must open
the file using the Open command on the MicroGDS File menu, or drag
the template file into the MicroGDS window. If you double-click the
file in Windows Explorer, a new document based on the template will
be created.
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If you often want the same graphics and styles to be available in new
documents, you can set a default template to be used for all new, blank
files.

You specify the location of your templates on the File Locations tab in
your preferences. Then, when you choose to use a template, MicroGDS
lists any templates that exist in the specified location. For details about
setting your preferences, see Chapter 17, Customizing MicroGDS.

For more details about creating and using templates, refer to Help.
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Documents can share styles by using style files. You can create and
access the following types of style file:

Style file name Style type

LINES.STY linestyle

CHARS.STY charstyle

LIGHTS.STY lightstyle

MATLS.STY material

ATTRS.STY mnemonic definition

SCHEMAS.STY schema definition

Only style definitions are saved in a style file. If you create graphics to
help you define the styles, they are discarded when you save and close
the style file.

For single-user documents, you can access style files by specifying their
location on the style search path. For more details, see the following
section Styles and single-user documents.

For multi-user projects, the location of style files is set in the project
database. For more details, see Styles and multi-user projects on
page 27.

You can also access any style files that exist in the location for styles
and fonts, defined in your file location preferences. Any style files that
exist in the specified location are made available to all your documents
(single-user documents and projects). Note that although the style files
in this location are made available, it is the location in which any are
installed with MicroGDS. If you wish to place your own style files in
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this location, first ensure that a style file of its type does not already
exist. If you do store files in this location, be sure to move them before
your MicroGDS installation is updated or repaired, otherwise they may
be lost.
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1 On the File menu, click Preferences.

2 Click the File Locations tab.

3 In the Styles & Fonts box, specify the location in which global style
files (and MicroGDS font files) are located.

By default, the location is set to the Fonts folder in your MicroGDS
installation directory.

Note that your CAD manager can set policies to restrict any of your
preference settings. If the Styles & Fonts box is greyed out, this
indicates that a policy is in place and you cannot change the set
location.

Any changes to your preferences are saved only in memory. To save
changes permanently, save your settings when you exit MicroGDS.
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When you create or modify a style in a single-user document, the style
is saved in the MAN file. These styles are called local styles. However,
you can also access styles in external style files. To do this, you specify
the folder in which the STY files are located on the style search path.
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1 On the File menu, click Style Search Path.

2 In the Edit Search Path dialog box, define the locations of the styles
files (.STY) that are to be referenced by the current document.

The order in which the search paths are listed is important because if
a style name of the same type appears in more than one style file,
MicroGDS uses the first style that it finds.

If changes are later made to any of the styles in a style file, those
changes are reflected in all documents that reference the file.
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If you modify a style from a style file, it becomes a local style in the
current document and is saved in the MAN file. Styles saved in a
document take precedence over styles of the same name in a style file.

For more details about creating and using style files, refer to Help.
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In multi-user projects, all styles are stored in external style files which
are defined in the project database.

If you modify a style from a style file, it becomes a local style and is
saved in the first location on the project’s style search path. For details
about creating multi-user projects, see Chapter 16, Multi-user projects.

4#�����

An alias is a name given to a folder so that the path to that folder does
not have to be specified in full. This is similar to using Windows
shortcuts. Mapping a location to an alias is useful when files are moved
in the filing system.

In a single-user document, aliases can be used to reference the locations
of:

� object libraries

Object libraries are MicroGDS MAN files that contain objects you
can insert or link to the current document. For details about objects,
see Chapter 3, Working with primitives and objects.

� raster images

Raster images are image files that you can insert into the current
document. For details about raster files, see Chapter 15, Working
with different file formats.

� reference documents

Reference documents are MicroGDS documents that contain
window definitions that can be used in photos in the current
document. For details about photos, see Chapter 3, Working with
primitives and objects.

� renderer files

Renderer files can be used by materials, lights, and rendering
environments in MicroGDS Collaboration. For details about
rendering, see Part Two: Advanced 3D and rendering.
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Aliases are defined using the Aliases command on the File menu and
are stored in the current document.

Aliases are also used to define the locations for layer and window
definition files, and are set up in the project database. For details, see
Chapter 16, Multi-user projects.
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1 On the File menu, click Aliases.

2 In the Aliases dialog box, define the alias definitions for the current
document:

� to add a new alias, click Add

� to change an existing alias, click Edit
� to remove an alias, click Remove

When you add or change an alias, the Alias Editor is displayed.

3 In the Name box, type the alias name you want to use.

4 In the Location box, specify the physical location to which the alias
refers.

Note that if you map an alias to a network drive, the assignments
will only work for all users who use the same standardised mapping
of drive letters to disks. If you do not use a standardised network
mapping system, you should specify the full network pathname
when you set up alias names.

5 From the Type list, select the alias type you require.

For example:

6 To allow an alias name to be expanded which will give access to any
subfolders below, select the Expandable check box.

7 Click OK to close the Alias Editor, and again to close the Aliases
dialog box.
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When you have set up aliases for object libraries and raster images, you
can access the data from the Document Organizer (described next).

You can view the contents of raster and library alias locations in
Windows Explorer by right-clicking over the folder and clicking
‘Explore folder’ on the shortcut menu.

More details about setting up and using aliases are given in Help.

�����������	�&�����
����2�

Use the Document Organizer to work with the data relating to
documents that you have open. For example, you can open and rename
window definitions in a document, create and modify styles, and copy
and rename layers. The Document Organizer also provides access to
files in any aliased file locations.
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� press F4, or on the Window menu, click Document Organizer
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When you open a document, it becomes the current document in the
Document Organizer and its name is displayed in the document list.

If you open more than one document, you can switch between them
using the document list. This enables you to view, share, and work with
data in any number of documents.
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The first time you open the Document Organizer in the current session,
the Window Definitions tab is displayed. This shows a list of the
window definitions in the document. In a single-user document, the
name of the principal window is shown in bold. (This is the window
that MicroGDS opens each time you open the document.)

In a multi-user project, the name of the default window alias is shown
in bold. This is the default location in which new window definitions in
the project are saved. For details, see Chapter 16, Multi-user projects.

The Document Organizer has five tabs. Each tab provides a toolbar and
a shortcut menu for commands specific to the type of data:

� the Window Definitions tab

Includes commands to work with window definitions and saved
views. For example, you can open, rename, find, and export window
definitions and show, copy, rename, and delete views. For details,
see Working with window definitions on page 38 and Working with
multiple views on page 53.

� the Layers tab

Includes commands to copy, rename, find, and export layers. For
details, see Chapter 4, Using layers and phases.

� the Styles tab

Includes commands to create, modify, and change styles. For details,
see the individual styles chapters (Chapters 7 and 8, and Chapters 10
and 11).

� the Library Files tab

Includes commands to preview and insert objects from aliased MAN
file libraries. For details about objects, see Chapter 3, Working with
primitives and objects.

� the Raster Files tab

Includes commands to preview and insert raster images from aliased
raster files. For details about raster images, see Chapter 15, Working
with different file formats.

The Window Definitions and Layers tabs list the windows and layers
currently available in the document, in alphabetical order.

The Styles tab shows the style categories; there is one category for each
style. When you open a style category, a list of locations in which style
files exist is displayed. The first location is the current MAN file; all
new styles are saved in the MAN file. The path for each location
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defined in the style search path is then displayed. At the end of the list,
the path set for styles and fonts (in your file location preferences) is
shown, provided that a style file for the displayed category exists.
Setting up the style search path is described on page 25.

If you have set up aliases for object libraries and raster files, the Library
Files tab and the Raster Files tab list each aliased location.

To display the items available in a style category, or from a library or
raster alias, you must open it.
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� double-click the name, or click the plus sign (+) to its left

Whenever a list of items is displayed in the Document Organizer, you
can preview an item.
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1 Click the appropriate tab.

2 Select an item.

3 Click , or on the shortcut menu, click Toggle Preview.

To close the preview area, select the command again.

Remember that you can also view the contents of raster and library alias
locations by right-clicking over the alias folder and clicking ‘Explore
folder’ on the shortcut menu.

The facilities available from the Document Organizer are described in
the relevant sections in this guide. For more details, refer to Help.
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Your system administrator may set up special naming standards for
layers and objects at your site, using name assistants. Name assistants
define the naming standards for layers and objects and can be set up to
suggest or enforce the names.

If you begin to draw immediately, MicroGDS usually creates an object
and a layer using the default names. However, if the name assistants are
in force, and the default object and layer names do not conform to the
naming standards, the following message appears:
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MicroGDS then opens the Layer Name or New Object dialog box as
appropriate, for you to specify a name that conforms to the naming
standards. The dialog box shows a tree-like structure of naming
conventions.

For example:

Note that when you create a layer in a multi-user project, an additional
box is displayed at the bottom of the Layer Name dialog box. For
details, see Chapter 16, Multi-user projects.

If you are using name assistants and the tree structure is not shown,
either the appropriate configuration file has not been set up or the name
of the layer on which you are creating the new object does not conform
to the naming standards.

To expand a name category, double-click the name. Each time you
select a name, MicroGDS adds a component to the displayed name in
the Name box.
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For example:

The listed descriptions and the corresponding layer names are defined
in the configuration file.

You specify the names and locations of the configuration files and their
applicability on the Name Assistants tab in your preferences. Details on
how a system administrator can set up the name assistants is given in
Chapter 17, Customizing MicroGDS.
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This section describes how to create, open, save, and close a single-user
document.

For details about how to work with multi-user project files, see
Chapter 16, Multi-user projects.
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1 On the File menu, click New.

MicroGDS displays the Create a New File dialog box:



34 Using MicroGDS 11

2 Do one of the following:

� to create a new blank document, or a document based on a
default template, select Blank and click OK

� to create a document based on a template, select From template,
then click Next

Use the displayed dialog box to locate the template (a .MTF
file), and click Open.

The initial location that MicroGDS should look for template files
can be set in your File Locations preferences.

You can also create a new document based on a template by
double-clicking a template file in Windows Explorer. (Do not drag a
template file into the MicroGDS window unless you want to open
the template file.)

A new window opens in the MicroGDS window. Each new window
is numbered sequentially from 1 within the current document (and in
the current session).

For example:
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The window items are described in Working with windows on page 41.

When you create a single-user document, MicroGDS creates a window
definition (the principal window) and a default view onto the window.
The principal window opens and the default view is shown each time
you open the document. You can create additional window definitions
and saved views as required. For details, see Working with window
definitions on page 38 and Working with multiple views on page 53.
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� on the File menu, click Open, and select the document to open

� or, double-click the .MAN file in Windows Explorer

� or, drag the .MAN file from Windows Explorer into the MicroGDS
window

When the document has loaded, the default view in the principal
window definition opens.

For example:

You can open other MicroGDS documents, such as style files, in the
same way.

You can also open files of other formats, for example, DXF files. For
details, see Chapter 15, Working with different file formats.
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By default, if MicroGDS detects any errors with the document, a
Problems dialog box opens giving details about the error. For example,
an error might indicate that the document contains a link to another
document or file for which MicroGDS cannot find the source or that
fonts used in the document are not installed on the current machine. The
Problems dialog box provides facilities to view and correct the detected
errors. More details are given in the section relevant to the type of data
to which a problem has been found.

Whenever there are unsolved problems in an open document, a yellow

warning triangle is shown on the information bar. You can
double-click the button to open the Problems dialog box.
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When you open a .MAN file, MicroGDS creates a parallel lock file in
the filing system. The lock file has the extension .MA#. Lock files
ensure that only one person can edit the document at one time. The lock
file is removed when the document is closed enabling another person to
open it for editing. While a document is locked, other users can open
the document as read-only.

If you have the Backup option set, on the General tab of your
preferences, and you have made changes to the document since it was
last saved, MicroGDS creates a backup file with the extension .MA$.
When the document is next saved, the backup file is removed.

If a document is not closed correctly, for example, if MicroGDS stops
responding, the lock file and the backup file (if it exists) remain in the
filing system. When you next open the document, MicroGDS prompts
you to first unlock the file. If you unlock the file and a backup file
exists that is more recent than the file at the time it was closed,
MicroGDS displays a second message prompting you to save the file.

If you close the backup file and then open the original file, you cannot
re-open the backup file.

Template files and style files are locked and backed up in the same way.

If the Backup option is not set, a backup file does not exist and any
unsaved changes to a file are lost.
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As you work on a document, you can save the document using either
the same name, or a different name.
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� press Ctrl+S, or on the File menu, click Save MAN File

This command reflects the type of document you are saving. For
example, if you are saving a STY file, the command shows Save
STY File.

If you have not yet saved the document, a Windows Save As dialog
box is displayed. In the Save As dialog box:

a) ensure that the Save as type box shows MicroGDS File (*.MAN)

b) specify the name and location for the document

If you do not include the .MAN extension, MicroGDS adds it
automatically.

c) Click Save.

To save a document to another MicroGDS format, select the appropriate
file type in the Save as type box. You can also export window
definitions to other formats, for example, DXF. For details, see
Chapter 15, Working with different file formats.

�#����������	�&���

� 3��	#����-��
���	�&���

� on the File menu, click Close MAN File

This command reflects the type of document you are closing. For
example, if you are closing a STY file, the command shows Close
STY File.

If the document has not yet been saved, you are prompted to save or
discard it. If you choose to save the document, MicroGDS displays a
Windows Save As dialog box. Save the document as described in the
previous section.

If the document has unsaved changes, you are prompted to save or
discard them.
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Each window definition you open or create is opened in a new window.
You can store multiple window definitions in a single document. This
enables you to work with different parts of a document, and also share
data throughout a document.

For each window definition that you create, MicroGDS also creates an
initial, default view. You can create additional views and move easily
from one to another. For more details, see Working with multiple views
on page 53.

This section describes some of the basic, window definition tasks. For
full details, refer to the appropriate chapters in this guide and also refer
to Help.
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1 On the Document Organizer, click the Window Definitions tab:
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2 Click the New Window toolbar button 

Alternatively, use the Window, New command on the File menu.

The window definition opens in a new window. The window title shows
Windown – Viewn, where:

� Windown is the next sequential window definition number within
the current document

� Viewn is the next sequential view number within for the current
window definition

If you do not change the names, MicroGDS stores the window
definition and view with the generated names when you save the
document. Details about renaming window definitions and views are
given later.

When you create a window definition in a multi-user project, you must
save the window to a file. For details, see Chapter 16, Multi-user
projects.
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� in the Document Organizer, double-click the name of the window
definition to open

The default view of the window definition opens in the MicroGDS
window.

If a window definition has multiple saved views, you can open a
different view by clicking the plus sign to the left of the window
definition name and then double-clicking one of the displayed view
names.

For example:
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Note that the view icons depict the type of view they store. For more
details, see Working with views on page 45.

You can use the Find facility in the Document Organizer to search the
document for specific window definitions. You can use wildcards to
find window definitions that have similar names. For details, refer to
Help.

You can also open the default view in a window definition from the File
menu:

1 On the File menu, click Window, Open.

MicroGDS displays the Open Windows dialog box.

2 Double-click the name of the window definition to open.
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1 In the Document Organizer, select the name of the window
definition that you want to set as the principal window.

2 Right-click to display the shortcut menu, and select Set as Principal.

The name of the window definition is shown in bold, to indicate that
it is now the principal window.

This command is not applicable with multi-user projects.

5���&���� ���� ���0��������

� 3��
���&���� ���� ���0�������

1 In the Document Organizer, select the window definition you want
to rename and press F2.

2 Enter the new name and press Enter.

You can group window definitions in a MAN file into categories, by
typing the name in a particular format. This will show the windows in a
document in a tree structure in the Document Organizer. For details,
refer to Help.
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� on the File menu, click Window, Close

If you have unsaved changes in the window definition, you are not
prompted to save them. The changes will be saved when you save
the document.

If the window definition is the last view onto the document, the window
is closed but the document remains open. MicroGDS creates a
placeholder window for the document, which appears minimized at the
bottom of the MicroGDS window. This enables you to work with the
document later in the current session.

The name of the document represented by the placeholder window is
shown in its title bar. For example:

�����������
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You can reopen recently-used windows in the document, using the

window’s document menu. You can close the document by clicking 
on the placeholder window or using the Close MAN File command on
the File menu.

Note that if you close a window definition in a multi-user project to
which you have unsaved changes, you are prompted to save the
changes. This is because window definitions in a project are saved in
separate files.
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When you create or open a document, MicroGDS opens a new window.
The rectangle inside a window is where you produce your drawing.
This rectangle is the view extent and is a view onto the drawing sheet.
By default, the axes are shown in the centre of the window. MicroGDS
uses the axes to draw and place graphics. Further details about the axes,
the view extent, and the drawing sheet are given in the next section.

When you have drawn graphics, as you move the mouse pointer around
the view extent you will notice the following:

� if you have hover highlighting switched on, any editable primitive
or object beneath the mouse pointer is highlighted, and information
relating to the graphics is shown in an InfoTip

For more details about hover highlighting, see Chapter 3, Working
with primitives and objects.

� if you have snap guides switched on, MicroGDS creates temporary
construction lines that you can use to help position and align
graphics precisely

For more details about snap guides, see Chapter 5, Entering
positions.

� the pointer constantly changes to identify the type and location of
the nearest snap point (if you have the ‘Dynamic pointer position’
check box selected in your preferences)

MicroGDS provides snapcodes to enable you to snap exactly to any
given point in a window. This ensures accuracy in drawing,
selecting, moving, and placing graphics. For details about the
snapcodes, see Chapter 5, Entering positions.
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You can create multiple windows, each showing a different view of the
same window definition or showing different window definitions. To
the left of each window are the viewing buttons for moving around the
view, and the zoom bar. These are described later in Working with views
on page 45.
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The current view extent is simply a view onto the drawing sheet. You
can think of the drawing sheet as a sheet of paper on a drawing board.
You can draw on any part of the sheet—you do not have to use the
entire drawing sheet.

You can change the view extent to see different parts of a drawing, and
you can enlarge or reduce the extent. For more details, see Working with
views on page 45.

When you start to draw, you choose a scale. You do not have to print at
this scale—you can choose to make your graphics fill as much or as
little of whatever size paper you have in your printer or plotter. When
you print a 2D or 3D view, MicroGDS prints only what is in view in the
view extent, so if you want to print the entire contents of the window,
you must ensure that it is completely in view. For a print-layout view,
MicroGDS always prints the whole of the paper.

Note that the sheet has a fixed-paper size of 100,000 km square, at a
scale of 1:1.
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By default, in the centre of the view extent are the axes. The axes
provide a powerful drawing aid when you draw and place graphics.

If the axes are within the view extent, by default the axes are always
displayed on the screen, but they are never printed. Each window has its
own set of axes but only the axes in the current view of a window are
shown.
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Positions on the sheet are measured in relation to the origin of the
current axes—using the X, Y, and Z coordinates. Coordinates are
shown, and given, in the order X, Y, Z. The coordinates are shown to
the right of the prompt bar. MicroGDS shows either the coordinates the
dynamic pointer position or the last point input, depending on your
preferences.

You can change the position of the axes and their rotation as you work.
You can save a window’s axes so that you can restore it at any time.
You can also choose to hide or show the axes on your screen.

For more details, see Chapter 6, Using the axes.
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By default, the position at the centre of the drawing sheet is called the
drawing origin. The point is 0 on the X, Y, and Z axes and is the
position on your drawing sheet that you use as a point of reference.

When you create a new, blank document, the normal axes’ position has
the axes’ origin at the drawing origin. If you create a document from a
template in which the drawing origin has been changed, the axes are set
at the centre of the drawing sheet and not at the position set by the
drawing origin.

You can change the location of the drawing origin, using the Document
Properties command. You might want to do this, for example, to
measure positions from the bottom, left-hand corner of a plan, rather
than from the centre. You can then move the axes’ origin to the drawing
origin using the Axes Normal command.

Note that the Axes Centre command always resets the axes to the centre
of the drawing sheet.

In the following example, the drawing origin in the first illustration is
set at the default position, that is at the centre of the drawing sheet at
coordinates 0/0/0. This is currently the centre axes’ and the normal
axes’ position. In the second illustration, the drawing origin has been
moved in a negative X direction. The drawing origin coordinates are
measured from the centre axes position, relative to the new drawing
origin. Therefore, the drawing origin is set to 50/0/0.
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1 On the Set menu, click Axes, Centre to set the axes to the centre of
the drawing sheet.

The drawing origin is specified as the position from the centre of the
drawing sheet relative to the new drawing origin.

2 On the File menu, click Document Properties.

3 In the Document Properties dialog box, enter the X, Y, and Z
coordinates for the new drawing origin, relative to the centre axes,
then click OK.

Coordinates are always displayed relative to the current axes and its
origin, even if you change the drawing origin.
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� on the Set menu, click Axes, Normal

For more details about coordinates and axes, refer to Chapter 5,
Entering positions and Chapter 6, Using the axes respectively.
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You can draw at any scale you like and in any measurement units; both
scale and units can be set on the status toolbar or by using commands
on the Set menu.
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� in the Scale box on the status toolbar, type or select the scale you
require

� or, on the Set menu, click Axes, Scale and enter the scale you
require in the prompt bar
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When you specify a scale, MicroGDS uses a scales file to determine the
scales that are available. You specify the scales file to be used in your
preferences. If you type a scale that corresponds to a value in the list,
then that element is selected. For details about creating a scales file, see
Chapter 17, Customizing MicroGDS.

When you have set the scale, all new graphics are drawn at this scale
until you change it. The scale of existing graphics is not changed.
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� in the Units box on the status toolbar, select the units you require; in
the Places box, type the number of decimal places

� or, on the Set menu, click Units, enter the units you require in the
prompt bar and then enter the number of decimal places you require

The number of decimal places does not affect the accuracy to which you
draw, only the precision to which dimensions and numbers are
displayed in MicroGDS.

For more details about inputting positions, see Chapter 5, Entering
positions.
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A view comprises a number of settings including the extent of the
window definition that is visible and the window quality settings used
to display the graphics.

The window quality settings determine how graphics are to be
displayed. You can set the window quality using the Quality command
on the View menu. For details, refer to Help.

In MicroGDS, there are three view types that you can switch between:

� 2D view

2D is the default view of a window definition. The extent of the
view is in the XY plane.

� 3D view

A 3D view extent is defined by the eye position and the look-at
point. This determines the (pyramid-shaped) cone of view, with the
apex of the cone at the eye position. For more details, see Chapter 9,
Working in 3D.
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� print layout view

Print layout view is specifically for setting up how the physical page
will be printed. A print layout view stores the paper size, orientation,
and margins. The extent of the view is in the XY plane.

In general, a print layout view behaves similar to a 2D view.
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� on the View menu or on the View toolbar, click the view type you
require:

2D view

3D view

print layout view

You can also switch between views using the viewing buttons which are
on the left of each window. These are described later in this chapter.
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When you switch to 3D for the first time, a default 3D perspective view
is shown.

When you subsequently switch to 3D, a view with the previous 3D
parameters is shown.
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When you switch to print layout for the first time, MicroGDS displays
the Page Setup dialog box for you to set your paper size requirements.
For example:

The name of the paper displayed in the Paper box defines the
orientation, paper size, and margins of the current paper. MicroGDS
uses a paper sizes file to determine the paper definitions available to
you. A sample file called ‘paper sizes.csv’ is installed to your
MicroGDS Programs folder and is automatically referenced in your File
Location preferences. For details about editing or creating a paper sizes
file, see Chapter 17, Customizing MicroGDS.

You can select any paper available to you. You can also change any of
the displayed settings, for example, you can increase the margins to add
more white space around your graphics.

When you subsequently select print layout, MicroGDS uses the paper
definition that you set up. The paper definition is saved with the
window when you save the document. To change the assigned paper
size at a later date, use the Window, Page Setup command on the File
menu, or click the Page Setup button on the Window Editor. The
Window Editor is described in Chapter 4, Using layers and phases.
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When you work with a document, you will constantly need to change
the extent to see different parts of the view in the window definition. In
MicroGDS, you can move around a view, and you can zoom in and out
to enlarge or reduce the extent.

Each time you change a view, MicroGDS records the new parameters
and updates the view parameters.

There are a number of ways in which you can view different parts of a
window definition. For example, you can use:

� the zoom commands and the zoom bar

� the scroll bars

� the viewing buttons

� the Navigate window

� commands on the View menu

You can also view and manually change the parameters using the View
Parameters command on the Window menu. More details about the
view parameters are given in Chapter 9, Working in 3D.

If you are using a wheel mouse, you can zoom in and zoom out of the
current window by rotating the wheel, and pan the window by pressing
the wheel whilst moving the mouse.

The zoom bar, scroll bars, and the viewing buttons are known
collectively as the view controls. You can choose which view controls
you want to be made available on your windows. For details, see Setting
the view controls on page 53.
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Use the zoom bar to zoom in and out of the window about the current
view centre. By default, the zoom bar is situated on the left side of the
window, below the viewing buttons.
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To zoom out, click above the slider; to zoom in, click below the slider.
Or drag the slider in the required direction.

� in a 2D view

Dragging the slider to the top of the zoom bar zooms out 100 times,
and dragging it to the bottom zooms in 100 times. The slider
automatically returns to the centre of the zoom bar when you release
it.

� in a print layout view

The zoom bar behaves in an absolute manner, relative to the selected
paper size. Note that you cannot zoom out beyond the selected paper
size.

You can also zoom in and out using the viewing buttons, and the Zoom
commands on the View menu.
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You can pan around a window definition using the scroll bars. The
vertical scroll bar is on the right of the window and the horizontal scroll
bar is at the bottom.

The scroll box indicates the extent of the graphics shown in the window
as a proportion of the total extent of all graphics. When all graphics are
shown, the scroll box fills the entire scrolling area; no background is
visible.
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In a 2D view, you can scroll the view almost without limit; in a print
layout view, you can scroll only to the extent of the selected paper.

For details about navigating in 3D views, see Chapter 9, Working in 3D.
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You can use the viewing buttons, at the left of each window, to change
the view. You can select different viewing buttons to display on 2D
(including print layout) and 3D views using the View Controls tab on
the Customize dialog box. To open the Customize dialog box, click
Profile, Customize on the Window menu.

The default buttons on a 2D window are:

switches to 2D view

switches to 3D view

switches to print layout view

expands the view extent to fill the window (not available with a print
layout view)

zooms in to a rectangular area that you specify

zooms to show the selected graphics as large as possible

zooms to show all the graphics as large as possible.

In print layout view, shows only graphics that are within the paper
extent.

switches back to the previous view

switches forward to the next view

creates a new window with a view extent that you specify

aligns the view with the current XY axes (not available with a print
layout view)

creates a new window with a view extent that you specify

advances to and retreats from a point

sets the drawing style in which to draw intelligent objects

These and other commands, such as changing the graphical quality of
the window, are also available through the View menu. All commands
to change the view in a window are also available from the View
toolbar.
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The default buttons on a 3D window are described in Chapter 9,
Working in 3D. More details about choosing view controls are given in
Setting the view controls on page 53.

When you change the view, you can use the Next View and Previous
View commands to move forwards and backwards between views. This
enables you, for example, to concentrate on a specific part of the
window and to see the results instantly by returning to the previous
view.
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When you have a 2D or print layout view, the Navigate window enables
you to zoom, nudge, pan, and move around using a thumbnail view. A
thumbnail shows a small picture that you can use to navigate the default
view in the associated window definition. A thumbnail is not available
in a 3D view.

For example:
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If the view is zoomed in on a specific part of the default view, the view
extent is highlighted in the thumbnail and the area outside is shaded in
the Navigate window.

*�����'����
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1 Ensure that the window whose contents you want to view in the
Navigate window is the active window.

2 On the Window menu, click Navigate.

When the Navigate window is open, the thumbnail is immediately
updated whenever you make a different window definition active.

You can select the viewing buttons to display on the Navigate window
on the View Controls tab of the Customize dialog box. For more details,
see the next section Setting the view controls.
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� using the right mouse button, drag the mouse pointer across the
required extent

As you drag, a rectangular outline is drawn to indicate the new view
extent.

For example:

When you release the mouse button, the view extent is updated.

The view extent of a print layout view cannot be larger than the
paper extent.
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� using the left mouse button, drag the rectangle in the thumbnail to
move the position of the view extent

Or, click at the new centre of the view.
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You can show and hide the zoom bar, the individual viewing buttons,
and the scroll bars. By default, a subset of viewing buttons are visible
on each graphics window and on each Navigate window. You can also
choose a different set of buttons for 2D (including print layout) and 3D
views, and change the orientation of the view controls.
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1 On the Window menu, click Profile, Customize.

2 On the Customize dialog box, click the View Controls tab.

3 Switch the zoom control options on and off by selecting the check
boxes.

4 To set the orientation of the controls, select Horizontal or Vertical.

5 Click OK.

��
����� ����&�#���#��'�� �
Each window definition has a default view. This is created
automatically whenever a new window definition is created. You can
create additional new views, rename a saved view, and change the
default view. You can also save and recall views.
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You can view different parts of the same window definition at the same
time. For example, you may want to create a new view from a view
which has a rotated axes. Or, you may want to have two views zoomed
into different parts of a window—one shown in 2D and the other shown
in 3D. You do this by creating a new view of the window.

When you create a new view, it is not a new window definition but
simply another view onto the active window. Any changes you make to
the graphics in one view are reflected in any other views.
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1 Open the window definition in which to create a new saved view.

2 Set up the view extent that you want to save.

3 On the View menu, click Save View As.
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4 In the View Name dialog box, specify the name for the view and
click OK

The view is added to the list of views, beneath the appropriate
window definition on the Document Organizer.

Note that you can also use the View Parameters dialog box to create
new saved views.
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1 In the Document Organizer, click the plus sign to the left of the
window definition whose views you want to list.

2 Double-click the name of the view to show.
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1 In the Document Organizer, expand the window definition whose
views you want to modify.

2 Right-click over the name of the view to set as the default view, and
select Set as Default.

The name of the view is shown in bold, to indicate that it is now the
default view.
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1 In the Document Organizer, expand the window definition whose
views you want to modify.

2 Select the view you want to rename and press F2.

3 Enter the new name and press Enter.
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When you open an existing document, by default MicroGDS displays a
default 2D view of the principal window based on your current printer
settings. For example, if your printer is set to A4 portrait, the view of
the window is displayed in portrait view. Note that the size of the view
is slightly smaller than the paper size to allow for the margins.
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If you are working on a specific part of a drawing that contains many
graphics, you may find it useful to save the view so that you can quickly
return to it later. Then, when you next open the window definition for
which you have a view saved, MicroGDS displays the saved view
instead of the default view. You can also recall the saved view at any
time.

Note that saving a document does not save the current view; you must
explicitly save the view you require.

Saving views can also be useful if you embed a MicroGDS document in
another application such as Word. You can save the view at the same
extent as the embedded document. Then, when you double-click the
embedded document, it is opened in MicroGDS at the same extent as it
appears in the application. For details about embedding and linking
data, see Chapter 15, Working with different file formats.
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� on the View menu, click Save viewname

Once you have saved a view, you can restore it later. You might want to
do this, for example, if you change the extent of the view.
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� on the View menu, click Restore viewname
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1 On the File menu, click Exit.

If you have made changes to your preferences, you are prompted to
save your personal settings.

2 Click Yes or No to save or abandon the changes, as required.

If you have any unsaved changes to your documents, MicroGDS
prompts you to save them before exiting.



56 Using MicroGDS 11



57

Chapter

33
��
����� �����
�&���'������

�()�	��

�
�&���'��������()�	��
All the graphics you see in a drawing consist of primitives and objects.
A primitive is a basic graphic item, such as a line or a block of text. An
object is a collection of graphics, which can be primitives or objects.
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A primitive is a graphical element drawn using a single command.
Primitives are the building blocks of a drawing. There are several types
of primitive:

� line primitives

Line primitives include multi-segments lines, arcs, circles,
rectangles and so on. Details on line primitives are given in Line
primitives described next.

� text primitives

Text primitives can be created in MicroGDS or can be imported text.
Details on text primitives are given in Chapter 8, Working with text.
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� OLE photo primitives

OLE primitives (Object Linking and Embedding) include Adobe
Acrobat and Microsoft Office documents and graphic images saved
as bitmaps. Details on OLE primitives are given in Chapter 15,
Working with different file formats.

� window photo primitives

A window photo primitive is a snapshot of the graphics in one
window that is displayed in another window. Details on photo
primitives are given on page 59.

� raster primitives

Raster primitives are images inserted into a drawing. Details on
raster primitives are given in Chapter 15, Working with different file
formats.

� clump primitives

Clump primitives are made of a material, and can also have a
different material allocated to each face. Details on clump primitives
are given in Chapter 9, Working in 3D.

Primitives are grouped together into objects; one primitive can be part
of only one object.
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Line primitives are made up of vertices and segments:
� a vertex is a point where two line segments join (for example, a

corner), or the point at the start and the end of a line

� a segment is a line between two vertices; it can be straight or curved

A number of MicroGDS commands work on paths. A path is a distance
along a line primitive between any two selected points (these do not
need to be vertex points). For example, you can delete a path or change
the linestyle of a path.
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For example:
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All line primitives have at least two vertices, one at the start and one at
the end. A line primitive that consists of a single segment has two
vertices, and a line primitive that consists of two segments has three
vertices. The start and end vertices of a closed primitive are at the same
position. A rectangle, for example, has five vertices, one on each corner,
and an end vertex at the same position as the start vertex.

When you draw a line primitive, MicroGDS adds vertices between
segments on the line. You can also add a new vertex to an existing line.
For example, the following rectangle (a closed-line primitive) has five
vertices. By adding another vertex, you can change the shape of the
graphic as shown in the example below:
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For details about adding, moving, and deleting vertices, refer to Help.
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A window photo primitive is a snapshot of the graphics in one window
definition (the source window), that is displayed in another window
definition (the destination window). The photo can reference a window
in the same document or in a different document.
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Window photo primitives are useful for composing plot compositions.
For example, if window definition A contains a frame, and window
definition B a building plan, you can construct photos of them both and
combine them in window definition C.
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Typically, you would use a print layout view for plot compositions. In a
print layout view, the size of the view corresponds to the size of chosen
paper. For details about print layout views, see Chapter 2, Exploring
MicroGDS.

Note that the contents of a window photo primitive are not shown in 3D
views.

When you insert a photo into a window definition, the location of the
original window from which it was taken is saved with it. Whenever the
original window definition is updated, MicroGDS updates the contents
of the photo. If the source window and target windows are in different
documents, you can set up a reference alias to point to the source
document’s location. Then, if the source document is moved to a
different location, you need only change the path of the alias. For
details about setting up aliases, see Chapter 2, Exploring MicroGDS.

If you open a document in which the source of a referenced photo
cannot be found, MicroGDS reports the error condition to the Problems
dialog box.

To re-establish the link, you must correct the name and location of the
document and/or window that contains the original graphics:

� if the location of the source file is aliased, you can edit the alias path

You can edit the alias path using the Problems dialog box or the
Aliases command on the File menu.

Note that you can only edit the path of an alias in a single-user
document. Reference aliases in a multi-user project are set up in the
project database. For details, see Chapter 16, Multi-user projects.
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� if the location of the file is not aliased, or you do not want to change
the alias path, you can edit the photo path

You can edit the photo path using the Problems dialog box, the
Properties window, or the Photo, Edit Path command on the Alter
menu.

Note that you can use the Many Paths command on the Edit menu to
update the paths of multiple missing linked graphics.

You can move, scale, and rotate a window photo primitive by
manipulating the photo border. You can also also assign a linestyle to
the photo border or change its shape using many of the primitive editing
commands. For example, you can move vertices to make an oblique
shape or use the Fillet command to round-off the photo corners. You
can even swap the border with that of another line primitive.

You can also snap onto the individual graphics within a photo primitive.
For example, you might want to align a specific item in the photo with
an existing graphic in the window, or measure the distance between two
points in a photo.

If you want to edit any of the graphics in a window photo primitive,
without changing the original graphics, you can burn in the photo. This
converts the photo primitive to graphics in your document which you
can then edit locally.

Full details on working with window photos are given in Help.
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An object is a collection of graphics. In MicroGDS, there are several
types of object:

� a plain object stores a collection of primitives

� an instance object does not contain graphics of its own, but has a
link to the original object in the document in which it is stored

� an intelligent object is created from graphics and attribute data or
just attribute data

An attribute is non-graphical information that can be attached to
graphics, such as height, colour, or cost.

� an assembly object contains only other objects; assembly objects can
contain plain objects, instance objects, intelligent objects, and other
assembly objects
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Each object has a name and can be treated as a single item that you can
edit, move, and so on. The commands that you can use, however,
depend on the type of object with which you are working.

When you construct primitives, they are automatically included in the
current plain object. By default, the current object is called no:name
until you create a new object. The name of the current object is shown
on the status toolbar.

You can change the default object name to something more meaningful
using your preferences, if you prefer. For details, see Chapter 17,
Customizing MicroGDS.
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Many MicroGDS commands require you to select graphics. For
example, if you want to move, copy, or alter an item, you must first
select it.

Before you select graphics, you must choose to select them as
primitives or as objects. If you select the graphics as primitives, you can
edit the individual primitives or a number of primitives from different
objects. If you select the graphics as objects, you edit all the primitives
within the whole object.

When you select a primitive or an object, the graphics change colour.
You can choose the colour in which to show selected graphics in your
preferences.

You can use the Set Edit command to define a filter to restrict editing to
particular primitives. For details, see Restricting editing on page 91.
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� press F9, or on the Edit menu, click Select Primitives
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� press F10, or on the Edit menu, click Select Objects

The way in which you select items depends on the ‘Explorer-like
selection and drag-and-drop’ option in your preferences. If this option is
selected, then the Windows behaviour is used; if the option is cleared,
then the default MicroGDS behaviour is used.

The following assumes that you are using the default MicroGDS
behaviour; if you are using the Explorer-like behaviour, refer to Help
for the equivalent details.
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1 Click the item using the appropriate snapcode:

� if you are selecting primitives, only the primitive you click is
selected

� if you are selecting objects, the primitive you click and all other
primitives within the same object are selected

If you select an assembly object, all objects within the assembly
are selected.

In MicroGDS, you use snapcodes to snap exactly to points on
existing graphics. As you move the pointer around, you see
snapcodes displayed beneath the mouse pointer. For more details,
see Chapter 5, Entering positions.

If multiple items lie within the snap radius of the mouse pointer, you
can cycle through the graphics by pressing Spacebar. When the item
you want to select is highlighted, click the mouse button or type the
displayed snapcode.

Note that you can change the key that is assigned to cycle through,
using your preferences.

2 To add to the selection, press Shift and click each item.

To deselect an item, press Shift and click the item.

You can select and deselect all graphics in a window. If you are
selecting primitives, all primitives will be selected, and if you are
selecting objects, all objects will be selected.
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� press F7, or on the Edit menu, click Select All
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� press F8, or on the Edit menu, click Deselect All

When in selection mode, you can select adjacent items by enclosing
them in a box.
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� click at the start of the box and then click at the opposite corner of
the box

You can deselect items and add to the selection by pressing Shift when
you define the box.
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To include all graphics that cross the boundary of the enclosing
rectangle, press Tab before giving the second position. When you press
Tab, the bounding rectangle changes to a dotted line. For example:
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Another way to select graphics is to use the Fence command on the Edit
menu to draw a fence. The graphics that are selected by the fence
depend upon the selection mode, that is, whether you are selecting
primitives or objects.

For more details on the select commands, refer to Help.
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By default, as you move the mouse over a drawing, graphics are
automatically highlighted. This provides constant feedback on your
drawing, and gives a clear indication of complex structures. Graphics
are highlighted only if the command you are using is able to operate on
them.

In select primitive mode, the primitive beneath the mouse pointer is
highlighted. In select object mode, the primitives within the object and
the extent of the object beneath the pointer are highlighted. The object
hook point is also shown (as a butterfly shape) if it is within the view
extent. The hook point can be thought of as the ‘handle’ of the object,
and is described further on page 68.
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If you continue to hover over a graphic, an InfoTip is shown giving
details about the highlighted primitive or object:
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The details in the InfoTip depend on the type of graphic that is
highlighted. For details about the type of information displayed, refer to
Help.

When a command is in progress, the graphic feedback reflects what is
required and highlights only items on which the command can operate.
For example, if you are moving a line segment, only the line segment
currently beneath the mouse pointer is highlighted:

When MicroGDS highlights an item, you can press Spacebar to move
through any other items that are within the snap radius. For example, if
you want to alter a line primitive but the primitive is obscured by other
primitives, use Spacebar to cycle through the graphics until the
primitive you want to alter is highlighted.

You can choose the level of hover highlighting you require using the
Hover Highlight button on the information bar, at the bottom-right of
the MicroGDS window:
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You can choose from:

� highlight graphics and show InfoTips

� highlight graphics only

� do not highlight graphics or show InfoTips

� show InfoTips only

Note that you can customize InfoTips using your Snapping preferences.

When the mouse pointer is over an object or primitive in selection
mode, to which a URL attribute has been assigned a link icon is shown
to the left of the mouse pointer:

This indicates that a hyperlink exists which you can open. For details
about assigning attributes, see Chapter 14, Working with attributes and
schemas.
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You can use the Properties window to see details about selected
graphics. The information available depends on whether you select
graphics as primitives or as objects. For example, in primitive mode, the
details include the number of vertices, the colour, and the linestyle
assigned to the primitive.
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1 In primitive or object mode, select the graphic whose details you
want to view.

2 If the Properties window is not currently displayed, press Ctrl+Q, or
on the Window menu, click Properties.

The first time you open the Properties window, the ‘Details display’ is
shown. This gives details about the document, layer, object, and
primitive (if in primitive mode) for the selection.
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For example:

You can use the buttons at the top of the window to view details for the
selection in different ways. If you save your settings when you exit
MicroGDS, MicroGDS remembers the last view selected in the
Properties window.

For more details about viewing the properties of graphics, see
Chapter 13, Getting information.
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As soon as you start to draw a primitive, it is included in the current
object and placed on the current layer.

To draw a primitive, you select the type of primitive you want to create
using the toolbars or menu commands, and then draw the graphic. For
example, to draw a line, you select the Construct Line command and
then specify the start and end points of the line.

Line primitives are drawn using the current linestyle. Linestyles define
the appearance of a line and are made up of one or more strokes. A
stroke can define the line thickness, the fill, or the pattern in which lines
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are drawn. The name of the current linestyle is shown in the Line box
on the status toolbar. For more details, see Chapter 7, Working with
linestyles.

Text primitives are drawn using the current charstyle. Charstyles define
the font, size, and style in which text is drawn. A charstyle also defines
any spacing around the text. The name of the current charstyle is shown
in the Char box on the status toolbar. For more details, see Chapter 8,
Working with text.

The commands for drawing graphics are on the Construct menu. Full
details on constructing graphics are given in Help.
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To group primitives into a new object, you usually create the object
before you draw the primitives. However, you can also move existing
graphics into a new object.

When you create a new object, you are prompted for the object’s name
and its hook point. The hook point can be thought of as the ‘handle’ of
the object and can be used, for example, to pick up and place the object
at an exact point in the window. It is also used in other commands that
work on objects.

Note that new objects are created on the current layer, therefore you
should first set the layer on which you want to create the object. For
details, see Chapter 4, Using layers and phases.
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1 If you want to move existing graphics into a new object, select the
graphics.

2 Do one of the following:

� to create a new empty object, on the Object menu, click New

� to create a new object from the selected graphics, on the Object
menu, click New from Selection
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The New Object dialog box is displayed. For example:

3 In the Name box, type the name of the object.

MicroGDS provides the current object name as the default.

The name must conform to the standard naming rules, described in
the next section.

If you are using a name assistant, you can select the object name
from the Object list. If you are not using the name assistant, the list
is empty.

You are now required to enter a position for the object’s hook point.

4 To set the hook point at the origin of the current axes, press Esc.
Otherwise, click a point in the window.

The new object is created on the current layer.

Note that you can change the location of the hook point using the Hook
command on the Object menu. For details, refer to Help.

You can also check that you have positioned the hook point correctly,
by hovering over the object (in select object mode), where you will see
the hook point. Alternatively, you can use the Axes, Reset command on
the Set menu. For details about the axes and objects, see Chapter 6,
Using the axes.



70 Using MicroGDS 11

�()�	���	�#�������"��

When you create an object, the current scale and current axes rotation
are saved with it. In this way, an object has its own internal scale and its
own axes, whose origin is located at the object’s hook point.

Note that you can move an object and change its axes rotation using the
Object Reposition command. For details, refer to Help.

Take care when placing objects that have a different scale from that of
the set axes scale. For example, if you copy an object with a scale of
1:50 from a window, and paste it into a window where the current scale
is 1:100, it would appear at half the size.

Note that you can change the scale of an object at any time using the
Scale command on the Object menu. For details about axes and scales,
see Chapter 6, Using the axes.
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You should structure object names in a meaningful way so that you can
use filters. Filters enable you to manipulate graphics in different ways.
For example, they enable you to restrict editing to only those objects
whose names contain certain characters. For more details, see Filtering
object names on page 72.

Rules for naming objects are:

� an object name can contain up to 256 characters and can include
spaces and certain punctuation marks

For a list of all valid characters that you can use in an object name,
refer to Help.

� object names can be separated into up to six facets (sections)

For example, the object name no:name has two facets: ‘no’ is one
facet, and ‘name’ is the other.

If you are creating an intelligent object using the predefined BIM
components provided with MicroGDS, the first facet of the object
name must conform to one of the predefined names. For more
details, see Using BIM intelligent objects on page 81.
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� each facet is separated by a colon (:)

You can use semicolons instead of colons. For example, if it is
easier, you can type internal;wall;plaster rather than
internal:wall:plaster. MicroGDS automatically converts the
semi-colons to colons.

Invalid characters are converted to colons.

� object names with only one facet can have between one and 255
characters, and must end with a colon

� object names are case sensitive, so ‘rad:1000’ and ‘RAD:1000’ are
two different objects

When you name objects, try to give them clear, descriptive names. For
example, the following object is a gas cooker:

The name for this object might be:

I:Kitchen:Cooker:Gas:Free

where:

I indicates that the object is part of the interior detail
Kitchen indicates that the object is located in the kitchen
Cooker indicates that the object is a cooker
Gas indicates that the cooker is gas sourced
Free indicates that the cooker is freestanding

If your system administrator has set up special naming standards for
layers and objects for your site and these are enforced, when you create
an object or a layer, MicroGDS displays a dialog box showing a
tree-like structure of naming conventions. This enables you to create
names by selecting facets from the list. For more details about name
assistants, see Chapter 2, Exploring MicroGDS.

Note that the object naming conventions are not displayed unless the
current layer name conforms to the layer naming conventions.
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You may want to rename existing objects from time to time. For
example, you may want to change the name of an object that you have
copied from another document. MicroGDS provides commands for
renaming a single object or a number of objects. These are described in
MicroGDS Help.
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Using a comprehensive naming structure for objects makes it easy to set
filters (using wildcards) when you set up an inclusion list. You use an
inclusion list when you want to define the graphics which:

� can or cannot be edited in a document, using the Set Edit command

For details about using the Set Edit command, see Restricting
editing on page 91.

� are to be displayed in a phase, using an inclusion list in the Window
Editor

For details about setting up an inclusion list in the Window Editor,
see Chapter 4, Using layers and phases.

You use the asterisk as the wildcard character to match facets in object
names, as follows:

* means match this single facet

** means match the remainder of the object name

You can also use the question-mark (?) to match any single character of
an object name.

For example:

Object name Wildcard Match
kerb: kerb:** �

kerb:paving �

kerb:paving:dropped �

external:kerb �

kerb: kerb:* �

kerb:paving �

kerb:paving:dropped �

kerb: kerb:*:dropped �

kerb:dropped �
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Object name MatchWildcard
kerb:paving:dropped �

kerb: **:paving �

kerb:paving �

kerb:paving:dropped �

kerb: kerb:? �

kerb:A �

kerb:B �

kerb:paving �

You can also reverse the sense of the action using an Exclude rule. For
example:

Exclude kerb:**

will match everything except objects with kerb as their first facet.

You can also use advanced filters to specify which primitives and
objects can or cannot be edited, and will or will not be displayed, using
attributes. For details, see Chapter 14, Working with attributes and
schemas.
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You can insert objects from one single-user document into another
document. This enables you to build up libraries of objects that you can
re-use at any time.

You can also link objects from other single-user documents to your
current document. A linked object is known as an instance object. An
instance object does not contain graphics of its own in the current
document, instead, it has a link to the original object in the document in
which it is stored. You can create libraries of standard objects, and these
objects can then be linked to a number of different documents as
instance objects, to ensure that the objects in the documents are all the
same.

Note that you can insert or link only to top-level objects, you cannot
insert an object that is part of an assembly object.
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If you are inserting or linking several objects in a document, you can set
up aliases to map the physical location of the files containing the
objects to an arbitrary name. If the files are later moved to a different
location, you need only change the pathname in the aliases table.

Note that if you want to use aliases, you should define the aliases before
you insert or link the objects to the document. For details about setting
up aliases, see Chapter 2, Exploring MicroGDS.

When you insert an object or an instance object, styles may be copied to
the target document if they are needed. If style names of the same type
already exist in the document, those are used instead.
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When you set up aliases for object libraries, the library aliases are
shown on the Library tab in the Document Organizer. This enables you
to insert library objects directly from the aliased locations.

You can also insert objects from aliased and non-aliased libraries, using
the Object menu. For details, see MicroGDS Help.
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1 If the Document Organizer is not displayed, press F4, or on the
Window menu, click Document Organizer.

2 Ensure that the appropriate document is the current document in the
Document Organizer.

3 Click the Library Files tab:
2��	�	��3��������

A list of each aliased object library file is displayed.

If you have not defined any aliases for object libraries, you can
either define the alias before you continue, or you can insert an
object using the Object menu.

4 Double-click the library MAN file that contains the object to insert.

The layers in the library are listed.
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5 Double-click the layer that contains the object to insert.

The objects in the library are listed.

You can preview an object by selecting its name. If the preview is

not currently visible, click 

6 To insert the selected object into the active window:

� to copy the object directly into the window, on the shortcut
menu, click Insert Object

� to create an instance object, on the shortcut menu, click Insert
Instance

MicroGDS prompts you to specify the position for the library
object, or to press Enter if you want to change the object size or
orientation.

For details about transforming objects, refer to Help.

For details about specifying positions, see Chapter 5, Entering
positions.

Note that you can also insert an object by dragging it into the window
definition. You can then move it to the required position and, if
necessary, use the Transform commands on the Alter menu to rotate,
enlarge or reduce, mirror, and stretch the graphics.

You can also use the shortcut menu in the Document Organizer on a
library file or a layer to open the Object Insert dialog box, with the
selected item as a filter. For more details about inserting objects, refer to
Help.
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When you insert an instance object into a document, you can view the
physical file location of the object in the Properties window.
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1 Press Ctrl+Q, or on the Window menu, click Properties.

2 Select the instance object to query.

The Properties window displays details about the library object,
including the name and location of the file in which the object is stored
and the name of the object.
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For example:

You can see more details about the instance object in an InfoTip, by
hovering over the Library object property.

If you selected the instance object in primitive mode, the Properties
window also shows the names of any styles, for example, the linestyle
or charstyle assigned to the primitive you clicked on in the instance
object. Note that the original styles may be copied to the target
document if they did not already exist.

Instance objects are read-only. You can change the size and the scale,
and move, copy, paste, and delete an instance object, but you cannot
change any of its individual primitives or add new primitives to the
object. Note that you must be in select object mode (F10) to manipulate
an instance object. If you delete an instance object, only the instance in
the current document is deleted.

If you open a document that contains an instance object that cannot be
found, for example, because the file has been moved to a different
location, MicroGDS displays the following symbol in its place:
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To re-establish the link, you must correct the name and/or location of
the MAN file that contains the original object:

� if the location of the file is aliased, you can edit the alias path

You can edit the alias path using the Problems dialog box or the
Aliases command on the File menu.

Note that you can only edit the path of an alias in a single-user
document. Library aliases in a multi-user project are set up in the
project database. For details, see Chapter 16, Multi-user projects.

� if the location of the file is not aliased, or you do not want to change
the alias path, you can edit the instance object path

You can edit the instance object path using the Problems dialog box,
the Properties window, or the Instance, Edit Path command on the
Object menu.

Note that you can use the Many Paths command on the Edit menu to
update the paths of multiple missing instance objects.

For more details on these commands, refer to Help.

If you want to make changes to the original object, for example, to alter
a primitive, you can open the file that contains the original object.
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1 On the Object menu, click Instance, Open.

2 Click the instance object whose MAN file you want to open.

Alternatively, double-click the instance object to open the MAN file to
which the object is linked.

The window definition of the document containing the original object
opens in a new window. The extent of the window is set to the extent of
the original object.

If changes are made to the original object, all instances of that object
are also changed. However, if the original object is changed and saved
while you are working with a document that references it, you will need
to update the document to see the changes.
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� on the Object menu, click Instance, Update

If you want to edit an instance object, without changing the original
object, you can burn in the object. You can then modify the object, or
any of its primitives.
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1 Press F10, or on the Edit menu, click Select Objects.

2 Select the instance object to burn in.

3 On the Object menu, click Instance, Burn In.

Any changes made to the original object will no longer be reflected in
the converted object.
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An assembly object is a collection of objects that can be used and
manipulated as a group. You can insert, scale, and rotate an assembly
object in a drawing. You can open an assembly object to access its
individual objects, modify them, and then close the assembly to work
with it once again as a group.

For example, suppose you are designing a dining room layout, you
might arrange table and chair objects into an assembly, which you could
then move about as a group.

Assembly objects can contain plain objects, instance objects, intelligent
objects, and other assembly objects. An assembly object can also be
instanced.

You can create libraries of standard assembly objects, which can then be
referenced by a number of different documents as instance assembly
objects. This will ensure that the graphics in the documents are all the
same. If the source assembly is edited, the instance assembly objects
can all be updated to make the changes visible.

Note that when you insert an object from a library, you can insert only
top-level objects, you cannot insert an object that is part of an assembly
object. As a consequence, if you insert an object as an instance object
and you later move the object into an assembly, the link will be broken.

Each assembly object has a name, hook point, scale, and rotation
associated with it. An assembly object, and all objects it contains, exist
on a single layer.
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To group objects into a new assembly object, you can either:

� create the assembly object and then create the objects it will store

� or, move existing objects into a new assembly object

The procedure for creating new assembly objects is similar to creating
new objects, described on page 68. This procedure is summarised
below; for full details refer to Help.
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1 If you want to move existing graphics into a new object, select the
graphics.

2 Do one of the following:

� to create a new empty assembly object, on the Object menu,
click Assembly, New

� to create a new assembly object from the selected objects, on the
Object menu, click Assembly, New from Selection

The New Assembly dialog box is displayed. This dialog box is the
same as the New Object box, except for its title.

3 In the Name box, type the name of the assembly object.

The name must conform to the standard naming rules. For details,
see Rules for naming objects on page 70.

If you are using a name assistant, you can select the assembly object
name from the Object list. If you are not using the name assistant,
the list is empty.

You are now required to enter a position for the assembly object’s
hook point.

4 To set the hook point at the origin of the current axes, press Esc.
Otherwise, click a point in the window.

The new assembly object is created on the current layer and is
opened for editing.

If the assembly object is empty, its extents are initially set to the
view extent; any visible graphics outside the extent are shown faded
to indicate that they cannot currently be edited. If the assembly
object contains graphics, its extent is set to the boundaries of the
objects it contains.
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For example:

You can now create new objects which will be stored in the
assembly object. If you immediately begin drawing without creating
a new object, the primitives are automatically included in a new
plain object.

When you have finished working with an assembly object, you can
close it.
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� double-click outside the boundary of the assembly object

� or, on the Object menu, click Assembly, Close
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� in Select Object mode (F10), double-click the assembly object

� or, on the Object menu, click Assembly, Open
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Sometimes, you might want to move the contents of an assembly object
up one level to its parent assembly or layer. You can do this easily, by
dissolving the assembly.
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1 Press F10, or on the Edit menu, click Select Objects.

2 Select the assembly object that you want to dissolve.

3 On the Object menu, click Assembly, Dissolve.

Any selected assemblies are moved to their parent assembly, or to
the layer if no parent assembly exists. The empty assembly objects
are deleted.
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In MicroGDS, a BIM (Building Information Modelling) intelligent
object is modelled parametrically from MicroGDS data. This is
typically achieved from line primitives and attribute data, or just
attribute data. The attributes are referenced in Object-level schemas.
The schema defines which objects a set of attributes are intended to be
used with. Each schema defines an objectstyle which describes the
properties of an intelligent object.

For example, a wall can be modelled as plan linework which defines its
centreline, together with a height, and a style which defines the layers
of the wall (for example, brick, cavity, and plaster). Individual
properties of the wall style, such as the thickness of the layers, can then
be overridden on an individual basis using the Properties window.

MicroGDS provides a set of predefined BIM (Building Information
Modelling) components, such as walls, doors, and windows. New
components will become available. It is recommended that you
periodically check the Informatix website for updates.

The basic procedure for creating an intelligent drawing is:

1 Set the style search path of your document to reference the
components that make the intelligent objects and drawings
available.

2 Set the drawing style to one of the BIM drawing styles.

3 Create a new object and name it using one of the predefined BIM
object names.

4 Set the objectstyle to the name of the schema that defines the
behaviour of the object.

5 For walls and slabs, draw ordinary line graphics to represent the
reference line of the wall or slab.

6 Modify the attribute values to tailor the objects to your drawing.
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You can customize the BIM environment in various ways, such as by
creating your own objectstyles or changing the mnemonic definitions
that describe the behaviour of a particular intelligent object. You can
also define your own BIM components. For more details, see
Chapter 17, Customizing MicroGDS.
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To enable the construction and drawing of BIM intelligent objects, you
must tell the MicroGDS document that you are going to be using
intelligent objects in your drawing. You can immediately tell if a
document can use intelligent objects by looking at the drawing style. If
the only entry shows <<Automatic>> then the document is not enabled
for intelligent objects. To enable the document, you add an entry to the
Style Search Path that points to the location of the BIM application
data:

<*MICROGDS_COMMON_APPDATA>BIM

This is the default location set up during the MicroGDS installation.
Note that by using this system format, you will not need to update the
path for each of your MicroGDS documents if the installation procedure
changes the location of the data in a future release; it will be done
automatically.

If you define your own intelligent objects, you need to reference the
relevant path to your own files on the style search path. For details, see
Chapter 17, Customizing MicroGDS.

Now several new entries appear on the drawing styles list. These
determine the the level of detail to show for the graphics in the current
view.
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When you work with a document that contains intelligent objects, you
choose a drawing style. Each drawing style is defined by a
Window-level schema. The schema contains attributes and a reference
to a predefined .NET assembly that determine the appearance of the
view. (The .NET assembly is responsible for the display of MicroGDS
BIM objects in the current view, in the selected drawing style.)
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1 On the viewing buttons or on the View toolbar, click 

2 Select the drawing style to set from the list.

MicroGDS provides the following drawing styles:

� Ceiling: shows a mirrored orthographic, bottom view of the solid
model of the building. Similar to ‘Detail’, this drawing type
using a clip plane and section styles to generate the required
drawing.

Note that clip planes and section styles are described in
Chapter 9, Working in 3D.

� Detail: shows an orthographic, top view of the solid model of the
building; this drawing type uses a clip plane and section styles to
generate the required drawing.

� Elevation: shows a horizontal, orthographic view of the solid
model of the building.

� GA (General Arrangement): shows a 2D view which draws the
building using linestyle and masking techniques. For large
buildings, you will probably want to use this drawing style for
most interaction as it is the fastest to draw.

� Perspective: shows a general purpose 3D view of the solid model
of the building.

In the 3D viewing styles, the reference line is not normally visible,
but becomes visible when the object (and no other object) is
selected.

In documents that are not enabled for intelligent objects, the
drawing style is set to «Automatic»

Note that additional drawing styles may be created by application
developers.

In addition to setting the appropriate type of view, the drawing style
also selects a suitable representation of certain building components.
For example, doors are shown open in a Detail view but closed in an
Elevation view.

Tip: To view the graphics in an intelligent drawing in different
drawing styles, create additional saved views for any other drawing
types and switch between them. For details about saving views, see
Chapter 2, Exploring MicroGDS.



84 Using MicroGDS 11

�
���������>�������##�������()�	�

The process for creating a MicroGDS BIM intelligent object is identical
to that for creating a plain MicroGDS object (described on page 68).
However, the first facet of the object name must be defined in the
intelligent object style that you want to use.

To use a style that is provided with MicroGDS, the first facet must be
one of the following:

For a wall object: IfcWallStandardCase
For a door object: IfcDoor
For a window object: IfcWindow
For a slab object: IfcSlab

The case and name must be identical to that shown.

Additional facets may be used to distinguish between different objects
of the same type. For example:

It is this first facet that tells MicroGDS which properties will apply to
the object.

After you place the new object’s hook point, the Properties window is
populated with all the parameters for the object type.

You now define the objectstyle which will set the default attribute
values for the type of construction you choose.
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Each objectstyle of a BIM intelligent object is defined by an
Object-level schema. The schemas contain attributes appropriate to the
type of intelligent object. A BIM wall object, for example, currently has
two objectstyles: Block and Brick-Cavity-Block. The two wall
objectstyles each have a subset of the wall properties. These schemas
are automatically associated with an object which has a corresponding
object name. The association is then made using an Objectstyle property
in the Properties window.
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For example:

�����������	�������������������*��������	����

������������	�/������0����

��������*��������	�.	��) /�*��� .���)
��0���������

� 3�����������()�	���-#�

� click the the Objectstyle value, then click  and select from the list
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For MicroGDS BIM wall and slab objects, you need to draw the
graphics to define the reference line of the object.

� for a slab object, draw the outline of the slab

This must be a closed-line polygon, for example, to represent a floor
slab.

� for a wall object, draw the centreline of the wall

This could be a single line for a garden wall or a closed-line polygon
for a building.

Note that when MicroGDS draws an intelligent object, curved surfaces
are facetted when they are extruded. You specify the number of facets to
use. The higher the number, the smoother the surface. For more details,
see Chapter 9, Working in 3D.

Tip: You can use the Z=0 button to force graphics to be drawn on the
XY plane, for example, if you are creating a floor slab. For details about
using the Z=0 facility, refer to Help.
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When you have drawn the primitive, the graphics are drawn in the
selected drawing style. For example:
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You do not draw any graphics for window and door objects. These are
drawn intelligently according the attribute data values. However, when
you create a window or door, set the object hook point at the position on
the drawing at which to place the bottom left corner of the window or
door. Then, to associate the window or door with an existing intelligent
wall object, move the window onto the wall.
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The depth of the window or door automatically adjusts to match the
wall thickness and a hole is made in the wall to accommodate it.

Note that snapping onto the wall when you initially create the window
or door object will not establish the connection between the two objects.
This is because the window or door only becomes intelligent when its
objectstyle has been set.
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When you add a BIM intelligent object to a drawing, its attributes and
values (defined by its objectstyle) are added to the Properties window.
You can modify the default values to suit your drawing’s environment.
For example, you can change the operation type of a door, that is,
whether it is a single or double swing door or whether it opens to the
left or right. You might also want to change the overall door width and
height and change the panel thicknesses. You do this by editing the
attribute values in the Properties window.
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Depending on the type of attribute, you can:

� type the new value in the box

� select a value from a list of predefined choices

� or edit the value in a dialog box

Any entry that you modify is shown in bold in the Properties window.

If you find that you are frequently using a particular set of attribute
values, you can set these up as a new objectstyle. For details, see  see
Chapter 17, Customizing MicroGDS.

For full details about editing attribute values, see Chapter 14, Working
with attributes and schemas.

Note that you can use the standard editing commands to modify the
reference line of a BIM intelligent object. For example, you can use the
Move Line Segment command to extend a wall area.
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You can move or copy selected graphics:

� from their current positions to new positions in the same document

� from one object to another within the same document or to another
document

� from one layer to another within the same document or to another
document

You can move and copy graphics as primitives or as objects. If you
want to move or copy objects from an assembly object or paste objects
into an assembly, you must first open it for editing. For details, see
page 80.

Note also that you can move and copy instance objects as a whole, but
you cannot move or copy individual items within the instance.

You can also move an object and change its axes rotation using the
Object Reposition command. For details, refer to Help.

The way in which you move and copy items depends on the
‘Explorer-like selection and drag-and-drop’ option in your preferences.
The following assumes that you are using the default MicroGDS
behaviour; if you are using the Explorer-like behaviour, refer to Help
for the equivalent details. (Note that if you are using Explorer-like
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behaviour, a shortcut menu is available which provides Cut, Copy,
Paste, and Delete commands.)

The procedures given describe just some of the moving and copying
operations. For more details on these, and all other move and copy
operations, refer to Help.
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You can move or copy selected primitives or objects from one position
to another.
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1 On the Edit menu, click Select Primitives or Select Objects, as
required.

2 Click the first graphic to move or copy.

3 Press Shift and click each subsequent graphic to move or copy.

4 Do one of the following:

� to move the selected graphics, press Shift+Ctrl and drag the
graphics outline to the new location

� to copy the selected graphics, press Ctrl and drag the graphics
outline to the new location

As soon as you have dragged the graphics away from their original
position, you can release the keys and mouse buttons.

5 To place the graphics at the new position, click the mouse button.

You can also use the Alter Move command and the Construct Repeat
command to move and copy selected graphics. For details, refer to
Help.
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You can move or copy primitives from one object to another. You can
also move or copy a primitive to an object that is on another layer or
even another document.

Below are just two methods you can use to move or copy graphics. For
full details, refer to Help.
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1 Press F9, or on the Edit menu, click Select Primitives.

2 Select the primitive to move.

3 On the Object menu, click Get.

4 Select the object in which to move the primitive.

To retain the original primitives, press Ctrl when you click the
object to which to move the item.
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1 Press F9, or on the Edit menu, click Select Primitives.

2 Select the primitives to copy to the object.

3 Press Ctrl+C, or on the Edit menu, click Copy.

4 On the Object menu, click New, then create the new object.

For details, refer to Creating objects on page 68.

5 Press Ctrl+V, or on the Edit menu, click Paste.

6 To test that all of the primitives are now one object:

a) Press F10, or on the Edit menu, click Select Objects.

b) Click one of the primitives in the new object.

When you snap onto one of the primitives, all of the primitives in
the object change colour, which means that they are all one object.

You can use the New from Selection command on the Object menu to
move primitives (or objects) into a new object.
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You can cut and delete graphics from your current document. Cut
graphics are copied to the Clipboard. You can retrieve a cut graphic by
pasting from the Clipboard or by undoing the Cut command. Deleted
graphics are not copied to the Clipboard and can only be retrieved by
undoing the command.

You can cut and delete graphics as primitives or as objects. If you want
to cut or delete objects from an assembly object or paste objects into an
assembly, you must first open it for editing. For details, see page 80.

Note also that you can cut or delete an instance object as a whole, but
you cannot cut or delete any of its individual primitives.
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When you cut or copy graphics to the Clipboard, MicroGDS stores the
location of the graphics relative to the current axes’ origin, and this is
used when you paste a graphic back into a window. If you move the
axes before you paste graphics back into the window, the graphics are
pasted back at the position, scale, and rotation relative to the current
axes origin.
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� press Ctrl+X, or on the Edit menu, click Cut
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� press Ctrl+V, or on the Edit menu, click Paste
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� press Delete, or on the Edit menu, click Delete
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� press Ctrl+Z, or on the Edit menu, click Undo

Note that if you are using Explorer-like behaviour, a shortcut menu is
available which provides Cut, Copy, Paste, and Delete commands.
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Another way in which you might want to edit objects is to globally
replace all occurrences of one object in a window for another.

For example, you might have started a floor layout with a simple object
representing a door, which you later change to one showing more detail.
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1 Ensure that the replacement object’s hook point, and the hook point
of each object being replaced, are in the appropriate positions.

The replacement object will be placed by its hook point at the hook
point of each replaced object.

For details on moving an object’s hook point, refer to Help.

2 Press F10, or on the Edit menu, click Select Objects.

3 Select the replacement object with which you will replace the
existing objects.
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4 On the Set menu, click Axes, Reset, then click the replacement
object.

The axes origin is moved to the hook point of this object.

5 With the replacement object selected, on the Edit menu, click Copy
(or Cut) to copy the replacement object to the Clipboard.

6 Select the objects to be replaced.

If there are a lot of different objects in the window, use Set Edit to
limit editing to just the objects that are to be replaced, and use the
Select All command on the Edit menu. For details about using Set
Edit, see Restricting editing on page 91.

7 On the Object menu, click Replace.

All the selected objects in the window definition are replaced with the
object on the Clipboard.

You can also replace primitives within objects, and superimpose objects
and primitives. For details, refer to Help.
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MicroGDS provides many commands for altering graphics. For
example, you can move a vertex, delete or move a line segment, alter a
path, and so on. Most of the commands that you use to change the
appearance of graphics are on the Alter menu.

An instance object does not contain any graphics of its own in the
current document, therefore you cannot alter the appearance of any
primitives it contains. However, you can use the Transform commands
to rotate, enlarge, mirror, and stretch an instance object as a whole. For
further details, refer to Help.

For details on all the commands that you can use to alter selected
graphics, refer to Help.
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The Set Edit command allows you to temporarily exclude primitives
and objects from being edited, or to restrict editing to specific
primitives or objects. It also enables you to restrict editing to graphics
that use particular linestyles, charstyles, materials, and colours.
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Note that style editing restrictions apply to primitives. Consequently,
you can select an object only if all its primitives are individually
selectable.

You can restrict editing to:

� specifically-named objects or all objects except those of a specified
name

� line primitives that use (or do not use) a certain linestyle
For details, see  Chapter 7, Working with linestyles.

� text primitives that use (or do not use) a certain charstyle
For details, see Chapter 8, Working with text.

� 3D clumps that use (or do not use) a certain material
For details, see Chapter 11, Working with materials.

� primitives that are assigned or are not assigned a certain colour
For details, see Changing the colour of graphics on page 94.

Furthermore, you can combine these options, making the Set Edit
command an extremely powerful facility.
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1 Press F3, or on the Set menu, click Edit.

You can also use the SETEDIT button on the information bar (at the
bottom right of the MicroGDS window) to set restrictions:

� if SETEDIT is not currently enabled, click the button
If SETEDIT is enabled, a single click of the button toggles the
current editing restrictions on and off.

� if SETEDIT is currently enabled, double-click the button

The Set Edit Filter Editor is displayed.

2 To define your object restrictions, do one or more of the following:

� click the New button to add a new rule, then type the object
name in the Wildcard/Schema box

� click the Pick button and click an item (object or primitive,
depending on the selection mode) in the window definition

� click the List button to browse to the object name using a list

For details on object naming conventions and use of wildcards, see
Rules for naming objects on page 70.

3 To specify the action of a rule, select Include or Exclude from the
Action list.
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4 Select the types of objects to which the rule applies from the Match
list.

For example, to restrict editing to objects whose names begins with
kerb, but to exclude objects with kerb as any facet other than the
first, you would specify the following:

Ensure that you enter Exclude rules at the start of the list, before any
inclusion rules.

You can toggle rules on and off using the check box under the
Active column.

You can also apply advanced filters to specify which primitives and
objects can or cannot be edited, using attributes. A brief
introduction to attributes is given later in this chapter. For details
about assigning attributes to graphics, and filtering graphics using
attribute values, see Chapter 14, Working with attributes and
schemas. You can also refer to Help.

5 To only allow editing of primitives using a specific linestyle,
charstyle, material, or colour, select the style or colour from the
appropriate list.
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� select «All» to apply the rule to all graphics of the corresponding
type

� select «Undefined» to apply the rule to graphics whose style is
missing

For example, styles may be missing from files imported from
other modelling systems.

Alternatively, click Pick and click a primitive to which the style or
colour is assigned.

To allow editing of all primitives, except those drawn in the
specified style or colour, select ‘Is not’ from the appropriate list.
Note that, when primitive colour is set to «All», you cannot set
Colour ‘Is not’ (as this would exclude all primitives from editing).

As you set up the filter rules, you can test the result at any time by
clicking Preview. Only objects that meet the criteria are highlighted.

6 Click Close.

When you have set up your restrictions, the SETEDIT button on the
information bar is pressed in and the text changes colour:

You can toggle the editing restrictions on and off by clicking the
button.

MicroGDS will not let you select any primitives which do not comply
to the restrictions you have set.

Remember to clear the edit restriction when you have made the changes
you require.
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By default, graphics are drawn using the colour defined for the phase in
which they are referenced. The default colours for phases are set in your
document properties (available from the File menu). You can change
the default colour for any phase to one of your choice, using the Mini
Window Editor or the full Window Editor. For details, see Chapter 4,
Using layers and phases.

You can override the phase colour for individual graphics using the Set
Colour command.
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1 Select the graphics whose colour you want to change.

2 From the Colour list on a status toolbar, select an existing colour or
choose a new colour.

If you want to assign a colour that is not available in the list, click
the ‘Select colour’ entry.

MicroGDS displays the Select Colour dialog box. For example:

You can choose a colour from the document’s colour table or define
a new, custom colour.

If you are defining a custom colour on the True Colour tab, you can
specify a level of transparency using the Alpha slider. For details
about specifying a custom colour using the True Colour spectrum,
refer to Help.

3 Specify the colour you require and click OK.

The colour assigned to the selected primitive is shown in the Colour
box on the status toolbar.

� When you select a primitive for which no explicit colour is assigned,
the Colour box shows ByPhase:

� When you select a primitive that has an explicit colour, the colour
and colour number are displayed in the Colour box:
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If the primitive has a custom colour assigned (specified by using the
True Colour tab on the Select Colour dialog box), the colour and the
red, green, blue, and alpha values are displayed in the Colour box:

� If the selected graphics have different colours assigned, the Colour
box is blank:

The colour assigned to selected primitives is also shown in the
Properties window. Note that primitives of different colours show
«Mixed» in the Colour property line.

You can also set colours for individual linestyle strokes and charstyles.
For example, you might have a linestyle that has a red border, and a
green fill, or a charstyle that uses a blue font.

To use the colours set in the linestyles and charstyles of the graphics
used in a phase, select the ‘Use style colours’ check box in the Window
Editor. Otherwise, MicroGDS draws the graphics using the phase
colour.

For details about creating and modifying linestyles, see  Chapter 7,
Working with linestyles. For details about creating and modifying
charstyles, see Chapter 8, Working with text.
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1 On the Edit menu, click Select All.

2 From the Colour list on the status toolbar, select ByPhase.

Any explicit colours set in the styles are honoured, provided that the
‘Use style colours’ check box is selected in the Window Editor.
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You can assign attributes to graphics. Attributes are non-graphical
information about the item. For example, an attribute might provide
information about the cost of an object, its colour, details of its supplier,
and so on. You can then export this information to other Windows
applications such as spreadsheets and databases, where it can be used to
produce reports such as parts lists, costings, and maintenance reports.

In addition to assigning attribute values, you can also:

� calculate attributes for primitives and objects

� retrieve information from external databases

You do not assign attributes to calculated and external attributes, the
values are calculated on request.

You can use an attribute as a filter in an inclusion list. For example, you
could define a filter to show only those objects which have a floor area
greater than 20 metres in one phase, and only those objects which have
a lesser floor space in another phase.

You can also use attributes in text primitives, as secondary annotation.
For example, if you were refurbishing an office, you could reference an
external attribute to retrieve employees names and telephone numbers
and assign them to the office desks.

For details about assigning attributes and filtering graphics using
attributes, see Chapter 14, Working with attributes and schemas.

Details about secondary annotation are given in Chapter 8, Working
with text.
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MicroGDS provides two facilities for producing reports about objects:

� Object List: produces a list of all the objects in the active window
definition, together with the number of times they appear in each
phase

� Object Schedule: generates a report that lists all the objects in the
active window definition, together with other information requested
such as any associated attributes

For details about the Object List and Object Schedule facilities, see
Chapter 13, Getting information. For complete details, refer to Help.
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MicroGDS enables you to divide your drawings into logical and
manageable portions by using layers. All the graphical data (primitives
and objects) in a document are drawn on layers. You can regard layers
as transparent overlays, with different parts of the drawing produced on
each overlay.

For example, if you were producing an cinema complex, you might
structure the drawing on the following layers:

� layers 1 – 10: the architectural detail

� layers 11 – 25: seating arena and foyer

� layers 26 – 30: wiring detail

� layers 31 – 34: lighting and projection

� layers 35 – 36: sprinkler system

If you create a new document and immediately begin drawing,
MicroGDS creates a layer for you, with the name ‘default’. You can
rename this layer or create a new layer to use.

You can also change the default layer name that is used for each new
window definition if you do not explicitly create a layer, in your
preferences.
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In a single-user document, layers are stored in the MAN file. There is
virtually no limit to the number of layers you can create.

In a multi-user project, the graphics on each layer are stored in separate
files (.LYR files). For details about multi-user projects, see Layers and
phases in multi-user projects on page 120.
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When you create a new layer, MicroGDS automatically creates a phase.
A phase determines which graphics from the layer are drawn and how
they are drawn.

The phase defines:

� whether the graphics are editable, hittable, visible, or invisible
(known as the editing status)

� which graphics on the layer are to be included in the phase

� the colour in which graphics are shown

� any overrides, such as a specific linestyle or a fading value to dim
down graphics

� the name of the layer to which the phase is linked

To specify which graphics stored on the layer are to be displayed in
each phase, you can use an inclusion list.

For example:
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You can use phases in this way to make editing easier. For example, you
can show different graphics on the same layer in different colours. Or,
you can choose which graphics in a phase are editable and which are
hittable.
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All new graphics are drawn on the current layer. If you open an existing
window definition and immediately select a construct command,
MicroGDS automatically makes the layer referenced by the last editable
phase the current layer, and draws the graphics on that layer. If the
window definition does not reference any layers, MicroGDS usually
creates a layer using the default name. If the name assistants are in
force, you may be prompted to specify a valid layer name. The new
layer is made the current layer.

For details about using the layer name assistant, see Chapter 2,
Exploring MicroGDS.

By default, the name of the current layer is shown on a status toolbar.
For example:

You can customize your status toolbars to hide layer names. For details,
see Chapter 17, Customizing MicroGDS.

All editable phases that reference the current layer are shown checked
in the Mini Window Editor. For example:

In the above example, phases 2, 3, and 5 all reference the current layer
‘Roof structure’. This is indicated by each phase having the same layer
link number, in this case (1). However, because only phases 2 and 5 are
editable, only these phases are checked.

For details about layer link numbers, see Phases list on page 104. For
details about the editing status, see the section Changing the editing
status of a phase on page 106.
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To help you identify which graphics are included in a phase, MicroGDS
assigns a default drawing colour to each phase. You can change the
colour of individual primitives and objects on any layer, or change the
default phase colour to one of your choice. For details, see Changing
the colour of a phase on page 107.

You will often want to work on different layers to add, delete, and
modify graphics held on other layers. To do this, you need to switch to a
different layer.
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� in the Mini Window Editor, double-click a phase that is linked to the
layer you want to make current

If the phase was not editable, MicroGDS automatically changes its
editing status to Editable.

� or, in the window definition click a graphic which is in an editable
phase that is linked to the layer you want to make current

You can also switch between layers using the full Window Editor,
described next.
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Although you can perform many tasks with the Mini Window Editor,
you can also use the main Window Editor to manage the layers and
phases in a window. For example, you can use either the Mini Window
Editor or the Window Editor to create layers and phases. But if you also
want to add a description to a layer, define style overrides for a phase,
or set a phase to be screen only, you can perform all these tasks with the
Window Editor.
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1 Select the window definition whose layers and phases you want to
modify.

2 Press F2, or on the File menu, click Window, Edit.

The Window Editor is displayed.

To display the layer and phase properties for more than one window
definition, select the next required window definition and then
press F2.

MicroGDS opens a new Window Editor for each subsequent
window definition.
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You can reposition or resize the Window Editor as required. When you
next display the Window Editor, MicroGDS remembers its last position
and size.

A number of shortcut menus are available when you work with the
Window Editor. To see a shortcut menu, click the appropriate item with
the right mouse button.
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The name of the window definition (and document) to which the
Window Editor refers is shown in the title bar.

The Window Editor has three main areas: a phases list, window and
paper details area, and three tabs: Phase, Layer, and Attributes.
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The phases list is at the top of the Window Editor. It shows all phases
that are referenced in the window definition. A bullet to the left of a
phase means that the layer it references is the current layer. If no layer is
current, no phases are marked.

The information shown for each phase is:

� the number of the phase; phases are numbered sequentially starting
from 1

The phase number determines the order in which the graphics are
drawn and printed.

� the editing status of the phase (E, H, V, or I)

� the colour and colour number (or colour value, for a user-defined
colour) of the phase

� the name and the link number of the layer to which the phase is
linked

The link number can be used to distinguish between layers that have
the same name.

Each layer in a multi-user project is stored in a separate layer file.
The link number is used to link the appropriate layer file to the
window definition.

� the modification status of the layer (shows M if modifications have
been made to the layer but not yet saved, or U if the layer is
unmodified)

If you are working on a multi-user project, there are two additional
statuses. For details, see Changing ownership of a layer on
page 123.

� the names of any overriding linestyle, charstyle, and material set for
the phase

� the percentage of any fading used to dim down the graphics on a
phase

� whether or not the phase is shown only on the screen, and not
printed

� the phase label (not visible in the above illustration), if one exists
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Phases can be sorted by different columns by clicking the required
column header. Clicking the column a second time will reverse the
order. The column on which phases are sorted shows an up or down
pointing arrow, depending on the sort direction.

The Window label box below the phases list enables you to add a
description of the associated window definition.

If you have set up a paper definition for use with a print layout view, the
paper size is shown below the Window label box. If you want to assign
or change the paper size, click the Page Setup button and define the
paper definition using the Page Setup dialog box. For details about
assigning a paper size for a print layout view, see Chapter 2, Exploring
MicroGDS.
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The Phase and Layer tabs enable you to work with the phases and labels
used in the related window definition. The Attributes tab enables you to
set up window-level attributes which apply to the entire window
definition.
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To work with the phases in the Window Editor, click the Phase tab.

Remember that many of the actions described in this section can also be
performed using shortcut menus in the Mini Window Editor.
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To change the properties of a phase, such as its editing status, the
colour, or description, you first select the phase.

� 3����#�	���������

� in the phases list, select the phase whose properties you want to
change

You can use the Windows multi-select facilities to select multiple
phases.
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� in the phases list, on the shortcut menu, click Select All

When you select multiple phases, the values for one or more properties
may become blank or appear unavailable. This indicates that the phases
have different values for those properties. If you change one of these
values, all selected phases assume the new value.
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The order in which the phases are numbered determine which graphics
are drawn over the top of other graphics (phase 1 is drawn first). You
can change the position of a phase in the sequence, thereby changing
the order in which graphics are overlaid.
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� in the phases list, drag the phase up or down the list
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� select the phase to move and, on the shortcut menu, click Move to
Top or Move to Bottom

Note that if you have changed the sort order, for example, to sort by the
‘Linked layer’ name, this changes only the sort order in the phases list;
phases are always drawn in numeric order.

If you are using mask (or opaque) linestyles, take care when reordering
phases. Unless the phases are correctly ordered, you might not be able
to see graphics which are referenced in different phases. For details
about creating and using mask linestyles, see Chapter 7, Working with
linestyles.
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Each phase determines the editing status of the graphics on the layer
with which it is associated. The editing status can be one of the
following:

� Editable (E)

You can edit and hit existing graphics, and create new graphics.

� Hittable (H)

You can hit existing graphics, but you cannot edit them or create
new graphics.
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� Visible (V)

You can see existing graphics, but you cannot hit or edit them, or
create new graphics.

� Invisible (I)

You cannot see, edit, or hit existing graphics, or create new graphics.
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1 In the phases list, point to the phase whose status you want to
change.

2 On the shortcut menu under the Status column, click the editing
status you require.

Alternatively, click the Status button you require on the Phase tab.

Tip: to change the editing status of a phase to Editable and make its
layer current, double-click the phase in the list.
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MicroGDS automatically assigns a colour for the graphics in each
phase. The default colours for phases are set in the document properties.
The colour allocations are saved when you save a document, therefore,
you can have different colour allocations for each document. You can
also copy the colour allocations of a document to and from the
document defaults, which are used for all new documents. For details
about changing the default colour allocations, see Chapter 17,
Customizing MicroGDS.

If you have the Colour list on a status toolbar, the colour assigned to the
graphics in the current phase is shown in the box. Unless you change
the colour of individual graphics, the Colour box shows ByPhase. This
indicates that MicroGDS is using the phase colour for new graphics.

All graphics in the phase are drawn in the phase colour (unless you
change the colour of individual items using the Colour list). If you
change the colour of an individual graphic, the colour (and its number
or value) is shown in place of ByPhase.
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1 In the phases list, point to the phase whose colour you want to
change.

2 On the shortcut menu under the Colour column, select an existing
colour or choose a new colour in which you want the graphics to be
displayed.

To assign a colour that is not available from the list, click the ‘Select
colour’ entry. Then, select your colour using the Select Colour
dialog box. For details about using the Select Colour dialog box, see
Chapter 3, Working with primitives and objects.

Alternatively, select the Colour you require on the Phase tab.

5����	������
�&���'��	�#��
�

You can set colours for individual graphics. By default, graphics are
shown in their set colours. Graphics that have not been set explicit
colours are shown in their phase colours.
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1 In the phases list, select the phase that uses set colours for individual
graphics.

2 On the Phase tab, select the Use primitive colours check box.

The graphics are drawn in their set colours, and not in the phase
colour.
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You can set colours for individual linestyle strokes and charstyles. For
example, you might have a linestyle that has a red border, and a green
fill, or a charstyle that uses a blue font.
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1 In the phases list, select the phase that uses styles with the embedded
colours you want to retain.

2 On the Phase tab, select the Use style colours check box.

The styles are drawn in their embedded colours, and not in the phase
colour.
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For details about creating and modifying linestyles, see Chapter 7,
Working with linestyles. For details about creating and modifying
charstyles, see Chapter 8, Working with text.

Note that if you select both ‘Use style colours’ and ‘Use primitive
colours’, any set colours for individual primitives are used.
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Occasionally, you may want to show the graphics in a phase only on the
screen. MicroGDS enables you to display graphics on screen, but will
hide them when you:

� print a window definition in which the phase is referenced

� include a photo of a window definition in which the phase is
referenced in another window definition

� publish a window definition in which the phase is referenced

Details about each of these procedures is given in the corresponding
chapters in this guide. Refer also to Help.
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1 In the phases list, select the phase whose graphics you want to
display only on screen.

2 On the Phase tab, select the Screen only check box.

Note that graphics are also not shown in the thumbnail picture in the
Navigate window (for 2D views) or the window preview in the
Document Organizer.
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By default, all graphics on a layer are included in all phases that are
linked to the layer. This is indicated by «Unrestricted» shown on the
Phase tab of the Window Editor.

You can use a phase filter to include and exclude specific graphics on a
layer. For example, you might want to include the electrical circuits in a
phase, but do not want to show the actual wiring detail.
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1 In the phases list, select the phase whose phase filter you want to
edit.

2 On the Phase tab, click Filter.

The Phase Filter Editor is displayed, for example:

The default phase filter is simply ** (under the Wildcard/Schema
column). This means, include all graphics stored on the layer linked
to this phase.

3 Edit the phase filter as appropriate and click OK.

You set up a phase filter in much the same way as when restricting
graphics from editing. This is described in Chapter 3, Working with
primitives and objects.

It is important to remember however that you must specify any
Exclude rules at the start of the list, before any Include rules.

For example, if you specify:

Exclude A:DR
**

all objects are included except A:DR.

However, if you want to exclude all objects that match a particular
wildcard EXCEPT for some specific objects, you must specify the
exceptions before the Exclude statement.



Chapter 4: Using layers and phases 111

For example:

Include ARCH:DOOR**
Include ARCH:WINDOW**
Exclude ARCH**
**

excludes all objects with the first facet ARCH, except for objects
with the first facets ARCH:DOOR and ARCH:WINDOW.

You can also use advanced filters to specify which primitives and
objects will or will not be included in a phase, using attributes. For
details about assigning attributes to graphics, and filtering graphics
using attribute values, see Chapter 14, Working with attributes and
schemas. You can also refer to Help.

Once you have set up a phase filter, you can copy it to other phases if
required.
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1 In the phases list, select the phase whose filter you want to copy.

2 On the Phase tab, click Copy Phase(s).

3 In the phases list, select the phase in which to copy the filter rules.

4 On the shortcut menu, click Paste Phase Filter.

Note that this command copies a phase filter from a single phase. If you
copy multiple phases, the command is unavailable.
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Usually, graphics are drawn and printed using the style definitions that
are assigned to the graphics. For example, a line primitive uses a
linestyle definition and a text primitive uses a charstyle definition.

You can specify a series of overrides to temporarily display or print the
graphics in a different way.
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Normally you choose a style per primitive, so that graphics in a phase
may be drawn using a mixture of linestyles, charstyles, and materials.
However, you can override this and display all line primitives in a phase
in a single linestyle, all text in a single charstyle, and all clumps in a
single material.
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You might want to do this, for example, if you are printing an early
draft of a drawing using a printer that does not have all of the fonts that
are used in the drawing.
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1 In the phases list, select the phase for which you want to set the
overrides.

2 On the Phase tab, select the styles you want the phase to use from
the linestyle, charstyle, or material lists.

For details about linestyles, charstyles, and materials, see chapters 7, 8,
and 11 respectively.
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You can use a fading override to dim down the graphics on a phase. You
might want to fade the graphics on one phase to help emphasize the
graphics on another phase.

A fading value affects all graphics in the phase, including raster files
and graphics that are assigned a primitive colour, using the Set Colour
command.
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1 In the phases list, select the phase for which you want to set the fade
override.

2 On the Phase tab, specify the fading percentage for the strength in
which you want the graphics to be drawn and printed.

100% draws the graphics in full colour; 0% makes the graphics
invisible. Intermediate values will be semi-transparent.
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You can create more than one phase to link to a layer. You can then
specify which objects on the layer you want to be included in each
phase.
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1 In the phases list, select the phase to copy.

2 On the Phase tab, click Copy Phase(s).
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3 Click the position in the phases list at which to paste the phase, then
click Paste Phase(s).

The new phase is assigned the next phase number, but it has the
same link number as the original phase. This indicates that both
phases are linked to the same referenced layer.

You can also copy a phase from one window definition to another by
copying the phase from one Window Editor and pasting it into another.
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Removing a phase from a document does not delete the layer graphics.
It simply removes the link to the layer, in the window definition.
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1 In the phases list, select the phase to remove.

2 On the Phase tab, click Remove Phase(s).

If you remove all phases that are linked to a layer, you can create a new
phase that references the layer’s data by copying the layer in the
Document Organizer into the Window Editor. For details, see Adding
layer graphics to a window definition on page 117.
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You can add a description to a phase. You could, for example, make a
note about the objects you have included in the phase.
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1 In the phases list, select the phase for which you want to add a
description.

2 On the Phase tab, type the description in the Label box.
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To work with the layers in the Window Editor, click the Layer tab.

Remember that many of the actions described in this section can also be
performed using shortcut menus in the Mini Window Editor.



114 Using MicroGDS 11

�
�������#�-�
������������

To divide your drawing into layers, you must first create the new layers
and phases.
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1 In the phases list, click the phase above which the new phase will be
positioned.

2 On the Layer tab, click New Layer & Phase.

The Layer Name dialog box is displayed.

If you are using a layer name assistant, a list of layer categories is
displayed in the box. If you are not using the name assistant, the box
is empty. For details about using the layer name assistant, see
Chapter 2, Exploring MicroGDS.

3 In the Name box, specify the name for the new layer, following the
rules described in the next section Naming layers.

4 If you want to add a description of the layer, in the Label box, type a
description (using up to 127 characters), and then click OK.

Note that if you are transferring data to a system using DXF/DWG
files, layer names will be converted to a format required by
DXF/DWG. You can force the exported layer name to a preferred
name by entering it in a special format in the Label box. For details,
refer to Help.

When you create a new layer, the associated phase is given the next
phase number in the sequence (from 1), and is added to the phases
list in the Window Editor. The phase is also assigned the next phase
colour.

5 If you want to change the editing status, or the colour in which the
graphics will be shown in the phase, make your changes as required.

A phase can have one of four editing restrictions. These are
described earlier in Changing the editing status of a phase on
page 106.

Changing the colour of a phase is described in Changing the colour
of a phase on page 107.

You can also create new layers and phases using a shortcut menu in the
Window Editor and the Mini Window Editor.
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You can rename an existing layer description using:

� the Rename Layer button on the Window Editor

� the Document Organizer

� and the Properties window

For details about the Properties window, see Chapter 13, Getting
information.

If you are using a layer name assistant, a layer description may have
been added to the layer name assistant configuration file. If a label does
exist, it is automatically displayed in the Label box. For more details,
see Chapter 17, Customizing MicroGDS.
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When you create or rename a layer, you should use a descriptive name.
For example, ‘architecture details’ is far more meaningful than
something like ‘top layer’.

Rules for naming layers are:

� a layer name can contain up to 256 characters

� names can include spaces, except at the beginning or end of the
name

� layer names are case sensitive, so ‘lighting’ and ‘LIGHTING’ are
two different layers

By default, layer names in a document do not have to be unique. You
can, however, force names to be unique, or request a warning if you
name a layer using the same name as one that already exists. You set the
applicability of unique names in your preferences. For details, refer to
Help.
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Every layer that is created is saved in the document. You can list all the
layers in a document by clicking the Layers tab on the Document
Organizer.

You can also preview the graphics stored on any individual layer.
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1 If the Document Organizer is not currently displayed, press F4, or
on the Window menu, click Document Organizer.

2 On the Document Organizer, click the Layers tab:
2���	�����

3 Select a layer to preview.

4 If the preview area is not currently visible, click , or on the
shortcut menu, click Toggle Preview.

All graphics are shown as two-dimensional images.

When the preview area is visible, the Preview button appears pressed in.
To close the preview area, click the button again.
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The Document Organizer can help you to locate layers that you cannot
find because, for example, the window definition that referenced the
layers has been deleted.
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1 On the Document Organizer, click the Layers tab.

2 On the Layers tab, click 

MicroGDS displays the Find Layers dialog box. For example:
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If you are working with a project the dialog box displays an
additional field called Location to display the path of any layers
found.

3 Specify your search requirements and click Find Now:

� in the Named box on the Name & Location tab, specify the name
of the layer

You can use wildcards to match characters in the name. Layer
names are not case sensitive. For example, S* matches all layers
with names that begin with ‘S’ or ‘s’, followed by any number of
characters, including none.

Note that the Look in box can be used only to search for layers
in specific aliases, in a multi-user project.

� to find layers by the assigned layer label, click the Advanced tab
and specify the layer label

You can also search for only those layers that are not referenced
by any window definitions, by selecting the ‘Unreferenced layers
only’ check box.

MicroGDS searches the document and lists any layers that match
your search criteria in the Results box. For more details about
finding layers, refer to Help.
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You can add the graphics on an existing layer to any window definition
in the same document. To do this, you create a new phase from the
layer, and then reference that phase in the required window.
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1 In the Document Organizer, ensure that the document from which
you want to copy a layer is the current document.

2 Click the Layers tab and then select the layers whose data you want
to copy to a window definition.

3 On the shortcut menu, click Copy.

MicroGDS copies the selected layers.
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4 Ensure that the window definition in which you want to create the
phase is the active window.

5 Under the Linked layer column in the Window Editor (or in the
Mini Window Editor), on the shortcut menu, click Paste Phases.

MicroGDS pastes a phase for each layer that you copied into the
window editor.

You can also create a new phase from a layer, by dragging the layer
from the Document Organizer into either of the window editors. For
more details, refer to Help.
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You can duplicate the data of an existing layer by cloning it. This may
be useful if you want to try changing the graphics, but you want to keep
the original layer graphics unchanged.
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1 From the phases list in the Window Editor, select the phase that
references the layer you want to clone.

2 Click Clone Layer(s).

The Clone Layers dialog box is displayed.

3 Do one of the following, and then click OK:

� to add a new phase to refer to the cloned layer, select this option

� to change the existing phase to refer to the cloned layer, select
this option

If you are using a name assistant, MicroGDS displays the Layer
Name dialog box for you to specify the name. The name must
comply with the MicroGDS naming rules.

If you added a new phase to reference the cloned layer, MicroGDS
adds a new phase to the Window Editor.

If you changed the existing phase to refer to the cloned layer,
MicroGDS replaces the existing phase by the new phase in the
Window Editor.
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When you delete layers in a single-user drawing, the graphics on that
layer are deleted from disk when you save the file. All phases that
reference the layer are also deleted.

Note that if you want to delete layers from multi-user projects, you must
use the MicroGDS Project Administrator utility. For more information,
refer to the online Help for the Project Administrator (if the Project
Administrator utility is available to you).
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1 In the Document Organizer, ensure that the document from which
you want to delete the layer is the current document.

2 Click the Layers tab and then select the layers that you want to
delete.

3 Press Delete, or on the shortcut menu, click Delete.

4 To confirm the deletion, click Yes at the prompt.
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Although objects are created on the current layer, you can move and
copy selected graphics from one layer to another—within the same
document or to another document.
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1 Press F10, or on the Edit menu, click Select Objects.

2 Select the objects to move.

3 On the Object menu, click Get.

4 Select the layer to move the objects to by clicking an object already
on that layer.
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1 In the source MAN file, press F10, or on the Edit menu, click Select
Objects.

To copy all objects on a layer, make all other layers not editable and
then press F7 or click Select All on the Edit menu.

2 To copy the objects to the Clipboard, press Ctrl+C, or on the Edit
menu, click Copy.
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3 In the destination MAN file, make the layer you want the objects to
be copied to, the current layer.

Ensure that a phase that is linked to the layer is editable.

4 To paste the objects onto the layer, press Ctrl+V, or on the Edit
menu, click Paste.
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Each layer in a multi-user project is stored in a separate layer file (a
.LYR file) and is referenced by the window definitions. When you open
a window definition, MicroGDS reads the list of layer names and looks
for the graphics that appear on those layers in the layer files. A window
definition can best be described as a set of filters on the graphical data
held in the .LYR files.

In the same way that each layer in a single-user document has a unique
link number, each layer file in a project also has a unique layer link
number. In a project, the layer link number is also used for the file name
of the layer. For example, if you create a new layer called
‘Foundations’, MicroGDS assigns it the next available layer link
number, for example, link number 78. Consequently, the file name on
disk is 78.LYR. It is important that you do not change the name of the
layer file (.LYR) in the Windows Explorer. If you do change the name
and you open a window definition that references the layer, an error
message is displayed.

The layer link numbers in a project can be used when multi-user project
files are shared over remote sites. The project manager can allocate
layer link number ranges to each site, using the Project Administrator.
The Project Administrator is available from the MicroGDS Program
menu. For details on how to use the Project Administrator, refer to the
utility’s online Help.

Each time a new layer is created, it is added to the project database.
Details about all the layers in the project database are recorded in the
Document Organizer. Other users can access the layers using the
Document Organizer and can copy or link a layer directly to a window
definition.

Because a layer can be referenced by more than one window definition,
more than one user can open a layer at one time. To prevent more than
one user editing the same layer at the same time, when a user opens a
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layer or creates a new one, they take ownership of that layer and
MicroGDS locks the file. This means that one user can edit the file and
other users can open it and snap onto the graphics, but cannot edit it at
that time. When the owner has finished editing a layer, they can disown
the layer which then enables another user to take ownership. This is
described further in the later section Changing ownership of a layer on
page 123.

Note that there is virtually no limit to the number of layers you can
create in a multi-user project.
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The name assistants enable you to create layers and objects whose
names conform to the naming standards in use at your site. Layers and
objects have separate configuration files. For information on using
object name assistants see Chapter 2, Exploring MicroGDS.

The layer name configuration file determines the names to be used for
new layers. For multi-user projects, this file can also define the location
in which a layer of a particular name should be located.

Any rule in the layer name assistant configuration file can have an alias
added to it. When an entry is selected from the top-level names in the
Layer Name dialog box, if there is a relevant alias attached and that
alias is defined in the project, that alias is selected in the alias location
of the dialog box.

To attach an alias to a rule in the file, add the alias in parentheses to the
end of the expansion text. For example:

ELEC–(Lighting)|Electrical

specifies that the alias name Lighting will be selected in the Layer
Name dialog box when a new layer starts with ELEC-.

You can also override a previously specified alias for a specific
expansion only. For example:

ELEC–|ALARM~(Security)|Alarm installation

overrides the alias set for the top-level entry for this specific expansion
only.
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When you create a new layer in a multi-user project, you can select the
layer alias in which to save the new layer.

Note that aliases are defined in the project database. For details about
creating a project database, see Chapter 16, Multi-user projects.
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1 Press F2, or on the File menu, or click Window, Edit.

2 In the Window Editor, click the Layer tab and then click New Phase
& Layer.

The Layer Name dialog box is displayed, for example:

If you are using a layer name assistant, a list of layer categories is
displayed in the top list box. If you are not using the name assistant,
this box is empty.
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3 Specify the name for the new layer.

By default, all new layers are saved in the location defined by the
default layer alias set for the workspace. However, if you are using a
layer name assistant the layer name configuration file may define
the preferred location to which a layer of a particular name should
be created. For more details, see the previous section, The layer
name assistant in multi-user projects.

4 Select the alias that defines the location in which you want to save
the layer from the list at the bottom of the dialog box.

Note that you can override the default alias for new layers for the
current work session using the Alias Overrides command. For
details about overriding the default aliases, see Chapter 16,
Multi-user projects.

5 Click OK.

Creating a new layer automatically creates a phase to refer to the newly
created layer.
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You can edit layers only if you ‘own’ them. When you create a new
layer, or when you are the first person to open a layer for editing (an
editing status of Editable), you are given ownership of the layer. Other
users can open the layer as Hittable or Visible, but cannot edit it.

When you save changes to a layer that you are editing, other users can
update to see the changes.
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1 The current owner must first save the window definition that
references the layer.

2 Once the window definition has been saved, in the Phases list in the
Window Editor, select a phase that references the layer whose
changes you want to see.
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3 On the Layer tab, click Update Layer(s):

The most up-to-date version of the layer is now available. Any edits that
have been saved by other users are displayed.

� 3��	����������� ��
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1 The current owner must disown the layer by:

a) selecting a phase that references the layer, and then

b) clearing the Owned check box on the Layer tab

If changes have been made to the layer that have not yet been
saved, MicroGDS prompts whether to save the changes or
discard them.

2 Another user can then take ownership of the layer by:

a) selecting a phase that references the layer, and then

b) selecting the Owned check box

The ownership of other phases that reference the layer is also
changed.

You can also own and disown a layer using the shortcut menu in the
Mini Window Editor.

When you disown a layer, the editing status of any editable phases that
reference the layer is changed to hittable. Another user can then take
ownership of the layer for editing.

Note that when you close a project workspace, all layers are
automatically disowned.
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You cannot delete layers from a multi-user project using MicroGDS.
The project manager can delete duplicate and unused layers using the
Project Administrator.

The Project Administrator is available from the MicroGDS Program
menu. For details on how to use the Project Administrator, refer to the
utility’s online Help.
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Many commands in MicroGDS require you to enter a position. You can
specify the position by using a snapcode to snap to existing graphics or
snap in free space, or by typing coordinates.

If you make a mistake when specifying a position, you can often use
Backspace to cancel the position.

MicroGDS provides the following drawing aids which you will find
useful when locating a position.

� snap guides which are drawn automatically for you to snap to

� a grid which you can use to help lay out your drawing

� the x, y, z buttons which you can use to fix a coordinate

� a current position from which you can measure relative coordinates
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By default, the position of the mouse pointer is shown in the Position
box at the bottom of the MicroGDS window.

This shows that the current position is 664mm along the X axis, 859mm
along the Y axis, and 0mm along the Z axis. The D represents the Dot
snapcode. The coordinates and snapcode are dynamically updated as
you move the mouse.

You can change your preferences to show the last hit position instead.
For details about changing your preferences, see Chapter 17,
Customizing MicroGDS.

Note that unless you snap to a graphic that has a Z coordinate, or you
explicitly type a Z coordinate, the previous Z coordinate is used. If no
graphics in the window have a Z coordinate, you can omit the Z value
as it will always be 0.

����������	����
Snapcodes enable you to snap exactly to points on the graphics. This
ensures accuracy in drawing, selecting, moving, and placing primitives
and objects.

As you move the pointer around, you see snapcodes displayed at their
appropriate positions as the pointer passes over them. For example:

and

MicroGDS tries to anticipate what you are trying to snap to based on
the command you are using and the position of the mouse pointer. You
can accept the suggested snapcode by clicking the mouse button or
choose a different one by typing an explicit snapcode.

When MicroGDS looks for a snapcode to show, a default distance is
used which determines how far away from the mouse pointer to look.
Usually, this distance will be suitable. You can, however, specify your
own hit-radius value, using your preferences.
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When there are no graphics to snap to at the pointer position, the Dot
snapcode is shown. The coordinates of a Dot snapcode will have an X
coordinate, a Y coordinate, and a Z value of 0. If you draw graphics
using a Dot snapcode, the graphics will always have a Z value of 0.
This is because the Dot snapcode always snaps to the XY plane. The XY
plane is the default view—looking across the XY plane, with the X axis
running left-to-right, and the Y axis running bottom-to-top.

� 3������������	���

� click the mouse button when you see the snapcode displayed

� or, type the initial letter for the snapcode you want

If multiple items lie within the snap radius of the mouse pointer, you
can cycle through the graphics by pressing Spacebar. When the item
you want to select is highlighted, click the mouse button or type the
displayed snapcode.

By default, snapcodes are displayed using the whole word. You can set
your preferences to have snapcodes shown using just their single letter
reference.

The table below shows the snapcodes with their single-letter reference,
highlighted in bold:

Axes parallel to the current X or Y axes
Box one of nine justification points around a text box (corners,

midpoints, and centre)
Centre centre of curvature of arc or circle
Dot position of mouse pointer (when there are no underlying

editable or hittable graphics)
End end of a line
Face surface of a clump
Grid points on a grid
Inside centre of gravity of a 2D shape or centre of the 3D clump

face
Line nearest point on a line
Middle middle of the nearest line segment
Normal position on the nearest line to create a ninety degree angle
Origin origin (hook point) of the nearest object
Point vertex of a line, or the intersection of two lines
Tangent position on the nearest line to create a tangent
Vertex vertex of a line
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Note that snapcodes A, O, T, and V are never shown at the mouse
pointer; you must always type the initial letter to use them. Note also
that G is shown only when the grid is enabled, but is always available
when a grid has been defined by typing the initial letter.

Snapcodes are displayed with an initial uppercase letter. When you type
a snapcode, you can type it in uppercase or lowercase.

If you type a snapcode that is not applicable to the current graphics,
MicroGDS displays a warning. For example, if you hover over a line
segment of a rectangle and you use the Centre snapcode, instead of the
Inside snapcode to snap to the centre of the rectangle, MicroGDS
displays the message: ‘Cannot get centre of straight line’. You can
choose to switch off snapcode error messages in your preferences.

������	��
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To give exact positions when you are drawing or moving graphics, you
can use coordinates.

The principle of coordinates is the same as that used for map references,
where a point is represented by two numbers indicating its position
along an X axis and a Y axis. The following grid shows this principle.

6��'��
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Horizontal measurements are along the X axis, and vertical
measurements are along the Y axis. In this case, measurements along
both axes start from the bottom left of the grid and are incremented in
the positive directions (that is, right along the X axis, and up along the
Y axis). The bottom left-hand corner is therefore 0/0/0, known as the
origin. The last position of the coordinate (that is, /0) is the Z position.
The Z axis runs vertically through the XY plane at the origin.
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The spot shown in the example above, is 5 units along the X axis, 6
units along the Y axis, and 0 along the Z axis. In MicroGDS, this point
is referred to as 5/6/0 or 5,6,0 (depending on your list separator setting).
These are the coordinates of this position.

When you draw and place graphics, it is often useful to move or rotate
the axes. You can change the position, scale, and orientation of the axes
as required, For details, see Chapter 6, Using the axes.

3���	�
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MicroGDS marks the last hit position in the document window by a
small circle. This is called the current position. For example:

��		�������������
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It is from this position that relative coordinates are measured. Each time
you specify a new position, the current position and circle marker move
accordingly.

You can change the current position without specifying a position
simply by hovering over a point where one of the following snapcodes
is shown:

� Centre
� End
� Inside
� Middle
� Box
� Point

Then, when you use a relative coordinate, the position is interpreted as
an offset from the current position. For more details, refer to MicroGDS
Help.
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When you type in coordinates, if you do not specify units of
measurement MicroGDS uses the current set units as shown on the
status toolbar. For example:

If you want to enter the coordinates in different units from the set units,
you simply enter the correct symbol for the units when you type in the
numbers. MicroGDS automatically converts the coordinates to the
current set units to draw the item accurately.

For example, you may be drawing an office work area in metres and
you want to add a desktop for which you only have the imperial
measurements. You could type the desktop’s imperial dimensions,
followed by the feet symbol (’) and MicroGDS would convert the
dimensions for you.

The types of units you can use, with examples, are:

mm (for millimetres) 1.2mm

cm (for centimetres) 1.2cm

Inches 1.2″

m (for metres) 0.23m

km (for kilometres) 1.34km

Feet 2.3′

Feet+Inch 2′6.5″

Imperial 2′6 1/2″

Miles 0.23miles

Ken 3.4ken

Shaku 15shaku

Sun 1.4sun

Bu 15bu

Nautical Miles 1.5nmi

You can combine different units, for example 5”/2’ specifies the X
coordinate in inches and the Y coordinate in feet.
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In addition to setting the type of units you want to work in, you also set
the number of decimal places used for measurements. This does not
affect the accuracy to which you draw, only the precision to which
dimensions are displayed. If you are working in Imperial units, this is
the fractional unit. For example, if you want measurements to be
displayed to an accuracy of sixteenths of an inch, set decimal places
to 16.

Note that each type of measurement unit has a maximum number of
decimal places that you can set. The maximum number of decimal
places you can set per measurement is given in a table in Help.

If you save the axes for a window definition, the current units and
decimal places are also saved. When you open a window definition, its
axes are loaded from the window’s stored values. You can recall a
window’s axes which will also restore the units and decimal places. For
details about saving and recalling a window’s axes, see Chapter 6,
Using the axes.

MicroGDS stores the coordinates of graphics as double-precision,
floating-point numbers. The accuracy of this storage is 1/10,000mm
over a space of �50,000km. So, if you set the scale to 1:1 and are using
mm as the set units, the smallest value that you can enter (and that
MicroGDS can display) accurately, is 0.0001mm. If you set a scale of
1:50 and are using miles as the set units, the smallest value is
0.000000001 miles.

You can specify the type of units and number of decimal places on the
status toolbar or by using the Units command on the Set menu.
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1 On the Set menu, click Units.

2 At the prompt bar, type the units you require.

3 At the prompt bar, type the number of decimal places you require.

When you set the units, those units are also used, by default, for new
dimensions, measurements, lengths, and coordinate positions, unless
you change them.

Note that the number of decimal places specified does not affect the
number of decimal places for angles. The decimal places for angles are
set on the General tab of your preferences. For more details, refer to
Help.
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You can use coordinates whenever MicroGDS requires you to give a
position. To enter the position, just start typing the coordinates. As soon
as you begin typing, MicroGDS displays the Position prompt bar for
you to enter the coordinates.

For example:

When you have typed the coordinates, press Enter or click �

There are two types of coordinates you can use:

� Cartesian coordinates

� Polar coordinates

Both Cartesian and Polar coordinates can be absolute or relative:

� absolute coordinates are measured relative to the current axes

By default, the set axes have their origin at the centre of the drawing
sheet. You can move the axes, and therefore the origin for measuring
absolute coordinates, to anywhere on the drawing sheet.

� relative coordinates are measured relative to the current position

The current position is marked by a small circle. This position is the
base point from which relative coordinates are measured.

You enter coordinates in the order X, Y, Z. If you omit a coordinate,
MicroGDS uses the last value specified for that coordinate. If you omit
the Z coordinate and no Z coordinate has been specified, the Z
coordinate is 0.

In MicroGDS, you can use in-line equations when you enter
coordinates. MicroGDS solves the equation to calculate the required
position. When you enter in-line equations, you must enclose the
equation in brackets. Note that there must be no spaces between an
arithmetic operator and the coordinate.

For example, to draw a line which has a total length of two existing
graphics, you could add the two X dimensions of the graphics together
by typing:

(42.5+65.23)/20

MicroGDS solves the equation to calculate the precise length for the
line. For a summary of the in-line equations you can use, refer to Help.
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Cartesian coordinates are defined by a distance horizontally and a
distance vertically.

Absolute and relative Cartesian coordinates must be separated by a
slash (/) or by the list-separator character (often a comma) specified in
your Windows Regional Settings.

Any point can be given in absolute coordinates, relative coordinates, or
a mixture of both.
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Absolute Cartesian coordinates are measured from the set axes’ origin.
For example, a line drawn from 25mm/40mm to 90mm/–15mm appears
as:

Y

X
�	����
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Type absolute coordinates in the format:

� X/Y/Z or X,Y,Z

For example, 120/20/20 or 120,20,20

$��	�����#	�����	
�������
	���

Relative Cartesian coordinates are measured relative to the current
position. For example, if you were to draw a line from x=500, y=1000
to x=4500, y=–1500, you might give the first position in absolute
coordinates, at 500/1000. Then, to specify the other end of the line, you
could enter the position relative to the current position (indicated by the
small circle), r4000/r–2500:
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Type relative coordinates in the format:

� rX/rY/rZ or rX,rY,rZ

For example, r120/20/20 or r120,20,20

or:

� @X/Y/Z or @X,Y,Z

For example, @120/20/20 or @120,20,20

��#�
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Polar coordinates are defined by a distance and an angle. An angle is
either an angle value or a bearing (a direction). Angles are measured
from the X axis, where normal X has a rotation of 0° (with a bearing of
East). Angular units are described in detail in Help.
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Absolute Polar coordinates are measured from the set axes’ origin. For
example, to copy a circle 600mm along a construction line where the
angle of the construction line is 8° to the X axis, you could enter 600<8:
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Type absolute Polar coordinates in the format:

� distance<angle/Z

For example, 850<45/0
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Relative Polar coordinates are measured relative to the last position. For
example, you could draw a line of length 800 at an angle of 35° to the X
axis:

Y

X
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Type relative Polar coordinates in the format:

� rdistance<angle/rZ

For example, r330<90/r0

or:

� @distance<angle/Z

For example, @330<90/0
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You can specify the next position to be measured from the current
position, by typing the distance.

When you type a distance, the next position is constrained in all
directions from the current position. As you move the mouse pointer
outside the radius of the distance, a ghost chain line is drawn to the
current mouse position.
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For example, you may want to draw a line 1000 units from the centre of
a rectangle, at an angle which intersects the centre of a second
rectangle. To do this, start the line command and click in the centre of
the first rectangle, then type a distance of 1000 and click in the centre of
the second rectangle:
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If you want to use the same value for X, Y or Z as the previous position,
you can omit that coordinate when you specify the new position. For
example, //50 means use the same X and Y values as the previous
position, and a value of 50 for Z.

If you enter an X and Y coordinate, the previous Z position (or zero if
no Z position has been specified) is used. So, /20 means use the same X
value as the previous position, a value of 20 for Y, and the same Z value
as the previous position. A single slash (/) character means use the same
X, Y, and Z values as the previous position.

Note that you must use ‘/’ (not ‘,’) to specify the same value as a
previous position.
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You can combine a snapcode with a coordinate. This enables you to
specify a coordinate (or an approximate coordinate) and use a snapcode
to snap exactly to a given point on the graphics.

To combine a coordinate and a snapcode, you simply type the
single-letter snapcode reference. MicroGDS finds the nearest graphic
component to the given coordinate. You can use any snapcode that is
appropriate to the graphic with which you are working.
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For example, to place a 50mm radius circle in the centre of a 100mm by
100mm rectangle, you can use an I (Inside) snapcode:

4++

4++

‘I’
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Type the coordinate and snapcode in the format:

� coordinate snapcode

For example, 100/100/0 i

You must leave a space between the number and the snapcode.

!"�&�#����0�'�#���	��
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50m/75m absolute Cartesian coordinates in metres

r50/r50/r100 relative Cartesian coordinates in the current set units

r50/100 relative Cartesian coordinates in X, absolute in Y in
the current set units

10/5/8 absolute Cartesian coordinates in the current set units

@75,60 relative Cartesian coordinates in the current set units

35m<30,15 absolute Polar coordinates, distance in metres, height
in current set units

@250<30 relative Polar coordinates in the current set units

550,225,100 absolute Cartesian coordinates in the current set units

5″,2’ absolute Cartesian coordinates, X in inches, Y in feet
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Snap guides are temporary construction lines that are automatically
created for you by MicroGDS. You can use snap guides to help position
and align graphics more precisely. Snap guides are displayed whenever
you are prompted for a position in a command.

For example:

A set of default snap guides is created at the point of the last snap. They
are shown whenever the mouse pointer is within the snap radius. A
label indicating the origin of the snap guide is also shown.

You can remove the default angles or define additional angles, using
your Snapping preferences. You can also choose whether or not to show
snap guides in the Z direction.

Note that the angles are measured relative to the current axes.

By default, the snap guides are drawn as thin, black dashes. You can
change the colour, width, and pattern in which snap guides are
displayed in your preferences.

MicroGDS also creates snap guides at the angles and intersections of
existing graphics, simply by hovering the mouse pointer over an
appropriate position. For example, if you hover over a point, the default
set of snap guides are shown. If you hover over a line, Extension or
Parallel snap guides are shown through the current position.
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If you hover over a snap guide, MicroGDS shows details of its origin in
an label. This shows:

� an angle, if the snap guide was generated from an angle in your
preferences

� Extension, if the snap guide is the infinite extension of an existing
line

� or Parallel, if the guide was created parallel to an existing line

Note that if snap guides are coincident (for example, an extension and
45° angle), a label is given only for the first guide to be added.

You can switch snap guides on and off, using the Snap Guides button on
the Information bar:

�����>������������



142 Using MicroGDS 11

���������
��
You can use a grid to help you draw and align graphics. You can display
the grid or set it to invisible, using the Grid command on the Set menu.

When visible, you can choose the spacing of the grid, and specify
whether to display it as dots or as graph paper.

When the grid is visible as graph paper, you can choose a colour for the
lines, and also vary the thicknesses of the lines by specifying a change
in boldness at set line intervals.

When a grid is defined, the grid is always active, even when invisible.
This means that you can always snap to it using the Grid snapcode. You
can choose to automatically snap to the grid point nearest the mouse
pointer when drawing in free space or only snap to the grid using a G
snapcode.

When a grid is defined, you can also show and hide the grid by clicking
the Grid button on the information bar:
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Note that if you save a window’s axes and you have a grid defined, the
x and y grid spacing is also saved. For details about saving and
restoring a window’s axes, see see Chapter 6, Using the axes.

For more details about using a grid, refer to MicroGDS Help.

=�"��������������
You can fix the X, Y, or Z (or a combination of them) coordinates so
that the next point you pick uses the fixed X, Y, or Z position. You can
do this using the x y z status toolbar buttons:
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You can use these buttons when you are prompted to give a position.
When you click on a status toolbar button, it remains pressed until you
specify the corresponding coordinate. When you specify the position,
the status toolbar button changes colour to show that the coordinate is
fixed. When you specify the next position, the button reverts to its
normal state and the coordinate is no longer fixed.

Note that, as an alternative, you can press the X, Y, and Z keys on your
keyboard.

The following example shows how you can position the centre of a
circle at the intersecting coordinates of an existing graphic, where the
intersecting coordinates are not known.

1 Click 

2 To fix the X coordinate, click anywhere on the far right line:
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The button changes colour to show that it is fixed.

As you move the mouse pointer away from the fixed X coordinate, a
ghost chain line is drawn from the centre of the attached circle to the
intersection of the current mouse position. For example:

3 To indicate the Y and Z coordinates, click the appropriate point on
the top line.

You can fix any combination of coordinates you require.

You can also force all graphics to be drawn on the XY plane, using the
Z=0 button on the information bar. When the button is switched on,
MicroGDS also switches on the fix Z button (on the status toolbar) and
then switches it off again when you end Z=0 mode. For details about
using the Z=0 facility, refer to Help.
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MicroGDS uses axes to draw and place graphics. Coordinates are
measured from the origin of the axes, that is, 0,0,0. Some commands
use the rotation of the axis (also called the angle) to place graphics.

Each window definition has its own set of axes; these are used for all
views within the corresponding window definition. You can save a
window’s axes so that you can restore them at any time. For details, see
the later section Saving and restoring a window’s axes.

By default, the axes are set with:

� the origin at the centre of the drawing space

� the X axis horizontal in 2D view (a rotation of 0°), the Y axis
vertical, (and the Z axis coming out the screen)

� a scale of 1:1
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For example:

MicroGDS does not show the Z axis in a 2D view if it points directly up
the world Z axis, out of the paper.

If you have moved or rotated the axes, or changed the axes’ scale, you
can reset them to their ‘normal’ position. For details, see the later
section Repositioning the axes.

You can choose to hide the axes, but note that the axes are never printed
even when they are shown.

You can draw lines that will always be parallel to either the X, Y, or Z
axis by using the Construct Oline command (orthogonal). This is the
same as using the A (Axes) snapcode with the Construct Line
command.

Where any part of a graphic lies on the same coordinate as the axes, the
associated part of the axes may change colour.

Note that you can also display a grid, for which you specify the grid
spacing, to further assist you when drawing and placing graphics. For
details, refer to Help.

��� ��������������������"��
The axes are often useful to have on screen as they can help you when
you are drawing and placing graphics. At times, however, you may
prefer to work with the axes switched off.

� 3��������
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� on the Set menu, click Axes, Show
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It is often useful to move or rotate the axes. For example, you may want
to carry out a series of constructions and measurements at a specific
angle to the horizontal.

Y
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Text is always drawn parallel to the X axis. You can change the
alignment of existing text using the Alter Align command. For details,
refer to Help.
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1 On the Set menu, click Axes, Move.

A set of axes are attached to the pointer.

2 To specify the new origin:

� click on the drawing at the required position

� or, type the coordinates of the position, relative to the existing
axes

� or, if you are working in 3D you can press Tab to use the
orientation of a 3D clump face, and then click on the face at the
required position

For details about working in 3D, see Chapter 9, Working in 3D.

MicroGDS now prompts you to specify the position of the X, Y, and
Z axes, in turn. In each case, you can:

� cycle through the possible axes, in the order X, Y, Z, –X, –Y, and
–Z by pressing Tab

� cycle through the possible axes in reverse order, by pressing
Shift+Tab

� retain the current rotations, by pressing Esc

3 Specify the position of the axes.

The axes are moved and the rotation is shown in the Angle box on
the status toolbar.
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If you know the exact angle you require, a quicker way to rotate the
axes is to specify the angle of the X axis (relative to its normal position)
using the Angle box on the status toolbar:

This is the angle through which the X axis will be rotated from the
normal position (horizontal on the screen). A positive angle usually
indicates an anti-clockwise rotation. However, you can change this on
the General tab of the Preferences dialog box. For details about
changing your preferences, see Chapter 17, Customizing MicroGDS.

When you rotate the axes, MicroGDS uses an angles file to determine
the strings and corresponding angles. You specify the angles file to be
used in your preferences. For details about creating an angles file, see
Chapter 17, Customizing MicroGDS.

You can also use the Axes Spin commands to rotate the axes. Using
Axes Spin Z is similar to typing in the Angle box—the axes are rotated
in the XY plane, about the Z axis. However, when you use the spin
commands, the angle you specify is measured from the current position.
Note that if you spin the axes about the X or Y axis, the Angle box
displays Skew to indicate the rotation in three dimensions.

For more details, refer to the Axes commands in Help.

Note that when you are working in 3D, it is often useful to rotate the
axes to a particular orientation before you construct 3D graphics (or
before you copy a 3D graphic to the Clipboard). For details about
working in 3D, see Chapter 9, Working in 3D.

5������������������"��
In addition to simply moving the axes as described above, you can
reposition the axes in a number of ways. This section describes how to
reset the axes to normal, and how to centre the axes.

For details on the commands you can use to change the position, the
origin, and the rotation of the axes, refer to Help.

Note that you can also move an object and change its axes rotation
using the Object Reposition command. For details, refer to Help.
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� on the Set menu, click Axes, Normal

This resets the axes to the drawing origin and sets the scale to 1:1.

If you have not moved the drawing origin, the axes are set to their
normal position. For more details about the drawing origin, see
Chapter 2, Exploring MicroGDS.
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� on the Set menu, click Axes, Centre

This resets the axes to the centre of the drawing sheet, but leaves the
scale as you have set it.

5������������'�� 
You can rotate the view to align all the graphics in the window to the
XY plane. This enables you, for example, to work more easily with
graphics drawn at different angles. This is the equivalent of actually
turning the paper around to look at a different angle of the drawing.

When you have finished, you can revert the view to its real-world
orientation. For example:
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1 Set the angle at which to rotate the view.

The angle of the XY axes define the orientation for the view.

2 On the View menu, click Align to Set XY Axes.
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In MicroGDS, you can draw at full size (that is, 1:1), or you can use
different scales for different objects just as you would if you were
drawing on a piece of paper. For example, you may want to draw an
office cubicle at a scale of 1:50 on one layer, and then draw a particular
work area, for example, the desk space at 1:10 on another layer. You
simply set the scale before drawing the first object and then change the
scale before drawing the next object.
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New graphics are drawn at the current scale. The current axes’ scale is
shown on the status toolbar:

You can change the current scale at any time. When you change the
scale, any new objects are drawn at that scale until you change it again.
Existing graphics are left unchanged. This means that you can have
different objects, at different scales, together in one document.
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� in the Scale box on the status toolbar, type or select the scale from
the list

Or:

1 On the Set menu, click Axes, Scale.

2 Enter the scale you require at the Axes scale prompt.

When you specify a scale, MicroGDS uses a scales file to determine the
strings and corresponding scales. You specify the scales file to be used
in your preferences. For details about creating a scales file, see
Chapter 17, Customizing MicroGDS.

When you are drawing, you input real-world dimensions. MicroGDS
converts the dimensions and draws to the set scale. For example, to
draw a desk of 1800mm x 800mm, you would construct a rectangle,
giving its dimensions as 1800 and 800, no matter what the current set
scale is.

More information about objects and their scale and rotation is provided
in the following section.



Chapter 6: Using the axes 151

��'��������
����
������ ���� ?���"��
Each window definition in a document has its own set of axes. By
default, this is the normal axes. If you move, rotate or change the axes’
scale, you can save the axes for the window. You can then restore the
window’s saved axes later.
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� on the View menu, click Save Window Axes

Note that a window definition stores the following values:

� the axes origin, rotation and scale

� the units and decimal places

� the x and y grid spacing

The axes are saved in memory. To save the window axes in the window
definition, you must save the document.
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� on the View menu, click Restore Window Axes

If you are using a grid, the grid location and orientation are reset to
align to the restored axes.

4"��������()�	��
Each object has its own internal axes’ scale and rotation. When you
create an object, you set the hook point for that individual object. The
hook point is the ‘handle’ of the object which you can use to pick up
and place the object. It also defines the origin of the object’s internal
axes.

When you create an object, the current scale and rotation of the axes are
saved along with the new object. If you subsequently rotate or scale the
object, its internal axes are also rotated and scaled. The current axes are
unaffected.

The following drawing of an articulated lorry consists of two objects:
one object is the cab, and the other object is the trailer. The objects were
drawn as shown in Figure 1, and then the cab was rotated as shown in
Figure 2. The cab will have its axes saved as shown in the second
figure.
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If you later want to modify an object, you may want to set the current
axes to be the same as the object’s axes.

You can use the Query window to obtain the scale of an object’s axes
and its angle. For details, see Chapter 13, Getting information.
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1 On the Set menu, click Axes, Reset.

2 Click on the object to set the axes to.

MicroGDS aligns the current axes rotation with the selected object, puts
the origin of the axes at the object’s hook point, and sets the scale to be
that of the object.

If the object was the current object, it remains the current object. If the
object was not the current object, this does not make it current.
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MicroGDS provides commands for you to measure graphics. For
example, you can measure:

� the distance between any two points

� the angle between two lines

� the radius of an arc or a circle

For some measure commands, such as measuring the angle between two
lines, the scale is not important. An angle of 90° will be 90° at any
scale.

For other commands, for example, when you measure the area of a
graphic, the scale can be important. When you measure the area of a
graphic, MicroGDS calculates and reports the area of the graphic at the
set scale and at the object scale.
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Note that when you measure graphics, MicroGDS displays the results in
a Query Measurements dialog box if the Query dialogues check box is
selected in your preferences. For details about setting your preferences,
see Chapter 17, Customizing MicroGDS.

More details about the measure commands, and other facilities that you
can use to access information about the graphics in your document, are
given in Chapter 13, Getting information.
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When you cut or copy graphics to the Clipboard, MicroGDS stores the
location of the graphics relative to the current axes’ origin, and this is
used when you paste a graphic back into a window. This is important
when you replace one object with another using the Object Replace
command, or place one object on top of another using the Object
Superimp command.

You can replace multiple copies of one object with another, and
superimpose one object on top of multiple objects.

If you move the axes before you paste graphics back into the window,
the graphics are pasted back at the position, scale, and rotation relative
to the current axes origin.
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1 Select the new object.

2 Copy it to the Clipboard (using the Edit Copy command).

3 Select the range of objects to be replaced.

4 Replace the objects with the new object (using Object Replace).

When you replace the old object, the new object is positioned so that
the origin of the axes when it was copied to the Clipboard is placed at
the point of the old object’s hook point. To avoid having objects
displaced, use the Set Axes, Reset command to reset the axes onto the
new object before copying it to the Clipboard.

Replacing objects is described in Help and an example is also given in
Chapter 3, Working with primitives and objects. For details about
superimposing objects, refer to Help.
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All line primitives have a linestyle, which defines what the line looks
like. A linestyle is made up of one or more strokes. Each stroke defines
specific characteristics of the linestyle. For example, one stroke can
define the line thickness, another can define the fill properties, and a
third stroke could define an offset pattern.

For example:
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MicroGDS provides a variety of built-in linestyles for you to use or
modify. When you create a new document, two linestyles are always
available: DEFAULT and BLANK.
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� DEFAULT is a basic, standard linestyle which draws with a
single-stroke line. It is shown as one pixel wide on the screen, and it
will print in the thinnest line available to your printer (unless you
select a different pen width when you print).

� BLANK is an invisible linestyle used by MicroGDS, for example,
for the borders of raster images. You might use it, for example, to
hide construction lines.

The DEFAULT and BLANK linestyles are stored separately from any
linestyles and cannot be saved, deleted, or replaced.

The thickness of lines shown in the graphics window will vary
according to how much the view is zoomed. Note that the thickness of
lines is dependent on the co-ordinate space setting for the linestyle
stroke, as described in Defining strokes on page 167.

You can add a style to a document by selecting a built-in MicroGDS
style or by creating your own.
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MicroGDS provides a number of built-in linestyles, for example:

DEFAULT

SCISSOR

DASHA

14M

When you select a linestyle, MicroGDS shows you a sample of the
selected linestyle. You can use a linestyle as it is, or you can modify it
and save it for future use within the document.

Although MicroGDS linestyles are stored separately from your own and
cannot be overwritten, you can, however, accidentally overwrite
amended versions if you use the same name as that of a built-in
linestyle. For example, if you select SCISSOR, change the symbol size
and save it with the same name, your version of SCISSOR takes effect.
If you later reselect SCISSOR from the built-in styles and save it to the
same name, your version is overwritten and all graphics using this
linestyle now use the characteristics defined in the MicroGDS version.
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For single-user documents, new linestyles are stored in the document.
They are saved when you save the document.

You can also access linestyles from external style files (called
LINES.STY). To do this, you specify the folders in which the
LINES.STY files are located using the Style Search Path command on
the File menu. You can add more than one folder to the style search
path, but only one LINES.STY file can be stored in each location. If
you modify and save a style from an external style file, it is saved in the
document. For more details about style files, see Chapter 2, Exploring
MicroGDS.

For multi-user projects, all linestyles are stored in external style files
(LINES.STY). New linestyles are saved in the first LINES.STY
location on the style search path. A linestyle is saved in the style file as
soon as you save the style, even if you do not save the project.

You can access linestyles available to a document from the Document
Organizer and also from the status toolbar.
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1 On the Document Organizer, click the Styles tab:
����������

2 Double-click the Linestyles category, or click the plus sign (+) to the
left.

A list of all locations from where you can access linestyles is shown:

� for a single-user document, the name of the document with
which you are working is shown first, followed by the path of
each style file defined in the style search path if any

� for a multi-user project, the name of the first style file defined in
the style search path for the project is shown first, followed by
the path of each subsequent location defined in the project

If a LINES.STY file exists in the location defined for styles and
fonts in your file location preferences, this location is shown last in
the list. This enables you to reference a set of global style files that
are available to all your documents. For more details, refer to Help.
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3 To display a list of linestyles in a location, double-click the location
or click the plus sign (+) to the left.

For example:

Linestyles are prefixed by an icon. The colour of the icon
determines the availability of the style:

� linestyles that can be used in the document are prefixed by a red
icon

� linestyles that are not currently available to the document are
prefixed by a grey icon

(A linestyle is unavailable if a linestyle of the same name already
exists in a location higher in the style search path.)

4 To preview a linestyle, select the style and then, on the shortcut
menu, click Toggle Preview.
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� on the Line box on the status toolbar, click the arrow

All styles available to the current document are listed.

4��������#�����-#�
You can add a new linestyle to a document by saving one from those
available with MicroGDS or by creating your own.

When you add a linestyle, it immediately becomes current and any
selected graphics are assigned that linestyle. Any new graphics you
draw are also assigned the current linestyle.
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Note that if you open a document in which there are missing linestyles,
for example, if they have been deleted, MicroGDS reports the error
conditions to the Problems dialog box. You can use the dialog box to
correct the errors by:

� changing the styles and fonts folder

� editing the style search path

� adding new linestyles

This section describes how to add a new linestyle to your document. For
details about the characteristics that make up a stroke, see Defining
strokes on page 167.
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1 Click the Styles tab on the Document Organizer, and then
double-click the Linestyles category.

2 Do one of the following:

� to create a new linestyle based on DEFAULT, select the
Linestyles category and then, on the shortcut menu, click New

� to create a new linestyle based on an existing style, select the
linestyle on which to base the new style from the required
location and then, on the shortcut menu, click New based upon

MicroGDS displays the Linestyle dialog box.

The dialog box shows you a sample of the linestyle, and the
characteristics of the first stroke in the linestyle. Each stroke is
represented by a separate tab.

3 If you want to use or amend a linestyle other than the current one,
do one of the following:

� to base the linestyle on an existing style in the document, click
‘Document style’, and then select the linestyle on which to base
the new style from the list

� to base the linestyle on a built-in style, select ‘MicroGDS style’,
and then select the linestyle on which to base the new style from
the list

You can use a built-in linestyle as it is, or you can modify it and save
it with a different name.

If you select a style from a list, all settings in the Linestyle dialog
box are reset to those stored with the selected linestyle.
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4 Specify the settings in the Linestyle dialog box, as required.

5 Check that the linestyle is what you require in the Sample box.

6 Save the linestyle:

� to save the linestyle with the existing name, as shown on the title
bar, click Save

� to save the linestyle with a new name, click Save As, type the
name in the Style Name dialog box and click OK

The name must comply with the MicroGDS naming rules, as
described later in this section. You cannot use the name DEFAULT
or BLANK.

The named linestyle is made current and its name is shown in the Line
box on the status toolbar.
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1 Deselect all graphics.

2 From the Line list on the status toolbar, select the linestyle on which
you want to base your new linestyle.

3 On the Styles menu, click Linestyle Modify

4 Specify the settings in the Linestyle dialog box, as required.

5 Check that the linestyle is what you require in the Sample box.

6 Save the linestyle as described in step 6 in the previous procedure.

5�#���0�
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� a linestyle name can contain up to 256 characters

� names can include spaces, except at the beginning or end of the
name

� linestyle names are case sensitive, so ‘fill 100’ and ‘FILL 100’ are
two different linestyles

� you cannot save to the name DEFAULT or BLANK
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When you add a linestyle, it immediately becomes current. To use
another linestyle, you select it from those available with the document.
When you change the linestyle, you can:

� change the current linestyle

� change the linestyle of selected graphics

� change the linestyle of all graphics using a specific linestyle

� override the linestyle of all graphics for a particular phase

You can also change the linestyle of part of an existing primitive, using
the Path, Linestyle command on the Alter menu. For details, see Help.

When you change to another linestyle or change the linestyle of an
existing graphic, MicroGDS automatically refreshes the window so that
you can see its effect.

If you are working with a complex drawing, redraws may take some
time. You can speed up redraws by changing the view quality options.
These determine how linestyles, text, and selected graphics are to be
displayed. Note that the quality settings also affect the printed drawing.
For details on setting the window quality, refer to Help.
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The current linestyle is assigned to new line primitives that you draw.
The name of the current linestyle is shown in the Line box on the status
toolbar.

If you have selected several graphics that have different linestyles
assigned, the Line box is blank.

Note that each time you click a line primitive, the current linestyle
changes to that primitive’s linestyle.
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1 Select any graphics for which you want to change the linestyle.

2 Do one of the following:

� from the Linestyle list on the Properties window, select the
linestyle

� from the Styles tab on the Document Organizer, select the
linestyle and then click Set as current on the shortcut menu

� from the Line list on the status toolbar, select the linestyle
� on the Set menu, click Linestyle, type the name of the linestyle

in the prompt bar and press Enter

The linestyle name must match a linestyle that you have already
added to the document.
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1 Select any graphics for which you want to change the linestyle.

2 Select the replacement linestyle, as described in the previous
section.
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MicroGDS makes it very easy to change the linestyle of a number of
graphics drawn using one linestyle to another linestyle. You simply
restrict editing to a specific linestyle.
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1 Press F3, or on the Set menu, click Edit.

You can also use the SETEDIT button on the information bar (at the
bottom-right of the MicroGDS window) to set restrictions:

� if SETEDIT is not currently enabled, click the button

If SETEDIT is enabled, a single click of the button toggles the
current editing restrictions on and off

� if SETEDIT is currently enabled, double-click the button

The Set Edit Filter Editor is displayed.

2 From the Linestyle list, select the linestyle to which you wish to
restrict editing.
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Alternatively, click the Linestyle Pick button and click a line
primitive to which the style is assigned.

3 Click Close.

When you have set up your restrictions, the SETEDIT button on the
information bar is pressed in and the text changes colour. You can
toggle the editing restrictions on and off by clicking the button.

4 Ensure that you are in Select Primitives mode by pressing F9, or on
the Edit menu, click Select Primitives.

5 In your graphics window, select the relevant primitives; the status
toolbar shows you the number of primitives selected and that they
all use the same linestyle.

You cannot select any primitives that do not use the specified
linestyle.

To select all primitives drawn in the linestyle, press F7, or on the
Edit menu, click Select All.

6 Select the replacement linestyle as described in Changing the
current linestyle on page 161.

Remember to clear the editing restriction when you have changed the
linestyle.
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Usually, you assign linestyles to individual primitives. This means that a
phase can show primitives in many different linestyles. You can,
however, force all line primitives within one phase to be displayed and
printed in a single linestyle.
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1 Press F2, or on the File menu, click Window, Edit.

2 From the phases list in the Window Editor, select the phase whose
linestyles you want to override.

3 From the Linestyle Overrides list on the Phase tab, select the
linestyle you wish the graphics in the phase to use.

All line primitives within the selected phase are now drawn using
the chosen linestyle. Note that although they appear on screen and
print using the linestyle override, their original linestyles are
unchanged and still appear in the Line box on the status toolbar.

You can also see the name of the linestyle assigned to a line
primitive in the InfoTip, if you have hover highlighting on the
Information bar switched on. For details about hover highlighting,
see Chapter 3, Working with primitives and objects.

If you later remove the override, the primitives are drawn using their
original assigned styles.

You would probably use this feature as a temporary override. To change
the linestyle permanently, you would make the phase the only phase
editable, then select all the graphics, and change the linestyle.
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Linestyles are made up of one or more strokes. There are three types of
stroke: pattern, fill, and vertex. Each linestyle can have up to 20 strokes.

For example, you might define two pattern strokes, each with a different
line thickness and a different colour, to create an overlay effect.

You can use symbols in linestyles, for example, to fill the area of a
closed-line primitive with a pattern. When you use symbols in
linestyles, you select the symbol from a font. You can also create new
fonts to define your own symbols. For more details, see Using symbols
in strokes on page 166.
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You use the Linestyle dialog box to add, delete, and reorder strokes in a

linestyle. For example:
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When you create a new stroke in a linestyle MicroGDS adds a new tab

to the Linestyle dialog box for you to define the characteristics of the

stroke. Each stroke tab is assigned the next sequential number; this

number defines the order of the strokes in the linestyle.



166 Using MicroGDS 11

� 3��	
��������� ���
���������#�����-#�

1 On the Linestyle dialog box, click the appropriate tab for the stroke
on which to base the new stroke.

MicroGDS creates a new stroke that is a copy of the currently
selected stroke.

2 Click New Stroke.

A new tab to define the stroke is added to the dialog box.

3 From the Stroke type box, select the type of stroke to define.

4 Define the characteristics for the stroke, as described in Defining
strokes on page 167.
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The order in which strokes are drawn may be important. For example, if
one stroke defines a black fill and another stroke defines a white
criss-cross hatch, you would need to place the black fill before the white
hatch so that the hatch pattern is visible.
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1 On the Linestyle dialog box, click the tab of the stroke to reorder.

2 Click << Move Up or Move Down >>, as required.
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1 On the Linestyle dialog box, click the tab of the stroke to delete.

2 Click Delete Stroke.
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When you use symbols in a stroke, the set of symbols that is available
depends on the selected font. MicroGDS supplies a large variety of
fonts that you can use in your linestyles and charstyles. The folder in
which MicroGDS looks for fonts is set in your File Location
preferences. For details about setting your file location preferences,
refer to Help.

If you want to use special characters or symbols in a linestyle that are
not available in the supplied MicroGDS fonts, you can create your own
fonts from graphics.
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In MicroGDS, there are two types of font files: CV7 and CV6:

� CV7 fonts save many types of primitive as part of the font graphics.
All linestyle properties, such as filled strokes, multiple colours, and
thickened offsets are retained. Other graphics, such as text
primitives, and raster primitives, are also saved.

� CV6 fonts save only line primitives as part of the font graphics. All
linestyle properties and other graphics, such as text primitives are
ignored.

A CV6 symbol is presented in a linestyle as having a font and a size.

A CV7 symbol is presented in a linestyle as having a font and a scale,
however, it can also have a size. To specify a size, you assign the
special MGDS_SymbolSize attribute to the symbol objects. For
example, if you have a church symbol that has a base width (and
MGDS_SymbolSize attribute) of 5mm, and you specify a size of 10mm
in the Linestyle dialog box, the symbol is enlarged by a factor of 2.

For more details on fonts and creating MicroGDS CV6 and CV7 font
files, refer to Help.
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When you add or modify a linestyle, MicroGDS displays the Linestyle
dialog box (shown on page 165). The name of the current linestyle is
shown in the title bar of the Linestyle dialog box. If you are creating a
new linestyle or if there are no linestyles saved in the current document,
the title bar does not show a linestyle name.

The top part of the dialog box contains:

� Document style and MicroGDS style options

� the linestyle name if you are basing the linestyle on an existing
document style or on a MicroGDS linestyle

� the units in which to display and interpret measurements in the
dialog box

� an example of the linestyle in the Sample box

� buttons to create, delete, and reorder strokes
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Each type of stroke (Fill, Pattern, and Symbol) has a number of
common properties. These define:

� an offset
� a colour
� a co-ord space
� whether to resolve snaps for this stroke
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When you draw a line, the line goes through the given positions. You
can offset the drawn line to the left or right.

Use the Offset box to specify an offset to the left or right of the drawn
line, in the display units. Enter a positive value to offset the stroke to the
left, a negative value to offset the stroke to the right.

For example, the stroke for the line below has a positive offset and so is
offset to the left of the line:
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With offset lines, left and right is determined by the direction in which
you draw the line.

When you use the Rectangle, Ellipse, or Circle commands, the graphics
are drawn anti-clockwise. This means that a stroke with a negative
offset is offset outside a rectangle or circle, and a stroke with a positive
offset is offset inside.

For example:
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Note that the Colour option is not available with Raster and Gradient
fill strokes. The colours for a Raster fill are defined in the raster image;
the colours for a Gradient fill are defined by two colours which are
specified in the Gradient area. For more details, see Creating filled
strokes on page 176.

By default, MicroGDS draws graphics using the colour defined for the
current phase.

You can use the colour list to specify the colour of a stroke:

� to use any colours defined in the stroke’s components, select Neutral

If you select Neutral, MicroGDS uses the colours embedded in the
components that make up the stroke, if any. For example, if you use
a symbol for a filled stroke and the symbol primitives were created
in green, the fill symbol is drawn in green. However, if you select
red in the Colour box, the fill symbol is drawn in red.

� to use an explicit colour for the stroke, select an existing colour
from the list

If you want to assign a colour that is not available in the list, click
the ‘Select colour’ entry. Then, select your colour using the Select
Colour dialog box. For details about using the Select Colour dialog
box, see Chapter 3, Working with primitives and objects.

To use the colours in a linestyle, ensure that the Use style colours check
box is selected in the Window Editor for the phase that uses the
specified linestyle.

Note that if the primitive has an explicit colour set (using the Set Colour
command), by default the primitive is drawn in the set colour and any
stroke colours are ignored. To use the stroke colours in a linestyle, clear
the Use primitive colours check box in the Window Editor.

For details about changing the colour of the graphics in a phase, see
Chapter 4, Using layers and phases.
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Use the Co-ord space options to control the way in which the stroke is
drawn. Select the type of co-ordinate space to use:

� Object

Use Object space if you want the linestyle graphics to move, rotate,
and scale along with their object.
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� Drawing

Use Drawing space if you want the linestyle graphics to stay in
proportion when you zoom in and out; the graphics are not tied to
the object scale.

� Output

Use Output space if you want the linestyle graphics to always be the
same size, irrespective of scale and zoom.

In a print layout view, any graphics that have linestyles assigned that
use output space are drawn so that they are a scaled version of what
will appear on the paper. For details about print layout views, see
Chapter 2, Exploring MicroGDS.

� Version 6

Use Version 6 only if you want the same results as in earlier
MicroGDS releases.

For further details about co-ordinate space, and tips for choosing the
right co-ordinate space, refer to Help.
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Use the Use for snapping option to specify whether to resolve snaps for
this stroke. When selected, snaps for patterned strokes are resolved at
each edge of the thickened stroke. For other strokes types, snaps are
resolved along their offset. All lines can be snapped along their base
line (at offset zero). Note that the setting of this option is ignored for
Output space styles, which are never snapped to.
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Use a pattern stroke to create complex linestyles using combinations of
dots, dashes, and symbols embedded in the line. You can also change
the line thickness and specify the phasing for the pattern.
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Use the Thickness box to specify the thickness of the stroke, in the
display units. The stroke can also be offset (to the right or left) as
specified in the Offset box.
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Note that you can increase the width for unthickened lines when you
print. For example, if you are using a high-resolution printer or if you
intend to photocopy a drawing, this may help to ensure that the lines are
visible. For details about printing a view, see Chapter 12, Printing and
plotting.

When you specify a thickness, the value you give is a real-world value.
When it is printed, the line will be drawn according to the type of
co-ordinate space selected, as described earlier.
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You define your pattern, using the pattern buttons, in three parts: the
start, middle and end. The start and end are drawn once per line
primitive, and the middle pattern is repeated in between. If necessary,
the middle can be stretched to fit the line.

Use the pattern buttons to build up your pattern:

draws a line of a specified fixed length

draws a space of a specified fixed length

draws the specified character or symbol from the selected font

draws a line of a variable length (Middle only)

draws a space of a variable length (Middle only)

Lines and spaces of variable lengths are called elastic components. You
can specify the length for elastic components, but they can be stretched
to fit the line if necessary. The elastic components are varied according
to the phasing of the linestyle, described in the following section.
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� drag the required pattern buttons into the appropriate list

MicroGDS calculates the line using the start and end components of
the pattern. Therefore, elastic lines and spaces can be used only in
the middle of the pattern.
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For example:

You can set the length for fixed and elastic length lines and spaces; the
length of a symbol is regarded as zero. If you want to leave a gap in the
pattern for the symbol, add spaces to either side of the symbol.
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1 Double-click the component and then select or type the length you
require.

For elastic components, the value you enter defines the ‘unstretched’
length.

If you type the length in different units from the display units shown
at the top of the dialog box, MicroGDS automatically converts the
measurements to the display units to draw the line. For details on the
types of units you can use, see Chapter 5, Entering positions.

2 To accept the new value, click �
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1 Click the line or space component whose length you want to change.

The Linestyle dialog box displays options for changing the
properties of the component. For example:

2 To change the length, select from the list or type the length you
require.
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3 To change a fixed component to an elastic component, select the
Elastic check box.

To change an elastic component to a fixed component, clear the
Elastic check box.
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1 Double-click the symbol component and then select the character
you require.

The characters available from the list are determined by the current
font. If the symbol you require is not available in the current font,
you can choose another font.

2 If the symbol you require is available in the current font, accept the
new value by clicking �
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1 Click the symbol component whose details you want to change.

The Linestyle dialog box displays options for changing the
properties of the symbol. For example:

2 To change the character, font, size, and orientation for the selected
symbol, select the value you require from each of the boxes.

Note that the fonts that you can choose from depend on the font files
available in your font path set in your File Location preferences.

� If you are editing the details of a MicroGDS CV6 font, type the
size for the symbol or select from the list.

� If you are editing the details of a MicroGDS CV7 font, type the
scale for the symbol or select from the list instead.

Note that if a symbol size attribute is assigned to the symbol, a
Size box is also shown, displaying the specified symbol size.
(The Size and Scale boxes are interlinked, that is, if you change
one value, the other changes accordingly.)
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3 To draw the symbols at the specified orientation, relative to the line,
select the Relative to line check box.

To draw the symbols at the specified orientation, relative to the
chosen co-ordinate space, clear this check box. For details about the
co-ordinate space settings, see Defining strokes on page 167.

For more information about the symbol details, refer to Help.
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� press Delete or drag the component out of the list
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� drag  into the appropriate list
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� click Clear All

The following example shows how you would define a linestyle that
repeats a pattern of fixed-length lines and fixed-length spaces
throughout the line, and ends each line primitive with a scissors symbol:

If you draw an ellipse using this linestyle pattern, it appears as:
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Stroke patterns can include variable length, or elastic, components. You
can specify the length for elastic components, but they can be stretched
to fit the line if necessary. The elastic components are varied according
to the phasing of the pattern. Phasing is commonly used to ensure that
the vertices of a line primitive appear at a line, and not at a space in the
pattern.

Note that elastic components are only applicable to the middle
components in a pattern. Components that make up the pattern are
described in the previous section.

There are five phasing options; select the phasing you require from the
list:

� Select None for no phasing. The pattern starts at the start vertex of
the line, and repeats to the end vertex. Elastic components are drawn
at their defined lengths. The end of the line does not necessarily
correspond with the end of a pattern repetition.

� Select Angle to restart the middle pattern at each angular vertex
(where the two line segments that meet at the vertex are not
tangential). Elastic components are stretched as necessary.

� Select Line to ensure that the start of the End pattern corresponds
with the end of a Middle pattern repetition. Elastic components are
stretched as necessary.

Note that if the Middle pattern ends with a space, the last pattern
repetition is forced to end at the last line or symbol in the pattern.

� Select Grid to line up the components of the pattern when they occur
on parallel lines. You can use this option to line up the hatch pattern
when you use the Construct Hatch command to create hatch lines.

� Select Vertex to restart the middle pattern at each vertex, where each
segment is separately phased. Elastic components are stretched as
necessary.
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Use a fill stroke to flood fill closed primitives. Fill has no effect on open
primitives.

There are several fill types from which you can select:

� Brush

� Gradient

� Hatch

� Raster

� Symbol

MicroGDS provides options for you to choose how to fill multiple,
overlapping closed line primitives. You can specify that ‘holes’ are
created where the primitives overlap, or that those areas should be filled
in. These options apply only to primitives which are in the same object,
and use the same filled linestyle and primitive colour.

You choose how to fill the primitives using the ‘Rule for multiple loops’
option on the Fill tab:

� Use loop depth
Creates a hole wherever primitives overlap:

If another primitive with the same fill attributes is overlaid, any part
of the hole that it overlaps is filled, and any fill that it overlaps
creates a hole:

If you explicitly change the colour of one of the primitives, any
holes in the primitive are filled:
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Furthermore, if strokes in a linestyle use offsets, each closed line
primitive is offset independently before all the primitives are
combined.

� Use loop sense

Select this option to take account of the direction in which each line
primitive is drawn. Overlapping primitives that are drawn in the
same direction are simply overlaid. Holes are created only where
overlapping primitives are drawn in opposite directions.
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For details about the direction in which primitives are drawn and
how to reverse the direction, refer to Help.

� Independent loops
This option draws each primitive independently, ignoring the
direction in which the primitive was drawn. No holes are created.

The following illustration shows part of a floor plan, with a sofa placed
on a tiled floor. The sofa uses an opaque, brush filled linestyle. Initially,
the style is set to ‘Use loop depth’, which means that a hole is created
wherever the sofa line primitives overlap:
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Notice that the floor tiles are visible wherever the cushions overlap.
One way to correct this is to use different linestyles for the sofa and
cushions. A more efficient way is to simply change the rule for multiple
loops option to ‘Independent loops’:

The Fill tab has options to control the ways in which colours are mixed
at each pixel, to obtain the final result.

In this particular example, you could achieve the same result by
reversing the line direction of overlapping primitives and using ‘Loop
sense’.

‘Loop sense’ creates holes only where overlapping primitives are drawn
in opposite directions. This gives you more control over the appearance
of each nested primitive. To create a hole, make sure that the outer and
inner primitives are drawn in different directions. When you reverse the
direction of a primitive, the area of the primitive is reported as negative.
This enables you to calculate areas based on the positive and negative
line directions.

For all fills except Gradient, you can choose to make a fill transparent
or opaque (the default). To make the fill transparent, clear the Opaque
check box. Gradient fills are always opaque (unless a colour includes an
alpha value).

Transparent means that you will see any graphics that are drawn
underneath, and opaque means that you will not:
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Brush fills also provide a ‘true transparency’ option, where the colour
builds up where primitives overlap. You will see this in the next section.

Note that some output devices do not support transparent fills.
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For more details on the transparency options and the formulae for
colour mixing, refer to Help.
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� from the Fill list, select the fill type you require
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Select Brush to create a fill using a brush or pattern.

� select Percent fill and select the percentage fill from the list

� or, select Brush pattern and select the brush pattern from the list

The listed brush patterns are compatible with all versions of
MicroGDS.

� or, select Extended brush pattern and select the brush pattern from
the list

The listed brush patterns are compatible with MicroGDS version 8.0
and later.

For percentage fills, you can specify to use true transparency. True
transparency ‘builds up’ the colour where primitives overlap:

This option is not available if the Opaque check box is selected.

Brush patterns always use Output co-ordinate space, and are never
rotated or scaled. If you change the co-ordinate space, it has no effect
on the pattern.

Note that some output devices cannot print solid fills and overlapping
fills, therefore test your device before you use this feature.
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Select Gradient to create a fill that gradually changes from one colour to
another.

You can define linear and radial Gradient fills:
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� From the ‘Type of gradient fill’ options, select Linear to blend the
fill linearly, or Radial to blend the fill radially.

� To fit the fill to the primitives to which the gradient linestyle is
assigned, select the ‘Fit to primitive(s)’ check box. To fill a
primitive by specifying the coordinate positions, clear this check
box.

� Click the Colours boxes and select the colours you want for the
graduated fill.

Note that the colours you select are not affected by the phase colour
or the current colour.

� Use the Blend options to define the fall-off:

— Linear creates an even fall-off

— Bell creates a fairly steep fall-off, based on a bell-shaped curve

— Cosine creates a steep fall-off, using a cosine blend shape

The remaining options reflect the type of gradient fill, and whether or
not you have selected the ‘Fit to primitive(s)’ option.
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If you select ‘Fit to primitive(s)’:

� Specify the angle for the graduated fill, by selecting from the
Direction list or typing in the box.

� To mirror the gradient fill, from the mid-point of the extent of the
primitive, select the Mirror check box.

You might do this, for example, to create a shading effect for
cylindrical columns:

If you do not select the Mirror check box, the extent of the primitive
is filled with a single instance of the fill.
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If you did not select ‘Fit to primitive(s)’:

� In the From and To boxes, type the coordinates for the start and end
of the fill, in the display units.

If you want a vertical fill, set the X coordinates to be the same, or
the Y coordinates for a horizontal fill.

� If you want to mirror repeat the gradient fill, select the ‘Mirror
repeat’ check box.

The first example below uses a mirror-repeat gradient fill to
simulate profiled roof sheeting; the second example uses gradient
fill without a mirror repeat to represent louvered window shutters:
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If you select ‘Fit to primitive(s)’ with a radial fade, there are no
additional options to those described earlier.

If you did not select ‘Fit to primitive(s)’:

� In the From and To boxes, type the coordinates for the start and end
of the fill, in the display units

The From point is the centre of the fill and the To point is a point on
the circumference.
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Select Hatch to create a fill using a hatch pattern.

� to create a cross–hatch pattern, select the Cross hatch check box

By default, the hatching is drawn in the DEFAULT linestyle. You can
use any linestyle that exists in the document.

� to use a different linestyle, select the linestyle from the list

Note that only middle pattern strokes in the specified linestyle are used
for the hatching. Fill and vertex strokes are ignored. The pattern is
drawn as if its phasing were set to Grid. For details about phasing, see
page 175.
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Note also that there can be a conflict of co-ordinate spaces between the
pattern stroke, and the strokes of the hatch linestyle. In these cases, the
hatch style will be drawn in the ‘lower’ space, where the spaces rank in
the order Object, Drawing, Output (from high to low). Consequentially,
if you are designing a linestyle for use in hatching strokes in different
spaces, Object space is the most likely to give the desired results.

Use the Grid settings to define the grid along which the hatching lines
will be drawn:

gap specifies the gap between the rows of hatching

shear specifies the distance by which the hatched rows are to be
offset from one another

This affects the way in which any pattern elements line up.

slope specifies the angle at which the hatched lines are to be
drawn

origin specifies the coordinates for the origin of the hatched grid;
the coordinates are interpreted in the selected co-ordinate
space

For example:

If you draw a rectangle using this hatch fill, it appears as:
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Select Raster to create a fill using a raster image. You might use a raster
fill, for example, to show wall textures or flooring. For example:

� In the File name box, type the full path of the raster file or click the
Browse button to select the file.

You can use any type of raster file that can be imported into
MicroGDS. For details, see Chapter 15, Working with different file
formats.

� To maintain the aspect ratio of the raster file, select the ‘Preserve
file aspect ratio’ check box.

Clear the check box to draw the raster image at the size specified by
the Height (Y size) and Width (X size) boxes.

� To retain the specified Height and Width settings if a different raster
file is later selected, select the ‘Keep grid if file changed’ check box.

Use the Grid settings to define the grid for placing the raster image:

height specifies the height of the raster image tile

shear specifies the distance by which the rows of raster images
are to be offset from one another

width specifies the width of the raster image tile

slope specifies the angle at which the raster image is to be drawn

origin specifies the coordinates for the origin of the grid; the
coordinates are interpreted in the selected co-ordinate space



184 Using MicroGDS 11

For example:

where a single instance of the raster image is:

If you draw a rectangle using this raster image with the above settings,
it appears as:
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Select Symbol to create a fill using symbols from a MicroGDS font.

� From the Symbol list, select the symbol you require. The set of
symbols that is available depends on the selected font. To change the
font, select the font you require from the Font list.

� To specify the size for the symbol:

— if you are editing the details of a MicroGDS CV6 font, type
the size for the symbol or select from the list

— if you are editing the details of a MicroGDS CV7 font, type
the scale for the symbol or select from the list

Note that if a symbol size attribute is assigned to the symbol, a Size
box is also shown, displaying the specified symbol size. (The Size
and Scale boxes are interlinked, that is, if you change one value, the
other changes accordingly.)
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� To draw the symbols at a specified angle, in the Orientation box,
type the angle for the symbol or select it from the list.

� To draw the symbols at the given orientation, relative to the line of
symbols as defined by the grid slope, select the Relative to line
check box.

Clear the check box to draw the symbols at the given orientation,
relative to the co-ordinate space.

Use the Grid settings to define the grid for placing symbols:

gap specifies the gap between each row of symbols

shear specifies the offset between the left edge of a symbol on
one row and the left edge of a symbol on the next row

spacing specifies the spacing between each column of symbols

slope specifies the angle at which the rows are to be drawn

origin specifies the coordinates for the origin of the grid; the
coordinates are interpreted in the selected co-ordinate
space

For example:

If you draw a rectangle using this symbol fill, it appears as:
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Use a vertex stroke to mark various points on a vertex, line, and/or
segment. For example, to mark the start, end, and mid-point of every
segment of a primitive, you could define the symbols as shown:

The following examples illustrate various combinations of marking
vertex and segment points:
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You can change the font for individual vertex and segment points. The
set of symbols that is available depends on the selected font.
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� under Vertex or Segment, select the check box for the appropriate point

MicroGDS indents the vertex or segment point to indicate that it is
the currently active property.

� from the Font list, select the font you require

� to specify the size for the symbol:

— If you are editing the details of a MicroGDS CV6 font, type
the size for the symbol or select from the list.

— If you are editing the details of a MicroGDS CV7 font, type
the scale for the symbol or select from the list, instead.

Note that if a symbol size attribute is assigned to the symbol, a Size
box is also shown, displaying the specified symbol size. (The Size
and Scale boxes are interlinked, that is, if you change one value, the
other changes accordingly.)
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You draw objects on layers, and you use phases to reference the layers.
The order in which MicroGDS draws the graphics on a layer is defined
by the phase order in the Window Editor. For details, see Chapter 4,
Using layers and phases.

Generally, objects are drawn in a phase in the order the objects are
created. However, MicroGDS draws the primitives within an object in a
particular order. This order is important, particularly with filled,
closed-line primitives. The order in which primitives in an object are
drawn is:

� all closed-line primitives that have any type of filled stroke are
drawn first

Within the filled primitives, all graphics that are assigned the same
linestyle, and colour, are filled together (with the strokes being
drawn in the order in which they are defined).

� all non-filled strokes are then drawn, in their defined stroke order

� finally, all other graphics in the object are drawn

For details about filled linestyles, see page 176.
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You can use a filled linestyle to mask out parts of a drawing. You define
a mask linestyle by setting a brush of 0% and a fill of opaque (so that
graphics underneath are covered by the background colour).

For example, you could use a mask linestyle if you are inserting
windows into a wall elevation. You can draw the wall in a hatched
linestyle—to represent the brickwork—and then create a new object,
and reference it in a different phase (or on a different layer), for a
window. If you then create the background rectangle of the window in a
mask linestyle (and the detail in a normal, visible linestyle), it masks
over the brickwork detail wherever you place it on the wall.
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For this to draw correctly, you will need to ensure that the phase in
which the wall is referenced is drawn first, the window background
rectangle is drawn next (because it is a filled linestyle) and the window
detail is drawn last.

Primitives drawn with mask linestyles will not mask:

� other primitives in the same object

� items on layers placed on top of the masked-object layer

Phases are drawn and printed in the order in which they are listed in the
Window Editor. Each phase is drawn on top of the previous phase. You
may need to reorder the phases if you want to mask out items on other
layers. For details, see Chapter 4, Using layers and phases.
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With the exception of DEFAULT and BLANK, you can modify any
linestyle that is available to the document.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, locate the linestyle that you want to modify.

3 Double-click the linestyle name, or on the shortcut menu, click Edit.

This command is unavailable for any linestyle where a linestyle of
the same name exists in a location higher in the style search path.

If you want to edit a linestyle referenced in a style file, you can open
the style file for editing, using the shortcut menu.

MicroGDS displays the Linestyle dialog box.

4 Modify the characteristics as required.

5 To save the linestyle, do one of the following:

� to keep the same linestyle name, click Save

If you retain the linestyle name, all line primitives that use the
linestyle are immediately updated.

� to save the linestyle with a new name, click Save As, type the
name in the Style Name dialog box and click OK

If you modify a linestyle from an external style file, MicroGDS
creates a new local linestyle with the name you specify.

For more details about style files, see Chapter 2, Exploring
MicroGDS.

If you save a linestyle to a name that exists in an external style file, the
icon for the external linestyle changes colour in the Document
Organizer. This indicates that a local style of the same name now exists.
For more details, see Accessing linestyles on page 157.
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1 From the Line list on the status toolbar, select the linestyle to
modify.

Alternatively, select a primitive that uses the style you want to
modify.

2 On the Styles menu, click Linestyle Modify.

3 Modify the linestyle and then save the linestyle, as described in
step 5 in the previous procedure.
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You can delete linestyles that are no longer required. You cannot
retrieve deleted linestyles.

If you select a graphic whose style has been deleted, the Line box on the
status toolbar is empty. You can see the name of the assigned linestyle
in the InfoTip, if you have hover highlighting on the Information bar
switched on. You can also see the name in the Properties window
(Ctrl+Q).

If you later create another linestyle with the same name as the deleted
linestyle, it is used by the graphics to which the style was originally
assigned (if you have not assigned a different linestyle in the
meantime).

You cannot delete the DEFAULT or BLANK linestyle.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, select the linestyle that you want to delete.

You can delete multiple linestyles (or multiple styles of any type),
using Windows multi-select facilities.

3 Press Delete, or on the shortcut menu, click Delete.

4 To confirm the deletion, click Yes at the prompt.
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All text primitives have a charstyle (character style), which defines
what the text looks like. A charstyle determines the height and width of
the text, the spacing and margins around the text, and the font that is
used.

For example:
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MicroGDS provides a variety of built-in charstyles for you to use or
modify. When you create a new document, there is only one available
charstyle, DEFAULT. This uses a MicroGDS font that draws text in a
text box that has a height of 5mm.

The DEFAULT charstyle is stored separately from any charstyles you
create and cannot be saved, deleted, or replaced.

Note that you specify the size for a charstyle using real-world
measurements. The size of the text shown in the window will vary
according to how much the view is zoomed. The size of text is
independent of the current axes scale, and the scale of the object.

You can add a charstyle to a document by selecting a built-in
MicroGDS style or by creating your own. When you create your own
charstyles, you can use either a Windows font or a MicroGDS font. You
can also create new fonts that you can then use to create or modify
charstyles. For details about creating your own fonts, refer to Help.
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MicroGDS provides a number of built-in charstyles, for example:

When you select a charstyle, MicroGDS shows you a sample of the
selected charstyle. You can use a charstyle as it is, or you can modify it
and save it for future use within the document.

Although MicroGDS charstyles are stored separately from your own
and cannot be overwritten, you can, however, accidentally overwrite
amended versions if you use the same name as that of a built-in
charstyle. For example, if you select AR25, change the font height and
save it with the same name, your version of AR25 takes effect. If you
later reselect AR25 from the built-in styles and save it to the same
name, your version is overwritten and all text boxes using this charstyle
now use the characteristics defined in the MicroGDS version.
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For single-user documents, new charstyles are stored in the document.
They are saved when you save the document.

You can also access charstyles from external style files (called
CHARS.STY). To do this, you specify the folders in which the
CHARS.STY files are located using the Style Search Path command on
the File menu. You can add more than one folder to the style search
path, but only one CHARS.STY file can be stored in each location. If
you modify and save a style from an external style file, it is saved in the
document. For more details about style files, see Chapter 2, Exploring
MicroGDS.

For multi-user projects, all charstyles are stored in external style files
(CHARS.STY). New charstyles are saved in the first CHARS.STY
location on the style search path. A charstyle is saved in the style file as
soon as you save the style, even if you do not save project.

You can access charstyles available to a document from the Document
Organizer and also from the status toolbar.
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1 On the Document Organizer, click the Styles tab:
����������

2 Double-click the Charstyles category, or click the plus sign (+) to
the left.

A list of all locations from where you can access charstyles is
shown:

� for a single-user document, the name of the document with
which you are working is shown first, followed by the path of
each style file defined in the style search path if any

� for a multi-user project, the name of the first style file defined in
the style search path for the project is shown first, followed by
the path of each subsequent location defined in the project
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If a CHARS.STY file exists in the location defined for styles and
fonts in your file location preferences, this location is shown last in
the list. This enables you to reference a set of global style files that
are available to all your documents. For more details, refer to Help.

3 To display a list of charstyles in a location, double-click the location
or click the plus sign (+) to the left.

For example:

Charstyles are prefixed by an icon. The colour of the icon
determines the availability of the style:

� charstyles that can be used in the document are prefixed by a red
icon

� charstyles that are not currently available to the document are
prefixed by a grey icon

(A charstyle is unavailable if a charstyle of the same name
already exists in a location higher in the style search path.)

4 To preview a charstyle, select the style and then, on the shortcut
menu, click Toggle Preview.

� 3���		����	��
��-#���0
�&���������������#(�


� on the Char box on the status toolbar, click the arrow

All styles available to the current document are listed.
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You can add a new charstyle to a document by saving one from those
available with MicroGDS or by creating your own.

When you add a charstyle, it immediately becomes current and any
selected text changes to use that charstyle. Any new text you create also
uses this charstyle.

Note that if you open a document in which there are missing charstyles,
for example, if they have been deleted, MicroGDS reports the error
conditions to the Problems dialog box. You can use the dialog box to
correct the errors by:

� changing the styles and fonts folder

� editing the style search path

� adding new charstyles

This section tells you how to add a new charstyle to your document. For
details about each of the charstyle characteristics, see Charstyle
properties on page 201.
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1 Click the Styles tab on the Document Organizer, and then
double-click the Charstyles category.

2 Do one of the following:

� to create a new charstyle based on DEFAULT, select the
Charstyles category and then, on the shortcut menu, click New

� to create a new charstyle based on an existing style, select the
charstyle on which to base the new style from the required
location and then, on the shortcut menu, click New based upon

The Charstyle dialog box shows the characteristics of the current
charstyle.

3 If you want to use or amend a charstyle other than the current one,
do one of the following:

� to base the charstyle on an existing style in the document, click
‘Document style’, and then select the charstyle on which to base
the new style from the list
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� to base the charstyle on a built-in style, select ‘MicroGDS style’,
and then select the charstyle on which to base the new style from
the list

If you select a style from a list, all settings in the Charstyle dialog
box are reset to those stored with the selected charstyle.

4 Specify the settings in the Charstyle dialog box, as required.

5 Check that the charstyle is what you require in the Sample box.

6 Save the charstyle:

� to save the charstyle with the existing name, as shown on the
title bar, click Save

� to save the charstyle with a new name, click Save As, type the
name in the Style Name dialog box and click OK

The name must comply with the MicroGDS naming rules, as
described in the next section. You cannot save a charstyle with the
name DEFAULT.

The named charstyle is made current and its name is shown in the Char
box on the status toolbar.
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1 From the Char list on the status toolbar, select the charstyle on
which you want to base your new charstyle.

2 On the Styles menu, click Charstyle Modify.

MicroGDS displays the Charstyle dialog box.

3 Specify the settings in the Charstyle dialog box, as required.

4 Check that the charstyle is what you require in the Sample box.

5 Save the charstyle as described in step 6 in the previous procedure.

5�#���0�
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� a charstyle name can contain up to 256 characters

� names can include spaces, except at the beginning or end of the
name

� charstyle names are case sensitive, so ‘courier8’ and ‘Courier8’ are
two different charstyles

� you cannot save to the name DEFAULT
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When you add a charstyle, it immediately becomes current. To use
another charstyle, you select it from those available with the document.
When you change the charstyle, you can:

� change the current charstyle

� change the charstyle of selected text primitives

� change the charstyle of all text primitives using a specific charstyle

� override the charstyle of all text primitives for a particular phase

When you change to another charstyle or change the charstyle of
existing text, MicroGDS automatically refreshes the window so that
you can see its effect.

If you are working with a complex drawing, redraws may take some
time. You can speed up redraws by changing the view quality options.
These determine how linestyles, text, and selected graphics are to be
displayed. Note that the quality settings also affect the printed drawing.
For details on setting the view quality, refer to Help.
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The current charstyle is assigned to new text that you draw. The name
of the current charstyle is shown in the Char box on the status toolbar.

If you have selected several text primitives that have different charstyles
assigned, the Char box is blank.

Note that each time you click a text primitive, the current charstyle
changes to that primitive’s charstyle.
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1 Select any text for which you want to change the charstyle.

2 Do one of the following:

� from the Charstyle list on the Properties window, select the
charstyle

� from the Styles tab on the Document Organizer, select the
charstyle and then click Set as current on the shortcut menu
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� from the Char list on the status toolbar, select the charstyle

� on the Set menu, click Charstyle, type the name of the charstyle
in the prompt bar and press ENTER

The charstyle name must match a charstyle that you have already
added to the document.

Note that if you have enlarged, reduced, or stretched the text, and you
want to retain the size, ensure that you reapply the charstyle using the
Properties window. If you reapply the charstyle using any other method,
the text returns to the size set in the charstyle definition. For details
about enlarging and stretching graphics, refer to Help.
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1 Select any text for which you want to change the charstyle.

2 Select the replacement charstyle, as described in the previous
section.
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MicroGDS makes it very easy to change the charstyle of a number of
text primitives drawn using one charstyle to another charstyle. You
simply restrict editing to a specific charstyle.
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1 Press F3 or on the Set menu, click Edit.

You can also use the SETEDIT button on the information bar (at the
bottom-right corner of the MicroGDS window) to set restrictions:

� if SETEDIT is not currently enabled, click the button

If SETEDIT is enabled, a single click of the button toggles the
current editing restrictions on and off

� if SETEDIT is currently enabled, double-click the button

The Set Edit Filter Editor is displayed.

2 From the Charstyle list, select the charstyle to which you wish to
restrict editing.

Alternatively, click the Charstyle Pick button and click a text
primitive to which the style is assigned.
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3 Click Close.

When you have set up your restrictions, the SETEDIT button on the
information bar is pressed in and the text changes colour. You can
toggle the editing restrictions on and off by clicking the SETEDIT
button.

4 Ensure that you are in Select Primitives mode by pressing F9, or on
the Edit menu, click Select Primitives.

5 In your graphics window, select the relevant text primitives; the
status toolbar shows you the number of primitives selected and that
they all use the same charstyle.

You cannot select any text primitives that do not use the specified
charstyle.

To select all primitives drawn in the charstyle, press F7, or on the
Edit menu, click Select All.

6 Select the replacement charstyle, as described on page 197.

Remember to clear the editing restriction when you have changed the
charstyle.
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Usually, you assign charstyles to individual text primitives. This means
that a phase can show text primitives in many different charstyles. You
can, however, force all text primitives within one phase to be displayed
and printed in a single charstyle.
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1 Press F2, or on the File menu, click Window, Edit.

2 From the phases list in the Window Editor, select the phase whose
charstyles you want to override.

3 From the Charstyle Overrides list on the Phase tab, select the
charstyle you wish the graphics in the phase to use.

All text primitives within the selected phase are now drawn using
the chosen charstyle. Note that although they appear on screen and
print using the charstyle override, their original charstyles are
unchanged and still appear in the Char box on the status toolbar.

You can also see the name of the charstyle assigned to a text
primitive using the Properties window (Ctrl+Q). For details about
the Properties window, see Chapter 13, Getting information.

If you later remove the override, the primitives are drawn using their
original assigned charstyles.

You would probably use this feature only as a temporary override. To
change the charstyle permanently, you would make the phase the only
phase editable, then select all the graphics, and change the charstyle.
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When you add or modify a charstyle, MicroGDS displays the Charstyle
dialog box. For example:

The name of the currently specified charstyle is shown in the title bar. If
you are creating a new charstyle or if there are no charstyles saved in
the current document, the title bar of the dialog box does not show a
charstyle name.

The dialog box shows:

� the charstyle name if you are basing the charstyle on an existing
document style or on a MicroGDS style

� an example of the charstyle in the Sample box



202 Using MicroGDS 11

� whether this style uses a MicroGDS font or a Windows font, and the
name of the font

If the charstyle uses a Windows font that is not available, for
example, because it is not installed on this machine, the name of the
substitute font used by MicroGDS is shown.

� the colour for the font

� the units in which to display and interpret measurements in the
dialog box

� the size, spacing, and margins for the font

� the type of outline and any linestyle for the outline, if used

Note that if you type any measurement in different units to the display
units shown at the top of the dialog box, MicroGDS automatically
converts the measurements to the display units to draw the text. For
details on the types of units you can use, see Chapter 5, Entering
positions.

=���

The font is the style in which the characters are drawn, for example:

Arial Bold Italic 11pt

Courier New Regular 14pt
������	
 ���� ��	�

Fonts can be scaled, rotated, and drawn in perspective.

To choose a font on which to base your new charstyle, click Windows
or MicroGDS.

� Windows

Any TrueType font (including OpenType) that is available on your
computer can be used.

When you click Windows, a Windows Font dialog box is displayed
listing the TrueType fonts (including OpenType) that are available
on your computer. Use this dialog box to choose a font and style for
the new charstyle (bold, italic, and so on). You can also choose the
size of the font, in points. If you prefer, you can specify the height
and width of the font, in the display units, on the Charstyle dialog
box.
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Note that when you select a font, MicroGDS resets various settings
on the Charstyle dialog box based on the point size of the selected
font. Therefore, select the font before you change the individual
parameters.

� MicroGDS

MicroGDS fonts are normal graphics that have been drawn using
MicroGDS. Some examples are:

When you click MicroGDS, the MicroGDS Font dialog box is
displayed listing the fonts that are available. Use this dialog box to
choose a font for the new charstyle.

You set the path in which to look for MicroGDS fonts using the
Preferences dialog box. For details about setting your preferences,
see Chapter 17, Customizing MicroGDS.

In MicroGDS, there are two types of MicroGDS font files: CV7 and
CV6:

— CV7 fonts save many types of primitive as part of the font
graphics. All linestyle properties, such as filled strokes,
multiple colours, and thickened offsets are retained.

Other graphics, such as text primitives, and raster primitives,
are also saved. Note that you cannot, however, use instance
objects, photo primitives, or OLE objects.

— CV6 fonts save only line primitives as part of the font
graphics. All linestyle properties and other graphics, such as
text primitives are ignored.

Although MicroGDS supplies a number of font files, you can also
create your own. When you create a new font, you can define the
font to be proportional by assigning a special attribute to the
character objects. For a MicroGDS CV7 font, you can also define
the size of the character objects

Full more details on fonts and creating MicroGDS CV6 and CV7 font
files, refer to Help.



204 Using MicroGDS 11
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Use the Height box to specify the height of the text box in which a
single-line text block is placed. The height you specify is the height of
the font including the top and bottom padding (the total padding for a
CV6 font is calculated to half the font height). For example:
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The padding for TrueType fonts will vary, but is usually approximately
20% of the font height.

The set scale and object scale do not affect the size of text. For example,
a 5mm text block is always printed in a surrounding 5mm text box,
whatever the axes’ or object scale.

Use the Width box to define the width of the text box. A width of 0
means that MicroGDS will pick a default width based on the height of
the text box.

When you specify a size for a charstyle, the values you give are
real-world values.

��#��


Use the Colour box to specify the colour of the charstyle:

� to use any colours defined in the compiled font, select Neutral

If you select Neutral, MicroGDS uses the colours embedded in the
font, if any. For example, if you use a CV7 font that was created in
multiple colours, the charstyle is drawn in multiple colours.
However, if you select red in the Colour box, all characters in the
font are drawn in red.

� to use an explicit colour for the font, select an existing colour from
the list

If you want to assign a colour that is not available from the list, click
the ‘Select colour’ entry. Then, select your colour using the Select
Colour dialog box. For details about using the Select Colour dialog
box, see Chapter 3, Working with primitives and objects.

By default, MicroGDS draws graphics using the colour defined for the
current phase.
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To use the colours of a font, ensure that the Use style colours check box
is selected in the Window Editor for the phase that uses the specified
charstyle.

Note that if the text primitive has an explicit colour set (using the Set
Colour command), by default the primitive is drawn in the set colour
and any font colours are ignored.

Note that if the primitive has an explicit colour set (using the Set Colour
command), by default the primitive is drawn in the set colour and any
font colours are ignored. To use the font colours in a charstyle, clear the
Use primitive colours check box in the Window Editor.

For details about changing the colour of the graphics in a phase, see
Chapter 4, Using layers and phases.
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Use the Character box to specify the spacing between each character of
text.

Use the Line box to specify the spacing between each horizontal or
vertical line in a multiple-line text block. For example:
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Note that if you are constructing vertical text, you may want to set a
higher value for the inter-line spacing.
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Use the Margins boxes to specify the additional spacing around the text.
For example:
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Note that when you select a Windows font, the left and right margins
are set to allow for overhangs in the font’s lettering.
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Use the Outline options to specify whether or not to draw an outline
around the text. Select:

� None if you do not want to outline the text

� Inner box to draw an outline inside the margins

� Outer box to draw an outline outside the margins

� Text lines to draw an outline around the boundary of the text
characters, inside the margins

For example:
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If you select an outline option, choose the linestyle for the outline from
the list.
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With the exception of DEFAULT, you can modify any existing charstyle
that is available to the document.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, locate the charstyle that you want to modify.

3 Double-click the charstyle name, or on the shortcut menu, click
Edit.

This command is unavailable for any charstyle where a charstyle of
the same name exists in a location higher in the style search path.

MicroGDS displays the Charstyle dialog box.

4 Modify the characteristics as required.
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5 To save the charstyle, do one of the following:

� to keep the same charstyle name, click Save

If you retain the charstyle name, all line primitives that use the
charstyle are immediately updated.

� to save the charstyle with a new name, click Save As, type the
name in the Style Name dialog box and click OK

If you modify a charstyle from an external style file, MicroGDS
creates a new local charstyle with the name you specify.

For more details about style files, see Chapter 2, Exploring
MicroGDS.

If you save a charstyle to a name that exists in an external style file, the
icon for the external charstyle changes colour in the Document
Organizer. This indicates that a local style of the same name now exists.
For more details, see Accessing charstyles on page 193.
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1 Deselect all graphics.

2 From the Char list on the status toolbar, select the charstyle to
modify.

Alternatively, select a primitive that uses the style you want to
modify.

3 On the Styles menu, click Charstyle Modify.

4 Modify the charstyle and then save the charstyle, as described in
step 5 in the previous procedure.
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You can delete charstyles that are no longer required. You cannot
retrieve deleted charstyles.

If you select a text primitive whose style has been deleted, the Char box
on the status toolbar is empty. You can see the name of the assigned
charstyle in the InfoTip, if you have hover highlighting on the
Information bar switched on. You can also see the name in the
Properties window (Ctrl+Q).
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If you later create another charstyle with the same name as the deleted
charstyle, it is used by the graphics to which the style was originally
assigned (if you have not assigned a different charstyle in the
meantime).

You cannot delete the DEFAULT charstyle.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, select the charstyle that you want to delete.

You can delete multiple charstyles (or multiple styles of any type),
using Windows multi-select facilities.

3 Press Delete, or on the shortcut menu, click Delete.

4 To confirm the deletion, click Yes at the prompt.

�
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Text is drawn on the current layer, aligned with the current X axis, in
the current object. It has a charstyle, justification point, a direction, and,
optionally a wrap width, point behaviour, and a linestyle for text-box
decoration, all of which you can choose when you create the text
primitive.
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You create text in your document by typing the text in the New Text
dialog box.
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1 On the Construct menu, click Text.

The New Text dialog box is displayed, for example:
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The options on the top row of the New and Edit Text dialog boxes
affect the entire text block. The options below enable you to
override properties for individual text characters.

2 From the Charstyle list, select the charstyle for the new text.

3 Press the mouse button over the current Justification button, and
click the button for the alignment you require.

For more details about justification, see Justifying text on page 213.

4 If you want to enclose the text block in a box, select the Apply
linestyle check box and then select the linestyle you wish to use
from the list.

If you want to enclose only part of the text in a box (in the default
linestyle), you can use the box formatting button, described below.

5 Select the required direction option.

By default, text is displayed horizontally in rows. To display the text
vertically in columns, select ‘Vertical, left to right’ or ‘Vertical, right
to left’ from the list.



210 Using MicroGDS 11

6 If you want to specify that only the justification point of the text
primitive is hittable, select the Point check box.

This option has the effect of making the text primitive behave like a
‘point’ symbol. You might do this, for example, if you wanted to use
a suitable vector character symbolising the point, such as an
electrical outlet symbol.

7 By default, text is drawn on a single line, only wrapping to the next
line when a carriage return is encountered.

If you want to automatically wrap multiple lines to the width of the
New Text dialog box, select the Wrap check box. Note that you can
resize the dialog box as required.

If you prefer to wrap multiple lines to a fixed width, select the Wrap
check box and type the width in the set units in the box. Note that
the width includes the left and right margins set in the assigned
charstyle.

You can also change the width of an existing text block using the
Text, Width command on the Alter menu.

8 You can change the following properties for selected text or new
text:

� Font: for charstyles that use a Windows font, you can select a
new font from the list

� Size: to change the size of the text, select from the list or type the
size in the displayed units

� Units: to change the unit of measurement, select from the list

� Text and Background colours: to change the font colour or the
background colour, select from the colour lists:

— to use the default colours, select Neutral

— to use an explicit colour, select the colour from the
document’s colour table or define a new, custom colour

� Formatting: you can apply Box formatting to text

For charstyles that use a Windows font, you can also apply bold,
italic, underline, and strikethrough in any combination.

If you select text that already has formatting applied, clicking the
corresponding button removes the formatting.
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� Text alignment: to change the alignment, click the appropriate
button

You can choose from Left, Centre, Right, and Justify,
respectively.

9 Type the text in the text box.

� You can use commands on the shortcut menu to cut and copy
data from other Windows-based programs, and paste into this
text box.

� To include a character not on your keyboard, such as a trademark
symbol or special mathematical character, click the Insert
Symbol box. Then either select a recently used symbol from the
list or click Insert Symbol to insert a new symbol.

When you insert a new symbol, MicroGDS displays the
Microsoft Windows Character Map. To insert a symbol, select
the symbol (so that it is drawn enlarged), and then either:

— drag it to the appropriate position in your text

A character is added to the Insert Symbol list when you
drag a single character into the text box.

— click Select in Character Map, then click Copy, and then
paste the symbol into your text

You can add multiple symbols to the Select box and copy
them in one action.

If you are not familiar with using the Character Map, click the
Help button on the window.

You can also enter secondary annotation in a text block. Secondary
annotation is a reference which calls up information such as
attributes and displays it as text. For more details, see Using
secondary annotation on page 215.

10 To check the spelling of the text, click the Check Spelling button.

If any errors are found, MicroGDS displays suggestions for
correcting them.

This facility requires Microsoft Word to be installed on your
computer. The spelling checker automatically uses the default
language, and any custom dictionaries, as set in Microsoft Word.

If a suitable version of Microsoft Word cannot be found on your
computer, the Check Spelling button is not available.
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11 Click OK.

The New Text dialog box closes and a text box is attached to the
pointer. The text box is sized to accommodate the amount of text
you entered. For example:

12 Place the text box in the window by clicking, or by typing in the
snapcode or coordinates.

!���������"�

You can edit existing text blocks, for example, to correct spelling
mistakes, change the justification, change the font or size, or change the
wording.
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1 Do one of the following:

� double-click the text block you wish to edit, using a B (Box)
snapcode

� or, on the Alter menu, click Text, Edit and then click on the text
box you wish to edit, using a Box snapcode

The Edit Text dialog box is displayed with the contents of the
selected text primitive.

Note that if you clicked somewhere other than on existing text, the
New Text dialog box is displayed for you to create a new text
primitive.

2 Edit the text as required and click OK to update the text in the box.

3 When you have finished editing text, press ESC to cancel the
command.

You can also edit a number of properties of a text block using the
Properties window (Ctrl+Q). For details about the Properties window,
see Chapter 13, Getting information.

You can use the Curve, Cloud Text command on the Construct menu to
draw a revision cloud around a text block. This may be useful to
highlight changes you have made to text. For more details, refer to
Help.
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You can change the layout of a text block by changing its text wrapping.

You can wrap the text to:

� the width of the New/Edit Text dialog box

� a specific size, using the New/Edit Text dialog box or the Properties
window

You can also use the Text Width command to change the width
graphically:

1 On the Alter menu, click Text, Width.

2 Specify the text justification point on the text primitive around
which to format the text.

A ghost rectangle is drawn around the text block.

3 Specify the position to indicate the new wrap point of the text block.

When you move the mouse pointer, the ghost rectangle indicates the
current width of the text block.

The word wrapping, number of lines, and height of the text is
adjusted to fit the new size.

The width includes the left and right margins specified in the
charstyle’s definition.
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When you create new text, you place the text at the appropriate position
in the window. Every text block has a justification point, and this is the
point that is located at the on-screen position you choose. It also defines
the alignment of the text.
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There are nine possible justification points. These refer to points on an
imaginary rectangle drawn around the block of text, not to individual
letters or lines.

In the illustration below, ‘Text Block’ is the new text and the
abbreviated-justification codes are shown at the associated points of the
rectangle:

Text   Block
BR

TL

CL

BL

CR

TRTC

CC

BC

Top Left (T L)

Centre Left (C L)

Bottom Left (B L)

Top Centre (T C)

Centre Centre (C C)

Bottom Centre (B C)

Top Right (T R)

Centre Right (C R)

Bottom Right (B R)

When you type text in the New Text and Edit Text boxes, you select the
justification setting you want to use.
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1 If required, select any text primitives for which you want to change
the justification.

2 On the Set menu, click Justify.

3 In the prompt bar, type the justification you require.

You need only type in the initial letters of the two words, with a
space in between, (as shown in brackets above); you can use either
uppercase or lowercase.

If you do not type a space between the two letters, MicroGDS will
not accept the entry and displays a message.

4 Press Enter.

You can also set the left, centre, and right horizontal alignments of lines
in a text block using the three justification buttons on the status toolbar:
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Greeking is the term used when text is no longer displayed on screen as
text, each line of the text block being indicated by a straight line
instead.

Greeking is useful, for example, when you are zoomed a long way out
from your graphics, and text would be so small as to be illegible. The
greeking level is the size of text in pixels down to which it will be
displayed as text. You can set the level at which greeking occurs in your
MicroGDS preferences. For details on changing your preferences, see
Chapter 17, Customizing MicroGDS.
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You can place a reference in a text primitive so that you need not
change the text of the primitive each time the value changes. This is
called secondary annotation. For example, you might use secondary
annotation to insert the scale of an object.

You can use attributes for the reference or one of the standard
references provided by MicroGDS. For example, you might use a
reference to insert the current date and time, or the scale of the object in
which the text primitive resides.

An attribute is non-graphical information that you can attach to graphics
in a document. Details about attributes is given in Chapter 14, Working
with attributes and schemas.

You can choose to show the reference text itself rather than the
reference value using your user preferences. For details about changing
your preferences, see Chapter 17, Customizing MicroGDS.

MicroGDS automatically updates secondary annotation information
whenever needed.
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You can use a mnemonic definition to insert data in a text primitive, by
specifying a mnemonic name.

To insert an attribute value as secondary annotation, type the mnemonic
name in the appropriate position in the text using the following format:

^(mnemonic name)
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The mnemonic picks up the value allocated to the object that contains
the text primitive.

For example, the text:

Install a ^(manufacturer), ^(size), ^(colour) desk at this location

would use the values for manufacturer, size, and colour assigned to the
current object, and so might read:

Install a Steelcase, 30x60, Brown desk at this location

For a computed or external mnemonic, the appropriate computed value
is inserted in the text block. For example, the text:

The pipe length required here is ^(Pipe length)

might retrieve the length of all line primitives in an object, and so might
read:

The pipe length required here is 20m

Note that if a mnemonic of the specified name exists at more than one
level, you can prefix the name with the appropriate applicability.

Note also that if you open a document in which there are missing
attributes referred to by text primitives, for example, if they have been
deleted, MicroGDS reports the error conditions to the Problems dialog
box. You can use the dialog box to correct the errors by editing editing
the text.
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To use one of the standard references provided with MicroGDS, type
the reference in the appropriate position in the text using the following
format:

^(reference)

For example:

Status as of: ^(Time)

might read:

Status as of: Tue April 06 13:43:56 2004

For a list of the standard references provided by MicroGDS, refer to
Help.
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You can add dimension text to the graphics in a document. For example,
you can construct a dimension between two points, or construct a
dimension for the radius of an arc or a circle.

When you add dimensions to existing graphics, MicroGDS creates new
graphics for the dimensions. You can either create the new graphics in a
new object, or in the object that is current at the time. You specify the
object in which to create the new graphics using the Set Name
command. For details about setting the object name for dimensions,
refer to Help.

You can specify whether you want dimensions drawn at the object
scale, or the scale set when you created the dimension, in the document
defaults dialog box. For details about changing the document defaults,
see Chapter 17, Customizing MicroGDS.

MicroGDS provides a number of commands for constructing
dimensions. You use these commands by selecting Dimension on the
Construct menu. An additional command, Show Units, enables you to
choose whether or not the dimension text should display the units.

When you add dimension text, MicroGDS automatically sets the
linestyle and charstyle to those specified on the Dimensions tab in your
preferences. For details about changing your preferences, see
Chapter 17, Customizing MicroGDS.

By default, linear dimensions (not angle, arc length, or radius) are
created using intelligent text. This enables MicroGDS to update the
result if the primitive being dimensioned is changed. You can set your
preferences to create linear dimensions in plain text if you do not want
dimensions to be recalculated at any time.

Intelligent dimension text is displayed as meaningful text in the
window, but MicroGDS stores it as a formula. You can set your
preferences to display the formulas of dimensions or their result in the
window. For details, see Chapter 17, Customizing MicroGDS.

If you resize a graphic using Box Move or Fence Move on the Alter
menu, the formula is recalculated and the dimension text is updated
automatically. If the justification for the dimension text is set to bottom
left, bottom centre, or bottom right, the dimension text is also
repositioned with the dimension. You can move dimension text
temporarily by selecting and dragging the text box in the usual way.
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However, if you want to reposition dimension text permanently without
it being moved by the Box Move and Fence Move commands, change
its justification to any justification other than bottom left, bottom centre,
or bottom right.

For full details about constructing dimensions, refer to Help.
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When you work in MicroGDS, by default you work in a 2D view.
MicroGDS also enables you to work and view drawings in 3D. All data
in MicroGDS is held as 3D data.

When you view a 3D object, the object must be projected onto a 2D
plane, that is, your screen. MicroGDS uses planar geometric projections
in which straight-line rays, called projectors, are drawn from a centre of
projection, through the object, and onto the projection plane.

There are two types of planar geometric projection:

� perspective

� parallel
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In perspective projections, the centre of projection is a fixed distance
from the object.
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In parallel projections, the centre of projection is at infinity, which
means that the projectors are parallel.
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Projections are described in more detail later in this chapter.



Chapter 9: Working in 3D 221

� ��	����������%�'�� 
You can switch the view between 2D, print layout, and 3D at any time.
2D and print layout objects appear flat in a 3D view. For example:
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You can display 3D graphics in different modes. The first time you view
the graphics in a window definition in 3D, the graphics are shown in
wireline. When you display 2D graphics in a 3D view, all strokes in a
linestyle are shown in wireline mode. If you change the type of 3D
mode, filled strokes may not be shown, depending upon the mode
chosen. Types of 3D modes are discussed later in this chapter.

3D objects are viewed as if looking down the Z axis in a 2D view:
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� on the View menu, click 3D

When you view graphics in a document that is enabled for intelligent
objects, you also use the drawing style modes to switch between
predefined 2D and 3D views. For details about using intelligent objects
in a document, see Chapter 3, Working with primitives and objects.
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It is not necessary to be in 3D view to draw 3D objects. When you draw
a 3D object, you supply a Z coordinate in addition to the X and Y
coordinates. Whenever you do not explicitly specify a Z coordinate,
MicroGDS uses the last specified Z position. If no Z position has been
given, the Z coordinate is zero (0).

Although you can draw 3D objects in a two dimensional view, you
might find it difficult to visualise without seeing the object in 3D.

When you are working in a 3D view, you can use the Z axes snap guide
to help locate a 3D position. MicroGDS generates a Z axis snap guide
during many commands, through the current position and whenever you
hover over an End, Point, Inside, Centre, or Middle snapcode. You
switch the Z Axis option on and off using your Snapping preferences.

For more details about using snap guides, see Chapter 5, Entering
positions.
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When you switch to a 3D view, the graphics are drawn in the last 3D
projection. The first time you view the graphics in a window definition
in 3D, the eye position and look-at point are set up to show the extent of
existing graphics, centred in the window.

The eye position is your position in space, and the look-at point is the
point on the drawing at which you are looking. Together, these define
the direction of viewing (your line of sight) across a scene. For
example:
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In the same way that each 2D view has a set of view controls, the
window for each 3D view also has a set of view controls for moving
around a 3D view.

By default, these are displayed to the left of each window. You can
choose which view controls you want for your windows and their
orientation, using the Customize dialog box. For details about
customizing the view controls, see Chapter 17, Customizing MicroGDS.
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When you work in a 3D view, you will often want to change the
direction in which you view a model and move around to see different
parts of the window.

MicroGDS provides specific commands and controls for you to
navigate 3D views that are in addition to those facilities for working
with 2D views. These are covered briefly in the following sections. For
full details, refer to Help.
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In a 3D perspective view, the scroll bars and the zoom bar change their
behaviour.

In a perspective view, the zoom slider advances or retreats along the
line-of-sight. The slider range is scaled so that the middle position
corresponds to the distance set by the Zoom Extents command. Moving
up from the middle retreats from the scene and moving down advances
into the scene.

The scroll bars slide the look-at point across the view. Dragging the
scroll box to either end drags the look-at point from the centre to the
edge of the view.

Note that in a 3D parallel view, the scroll bars and the zoom bar behave
in the same way as for a 2D view. You can scroll the view almost
without limit. For details about changing the projection, see page 228.
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MicroGDS provides two thumbwheels that you can use to change the
line of sight, by swinging the eye position around the look-at point. The
3D round thumbwheel moves the eye position horizontally around the
look-at point, and the 3D wheel thumbwheel moves vertically around
the look-at point. The look-at point stays in the same place.
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By default, the 3D thumbwheels are situated at the top right, and bottom
left of the window definition, next to the scroll bars. You can show or
hide the 3D thumbwheels using the Customize dialog box. For more
details, see Chapter 17, Customizing MicroGDS.

The counters positioned in the centre of the thumbwheels show the
current horizontal and vertical positions, relative to the Z axis.
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� drag the appropriate thumbwheel in the required direction



Chapter 9: Working in 3D 225

� 3��&�'�������-�������������������

� click the appropriate point on the thumbwheel

Note that the size of the step depends on how far from the counter
you click.
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MicroGDS provides a number of viewing buttons that you use to zoom,
pan, and change the view. You can select the viewing buttons to display
on 2D (including print layout) and 3D views using the View Controls
tab on the Customize dialog box.

The default buttons on a 3D window are:

switches to 2D view

switches to 3D view

switches to print layout view

expands the view extent to fill the window

zooms in to a rectangular area that you specify

Note that in a 3D perspective view, you drag a frustum to
indicate the view extent.

zooms to show the selected graphics as large as possible

zooms to show all the graphics as large as possible.

switches back to the previous view

switches forward to the next view

creates a new window with a view extent that you specify

advances to and retreats from a point

changes the zoom angle and advances or retreats

slides the eye ray or pans across the scene

revolves the eye position about the look-at point

pans and tilts the look-at point around a fixed eye position

walks in and out of the scene

sets the drawing style
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The default buttons on a 2D window are described in Chapter 2,
Exploring MicroGDS. More details about choosing view controls are
given in Chapter 17, Customizing MicroGDS.
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MicroGDS also provides a set of nudge commands to enable you to
move the view up, down, left, and right.

The effect of a nudge command depends on the active nudge mode and
the current 3D projection. MicroGDS provides three nudge modes that
you use to nudge a 3D view:
� ‘Swing Round mode’ swings around the model

� ‘Walk Through mode’ walks through the model

� ‘Slide Past mode’ slides past the model
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1 On the View menu, click Alter View, Nudge, and then click the
nudge mode you require.

2 On the viewing buttons or on the View toolbar, click the nudge
direction button you require.

Alternatively, on the View menu, click Alter View, Nudge, and then
select the nudge direction.

For details on the nudge modes and each of the nudge commands, refer
to Help.

By default, the view is nudged by a 5° angle or by a distance of 10%.
You can change the amount in which the view swings or walks using
the Nudge Parameters dialog box, available from the View menu (Alter
View, Nudge, Parameters). For more details, refer to Help.

Note that you might want to assign shortcut keys to the nudge
commands and use them as an alternative to the mouse-based
navigation facilities. For details about assigning shortcut keys, see
Chapter 17, Customizing MicroGDS.
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A MicroGDS document has a view which consists of 2D, print layout,
and 3D parameters. A 2D view has an extent and a rotation from
horizontal. A print layout view has only an extent. A 3D view is either
parallel or perspective; these two views share the eye point and look-at
point parameters.
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When you switch between views, MicroGDS remembers the view
parameters independently. You can use the View Parameters dialog box
to display the projection and view parameters for the current view, and
set new parameters.
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� on the Window menu, click View Parameters

MicroGDS displays the view parameters for the current view, for
example:
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By default, the View Parameters dialog box is displayed in its shortened
form, showing the parameters that you are most likely to be interested
in. To expand the dialog box to see more parameters, click >>>. When
the dialog box is expanded, you can shrink the dialog box by
clicking <<<.

Use this dialog box to change the current projection and the line of
sight, as described next, and any other parameters specific to the
projection type. You can also create new saved views and recall and
apply any existing saved view from the View Parameters dialog box.
For full details on changing the view parameters and working with
saved views, refer to Help.
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There are two types of projection used in MicroGDS: parallel
projections, and perspective projections.

The first time you view a drawing in 3D, MicroGDS shows the graphics
using a 3-point perspective projection with a zoom angle of 60°. In a
3-point perspective projection, lines that are parallel to each other but
are not parallel to the projection plane (your screen) converge to a
vanishing point.

If the set of parallel lines is itself parallel to an axis, the vanishing point
is called a principal (or an axis) vanishing point. A 3-point perspective
projection has three vanishing points, corresponding to the X, Y, and Z
axes. The line of sight is defined by the eye position and look-at point.
You can also specify 1-point or 2-point perspective projections.

With a perspective projection, you specify the angle subtended by the
cone of vision at the eye position. The default angle of the cone is 60°,
but you can specify any angle between 0.1° and 179.9° (depending on
the number of decimal places for angles set in your preferences).

When you change the cone of vision, MicroGDS automatically includes
all graphics in the perspective view. Therefore, this angle also
determines the location of the eye position.

MicroGDS offers a range of standard parallel projections, such as
Isometric and Orthographic. For details about these projections, refer to
Help.

You can change the projection of a view using the View Parameters
dialog box. You can also view and change the eye position, look-at
point, and other parameters. Whenever you change the view, MicroGDS
stores the current view in memory so that you can return to a previous
or next view.

� 3��	�����������
�)�	�������� ��	������%�'�� �����
� �

1 On the Window menu, click View Parameters.

2 From the Projection list, click the projection you require.
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3 From the Projection mode list, click the mode you require.

With a perspective projection, you must specify the cone of vision
from the eye. The angle defines the apex of the cone, at the eye
position.

4 Click Apply.
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The line of sight is the line between your position in space (the eye
position), and the point on the drawing at which you are looking (the
look-at point).

You can change the eye position and the look-at point independently, or
together, using the View Parameters dialog box.
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1 On the Window menu, click View Parameters.

2 In the Eye or Look-at boxes, type the new coordinates in the current
set units and set axes.

3 Click Apply.
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1 Click one of the Pick buttons in the View Parameters dialog box.

2 In the graphics window, press the mouse button at the position to
identify the first value.

3 Move the mouse in the required direction, and then release the
mouse button.

As you move the mouse, a line is dragged to indicate the line of
sight.

4 At the position to identify the second value, click the mouse button.
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When you work in a 3D view, you can change the view to the current
XY plane while remaining in 3D view. This provides a flat view that
can be useful, for example, for exact positioning, or if you want to see
the top or side elevation of a shape.
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� on the View menu, click Axes XY Plane

The view is set to the XY plane, in an orthographic parallel
projection, and is zoomed to display all graphics.

Note that the view direction is automatically set to Top, but in the
example above, the Front view has been selected on the View
Parameters dialog box.
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A clump is a 3D primitive that comprises one or more joined faces.

One way to create clumps is from closed line primitives, where each
closed line primitive becomes a face. For example:
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You can create clumps when you want to show one graphic in front, or
on top, of another graphic. For example, if you drew two overlapping
rectangles, the outlines of both line primitives are shown in 2D and 3D
views as:
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You can clump the graphics to create 3D graphics, and use the 3D Hide
command so that hidden lines are not drawn:

You can change the colour of a clump by applying a material. Materials
are used when you use a 3D shaded view:

3D views are described further on page 241. For details about creating
and using materials, see Chapter 11, Working with materials.

In MicroGDS, there are two types of clumps: solid clumps, and mesh
clumps:

� solid clumps: When clump faces are joined to form a closed shape,
the clump is solid. For example, to create a cube you must first draw
six closed squares, one for each face of the cube. Each square must
be drawn in the same direction as you look at the cube from the
outside to ensure that the edges will match correctly. Then, when
you select Clump Create, each coincident edge is joined to form the
solid clump.

����������

� mesh clumps: When clump faces do not join to form a closed shape,
the clump is a mesh.
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You can use the Solid Construct commands to construct clumps, and the
Solid Boolean, Slice command to slice through clumps.

The following subsections show some of the different types of clumps
that you can construct. For full details about how to construct clumps
and details about each of the clump commands, refer to Help.

If you have MicroGDS Collaboration, additional 3D solid commands
are described in Part Two: Advanced 3D and rendering.
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MicroGDS converts graphics to facets when you construct a clump with
a curved surface. Facets are created when you extrude, displace, sweep,
and revolve graphics.

For example, if you extrude a circle to form a cylinder, the extrusion
has a number of faces. You specify the number of facets with the Set
Facet command. The default is 32, but you can change this to anything
between zero (which creates a solid clump with 2 faces) and 4906.
Using a high number of facets results in a truer shape, but increases the
time for redraws.
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1 On the Set menu, click Facet.

2 In the prompt bar, type the number of facets and then press Enter.

This number of facets will be used for new graphics; existing
faceted graphics are not affected.

MicroGDS remembers the set facet value between MicroGDS sessions.
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The Extrude command extrudes line primitives or objects. By default,
the graphics are extruded parallel to the Z axis.

You can use the Extrude command, for example, to create a cube from a
rectangle, or to create a cylinder from a circle:

You can also extrude graphics in any direction or taper graphics to any
given point.

When you extrude graphics:

� each closed line primitive forms a solid clump

� each open line primitive forms a mesh clump

� if you extrude a curved primitive, it is facetted

� if you extrude multiple, closed line primitives that are nested, holes
are created in the enclosing clump

The clumps are created in the current object. You can choose to replace
or retain the original graphics.

When you extrude graphics, you specify two points to extrude between.
For each point, you can snap to existing graphics or type in a 3D
coordinate. MicroGDS uses only the Z coordinates of these two points.

The graphics must lie in the XY plane if you want to use the true shape
of the graphics. If they do not, they are shadowed onto the XY plane
before extrusion.

You can snap to the XY plane either when you specify the position to
extrude from, or the position to extrude to. You cannot snap to the XY
plane for both positions because both Z values are zero.
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1 Select the graphics to extrude.

2 On the Solid menu, click Construct, Extrude.

3 Specify the coordinates, or use a snapcode, for the position to
extrude from.

You can press TAB to toggle between extruding freely or
constraining to the Z axis.

If you want to taper the extrusion, press Enter and type the scale
factor in the Extrude Scaling dialog box. MicroGDS calculates the
tapering as a ratio between the start point and the scaling factor. For
example, a scaling factor of 0 will join the vertices to a single point:

4 Specify the coordinates, or use a snapcode, for the position to
extrude to.

To create a new graphic rather than modify the selected graphic,
press Ctrl when you specify the position to extrude to.
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The Displace command displaces line primitives or mesh clumps, and
joins them up in the specified direction to form a surface or solid. For
example:
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You can also extrude graphics parallel to the Z axis or taper graphics to
any given point.
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When you displace graphics:

� each closed line primitive or mesh primitive forms a solid clump

� each open line primitive forms a mesh clump

� if you displace a curved primitive, it is facetted

� if you displace multiple, closed line primitives that are nested, holes
are created in the enclosing clump

The clumps are created in the current object. You can choose to replace
or retain the original graphics.

When you displace graphics, you specify two points to extrude
between. For each point, you can snap to existing graphics or  type in a
3D coordinate. MicroGDS uses only the Z coordinates of these two
points.

You can snap to the XY plane either when you specify the position to
extrude from, or the position to extrude to. You cannot snap to the XY
plane for both positions because both Z values are zero.
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1 Select the graphics to displace.

2 On the Solid menu, click Construct, Displace.

3 Specify the coordinates, or use a snapcode, for the position to
extrude from.

You can press TAB to toggle between extruding freely or
constraining to the Z axis.

If you want to taper the extrusion, press Enter and type the scale
factor in the Extrude Scaling dialog box. MicroGDS calculates the
tapering as a ratio between the start point and the scaling factor.

4 Specify the coordinates, or use a snapcode, for the position to
extrude to.

To create a new graphic rather than modify the selected graphic,
press Ctrl when you specify the position to extrude to.
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You can construct a clump by sweeping line primitives along a path:
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Note that if the path is not perpendicular to the plane of graphics, the
graphics are first shadowed onto the plane that is normal to the path.

The graphics need not lie on the path:
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When you sweep graphics:

� each closed line primitive forms a solid clump

� each open line primitive forms a mesh clump

� if you sweep a curved primitive, it is facetted

� if you sweep multiple, closed line primitives that are nested, holes
are created in the enclosing clump

The clumps are created in the current object. The original graphics are
always replaced by the new clumps.
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1 Select the graphics to sweep.

2 On the Solid menu, click Construct, Sweep.

3 Specify the coordinates, or use a snapcode, for the start of the path
to sweep from.

If you want to taper the swept graphics, press ENTER and type the
scaling factor in the Extrude Scaling dialog box.

4 Specify the coordinates, or use a snapcode, for the end of the path to
sweep to.

To sweep along the entire path of the graphic, press Ctrl and click
anywhere along the path.
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MicroGDS enables you to construct a clump by revolving a graphic
through 360° around the Y axis.
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There is an example at the end of this chapter that you can work
through to create a 3D desk lamp. In the example, the lamp stem and
base are converted to a clump by revolving the 2D primitive around the
Y axis.

For example:
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The graphics to be revolved must not cross the Y axis.

If you want to use the true shape of the graphics, the graphics should lie
in the XY plane. If they do not, they are shadowed onto the XY plane
before they are revolved.

When you revolve graphics:

� each closed line primitive forms a solid clump

� each open line primitive forms a mesh clump
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The surfaces are facetted so that the faces of the clumps can be created.

The clumps are created in the current object. You can choose to replace
or retain the original graphics.
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1 Select the graphics to revolve.

The graphics must lie in the XY plane, and must not cross the Y
axis.

2 On the Solid menu, click Construct, Complete Revolve.

To create a new graphic rather than modify the selected graphic,
press Ctrl when you select the command.

�
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MicroGDS offers a number of commands for you to work with clumps.
You can:

� clump existing graphics

� unclump existing clumps into constituent line primitives

� fragment existing clumps into constituent faces

You can assemble existing primitives and objects to form a single
clump.

� if two closed line primitives have coincident edges, and the edges
have opposite directions, they are joined to form a single clump

�����������������	����*��D
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if the edges have the same direction, the two primitives become two
clumps each with one face
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� if three or more faces have coincident edges in opposite directions,
the edges are joined in pairs

Clumps can only be created from closed line primitives; open line
primitives are ignored.

Full details on creating clumps are given in Help.

#����	
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If your graphics use co-planar geometry, 3D views may be
unpredictable. Co-planar geometry is where faces of two different
clumps wholly or partly coincide. Where graphics use co-planar
geometry, MicroGDS has no way of knowing which face should be in
front of the other. This is particularly obvious when you have assigned
materials to your graphics and you view the graphics in a 3D shaded
view.

In some circumstances, you may be able to extrude or move one of the
clumps so that they no longer coincide.

�#�	����	#�&��
You can slice a clump along the XY plane. For example, you may want
to slice a clump into two, and then separate the clumps to create an
exploded view of the object.

.���	��������� (���	��������



240 Using MicroGDS 11

When you slice graphics:

� if the original clump was a solid clump, the cut surfaces are closed
to make new solid clumps

� if the original clump was a mesh clump, the cut surfaces remain
open to create two new mesh clumps

The clumps are created in the current object.
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1 Set the axes so that the XY plane defines the slice that you want to
make.

You can achieve this using the Set, Axes Spin X, Spin Y, and Spin Z
commands, or Set, Axes Move. For details on how to use these
commands, refer to Help.

2 Select the clump to slice.

3 On the Solid menu, click Boolean, Slice.

The clumps are sliced in the XY plane.

To create an exploded view, move one of the new clumps.

�&��������	#�&��
You can smooth the edges between faces of 3D graphics. For example,
if a clump is facetted, you can smooth the facets so that edges between
facets appear softer.
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When you construct a clump from a curved line primitive, MicroGDS
facets the primitive so that the faces of the clump can be created, and
then automatically smooths the clump faces. However, if you import
external files the graphics are not smoothed.

You can smooth all edges in a clump between faces that meet at less
than a particular angle, or you can smooth individual edges of a clump.

To show or hide smooth edges between clump faces for non-rendered
3D graphics, use the Show Smooth Edges command on the View, Hide
Options menu, described next. For full details on smoothing clumps,
refer to Help.
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Note that smoothing clumps helps to produce clearer rendered images
in MicroGDS Collaboration. For details about rendering, refer to Part
Two: Advanced 3D and rendering.
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1 On the Solid menu, click Clump, Smooth Edge.

2 Click the edge that you want to smooth.
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1 Select the clumps to smooth.

2 On the Solid menu, click Clump, Smooth Angle.

3 Click the edge that you want to smooth.

4 Type the maximum angle between 0° and 120° between faces to be
smoothed and press Enter.

Faces that meet at an angle that is smaller than the angle you specify
are smoothed.

You can also change the angle of smoothing for the selected clumps
using the Properties window (Ctrl+Q). For details about using the
Properties window, see Chapter 13, Getting information.
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You can display 3D graphics in different ways:

� draw all lines as a wireframe (the default 3D view)

� display hidden lines in a dotted linestyle

� hide hidden lines

� shade graphics using materials and lights, with or without edges
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Hidden lines are those edges of a solid object that pass behind or
through other solids, and would be invisible if the solids were opaque.
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You can also display the graphics in a section view to show only
graphics that lie behind a specified plane or cube. This is explained in
Using section views on page 245.
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1 On the View menu, click Hide Mode.

2 On the Hide Mode submenu, click the hide mode you require.

You can modify the clumps in all types of view.

Note that raster images are not shown in shaded or hidden line views.
For details about constructing raster primitives, see Chapter 15,
Working with different file formats.

All 2D line primitives within the view extent are shown in all types of
view. This includes non-3D geometry such as construction lines, light
objects, and so on. If you do not want non-3D graphics to be shown,
ensure that external light objects are outside the view extent, and place
all construction lines onto a single layer and set that layer to Invisible.
This may be particularly relevant when you view graphics using a
shaded view.

Note that when you use a shaded or hidden view, by default you cannot
snap on to any hidden lines. If you want to snap on to hidden lines, you
can switch this facility on in your preferences. For details, see
Chapter 17, Customizing MicroGDS.
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You can display three-dimensional graphics in a 3D view so that
materials and lightstyles are used to shade the graphics. There are two
types of shaded view: ‘Shaded’ and ‘Shade with Edges’. The difference
between these two modes is that Shaded shades clump faces and ignores
the clump edges, whereas Shade with Edges adds the clump edges.

For example:

The shaded views enable you to produce fast and simple images from
3D models. You can define materials and lightstyles which MicroGDS
will use to shade the graphics.

In MicroGDS Collaboration, using a shaded view is quicker than
rendering, and you can draw in a shaded view, whereas you cannot
draw in a rendered image. For details about creating and using materials
and lightstyles, and rendering an image, see Part Two: Advanced 3D
and rendering.

Materials are shown as plain, matte colours in a shaded view. If there
are no materials in the document, MicroGDS uses a default matte shade
for all graphics.

For details about creating and assigning materials for a shaded view in
MicroGDS, see Chapter 11, Working with materials.

Materials are much more sophisticated in MicroGDS Collaboration, but
many of those attributes are not used in a shaded view.

If you have not added any lights to the scene, MicroGDS uses the
built-in simplified lighting. This consists of two lights, an eye light and
a distant light (that looks over the left shoulder of the camera).
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Where there are a large number of lights in a scene, the scene might not
be lit as expected. This is because only a limited number of lights are
processed and the ones that are processed might not produce the best
lighting effect. In such cases, use the Simplify Lights option on the
View menu to ignore all lights in the scene and simplify the lighting
instead.

For details about creating and assigning lights for a shaded view in
MicroGDS, see Chapter 10, Working with lightstyles.

In MicroGDS Collaboration, lights are also used when you render 3D
graphics. Many additional light types are also available in MicroGDS
Collaboration. For further details, see Part Two: Advanced 3D and
rendering.

<�� ��������

MicroGDS provides options on the Hide Options submenu that you can
use to select hidden-line options. These include:

� showing (in full or partially) or omitting smooth edges between
clump faces, in all views except shaded views
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You can show or hide smooth edges in all 3D views, except shaded
views.

� showing or hiding intersection lines, in hidden and dotted views

1��������	������������� �"�������	�������������

Show Intersection Lines is available only in hidden-line, dotted-line,
and shade with edges 3D views.
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You can use the Smooth commands to smooth edges and angles. Edges
and angles that are smoothed are shown when you select Full or Partial
smooth edges.

For full details about the Hide options that you can use, refer to Help.

Note that if you burn in the contents of a photo with a 3D view, the
overlaid intersection lines are placed in a new object called Graffiti:.
For details about photo primitives, refer to Chapter 3, Working with
primitives and objects.
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A section view lets you set a clipping point at which objects outside the
section are hidden. Section views are particularly useful for
constructing photos and placing them in a print layout view. You might
also find it useful for removing nonessential detail when you are
working within a particular 3D region.

There are two types of section view:

� Clip to Plane: clips the view to a single, specified plane

� Clip to Cube: clips the view to a specified cube

MicroGDS shows only graphics that lie behind the clipping plane or
within the clipping cube. You can choose whether cut faces are ‘closed’
or ‘open’ and specify the linestyles and materials to use for cut edges
and faces.

For example, you might create a section plane through a casement
window to reveal the extruded window profile:

�������������� "�	����������������������
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You can display a section view in any of the 3D hide modes described
earlier.

� 3�������������	�����'�� 

1 On the View menu, click Section Clip.

2 On the Section Clip submenu, click the type of section view you
require.

For more details about working with section views, refer to Help.
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If you want to modify text with the Solid commands—for example, if
you want to extrude it—you must first convert the outline of the text
into line primitives by ‘burning’ it in.

For example, if you burn the text primitive LABEL, it becomes eight
line primitives:
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Once you convert a text primitive to line primitive form, it can no
longer be edited as text.
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1 Select the text primitives you want to convert.

2 On the Alter menu, click Text, Burn In.

The outline of each text character is converted into a series of line
primitives.
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You can now use the 3D commands, such as extrude, on the converted
text. For example:

If you want to edit the text as a single entity, for example, to move or
copy it, first select each individual primitive. For more details, see
Chapter 3, Working with primitives and objects.
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This final section shows how to draw a simple desk lamp demonstrating
some of MicroGDS’s basic 3D capabilities.

The sample drawing gives you some ideas about how to construct 3D
graphics and work with 3D views.

Much of the lamp is constructed in a 2D view. This means that you will
not immediately see some of the construction and geometry until you
switch to 3D. If you want to see how the lamp is progressing, switch
between 2D and 3D view at any time. All the construction can be done
in a 3D view, but for the purpose of this exercise return to 2D view
before you continue with your drawing.

It should take only a few minutes to draw the desk lamp, but it is a good
idea to save at regular intervals. This will enable you to return to a
previous stage if necessary.
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In MicroGDS, there are usually several ways of accomplishing a task;
this example illustrates just one way of creating a 3D object.
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1 Start by creating a new document:

a) On the File menu, click New.

b) On the Create a New File dialog box, select Blank and click OK.

2 To set the units of measurement to millimetres, and decimal places
to one:

a) On the Set menu, click Units.

b) In the prompt bar, type mm and press Enter.

c) In the prompt bar, type 1 and press Enter.

3 To draw the lamp stem:

a) On the Construct menu, click Rectangle.

b) Press Enter to display the Rectangle dialog box.

c) In the X size box, type 8; in the Y size box, type 350 and press
Enter.

A rectangle of the specified size is attached to the mouse pointer.

d) To specify the top-left corner of the rectangle, type 0/0 and press
Enter.

MicroGDS constructs rectangles on the XY plane. This means
that you do not need to specify the Z coordinate; MicroGDS
assumes the Z coordinate to be 0.

e) To position the bottom-right corner of the rectangle, move the
mouse pointer towards the bottom right of the graphics window
until the rectangle appears below the axes and to the right, then
click the mouse button (using a Dot snapcode).

You do not need to end the rectangle command because you will
continue to use it in the next step.

4 To draw the lamp base:

a) First, you will need to change the view so that you can
accurately place the three tiers that will make up the lamp base.
If you are familiar with the zoom bar and zoom commands,
zoom in to the bottom of the lamp stem.
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Alternatively, use the View Parameters dialog box (available
from the Window menu) to change the view extent to 220/–225
in the top box, and –120/–440 in the box below, and then click
Apply.

b) To draw the top tier of the lamp base, press Enter to redisplay the
Rectangle dialog box.

If you have ended the previous rectangle command, you can use
the ‘repeat the last command’ feature to quickly reselect it: first,
if you used the View Parameters dialog box to change the extent,
click the MicroGDS window title bar to make sure it has focus
and then press Enter to repeat the last command. Then press
Enter to redisplay the Rectangle dialog box.

You could also reselect the Rectangle command on the Construct
menu but using the shortcut method of repeating the last
command can be quicker, especially when commands are nested
on submenus.

c) In the X size box, type 80 and in the Y size box, type 7 then
press Enter.

d) Click on the bottom-left corner of the lamp stem to position the
top-left of the rectangle (using a Point snapcode).

e) Move the mouse pointer towards the bottom right of the graphics
window until the rectangle appears below the lamp stem and to
the right, then click the mouse button.

f) Repeat steps b) to e) to draw and place two further tiers, one
below the other, using the sizes:

X size = 125, Y size = 5

X size = 150, Y size = 5

Your drawing should look like this:
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In the next step, you will glue the four primitives to form a single
primitive. You will then revolve the primitive to create a 3D lamp
stem and base.

5 To glue the primitives together:

a) On the Alter menu, click Glue.

b) To glue the first two primitives, click the lamp stem and then
click the top tier of the lamp base, using Line snapcodes.

The two primitives are joined and the coincident line is removed.

c) Repeat step b) to glue the newly-created graphic to the second
tier, and then the second tier to the third tier.

The existing primitives are now a single line primitive, and will
be treated as a single entity.

Before converting the 2D primitive to a 3D primitive, you will use
the Fillet command to soften the angle between the lamp base and
stem.

6 To fillet the primitive:

a) On the Alter menu, click Fillet.

b) At the radius size prompt, type 40 and press Enter.

c) Click the first right-angle of the graphic. That is, the angle
between the lamp stem and the first tier.

The drawing should now look like this:

7 To create the stem in 3D, on the Solid menu, click Construct,
Complete Revolve.
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This command constructs a clump from a line primitive. The
graphics are revolved through 360° about the Y axis:

A clump is a 3D primitive that comprises one or more connected
faces. A face is one surface of a closed line primitive. When you
revolve a primitive, MicroGDS converts the graphics to a number of
faces. The number of faces created is defined by the set number of
facets. For details about changing the number of facets, refer to
Help.

8 To show the graphics in the window at their maximum size:

a) On the View menu, click Zoom, Extents.

The clump is shown at its maximum size. You will now use
another Zoom command to zoom out by a factor of 2, about the
centre of the view.

b) On the View menu, click Zoom, Out.

In the next step, you will cut the lamp stand to the Clipboard, spin
the axes about the current X axes, and then paste the lamp stand
back to the window. This will stand the lamp stand vertically in the
scene when viewed in 3D, and will enable you to correctly construct
and position the lampshade.

9 To change the view ready to construct the lampshade:

a) On the Edit menu, click Cut.

The clump is cut from the window and placed on the Clipboard.

b) On the Set menu, click Axes, Spin X.

c) In the prompt bar, type 90d and press Enter.

This is the default axes rotation.
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d) On the Edit menu, click Paste.

The clump is pasted back, at the specified rotation. For example:

If you have the Angle setting on the status toolbar, ‘Skew’ is
shown in the Angle box to indicate that the X axis is rotated out
of the default XY plane.

e) To switch the view to 3D, on the View menu, click 3D.

The first time you view a drawing in 3D, MicroGDS uses a
3-point perspective projection. If you have changed the
projection, use the View Parameters dialog box (available from
the Window menu) to set the view to a Perspective, 3-point, with
an angle of 60°.

f) To reset the axes to the centre of the drawing sheet with a
rotation of 0°, on the Set menu, click Axes, Centre.

In the next step, you will construct the shade by drawing a circle and
using the Extrude command to extrude and taper it into a cone.

10 To construct the lampshade:

a) On the Construct menu, click Circle, Radius Centre.

b) At the radius prompt, type 200 and press Enter.

c) To place the circle at the axes origin, type 0/0 and press Enter.

MicroGDS constructs circles on the XY plane and so assumes
the Z coordinate to be 0.

d) On the Solid menu, click Construct, Extrude.

A cylinder is attached to the mouse pointer.

e) To specify the position to extrude from, type 0/0.

As you move the mouse pointer vertically up the window a ghost
cylinder is drawn, following the height of the pointer.
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f) To taper the cylinder, press Enter to display the Extrude Scaling
dialog box, type a scale factor of 0 and click OK.

MicroGDS calculates the tapering as a ratio between the start
point and the scaling factor. Therefore a scaling factor of 0 will
join the vertices of the circle to a single point.

g) To specify the position to extrude to, type //1000 and press Enter.

You can use // as a shortcut to mean use the same X and Y values
as the previous position.

h) To show the graphics in the window at their maximum size, on
the View menu, click Zoom, Extents.

You will now cut the cone using the Slice command, and remove
one part. The remaining part of the cone is your lampshade.

Note that you would probably design the lampshade by tapering the
extrusion to the precise scaling factor. Here, however, we want to
illustrate the effectiveness of the Slice command.

Because clumps are sliced along the XY plane, you will first move
the axes to where the clump will be sliced.

11 To edit the resulting clump:

a) On the Set menu, click Axes, Move.

b) To position the axes, type 0/0/350 (or //350)and press Enter.

c) To retain the orientation of the axes, press Esc.

You will now use the Slice command to slice the cone in two.
along the XY plane.

d) On the Solid menu, click Boolean, Slice.

The cone is split into two, with both parts selected.

e) To select only the upper part of the cone, click the upper part.

f) To delete the selected graphics, press Delete.

The lamp is complete. By default, the graphics are shown in
wireline view.
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12 To change the view:

a) To hide the axes, on the Set menu, click Axes, Show.

b) To change the view to hidden-line view, on the View menu,
select Hide Mode and then select Hide.

Alternatively, press Ctrl+H.

13 Finally, use the zoom commands to zoom into the view, and then
practice changing the position of the eye using the 3D Wheel
Thumbwheel (above the vertical scroll bar).

If the thumbwheel view controls are not displayed on the window,
use the View controls tab on the Customize dialog box to switch
them on.
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In MicroGDS, you can create lightstyles to change the atmosphere of a
shaded image. You can use different types of lights to cast light in
different ways. For example, you can focus light along the line of sight,
or use ambient lighting to illuminate all surfaces equally. Lights are
used when you use a 3D shaded view.

You assign lightstyles to objects to create lights. For details about how
to create objects, see Chapter 3, Working with primitives and objects. 

In MicroGDS Collaboration, lights are also used when you render 3D
graphics. Additional, more sophisticated, lightstyles are also available.
For further details, see Part Two: Advanced 3D and rendering.

When you create a new document, two lightstyles are always available:
DEFAULT and NONE.

� DEFAULT is based on an eye light type.

The DEFAULT lightstyle is stored separately from any lightstyles
you create and cannot be saved, deleted, or replaced.
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� NONE is not a light, but is the lightstyle automatically assigned to
all new objects; it cannot be modified.

By default, no objects in a document are light sources, and so
initially all have a lightstyle of NONE.

If you create an object for which you want to create a lightstyle, select
the DEFAULT lightstyle first and then modify it accordingly.

Lights work together with materials to enhance the appearance of
shaded images. For details about creating materials, see Chapter 11,
Working with materials.

If there are no lights assigned in a scene, MicroGDS automatically uses
the built-in simplified lighting in shaded views. Details about the
simplified lighting is given on page 266.
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In MicroGDS, lights can be based on the following types of light:

ambient illuminates all surfaces equally

distant emits parallel light as if from a very distant source, such as
the sun

eye emits light from the eye position equally in all directions

Note that an eye light and the DEFAULT light would look identical,
except that you can change the colour and intensity of an eye light.

If you are using MicroGDS Collaboration, many additional light types
are available. These are also used when you render the image. For
details, see Part Two: Advanced 3D and rendering.

Some examples of using different light types are shown next. Simple
materials have been added to the objects. The first example shows the
shaded image as it would appear using only the DEFAULT light. The
remaining illustrations show the same image, using each of the light
types in turn.
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If no user-defined lights exist in the model, MicroGDS lights the scene
using simplified lighting. You can also switch on simplified lighting if
you want to ignore any user-defined lights. For more details, see Using
simplified lighting on page 266.
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Ambient lights provide a general level of illumination. The position and
orientation of the object to which the light is assigned is not important,
because this type of light has no direction.

The colour of an ambient light tints the scene. You usually have only
one ambient light, but you may need to add additional lighting to create
a well-lit scene.
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A distant light emits parallel light rays coming from a single, distant
source. A distant light is appropriate as the main light source for sunlit
scenes.

The light is directed along the negative Z axis of the object to which the
light is assigned.

An example of how to create and place a distant light in a 3D scene is
given in the later section Lighting a scene—an example on page 267.
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An eye light creates a light source at the eye position and emits light
equally in all directions. The position and orientation of the object to
which an eye light is assigned does not affect the lighting.

The DEFAULT light is based on an eye light.
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For single-user documents, new lightstyles are stored in the document.
They are saved when you save the document.

You can also access linestyles from external style files (called
LIGHTS.STY). To do this, you specify the folders in which the
LIGHTS.STY files are located using the Style Search Path command on
the File menu. You can add more than one folder to the style search
path, but only one LIGHTS.STY file can be stored in each location. If
you modify and save a style from an external style file, it is saved in the
document. For more details about style files, see Chapter 2, Exploring
MicroGDS.

For multi-user projects in MicroGDS, all lightstyles are stored in
external style files (LIGHTS.STY). New lightstyles are saved in the
first LIGHTS.STY location on the style search path. A lightstyle is
saved in the style file as soon as you save the style, even if you do not
save the project.

You can access lightstyles available to a document from the Document
Organizer and also from the status toolbar.
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1 On the Document Organizer, click the Styles tab:
����������

2 Double-click the Lights category, or click the plus sign (+) to the
left.
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A list of all locations from where you can access lightstyles is
shown:

� for a single-user document, the name of the document with
which you are working is shown first, followed by the path of
each style file defined in the style search path if any

� for a multi-user project, the name of the first style file defined in
the style search path for the project is shown first, followed by
the path of each subsequent location defined in the project

If a LIGHTS.STY file exists in the location defined for styles and
fonts in your file location preferences, this location is shown last in
the list. This enables you to reference a set of global style files that
are available to all your documents. For more details, refer to Help.

3 To display a list of lightstyles in a location, double-click the location
or click the plus sign (+) to the left.

For example:

Lightstyles are prefixed by an flash light icon. The colour of the
beam determines the availability of the style:

� a yellow beam means that the lightstyle can be used in the
document

� a grey beam means that the lightstyle is not currently available to
the document

(A lightstyle is unavailable if a lightstyle of the same name
already exists in a location higher in the style search path.)

4 To preview a lightstyle definition, select the style and then, on the
shortcut menu, click Toggle Preview.
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� on the Light box on the status toolbar, click the arrow

All styles available to the current document are listed.
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You can add new lightstyles to make them available in your document.
When you add a lightstyle, it immediately becomes current and any
selected objects are assigned that lightstyle. Any new objects you create
are also assigned the current lightstyle.

Note that if you open a document in which there are missing lightstyles,
for example, if they have been deleted, MicroGDS reports the error
conditions to the Problems dialog box. You can use the dialog box to
correct the errors by:

� changing the styles and fonts folder

� editing the style search path

� adding new lightstyles
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1 Click the Styles tab on the Document Organizer, and then
double-click the Lights category.

2 Do one of the following:

� to create a new lightstyle based on DEFAULT, select the Lights
category and then, on the shortcut menu, click New

� to create a new lightstyle based on an existing style, select the
lightstyle on which to base the new style from the required
location and then, on the shortcut menu, click New based upon

The Lightstyle dialog box is displayed, showing the characteristics
of the current lightstyle.
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For example:

Note that the Display options are only applicable to light types
supported in MicroGDS Collaboration.

3 If you want to use or amend a lightstyle other than the current one,
select the style from the ‘Load dialog with’ list.

4 To create a new lightstyle, select the type of lightstyle to create from
the list: Ambient, Distant, or Eye.

5 If you want to change the intensity or colour of the light type, click
the attribute and modify the setting as required.

To reset any changed attributes to the defaults for the light type,
click Defaults.

For more details about lightstyle attributes, refer to Help.
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6 Save the lightstyle:

� to save the lightstyle with the existing name, as shown on the
title bar, click Save

� to save the lightstyle with a new name, click Save As, type the
name in the Style Name dialog box and click OK

The name must comply with the MicroGDS naming rules, as
described later in this section.

The named lightstyle is made current and its name is shown in the Light
box on the status toolbar.
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1 From the Light list on the status toolbar, select the lightstyle on
which you want to base your new lightstyle.

2 On the Styles menu, click Lightstyle Modify.

3 Specify the settings in the Lightstyle dialog box, as required.

4 Save the lightstyle as described in step 5 in the previous procedure.
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� a lightstyle name can contain up to 256 characters

� names can include spaces, except at the beginning or end of the
name

� lightstyle names are case sensitive, so ‘Red Eye’ and ‘red eye’ are
two different lightstyles

� you cannot save to the name DEFAULT or NONE
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When you add a lightstyle, it immediately becomes current. The name
of the current lightstyle is shown in the Light box on the status toolbar.

If you have selected several objects that have different lightstyles
assigned, the Light box is blank.

Note that each time you click a graphic for which a lightstyle is
assigned, the current lightstyle changes to that object’s lightstyle.



Chapter 11: Working with lightstyles 263

� 3��	����������	�

����#������-#�

1 Select any objects for which you want to change the lightstyle.

2 Do one of the following:

� from the Lightstyle list on the Properties window, select the
lightstyle

� from the Styles tab on the Document Organizer, select the
lightstyle you require, and then click Set as current on the
shortcut menu

� from the Light list on the status toolbar, select the lightstyle

� on the Set menu, click Lightstyle, type the name of the lightstyle
in the prompt bar and press Enter

The lightstyle name must match a lightstyle that you have
already added to the document.
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With the exception of DEFAULT and NONE, you can modify any
existing lightstyle that is available to the document.

If you are using MicroGDS Entry Level and you modify a lightstyle
that was created in MicroGDS Collaboration, the original lightstyle will
be overwritten if you save it using the same name. You may not be able
to re-create the lightstyle using MicroGDS Entry Level.

Note that you can only modify lights that are of types available to the
MicroGDS product you are using.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, locate the lightstyle that you want to modify.

3 Double-click the lightstyle name, or on the shortcut menu, click
Edit.

This command is unavailable for any lightstyle where a lightstyle of
the same name exists in a location higher in the style search path.

MicroGDS displays the Lightstyle dialog box.

4 Modify the characteristics as required.
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5 To save the lightstyle, do one of the following:

� to keep the same lightstyle name, click Save

If you retain the lightstyle name, all objects that use the
lightstyle are immediately updated.

� to save the lightstyle with a new name, click Save As, type the
name in the Style Name dialog box and click OK

If you modify a lightstyle from an external style file, MicroGDS
creates a new local lightstyle with the name you specify.

For more details about style files, see Chapter 2, Exploring
MicroGDS.

If you save a lightstyle to a name that exists in an external style file, the
icon for the external lightstyle changes colour in the Document
Organizer. This indicates that a local style of the same name now exists.
For more details, see Accessing lightstyles on page 258.
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1 From the Light list on the status toolbar, select the lightstyle to
modify.

Alternatively, select a primitive that uses the style you want to
modify.

2 On the Styles menu, click Lightstyle Modify.

3 Modify the lightstyle and then save the lightstyle, as described in
step 5 in the previous procedure.
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You can delete lightstyles that are no longer required. You cannot
retrieve deleted lightstyles.

If you select a graphic whose style has been deleted, the Light box on
the status toolbar is empty. You can see the name of the assigned
lightstyle in the InfoTip, if your have hover highlighting on the
Information bar switched on. You can also see the name in the
Properties window (Ctrl+Q).

If you later create another lightstyle with the same name as the deleted
lightstyle, it is used by the graphics to which the style was originally
assigned (if you have not assigned a different lightstyle in the
meantime).
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You cannot delete the DEFAULT or NONE lightstyle.

If you are using MicroGDS Entry Level and you delete a lightstyle that
was created using MicroGDS Collaboration, you may not be able to
re-create the light using MicroGDS Entry Level.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, select the lightstyle that you want to delete.

You can delete multiple lightstyles (or multiple styles of any type),
using Windows multi-select facilities.

3 Press Delete, or on the shortcut menu, click Delete.

4 To confirm the deletion, click Yes at the prompt.
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When you have added or changed a lightstyle, you can use one of the
shaded views to see the effects. There are two types of shaded view that
you can choose from: ‘Shaded’ and ‘Shaded with Edges’. The
difference is that Shaded shades clump faces and ignores the clump
edges, whereas Shade with Edges adds the clump edges.
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1 On the View menu, click Hide Mode.

2 On the Hide Mode submenu, click Shaded or Shade with Edges.

You can also press Ctrl+R to select Shaded view.

All 2D line primitives within the view extent are shown in the shaded
view, although the primitives themselves are not shaded. This includes
non-3D geometry such as construction lines, external light objects, and
so on. If you do not want non-3D graphics to be shown, ensure that
light objects are outside the view extent, and place all construction lines
onto a single layer and set that layer to Invisible.

When graphics are selected in a shaded view, they are drawn as a wire
frame.
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If the scene uses any advanced light types that are available only in
MicroGDS Collaboration, these are approximated for shaded views in
MicroGDS Entry Level. The number of lights used in MicroGDS Entry
Level are also limited according to the limits of the graphics card
(usually 6 or 8 lights). Advanced lights are used in MicroGDS
Collaboration when the window definition is rendered. For details, see
Part Two: Advanced 3D and rendering.

In MicroGDS Collaboration, the shaded views provide a method for
quick, fully interactive views, that can be useful prior to rendering the
image.
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When you view a scene in shaded view that has a large number of
lights, the scene might not be lit as expected. This is because only a
limited number of lights are processed and the ones that are processed
might not produce the best lighting effect. In such cases, you can use
the Simplify Lights option to ignore all lights in the scene and simplify
the lighting instead. This uses two predefined lights: a point light and a
distant light (which looks over the left shoulder of the camera).

In the following examples, the scene is first lit by the built-in lighting.
The same scene is then lit with a DEFAULT light assigned to the
ground plane:
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Note that if there are no lights in scene, MicroGDS automatically uses
the built-in simplified lighting in shaded views.
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� on the View menu, click Simplify Lights

You can change this setting for each view. To preserve the setting for
the current view, you must save the view and then save the document.
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This section shows you how to light a simple 3D scene using a distant
light.

The images below show the scene first using the default lighting and
then using a single distant light:
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1 Start MicroGDS and create a new document.

2 Set the scale to 1 and the units of measurement to mm.

3 Construct a circle:

a) On the Construct menu, click Circle, Radius Centre.

b) In the prompt bar, enter 50.

c) Place the circle at 0/0.

4 Extrude the circle to produce a cone:

a) On the Solid menu, click Construct, Extrude.

b) To taper the cone from the centre point of the circle, enter 0/0.
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c) Press Enter to display the Extrude Scaling dialog box and enter a
scale factor of 0 (zero).

d) To extrude the cone to a height of 65mm, enter //65.

The cone is tapered starting from the centre of the circle,
meeting at a point at the specified height.

5 Before you continue with the scene, save the document using a
name of your choice.

6 Create a new layer for the light object:

a) Press F2, or on the File menu, click Window, Edit.

b) Click the Layer tab and then click the New Layer & Phase
button.

c) In the Layer Name dialog box, enter a valid name for the layer
and click OK.

MicroGDS creates a new phase to reference the layer and adds it
to the phases list.

A bullet to the left of the phase means that the layer it references
is now current.

d) Click the Phase tab and then select a colour for the graphics from
the  Phase Colour list.

e) Minimize or move the Window Editor to one side.

7 Prepare the scene for lighting:

a) Draw a construction line using the line tool, for example:
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You will use the construction line when you place the light.
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b) On the Alter menu, click Vertex, Move.

c) Click on the end vertex (shown in the above illustration) of the
construction line.

d) In the prompt bar, enter //80.

8 Create a new object for the light object:

a) On the Object menu, click New.

b) Specify a valid name for the object and press Enter.

c) To specify the position for the object hook point, enter 0/0.

9 Draw the distant light object:

a) On the Construct menu, click Circle, Radius Centre.

b) Specify a radius of 10.

c) Place the circle at the object hook point by entering / in the
prompt bar, and then press Enter.

10 Switch to 3D view by clicking 3D on the View menu.

11 To position the light object:

a) On the Object menu, click Reposition.

b) Move the pointer to the centre of the circle, and when the Centre
snapcode is shown, click the mouse button.

c) Place the object at the end of the construction line, using an End
snap.

The prompt bar now requests that you set the position for the X
axis. However, since the light source of a distant light is directed
along the negative Z axis of the light object, you will specify the
–Z direction instead.

d) To position the –Z axis, press Shift+Tab.

Notice that the prompt bar now requests you for the position for
the –Z axis.

e) To direct the axis along the negative Z, use a Line snap
anywhere on the construction line.
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Although you may not see the entire axes in the view, the object
axes and the light object in a 3D view should look similar to this:

f) The direction of the X and Y axes is not important, so press Esc
to retain their current rotations.

g) To end the command, press Esc.

12 To view the scene using the default lighting, on the View menu,
click Hide Mode, Shaded.

13 Now create a lightstyle:

a) If necessary, click the light object to select it.

b) On the Styles menu, click Lightstyle Modify.

c) From the Light type list, select Distant and click Save As.

d) Type a name for the lightstyle and click OK.

e) To close the Lightstyle dialog box, click Close.

The shaded scene, now lit by the distant light, appears. For example:
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14 You can now hide the construction line, the light object, and the
axes:

a) Restore the Window Editor.

b) From the phases list in the Window Editor, select the phase that
references the layer you created earlier.

c) From the Linestyle Overrides list, select BLANK and then click
Close.

You can produce the same result by setting the Fading option,
which dims down graphics on a phase, to 0%.

d) On the Set menu, click Axes, Show.

e) To deselect all graphics, click in the window away from the
graphics.
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In MicroGDS, you can create materials to assign colours to the clumps
in a drawing. A clump is ‘made of’ a material, and can also have a
different material assigned to each face of the clump. For example, a
cube can be made of the material ‘red’, and have the material ‘blue
paint’ on some faces. Materials are used when you view graphics in a
3D shaded view.

For example:
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MicroGDS offers a number of commands for you to construct and work
with clumps, which are described in Chapter 9, Working in 3D.
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In MicroGDS Collaboration, materials are also used when you render
3D graphics. Additional, more sophisticated, materials are available in
MicroGDS Collaboration. For further details, see Part Two: Advanced
3D and rendering.

MicroGDS provides one pre-defined material called DEFAULT, which
is a plain matte white colour. If you have not added any materials to the
document, MicroGDS uses the DEFAULT material for all clumps when
you select the Shaded view.�You can add a material to the materials list
by modifying an existing material.

Note that the DEFAULT material is stored separately from any
materials you create and cannot be saved, deleted, or replaced.

Materials work together with lights to enhance the appearance of
shaded images. For details about creating lights, see Chapter 10,
Working with lightstyles.
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For single-user documents, new materials are stored in the document.
They are saved when you save the document.

You can also access materials from external style files (called
MATLS.STY). To do this, you specify the folders in which the
MATLS.STY files are located using the Style Search Path command on
the File menu. You can add more than one folder to the style search
path, but only one MATLS.STY file can be stored in each location. If
you modify and save a style from an external style file, it is saved in the
document. For more details about style files, see Chapter 2, Exploring
MicroGDS.

For multi-user projects in MicroGDS, all materials are stored in external
style files (MATLS.STY). New materials are saved in the first
MATLS.STY location on the style search path. A material is saved in
the style file as soon as you save the style, even if you do not save the
project.

You can access materials available to a document from the Document
Organizer and also from the status toolbar.
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1 On the Document Organizer, click the Styles tab:
����������

2 Double-click the Materials category, or click the plus sign (+) to the
left.

A list of all locations from where you can access materials is shown:

� for a single-user document, the name of the document with
which you are working is shown first, followed by the path of
each style file defined in the style search path if any

� for a multi-user project, the name of the first style file defined in
the style search path for the project is shown first, followed by
the path of each subsequent location defined in the project

If a MATLS.STY file exists in the location defined for styles and
fonts in your file location preferences, this location is shown last in
the list. This enables you to reference a set of global style files that
are available to all your documents. For more details, refer to Help.

3 To display a list of materials in a location, double-click the location
or click the plus sign (+) to the left.

For example:
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Materials are prefixed by an icon. The colour of the icon determines
the availability of the style:

� materials that can be used in the document are prefixed by a blue
icon

� materials that are not currently available to the document are
prefixed by a grey icon

(A material is unavailable if a material of the same name already
exists in a location higher in the style search path.)

4 To preview a material, select the style and then, on the shortcut
menu, click Toggle Preview.

If you are using MicroGDS Collaboration, the graphics in which the
preview is shown is set using the Preview list on the Material dialog
box. For more details, see Chapter 21, Advanced materials.
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� on the Mat box on the status toolbar, click the arrow

All styles available to the current document are listed.
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You can add new materials to make them available in your document.
When you add a material, it immediately becomes current and any
selected clumps are assigned that material. Any new clumps you create
are also assigned the current material.

Note that if you open a document in which there are missing materials,
for example, if they have been deleted, MicroGDS reports the error
conditions to the Problems dialog box. You can use the dialog box to
correct the errors by:

� changing the styles and fonts folder

� editing the style search path

� adding new materials
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1 Click the Styles tab on the Document Organizer, and then
double-click the Materials category.

2 Do one of the following:

� to create a new material based on DEFAULT, select the
Materials category and then, on the shortcut menu, click New.

� to create a new material based on an existing style, select the
material on which to base the new style from the required
location and then, on the shortcut menu, click New based upon.

MicroGDS displays the Material dialog box, showing the colour of
the material. For example:

If you are using MicroGDS Collaboration, the Material dialog box
provides facilities to create far more sophisticated materials. For
details about the materials in MicroGDS Collaboration, see
Chapter 21, Advanced materials in Part Two: Advanced 3D and
rendering.

3 If you want to use or amend a material other than the current one,
select the style from the ‘Load dialog with’ list.
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4 To define a colour for the material, click the Sample box.

MicroGDS displays the Define Colour dialog box:

5 Select or define the colour you require and click OK.

MicroGDS redisplays the Material dialog box.

6 Save the material:

� to save the material with the existing name, as shown on the title
bar, click Save

� to save the material with a new name, click Save As, type the
name in the Style Name dialog box and click OK

The name must comply with the MicroGDS naming rules, as
described later in this section. You cannot use the name DEFAULT.

The named material is made current and its name is shown in the Mat
box on the status toolbar.
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1 From the Mat list on the status toolbar, select the material on which
you want to base your new material.

2 On the Styles menu, click Material Modify.

3 Specify the colour for the material and then save the material, as
described in step 5 in the previous procedure.
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� a material name can contain up to 256 characters

� names can include spaces, except at the beginning or end of the
name

� material names are case sensitive, so ‘Blue Tint’ and ‘BLUE TINT’
are two different materials

� you cannot save to the name DEFAULT



Chapter 11: Working with materials 279

�������������&���
��#
When you add a material, it immediately becomes current. To use
another material, you select it from those available with the document.
When you change the material, you can:

� change the current material

� change the material of all clumps using a specific material

� override the material of all clumps for a particular phase

In addition, MicroGDS enables you to ‘paint’ the faces of a 3D graphic
in a different material from the solid material. This is similar to a veneer
on a piece of chipboard. For details, see Setting the face material on
page 282.
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The current material is assigned to new clumps that you create. The
name of the current material is shown in the Mat box on the status
toolbar.

When you draw a new primitive, or when you have only 2D graphics
selected, the Mat box is blank. This is because materials only apply to
clumps. In addition, if you have selected several clumps that have
different materials assigned, the Mat box is blank.

Note that each time you click a clump, the current material changes to
that clump’s material.

When you change the current material, any selected graphics are also
changed to that material.
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1 Select any clumps for which you want to change the material.

2 Do one of the following:

� from the Matstyle list on the Properties window, select the
material

� from the Styles tab on the Document Organizer, select the
material you require, and then click Set as current on the shortcut
menu



280 Using MicroGDS 11

� from the Mat list on the status toolbar, select the new material

� or on the Set menu, click Material, type the name of the material
in the prompt bar, and press Enter

The material name must match a material that you have already
added to the document.

If any selected clumps have face materials assigned, the face
materials are not overridden by the new material. For more details,
see Setting the face material on page 282.

You can also change the current material so that it is the same as the
material used for a specified face. You may want to do this, for
example, if you do not know the name of the material.
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1 On the Solid menu, click Material, Select From Face.

2 Click the face whose material you want to use.

The current material is immediately updated. Its name is displayed
in the Mat box on the status toolbar.

If you click a face that does not have a set face material, the current
material is set to DEFAULT.

3 When you have selected the material you require, press Esc.
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MicroGDS makes it very easy to change the solid material of a number
of clumps drawn using one material to another material. You simply
restrict editing to a specific material.

This does not change any material assigned to clump faces.
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1 Press F3, or on the Set menu, click Edit.

You can also use the SETEDIT button on the information bar (at the
bottom-right of the MicroGDS window) to set restrictions:

� if SETEDIT is not currently enabled, click the button

If SETEDIT is enabled, a single click of the button toggles the
current editing restrictions on and off

� if SETEDIT is currently enabled, double-click the button

The Set Edit Filter Editor is displayed.
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2 From the Material list, select the material to which you wish to
restrict editing.

Alternatively, click the Material Pick button and click a clump
primitive to which the style is assigned.

3 Click Close.

When you have set up your restrictions, the SETEDIT button on the
information bar is pressed in and the text changes colour. You can
toggle the editing restrictions on and off by clicking the SETEDIT
button.

4 Ensure that you are in Select Primitives mode by pressing F9, or on
the Edit menu, click Select Primitives.

5 In your graphics window, select the relevant clumps; the status
toolbar shows you the number of primitives selected and that they
all use the same material.

You cannot select any clumps that do not use the specified material.

To select all clumps that use the material, press F7, or on the Edit
menu, click Select All.

6 Select the replacement material as described in Changing the
current material on page 279.
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Remember to clear the editing restriction when you have changed the
material.
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Usually, you assign materials to individual clumps. This means that a
phase can show clumps in many different materials. You can, however,
force all clumps within one phase to be displayed and printed in a single
material.
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1 Press F2, or on the File menu, click Window, Edit.

2 From the phases list in the Window Editor, select the phase whose
materials you want to override.

3 From the Material Overrides list on the Phase tab, select the material
you wish the clumps in the phase to use.

All clumps within the selected phase are now drawn using the
chosen material. Note that although they appear on screen and print
using the material override, their original materials are unchanged
and still appear in the Mat box on the status toolbar.

You can also see the name of the material assigned to a clump in the
InfoTip, if you have hover highlighting on the Information bar
switched on. For details about hover highlighting, see Chapter 3,
Working with primitives and objects.

If you later remove the override, the clumps are drawn using their
original assigned styles.

You would probably use this feature as a temporary override. To change
the material permanently, you would make the phase the only phase
editable, then select all the graphics, and change the material.
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You can apply additional materials to the faces of a clump. This does
not change the material that the clump is ‘made of’ (the solid material).

The example shaded images shown next show a clump that uses the
DEFAULT material, and the same clump for which different,
customized materials have been assigned to individual faces:
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Note that the material assigned to the clump is shown in the Properties
window. To open the Properties window, press Ctrl+Q, or on the
Window menu, click Properties.

The face material is also shown in an InfoTip, if you have hover
highlighting on the Information bar switched on.

You can also check the material of a face using the Select From Face
command described in Changing the current material on page 279.

MicroGDS provides a number of face commands to:

� set a face material for all faces

� set a face material for a single face or surface

A surface is a region of a clump that is connected to a face by
smooth edges and which share the same material.

� apply the solid material to all faces of a clump that do not have a
face material

� apply a face material to the solid material and remove that face
material from any face to which it is assigned
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1 Select the clumps to which you want to add face materials.

2 On the Solid menu, click Material, All Faces.

3 In the prompt bar, type the name of the material and press Enter.

To return the faces of clumps to their respective solid materials, type
DEFAULT in the prompt bar.

The graphics are immediately updated. The current material is also
updated to the material you specified.
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1 On the Solid menu, click Material, Per Face or Per Surface.

2 Select the name of the material to which you want to set the first
face.

You can select the material from the Mat list on the status toolbar, or
from the Styles tab on the Document Organizer.

To return the face of a clump to its solid material, select DEFAULT.

3 Specify a position on the face for which you want to set the material.

You can also change the material for individual faces using the
Properties window:

1 Click on the Properties window.

2 Click the clump face whose material you want to change.

3 Click the ‘Face material’ line in the Properties window, and select
the material you require from the list.

For more details about using the Properties window, see Chapter 13,
Getting information.
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1 On the Solid menu, click Material, Solid to Faces.

2 Specify a position on the clump for which you want to assign the
solid material to all faces that do not have a face material.

All default faces of the clump are assigned the solid material of the
clump.
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1 On the Solid menu, click Material, Faces to Solid.

2 Specify a position on the clump face whose material you wan to
promote to solid.

The solid material is replaced by the face material. All faces that
were assigned the picked face material are set to none. Note that
faces that have a different face material to the one you pick are not
overridden.
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With the exception of DEFAULT, you can modify any existing material
that is available to the document.

If you are using MicroGDS Entry Level, and you modify a material that
was created in MicroGDS Collaboration, the original material will be
overwritten if you save it using the same name. You may not be able to
re-create the material using MicroGDS Entry Level.
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1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, locate the material that you want to modify.

3 Double-click the material name, or on the shortcut menu, click Edit.

This command is unavailable for any material where a material of
the same name exists in a location higher in the style search path.

MicroGDS displays the Material dialog box.

4 Modify the characteristics as required.

5 To save the material, do one of the following:

� to keep the same material name, click Save

If you retain the material name, all clumps that use the material
are immediately updated.

� to save the material with a new name, click Save As, type the
name in the Style Name dialog box and click OK

If you modify a material from an external style file, MicroGDS
creates a new local material with the name you specify.

For more details about style files, see Chapter 2, Exploring
MicroGDS.

If you save a material to a name that exists in an external style file, the
icon for the external material changes colour in the Document
Organizer. This indicates that a local style of the same name now exists.
For more details, see Accessing materials on page 274.
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1 From the Mat list on the status toolbar, select the material to modify.

Alternatively, select a clump that uses the style you want to modify.

2 On the Styles menu, click Material Modify.

3 Modify the material and then save the material, as described in
step 5 in the previous procedure.
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You can delete materials that are no longer required. You cannot
retrieve deleted materials.

If you select a clump whose style has been deleted, the Mat box on the
status toolbar is empty. You can see the name of the assigned material in
the InfoTip, if you have hover highlighting on the Information bar
switched on. You can also see the name in the Properties window
(Ctrl+Q).

If you later create another material with the same name as the deleted
material, it is used by the clumps to which the style was originally
assigned (if you have not assigned a different material in the meantime).

You cannot delete the DEFAULT material.

If you are using MicroGDS Entry Level and you delete a material that
was created using MicroGDS Collaboration, you may not be able to
re-create the material using MicroGDS Entry Level.
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��#

1 In the Document Organizer, ensure that the appropriate document is
the current document.

2 On the Styles tab, select the material that you want to delete.

You can delete multiple materials (or multiple styles of any type),
using Windows multi-select facilities.

3 Press Delete, or on the shortcut menu, click Delete.

4 To confirm the deletion, click Yes at the prompt.
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When you have added or modified a material, you can use one of the
shaded views to see the effects.
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1 On the View menu, click Hide Mode.

2 On the Hide Mode submenu, click Shaded or Shade with Edges.

You can also press Ctrl+R to select Shaded view.

MicroGDS Entry Level does not take into account many of the more
sophisticated material attributes that may have been used to create
materials in MicroGDS Collaboration. The full attributes of all
materials are used only in MicroGDS Collaboration when a window
definition is rendered. For details, see Part Two: Advanced 3D and
rendering.

In MicroGDS Collaboration, the shaded views provide a method for
quick, fully interactive views, that may be useful prior to rendering the
image.
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You can print a MicroGDS drawing using any printer or plotter that has
a Microsoft Windows printer driver and that can generate graphical
output.

If you are using MicroGDS Collaboration, you can also print a rendered
image using a printer or plotter that has a Windows printer driver. For
details, see Part Two: Advanced 3D and rendering.

Note that plotting and printing are referred to as printing for simplicity.

In MicroGDS you can print a single view or batch print multiple views.
The commands and print options differ according to the number of
views you are printing.
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Before you print a MicroGDS drawing, your printer must already be
installed and working in Windows. For information about this
procedure, refer to the documentation for Windows, your printer, and (if
applicable) your networking software.

If you are using a printer for the first time, you may need to set up
default printer settings before you print a drawing.
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1 On the File menu, click Printer Setup.

2 From the Print Setup dialog box, select the printer you wish to use
and specify its default settings.

3 Click OK.

When you print a 2D or 3D view, MicroGDS prints exactly what is
visible in the current view. If you want to print all the graphics in a
window, ensure that they are completely in view.

When you print a print layout view, MicroGDS always prints the entire
print layout view using the paper size assigned to the window
definition. For details about assigning a paper size, see Chapter 2,
Exploring MicroGDS.

You can specifically exclude graphics in a phase from being printed
from the Window Editor. For example, you may want to view the
graphics of an overall site plan on your screen, but want to print only
the graphics referenced in a specific phase. For details about marking a
phase for screen display only, see Chapter 4, Using layers and phases.

Note that raster images are not printed in shaded or hidden line 3D
views. For details about constructing raster primitives, see Chapter 15,
Working with different file formats.
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1 Ensure that the window displays the view type that you want to
print.

2 On the File menu, click Print.

The Print dialog box is displayed. For example:

If necessary, click the More button (which shows Less when the
dialog box is expanded) to see all the options in the dialog box.

3 Select the options you want.

� to use a different printer, select the printer from the Name list

� to change the page setup, fonts, orientation, or the document
settings, click Properties to display the standard Windows
Document properties dialog box

Note that the properties available depend on the selected printer.
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� to print to a file, select the ‘Print to file’ check box

The Print File dialog box is displayed when you click OK.
Specify the name and location of the file that will store the view
and click OK.

� to view details about the current printer, click the Information

button

� to change the current paper, select from the Paper list:

— for a print layout view, the paper size defined for the print
layout is automatically selected

If the defined paper size is not available on the current printer,
MicroGDS selects the nearest-matching paper size.

— for a 2D or 3D view, the printer’s default paper size is used

� to change the current Scale or Enlargement, type or select the
factor you require

— for a 2D or 3D view, MicroGDS calculates the scale to fit
the view onto a single sheet of the selected paper

— for a print layout view, a print scale of 1 is selected

The paper size and orientation are set from the paper defined for
the window definition.

Note that if you do not print at a factor of 1, any scale factors on
your drawing (such as 1:1250) will be incorrect. For more
details, see Scaling and sizing on page 295.

� to fit the graphics onto a single sheet of paper, click the Fit
button

� to adjust the extent of the region to be printed so that it exactly
fills the paper, to the printable area, select the Fill page check
box

This option is not available with a print layout view. To change
the region to be printed in print layout, use the Page Setup
command.

When Fill page is selected, the Fit button is not available.

� to print in black and white, select the ‘Black and white’ check
box

Note that MicroGDS sets the initial state of this check box to
match the Black and White when Printed command on the View
menu.
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� to increase the line thickness for unthickened lines, select the
number in pixels (between 1 and 100) from the ‘Pen width for
unthickened lines’ list

4 Use the tabs in the lower part of the Print dialog box to make further
changes:

� to change the margins and alignment of the view on the printed
paper for 2D and 3D views, use the settings on the Layout tab

The Layout tab is not available for a print layout view.

� to choose which pages to print if the scale and region to be
printed will not fit on a single sheet of paper, use the settings on
the Pages tab

You can also change the number of copies to print using the
Pages tab.

� to choose whether to rasterize the drawing before it is printed or
to draw cut-marks on the printed page, use the settings on the
Processing tab

You might rasterize a drawing if you are using a printer that does
not support transparency.

For some settings, you can choose to retain the value by clicking the

appropriate padlock button 

5 On the Print dialog box, click OK.

The view is sent to the printer, plotter, or to the file specified.
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1 On the File menu, click Batch Print.

The Batch Print dialog box is displayed.

2 On the Window Definitions tab of the Document Organizer, select
the views you want to print and then drag them into the ‘Views to
print’ box on the Batch Print dialog box.

The selected views are listed on the left of the dialog box.
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For example:

You can add to the list by dragging views from the Document
Organizer. The views can be in the same document or in different
documents.

You can also remove views and change the order in which the views
are printed using the buttons at the top of the dialog box.

3 Select the printing options you want.

Many options are the same as described for printing a single view in

the previous section. Additional options include:

� Print as multiple jobs: to send one print job per view to the

printer, select this check box. To send all views to the printer as a

single print job, clear the check box.
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� Collate: To order multiple copies of multiple views into their
proper sequence, select this check box. To print multiple copies
in successions equal to the number of copies specified, clear the
check box.

� Colour handling: Select the method by which to print the
graphics. To use the colour defined in the view, select ‘From
view’. Note that raster images are always printed in colour (on a
colour printer).

� From view/drawing: To override the selected paper size and use
the paper size set within the view or document, select this check
box. To print all views using the selected paper size, clear the
check box.

� Autorotate: To automatically adjust the orientation of mixed
landscape and portrait views, select this check box. To print all
views using the currently selected orientation, clear the check
box.

The remaining options depend on the view type, that is, 2D and
Parallel views, Perspective Views, and Print Layout Views. Again,
these options are the same as described for printing single views in
the previous section. For full details, refer to Help.

4 On the Batch Print dialog box, click OK.

The views are sent to the printer, plotter, or to the file specified.

You can use the buttons at the bottom of the dialog box to save and load
a set of views to a text file and also save and load a set of printing
parameters.
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The print dialog boxes enables you to control the scale or size at which
the current drawing is printed.

If you set the Scale or Enlargement to 1, you will get a print-out at the
scale (or scales) at which you drew.

If you set the Scale or Enlargement to any other value, your print-out is
reduced or enlarged accordingly. You should take this into account if
you will be taking dimensions from this print.

Note that if you choose Fit on the Print dialog box, the drawing is
printed as large as possible to fill the sheet, without regard to scale. This
option is not available on the Batch Print dialog box.
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When you print colour drawings using a Windows printer, the output
relies upon the capability of the printer.

A colour printer will get as close as it can to the on-screen colour. A
monochrome printer will approximate colours using a sequence of
shades ranging from black through to white. This may give you an
unclear print, unless you select the ‘Black and white’ check box on the
print dialog box.

Where a raster image contains overlapping coloured areas which use
transparency, we recommend that you select the GDI+ optimization
option on the Raster tab in your preferences. This should help improve
the appearance of the printed page. For details about setting
preferences, see Chapter 17, Customizing MicroGDS.

If your printer does not support transparency, you can rasterize the
drawing before it is printed by enabling the rasterize option on the print
dialog box. This will ensure that the printed drawing will match the
on-screen drawing. It may also help avoid other possible print driver
problems.
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When you print a drawing, you should be aware of the following
considerations regarding the linestyles and charstyles.

� Many linestyle parameters are defined by specifying a distance. The
values you give are real-world values. However, these values are
potentially subject to scaling, rotation, and positioning. To control
how linestyles are displayed on screen, and how they are printed,
MicroGDS uses co-ordinate space.

There are four co-ordinate space settings: Object space, Drawing
space, Output space, and Version 6 space.

Use object space, for example, if you want to move, rotate, and scale
the line primitives along with their object. Use Output space, for
example, if you want to fix the size of the line primitives, both on
screen and when printed. For more details about the co-ordinate
space settings, refer to Help.
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Note that, in a print layout view, output space linestyles are drawn
so that they are a scaled version of what will appear on the paper.
For example, if you select A1 paper size then a 10mm dash in an
output space linestyle will print 10mm long on the paper. If you
print to A2 paper size with an enlargement factor of 0.5, then each
dash of the 10mm linestyle will print at 5mm long.

� When you specify a size for a charstyle, the value you give is a
real-world value, and, when printed, the text always appears at this
size. This is always the case, no matter what the set scale is when
the text was created, nor at what scale the drawing is printed (unless
you use the Enlargement option on the print dialog box, which
enlarges everything).

� Not all printers can produce masks, or opaque and transparent filled
linestyles. You should refer to your printer’s documentation before
making use of these facilities.

For details about creating and modifying linestyles and charstyles, see
 Chapter 7, Working with linestyles and Chapter 8, Working with text
respectively.
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MicroGDS provides a number of facilities to help you keep track of the
status of your documents and their contents. These enable you to:

� view properties about the selected graphics

� query a graphic at a specific position

� measure primitives and objects, and count the objects on a layer

� track commands and prompts during the current session

� write a list of all objects in the current window, and their
occurrences

� record details about objects in the current window

In addition, you can assign non-graphical information (called attributes)
to primitives and objects. For details about attributes, see Chapter 14,
Working with attributes and schemas.

This chapter summarizes the ways you can assign and view
information. Full details are given in Help.
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A particularly useful facility for viewing information is the Properties
window. You use the Properties window to view extensive details about
the selected primitives or objects. You can also change the values of
many properties that are displayed.

For example, you can view the colour and linestyle of a line primitive,
the name of the object in which the primitive is stored, and the name of
the layer on which the object resides. You can also view attributes
assigned at each level.

In addition, you can switch to query mode to view details about any
specific position of a graphic. For example, you can query the face of a
material or the length of a line.
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1 Press Ctrl+Q, or on the Window menu, click Properties.

2 Select the items whose properties you want to view.

The properties are shown for the currently selected items. For
example:

Note that link numbers are shown only if you have ‘Show Advanced
properties’ selected in your preferences.
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The buttons at the top of the Properties window enable you to view
and select the data in the window in different ways.

You can change the value for any property that is not read-only.
Read-only values are indicated by a grey background.

3 To update the window with details about a new selection, select the
items.

If you select multiple items, any property for which different values are
assigned show «Mixed». For example, mixed is shown if you select two
line primitives which are assigned different linestyles. Note that if you
change a mixed value, the new value is assigned to all selected graphics
to which the property applies.

If the selection includes graphics of different types, any property that is
not common to all the selection is shown in italic. For example, if you
select a line primitive and a text primitive, only colour is the common
property so all other properties are shown in italic. Furthermore, if any
property is the same for all graphics of the same type, that property is
shown in italic. For example, if the selection includes multiple text
primitives which are assigned the same charstyle, the charstyle is shown
in italic.

You can also use the Properties window to assign a document label for
information. This can be used, for example, as a reminder about the
status of a document. Note that you must be in Details display to see the
document label:
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Note that if you are working with a multi-user project, you can add a
project label and a workspace label.

You can copy the information from the Properties window to the
Clipboard. You might do this, for example, to paste some of the
information into another Windows program.
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You can query any primitive that has an editing status of hittable or
editable that you hit. Details about the item are shown in the Properties
window.

You can initiate query mode directly from the Properties window or
using the Query, Details command.
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1 Do one of the following:

� on the Properties window, click 

� on the Query menu, click Details

The mouse pointer changes to 

2 Click the graphic at the position you want to query.

The details are loaded into the last selected view of the Properties
window. You can change the view using the three view buttons at
the top of the window.

By default, the graphic is queried at primitive level. To query the
graphic at object level, press Shift when you click the graphic.

3 When you have finished querying graphics, click  or press Esc.

For full details about viewing and changing properties, refer to
MicroGDS Help.
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The Query menu provides commands for measuring graphics. For
example, you can measure:

� the angle between two lines

� the area enclosed by a primitive or object

� the distance between two points

If the Query dialogues check box is selected in your preferences, a
Query Measurements dialog box is displayed when you measure
graphics. For example, when you measure a path of a graphic, the
following dialog box is displayed:
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You can use the Copy button on the dialog box to copy the displayed
measurement. You can then paste the information as plain text (for
example, using Edit Paste) or, for some measure commands, as linked
data (for example, using Edit Paste Special) in MicroGDS or in another
Windows program.

The measurement is also displayed in the Dialogue window (described
next), if you have it open.

The measurement is displayed in the set units, regardless of the units
used to draw the item. When you measure graphics, if the scale is
important, such as when you measure the area of a graphic, MicroGDS
displays the area in the object scale and the current set scale.

For details about using the query commands, refer to Help.
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To track the commands you have chosen in the current session, with
their prompts, use the Dialogue window.

You may find it useful to have the Dialogue window displayed while
you are learning how to use MicroGDS, until you are familiar with the
commands.
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� press Ctrl+D, or on the Window menu, click Dialogue

The Dialogue window is displayed showing information about the
session. For example:

�
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MicroGDS can scan a window definition and produce a list of all the
objects and the number of times they occur in each phase in the
window. The list is written to a text file called list.txt, in the Text files
folder specified in your preferences. If you have not specified a Text
files folder, the text file is created in the folder in which MicroGDS is
installed.
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1 Ensure that the status of each phase you want scanned is either
editable, hittable, or visible.

MicroGDS does not scan phases that are invisible.

2 On the Object menu, click List.

MicroGDS generates the text file and displays it in a Notepad
window:
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The first line in the text file shows the window definition name in
the MicroGDS document. The remainder shows details about:
� the phase number, together with its editing status, colour,

modification status, and the name of the layer to which the phase
is linked

� the name of each object included in the phase, and the number of
objects with that name

�
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The Object Schedule facility creates a report on objects in the current
window.

Before you create a report, you must create a format file (with an
extension of .FRM) to determine the data and layout of the information.
How to create a format file is described below.

MicroGDS writes the report to a text file in the Text files folder
specified in your preferences. If you have not specified a Text files
folder, the text file is created in the folder in which MicroGDS is
installed. The name of the file is the same as the format file with a .txt
extension. Each time you create a report, the previous report file is
overwritten. Therefore, if you want to keep a report, rename the file
before you create a new report.
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1 On the Object menu, click Format.

The Open dialog box is displayed for you to locate the format
definition file to load.

If you have not yet created an appropriate file, see the following
subsection for details.

2 Select the format definition file you want to use, and click OK.

3 On the Object menu, click Schedule.

If you have any objects selected in the window, a dialog box is
displayed in which you can choose whether to schedule only the
selected objects or to schedule all objects in the window. Select the
option you require.

MicroGDS generates the report and displays it in a Notepad
window:
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The format definition file determines what the report produced by the
Object Schedule facility looks like. The report is in the form of a table,
with each row displaying details of a different object.

You create a format definition file with a text editor, such as Windows
Notepad. To enable MicroGDS to locate the file, save it with a .frm
extension.
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The following is an example of a format definition file.

Most rows start with the word ‘column’ followed by a range of column
numbers allocated to the information. For example:

column 1 12 NAME

means allocate columns 1 to 12 (in the report) for the information
specified by the following keyword. In this case, NAME, which prints
the object name.

For a list of available keywords, refer to Help.
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Attributes are non-graphical information that you assign to graphics in
MicroGDS. There are three types of attributes:

� local attributes that you assign to primitives, objects, and layers

For example, if you were refurbishing an office, you could assign
attributes to provide information about the office workstations, such
as their colour, cost, design, and the name of the supplier.

� computed attributes that are retrieved by performing calculations

For example, if you were refurbishing an office, you could calculate
the area of a room to determine the floor space to be carpeted.

� external attributes that are retrieved from an external database

For example, if you were refurbishing an office, you could retrieve
employees names and telephone numbers from an SQL database and
assign them to the workstations.
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Using attributes is similar to using a database—you can extract the
information to produce parts lists, costings, reports, and so on. You can
export the information for use in other Windows applications; for
example, into word processors, spreadsheets, or databases.

Before you can use attributes, you must define the type of value that the
attribute will store. You do this by creating a mnemonic. You create a
mnemonic for each type of attribute you want to use. For example, you
might define a text mnemonic for ‘colour’ and a numeric mnemonic for
‘cost’. Then, every time you add an attribute that specifies the colour of
an item, you would use the colour mnemonic, and so on.

When you create a mnemonic, you also specify at which level the
mnemonic is to apply. You can create mnemonics at primitive,
reference, object, window, and layer level.

Some types of mnemonic can store multiple values. Where this is
applicable, you specify the maximum number of values that can be
assigned to an attribute. For example, for an attribute that defines
dimensions for height, width, and depth, you would specify three as the
maximum number of values in the mnemonic.

When you have created the mnemonics, you then indicate which objects
and layers the specified mnemonics are to be used with. You do this by
creating a schema. For example, a schema might specify that the
mnemonics Name and Height are for use with all objects named ‘Tree:’
and ‘Building:’, and that the mnemonic ‘Tree category’ is for use only
with ‘Tree:’ objects.

When you select a primitive or object to which a schema applies, the
specified mnemonics are shown in the Properties window. You can then
assign the appropriate values to the mnemonics.

Although you usually use a schema to associate mnemonics with
graphics, you can also manually add an attribute to any primitive,
object, window, or layer. You might do this, for example, where an
attribute is meaningful to only a limited number of items. For more
details, see Adding new attributes on page 322.
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For single-user documents, new mnemonics and schemas are stored in
the MAN file. They are saved when you save the document.

You can also access the mnemonics and schemas from external style
files (called ATTRS.STY and SCHEMAS.STY respectively). To do
this, you specify the folders in which the style files are located using the
Style Search Path command on the File menu. You can add more than
one folder to the style search path, but only one style file of each type
can be stored in each location. If you modify and save a style from an
external style file, it is saved in the document. For more details about
style files, see Chapter 2, Exploring MicroGDS.

For multi-user projects, all mnemonics and schemas are stored in
external style files. New mnemonics are saved in the first location on
the style search path.

You can also specify styles that you want to be available to all
documents, by placing global style files in the location for styles and
fonts in your file location preferences. By default, MicroGDS provides
an ATTRS.STY file which is installed into the MicroGDS Fonts
directory. This contains a number of useful computed attributes.
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1 On the Document Organizer, click the Styles tab:
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2 Double-click the Mnemonics or Schemas category, or click the plus
sign (+) to the left.

A list of all locations from where you can access the corresponding
styles is shown:

� for a single-user document, the name of the document with
which you are working is shown first, followed by the path of
each style file defined in the style search path if any

� for a multi-user project, the name of the first style file defined in
the style search path for the project is shown first, followed by
the path of each subsequent location defined in the project
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If an ATTRS.STY or SCHEMAS.STY exists in the location defined
for styles and fonts in your file location preferences, this location is
shown last in the list.

3 To display a list of styles in a location, double-click the location or
click the plus sign (+) to the left.

For example:

Mnemonic and schema styles are prefixed by an icon. The colour of
the icon determines the availability of the style:

� styles that can be used in the document are prefixed by a red icon

� styles that are not currently available to the document are
prefixed by a grey icon

(A style is unavailable if a style of the same name already exists
in a location higher in the style search path.)

For mnemonics, the icon also denotes the level of applicability:

W for window level
L for layer level
O for object level
R for reference level
P for primitive level

Mnemonic applicabilities is described in the next section.

4 To preview a mnemonic or schema, select the style and then, on the
shortcut menu, click Toggle Preview.

You can also access mnemonics and schemas using commands on the
Styles menu. For details, refer to Help.
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You can add new mnemonics to make them available in your document.
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1 Click the Styles tab on the Document Organizer, and then
double-click the Mnemonics category.

2 Do one of the following:

� to create a new mnemonic, select the Mnemonics category and
then, on the shortcut menu, click New

� to create a new mnemonic based on an existing style, select the
mnemonic on which to base the new style from the required
location and then, on the shortcut menu, click New based upon

MicroGDS displays the Mnemonic Definition dialog box.

For example:

3 Under Mnemonic, select the appropriate Applicability level:

� Window: enables you to assign the mnemonic to window
definitions

� Layer: enables you to assign the mnemonic to layers

� Object: enables you to assign the mnemonic to all objects of the
same name

� Reference: enables you to assign the mnemonic to a specified
object only

� Primitive: enables you to assign the mnemonic to primitives
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4 In the Name box, type the mnemonic name.

The name must comply with the MicroGDS naming rules, as
described on page 318.

You can use the same mnemonic name for different Applicability
levels.

You can define hidden attributes by typing an asterisk (*) as the first
character of the name. Hidden attributes are usually used only by
people writing customization programs.

5 If you are defining a reference or object-level mnemonic, you can
choose whether or not the attribute should be automatically copied if
any object to which it is assigned is copied.

Select the ‘Attribute copied with object’ check box to automatically
copy the attribute with the object. Otherwise, clear this check box.

Note that layer-level and primitive-level applicability attributes are
always copied with the copied graphics.

6 From the Storage options, select the location for the attributes:

� Local to store attributes in the document

You assign attributes to local mnemonics using the Properties
window. For details, see Assigning attribute values on page 319.

� External to use data stored in a linked external database

To access the data in an external database, you must first set up a
link to the database. You can then create External mnemonics
with which to query the database. You can also define a link to
an Excel spreadsheet, to access its data.

MicroGDS can read data in an external database, but does not
allow you to write to the database.

For details about linking and querying external databases, refer
to Help.

� Computed to use data stored about the graphics in the document

You do not assign attributes to a computed mnemonic, the value
is the result of a calculation.

7 From the Type list, select the attribute value type.

For Local mnemonics, select from:
� Text: free text of a specified amount
� Enumeration: a chosen word from a pre-defined word list
� Double: a double-precision floating-point number
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� Single: a single-precision floating-point number
� Integer: a whole number within a specified range
� Length, Area, and Volume: a measurement in the specified

drawing units
� Date: a date and time in a specified format
� URL: a uniform resource locator or a file name

For External mnemonics, the list contains a subset of those shown
above. For Computed mnemonics, the list contains mnemonic for
making calculations, for example to calculate the area of an object
or the length of a primitive.

Full details on how to creating different types of mnemonics is
given in Help.

8 Complete the definition of the mnemonic by entering the
appropriate details in the remainder of the dialog box.

9 If you want to add a description of the mnemonic, type it in the
Prompt box.

This prompt is shown when you enter the attribute value. It is used
as a reminder of the type of data to enter.

10 Click Save.

You can modify and delete mnemonics using the Document Organizer.
You can also create and modify mnemonics using the Mnemonic
Definition command on the Styles menu. For full details, refer to Help.

Note that you cannot change the applicability, storage, or type of a
saved mnemonic.

�
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You can add new schemas to define which mnemonics will be shown
for selected primitives and objects in the Properties window.
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1 Click the Styles tab on the Document Organizer, and then
double-click the Schemas category.

2 Do one of the following:

� to create a new schema, select the Schemas category and then,
on the shortcut menu, click New
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� to create a new schema based on an existing schema style, select
the schema on which to base the new style from the required
location and then, on the shortcut menu, click New based upon

The Define Schema dialog box is displayed, showing the
characteristics of the current schema if any. For example:

Note that the Behaviour box is for defining the behaviour of
intelligent objects. For more details, please refer to Help.

3 If you want to use or amend a schema other than the current one,
select the style from the ‘Load dialog with’ list.
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4 From the Type list, select the restriction type to which the schema
applies:

� Layer: applies the schema to the specified layers

� Object: applies the schema to the specified objects, on the
specified layers

� Window: applies the schema to the specified windows

If you are creating a schema that is based on an existing schema
style, you can change the type only if the current rules or
mnemonics are compatible. You may need to first edit the rules or
mnemonics saved in the schema.

5 Under ‘Applies to’, click Add and use the Schema Rule dialog box
to specify the layers and objects to which the rules of the schema
should apply.

You can use wildcards to set the filters for graphics. For details
about wildcards, see Chapter 3, Working with primitives and objects.

For example, to apply a schema to all objects with the last facet
‘chair’ on any layer whose name begins with ‘Furniture’, you would
set up the schema rule as:

Note that the Object filter is available only when the schema type is
Object.

6 Under Mnemonic, click Add and select the mnemonics that are to be
available to the graphics to which the schema applies, using the
Schema Mnemonic dialog box.

The order in which the mnemonics are listed defines the order in
which the attributes are displayed in the Properties window. You can
use the Up and Down arrow buttons to change the order.

7 If you want to assign any default values to the mnemonics, click the
attribute then do one of the following:

� type the value in the box

� click  and select the value from the list
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� click  to display an Edit Property Value dialog box in which
to enter the attribute value

For more details on assigning attribute values, see page 321.

Note that any default attribute values become active on the
Properties window only when you select the schema from the
Objectstyle list on the Properties window. If you do not select a
schema, all values default to «None».

8 To save the schema definition, click Save As and type the schema
name.

The name must comply with the MicroGDS naming rules as
described next.

You can modify and delete schemas using the Document Organizer. You
can also create and modify schemas using the Schema Definition
command on the Styles menu. For full details, refer to Help.
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Rules for naming mnemonics and schemas are:

� a mnemonic or schema name can contain up to 255 characters

� names can include spaces, except at the beginning or end of the
name

� names are case sensitive, so ‘Materials Used’ and ‘materials used’
are two different definitions

Note that the mnemonics and schemas supplied by MicroGDS for the
implementation and drawing of BIM intelligent objects follow special
naming conventions. For details about BIM intelligent objects, see
Chapter 3, Working with primitives and objects.

In addition, if you want to produce an object report that includes
attributes, do not name a mnemonic using any keyword used by the
format definition file. If a mnemonic name matches any of the format
file definition keywords, MicroGDS prints the details defined by the
keyword, and not the attribute value associated with the mnemonic.

For details about object reports and format definition files, see
Chapter 13, Getting information. Refer also to Help.



Chapter 14: Working with attributes and schemas 319

4������������
�(����'�#���
Where a schema indicates that the selected graphics are intended to
have a particular attribute, MicroGDS makes the corresponding
mnemonic available in the appropriate place:

� Window-level mnemonics are made available in the Window Editor

� all other level mnemonics are shown in the Properties window

Initially, local mnemonics usually have no value, indicated by showing
«None». To assign an attribute to the selected graphics, you provide a
value for the mnemonic.

Note that if any default attribute values have been set in a schema, the
default values are initially shown. If you change a default value for the
selected graphics in the Properties window, it overrides the value set in
the schema.
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1 Do one of the following:

� To assign a value to a window-level mnemonic:

a) open the window definition to which you want to assign an
attribute value

b) press F2, or on the File menu, click Window, Edit

c) on the Window Editor, click the Attributes tab

The Attributes tab is displayed showing any attributes associated
with the window. For example:
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� To assign a value to any other level mnemonic:

a) select the primitives or objects to which you want to assign
attributes, and to which a schema has been applied

b) press Ctrl+Q, or on the Window menu, click Properties

The Properties window is displayed showing details about the
selected graphics and associated attributes.

For example:

If any hidden attributes are associated with the selected graphics,
they are shown only if the Show Advanced properties check box is
selected in your preferences. Hidden attributes are designated by an
asterisk (*) as the first character. Hidden attributes can only be
modified by a custom program.

You can view details about any attribute by hovering the mouse
pointer over a mnemonic name or its value. Details for the item are
shown in a ToolTip. For example, if you hover over the mnemonic
name, the name of the schema in which the mnemonic is included, if
any, and any prompt defined for the mnemonic are shown.
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2 To assign an attribute value, click the attribute then do one of the
following:

� type the value in the box

� click  and select the value from the list

� click  to display an Edit Property Value dialog box in which
to enter the attribute value
For example:

— when assigning enumeration from a word list, the box
provides a drop-down list of the defined words for you to
choose from

— when assigning multiple values, some attributes show the
line numbers in the left column; to edit a line, click the
right-hand box of the appropriate line

— when assigning attributes to a URL mnemonic, specify the
value as a file name or a full URL

For details about the hyperlink formats you can use, see
Editing attributes in MicroGDS Help.

When a URL mnemonic is assigned to an object or
primitive, a link icon is shown to the left of the mouse
pointer, which you use to open the link.

— when assigning a date attribute, MicroGDS displays an Edit
Date dialog box; double-click the displayed date to set a
new date

You can remove the existing attribute value by clicking Delete.

If you remove an attribute that appears in a relevant schema, it
will continue to be shown in the Properties window with a value
of «None».
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If you remove an attribute that you have added to the selected
graphics, the attribute is no longer shown in the Properties
window.

3 Add further attributes as required.

The attributes are shown in the Window Editor or Properties
window, as appropriate.

For example:
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You usually create schemas to tell MicroGDS which entities are
expected to have which attributes. Sometimes, however, you might
want to explicitly assign an attribute to one or more graphic entities.
You can do this by adding it to the appropriate graphics.
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1 Follow step 1 in Assigning attribute values on page 319.

2 Click the Add Attribute button that is appropriate to the applicability
of the mnemonic.

For example, to add an attribute to a reference level mnemonic,

click the Add Reference attribute button  on the Object section of
the Properties window.

MicroGDS displays an Add Attribute dialog box and lists all local
mnemonics of the appropriate applicability, that are available.

For example:

The dialog lists only local mnemonics because you do not explicitly
assign values to external or computed mnemonics.

3 From the Mnemonic list, select the mnemonic to attach to the
selected graphics.

MicroGDS shows the selected mnemonic in the Value box, and
assigns a default value depending on the mnemonic type. For
example:

If required, you can change the value in the same way as described
in step 2 of the previous section Assigning attribute values.

4 To confirm the attribute and assign the value to the selected
graphics, click OK.
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MicroGDS copies attributes according to the following rules:

Mnemonic
applicability

Copying rule

Layer-level Always copied when a document, window, or
layer is copied.

Object-level Always copied when a document, window, or
layer is copied.

Copied when an object, or assembly containing
an object, is copied, only if the ‘Attribute copied
with object’ check box is selected for the
mnemonic.

If an attribute already exists in the target
document but with a different value, the target
value is used and the imported value is discarded.

Reference-level Always copied when a document, window, or
layer is copied.

Copied when an object, or assembly containing
an object, is copied, only if the ‘Attribute copied
with object’ check box is selected for the
mnemonic.

Primitive-level Always copied.

Window-level Always copied when a document or window is
copied.
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You can copy attribute values from the Properties window to the
Clipboard as DDE data. You can then paste-link this data into a
MicroGDS document or into an application that can handle linked data
(for example, a cell of an Excel spreadsheet). The pasted attribute value
is then automatically updated whenever that attribute value is changed
in the MicroGDS document.

To copy an attribute value, right right-click over the attribute and select
the Copy command from the shortcut menu.
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Link data in which the source and destination information is stored in
different files is stored in Dynamic Data Exchange (DDE) format. The
DDE link contains information about the source file name and location.
Therefore, you must save the source file to disk before you can copy or
cut the data for linking.

In MicroGDS, if you copy an item from a document and then paste-link
it back to the same document, you should paste the information using
the MicroGDS Linked Data format. This format automatically drops the
overhead of the source file and location, which is not needed for links
within the same document.

You can also copy some of the properties in the Properties window as
linked data, provided that the corresponding computed mnemonic is
available to the document. For more details, refer to Help.
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When you set up an inclusion list, you can filter the objects using
attribute values. You use an inclusion list to:

� define which objects are to be included in a phase, using the Phase
Filter Editor

For details about inclusion lists, see Chapter 4, Using layers and
phases.

� define the objects that can or cannot be edited in a document, using
the Set Edit Filter Editor

For details about editing restrictions, see Chapter 3, Working with
primitives and objects.

To filter objects using attributes, you use the Advanced section of the
Filter Editor:

To add a filter condition, click New or to edit a filter condition, click the
column you want to change.
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You choose whether the filter is to apply to ‘any’ or ‘all’ of the
following conditions must be met by selecting from the list. You then
define the filter condition to which the filter is to apply. The usual
syntax of a condition is:

mnemonic_name   operator   attribute_value

For example, to find all objects which have a floor area greater than 20,
you would set up the statement:

flooring > 20

To define the attribute filter, select the components from the lists. For
non-specific values such as free text, type the text using wildcards if
required. For example:

Full details on setting up attribute filters are given in MicroGDS Help.
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You can use attributes in a text primitive so that you need not change
the text of the primitive each time the value changes. This is called
secondary annotation. For example, you might use secondary
annotation to insert the area of an object.

To insert an attribute value as secondary annotation in a text primitive,
type the mnemonic name using the format:

^(mnemonic name)

For example:

The pipe length required here is ^(R.Pipe length).

might show:

The pipe length required here is 20m.

For more details about secondary annotation, see Chapter 8, Working
with text.
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In MicroGDS, you usually work with MicroGDS documents. However,
using the import, export, publish, raster, and link commands, you can
also work with other file formats.

These facilities enable you to work with files created in, converted to,
or linked to, other software packages, such as AutoCAD, Adobe, and
Corel Paint Shop Pro.
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You can use the File Open command to open the following
non-MicroGDS file types:

� DXF (AutoCAD’s drawing exchange file format)

� DWG (AutoCAD file; a smaller version of a DXF file)

� AIF (GDS ASCII Interchange Format)

� BIF (GDS Binary Interchange Format)

� SKP (SketchUp)

� 3DS 3D Studio files

When you open a non-MicroGDS file, this is, in reality, a shortcut to
creating a new, blank file and then importing the third-party file.
MicroGDS performs the following actions, in the background:

1 First, MicroGDS creates a new, blank document.

If a blank MAN file template is specified in your preferences, the
new document is based on the template. This enables styles to be
transferred to the graphics.

2 The file is then imported into one or more window definitions.

If you are using a style mapping table, the graphics are translated
according to the style mapping table.

For more details, see Using mapping tables on page 332. Refer also
to Help.

The Window label in the Window Editor shows the path of the
imported file.

For some file types, the Layer labels are set to ‘Imported from
filename.xxx’.

Note that details of third-party files cannot be displayed in the
Document Organizer.

You can also transfer project files between GDS and MicroGDS
projects using the GDS Transfer utility. GDS is a product of Graphic
Data Systems, Corp. You can access Classic GDS Transfer from your
MicroGDS, Applications menu on the Start menu. For details on how to
use the utility, refer to the Classic GDS Transfer Help.
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When you have a MicroGDS document open, you can import the data
from other MicroGDS documents, plus DXF, DWG, AIF, BIF, THF,
SKP, and 3DS files into the document.

Things files (.THF) are an effective way of transferring 3D geometry
(including 3D Classic GDS geometry) into MicroGDS.

If you want to import a WND file from a multi-user project, export the
window definition to a MAN file and then import the MAN file into the
document.
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1 Open the document into which you want to import the data.

If you are importing a THF file, you can import the data directly
into an existing window definition in the MicroGDS file. If
required, open the window definition into which to import the data.

For other file formats, new window definitions are created as
necessary.

2 On the File menu, click Import File.

3 In the File to Import dialog box, select the folder to look in.

4 From the Files of type list, select the type of file to import.

5 Select the file to import and click Open.

If you are importing from DXF, DWG, AIF, BIF, or SKP format, a
further Import dialog box opens. You can use the dialog box to
specify the input for the resulting file. For example, you can set up
style and entity mapping tables for DXF and DWG files and choose
whether to create assemblies for SketchUp groups and instances.
The dialog box also enables you to save sets of import options to a
file so that you can reuse the same set of options another time.

Mapping tables are described further below.

With the exception of importing a Things file, a new window definition
is created containing the imported file.

If you import a Things file, it is imported into the current window
definition, on the current layer, and in the current object. If no window
definition is selected, the file is imported into the last selected window
definition. If no window definitions are open, a new window definition
is created containing the imported file.
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When you import a DXF/DWG or AIF/BIF file, you can use mapping
tables to explicitly define the mappings of linestyles and charstyles,
layers, objects, and attributes. For more details, see Using mapping
tables on page 332. You can also refer to Help.

If you import a single-user document (a MAN file), and a window
definition of the same name already exists in the document, MicroGDS
prompts you to specify a new name. If styles of the same name and type
already exist in the document, the styles in the imported document use
the styles in the document into which you are importing. Furthermore,
if unique layer names are enforced and you import a document that has
the same layer names as those already in the document, unique names is
not enforced and MicroGDS creates duplicate layer names. (Unique
layer names can be set on the Name Assistants tab of your preferences.)

If an imported MAN file contains a photo that references another
document, the source window definition is also imported.

Note that if you import a single-user document into a multi-user project,
all window definitions and layer files are created in the current default
alias.
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In MicroGDS, you can export and publish a view of a window
definition to a number of model-based and image-based formats. The
difference is that MicroGDS translates the structure of a file for export
and draws the content for publish.

For example, you export a view to DXF and SKP formats and you
publish a view to PDF and BMP formats.

MicroGDS also supports exporting and publishing multiple views using
batch versions of the commands. The following subsections describe
how to export and publish a single view; for full details on exporting
and publishing single and multiple views, refer to Help.
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Before you export a view to another format, please check the Help to
see if there are any file-specific considerations that you need to be
aware of.

Note that if you export a view which has a sectioned view, the section
information is included provided that the export format supports the
current section.
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1 If you are saving to THF format, only clumps are exported therefore
select the clumps that you want to export.

2 On the File menu, click Export.

The Export dialog box is displayed.

3 From the Save as type list, select the file format in which to export
the graphics.

4 In the File name box, type the name for the file and click Save.

MicroGDS will automatically add the appropriate extension to the
file name.

Depending on the file format to which you are exporting,
MicroGDS opens a further dialog box which enables you to choose
output options for the resulting file.

If you are exporting to:

� MicroGDS format, you can choose the action for any photos that
are referenced by the window definition.

� 3DS format, you can specify how to write 3DS meshes. For
more details, refer to Help.

� AIF, BIF, DXF or DWG format, you can set many options to
specify how the output file should be generated. For example,
MicroGDS uses default mappings for DXF and DWG files. If
required, you can set up custom style mapping tables for each of
these formats. You can also set up entity mapping tables to
define the mapping of layers, objects, and attributes. Mapping
tables are described further below.
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Before you publish a view to another format, please check the Help to
see if there are any file-specific considerations that you need to be
aware of.

Note that if you publish graphics which have a sectioned view, the
invisible graphics are omitted from the resulting file.
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1 On the File menu, click Publish.

The Publish dialog box is displayed.

2 From the Save as type list, select the file format in which to publish
the graphics.

3 In the File name box, type the name for the file and click Save.

MicroGDS will automatically add the appropriate extension to the
file name.

Depending on the file format to which you are publishing,
MicroGDS opens a further dialog box which enables you to choose
output options for the resulting file. Many options in the upper part
of the dialog box are identical for each file type. Additional options
that you can use to set resolution and structure settings differ
depending on the file type. For details on each output option, refer to
Help.

If you are exporting to PDF format, MicroGDS displays the PDF
Export dialog box for you to specify the output for the resulting file.
Note that Adobe PDF format 1.6 is the recommended format.
(Adobe Reader 7 or later is required to read PDF 1.6 format
correctly.)
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Mapping tables can be used when MicroGDS translates files to and
from DXF, DWG, AIF, and BIF. They can be used to define how a file
should be opened or saved in MicroGDS.

There are two types of mapping tables available: style mapping tables
and entity mapping tables.

� a style mapping table defines which linestyles and charstyles are
used when MicroGDS translates files to and from BIF, AIF, DXF,
and DWG
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� an entity mapping table defines how data is handled when
MicroGDS translates files to and from DXF and DWG

For example, MicroGDS objects are converted into blocks, and
primitives are converted into entities.

MicroGDS supplies sample mapping tables for opening and saving files
in DXF and DWG format. These files are located in the MicroGDS
Programs folder.

You might set up a number of different mapping tables for different
purposes. You define the location of the mapping tables to use when
you start a file translation.

For more details about setting up and using mapping tables, refer to
Help.
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A raster image is a rectangular area of pixels. The image can represent
data such as a geographical area or a scanned drawing. You can edit the
size and location of a raster image in a file, but you cannot interact with
(for example, snap to, select, trace or edit) the raster graphics.

Raster images are treated as rectangle line primitives whose contents
are linked to the inserted raster file (specified when the image is
inserted). When a raster primitive is selected, MicroGDS displays the
boundary of the image, overlaid with a grid of dots. This helps you to
identify raster primitives, and also speeds up redraws.

The types of raster images you can insert into MicroGDS are:

BMP Windows bitmap image

TIFF (or TIF) images Tagged Image File Format

JPEG (or JPG) images Joint Photographic Experts Group
compressed image file

EPX files Piranesi Extended Pixel format

PNG files Portable Network Graphics file

TGA files TARGA format files
(Not all TARGA format files can be used
in MicroGDS; refer to Help for details.)
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If the file type supports transparency, any transparent areas in the raster
image are retained.
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If you are inserting several raster images into a document, you can set
up aliases to map the physical location of the files containing the
objects to an arbitrary name. If the files are later moved to a different
location, you need only change the pathname in the aliases table.

Note that if you want to use aliases, you should define the aliases before
you insert the raster images into the document. For details about setting
up aliases, see Chapter 3, Working with primitives and objects.

When you have set up aliases, you can drag a raster image from the
aliased library in the Document Organizer into the active window.
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1 On the Construct menu, click Raster.

The Raster Image dialog box is displayed.

2 Locate the folder that contains the image to insert, or if you are
using aliases, select the appropriate alias name from the Aliases list.

3 From the Files of type list, select the image format you require.

To list all raster types recognized by MicroGDS, select All Image
Files.

4 Select the file to open and click Open.

The Raster Details dialog box is displayed.

5 Specify the resolution and colour options you require, then click
OK.

If you are inserting a 1-bit image file, you can use the Colour
Handling options to assign a transparency value to either of the
image colours.

If you use transparency, you should select the GDI+ raster
optimization check box in your preferences.

6 Click in the window to position the bottom left-hand corner of the
raster image, or type the coordinates of the position.

The image is placed at the specified position, overlaid with a grid of
dots. When you deselect the primitive, the dots are no longer visible.
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When you set up raster aliases, details are added to the Raster Files tab
on the Document Organizer. This enables you to access the images in
the aliased locations directly from the Document Organizer.

� 3������
������#������
����
��&���

1 On the Document Organizer, click the Raster Files tab:
G����	����������

A list of each aliased raster location is displayed.

2 Double-click the aliased location that contains the image to insert.

The raster images in the aliased location are listed.

3 To display a preview of an image, select the image’s file name.

If the preview area is not currently visible, on the shortcut menu,
click Toggle Preview.

4 When you have located the image to insert, drag the image into the
window definition.

5 Specify the resolution and colour options you require, then click
OK.

The image is placed in the window definition.

When you have placed an image in a window definition, you can use
MicroGDS commands to alter the image. For example, you can move,
rotate, stretch, or mirror the image. You can also manipulate the border
of the image, for example, you can add vertices, move segments, and
swap the boundary with a closed line primitive. For details, refer to
Help.
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If an inserted raster file is deleted or moved, MicroGDS shows an
empty rectangular outline, and reports the error to the Problems dialog
box.

To display the image, you will need to update the raster path.

� if the location of the image is aliased, you can edit the alias path

You can edit the alias path using the Problems dialog box or the
Aliases command on the File menu.
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Note that the Aliases command is available only for a single-user
document. Raster aliases in a multi-user project are set up in the
project database. For details, see Chapter 16, Working with projects.

� if the location of the image is not aliased, or you do not want to
change the alias path, you can edit the image path

You can edit the image path using the Problems dialog box, the
Properties window, or the Raster, Properties command on the Alter
menu.

Note that you can use the Many Paths command on the Edit menu to
update the paths of multiple missing raster files.

You can also change the contents of an inserted raster primitive by
changing the path, thereby pointing to a different image altogether.

For more details on these commands, refer to Help.

!���������
����
��&���

You can open a selected raster image in the editor specified in your
Preferences. This enables you to edit the image as required.
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1 On the Alter menu, click Raster, Open.

2 Click on the border of the raster image you wish to edit.

3 Edit the image file as required and then save and exit from the
editor.

Alternatively, double-click on the border of the raster image to open the
file in the specified editor.
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Raster images that you insert in your document are not updated
dynamically when the raster file is changed. Therefore, you must update
it to see changes made to the file.
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1 On the Alter menu, click Raster, Update.

2 Click on the border of the raster image you wish to update.
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You use linked and embedded objects to share information between
Windows programs. (Note that the term ‘object’ when used in this
context does not refer to the special MicroGDS use of ‘object’.)

You can use a linked object or an embedded object to add data created
in any program that supports linked and embedded objects, to a file in
another application. For example, you can embed or link MicroGDS
graphics or views in other applications. Similarly, you can embed or
link data from other applications in MicroGDS documents by using the
Edit, Paste Special command.

You can also drag files and objects into a MicroGDS document to
move, copy, and link data. For example, you can add a bitmap from
Windows Explorer, or a text block from a Microsoft Word document.
You can drag files and objects into a MicroGDS document using both
the left and right mouse buttons. For more details, refer to Help.
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You can link an object from a window definition in a MicroGDS
document to a file in another application.

When you link an object, the linked data is stored in the source file. The
destination file stores only the location of the source file and displays a
representation of the linked data. The linked information is updated
only if you modify the source file.

Link data in which the source and destination information is stored in
different files is stored in Dynamic Data Exchange (DDE) format. The
DDE link contains information about the source file name and location.
Therefore, you must save the source file to disk before you can copy or
cut the data for linking. If you rename or move the source file, the link
is broken.

When you paste-link data from a single-user document to another
application, the link is made to the principal window only. If you
change the principal window, the link to the graphics in that window is
lost and the link then refers to the new principal window.

In MicroGDS, if you copy an item from a document and then paste-link
it back to the same document, you should paste the information using
the MicroGDS Linked Data format. This format automatically drops the
overhead of the source file name and location, which is not needed for
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links within the same document. You might use paste-link within the
same document, for example, to place dynamic measurements in your
documents using the Copy button on the Query Measurements dialog
box. Linked Data format is available only when the source and
destination document are the same.

Note that MicroGDS Linked Data should be used in preference to DDE
data, which carries more overhead. Use DDE Link Data when you
paste-link data between different documents or between applications.

You can double-click a linked object to open it in the source program if
the source program is OLE 2 (Object Linking and Embedding)
compliant. For further details, see the section OLE on page 339.
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1 Open the document that contains the graphics whose measurements
you want to link to Excel.

2 Open the window definition that contains the graphics.

In a single-user drawing, you must ensure that the window
definition containing the graphics is designated as the principal
window in the document.

3 On the File menu, click Preferences.

4 On the General tab, ensure that the Query dialogues check box is
selected and click OK.

5 On the Query menu, click Area.

6 Click on a closed line primitive to measure the area of the primitive.

7 When the Query Measurements dialog box opens showing the area
value, click Copy.

Note that the DDE link contains information about the source file
name and location. Therefore, if the source file has not yet been
saved, the Copy command copies only plain text.

8 Start Excel and open a spreadsheet.

9 Select the cell in which you want to paste the area value.

10 On the Edit menu, click Paste Special.
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11 Select the Paste link option and click OK.

The area of the primitive at the object scale is pasted into the cell,
using the current set units and decimal places. During this session, if
the item in MicroGDS is altered so that its area changes, the area
value will be updated automatically in Excel.

12 If required, save the Excel spreadsheet.

When you leave Excel, the most recent data is stored along with the link
information. The next time you start Excel, a prompt asks if you want to
re-establish the remote link. If you click Yes, it will check for any
updates to the data, and continue receiving updates during the session.
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You can embed an object from a MicroGDS document in a file in
another application.

OLE (Object Linking and Embedding) enables you to embed data from
one Windows program in another in such a way that, if you want to edit
that data, you can start the source program by double-clicking on the
embedded object. The source program is then started and loads the
relevant data.

For example, you might embed a window definition in a MicroGDS
single-user document in a Word document.
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Note that the following steps refer to Microsoft Office 2007. If you
have a different version of Microsoft Office installed, please see the
Microsoft Help for details.

If you are in Word:

1 Click in the document where you want to place the embedded
object.

2 On the Insert tab, in the Text group, click Object.

3 In the Object type box, double-click MicroGDS Document.

A MicroGDS document is inserted into the Word document.

4 To begin drawing in MicroGDS, select a command from the
Construct menu.

5 When you have finished, on the View menu, click Save View1.
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If you are in MicroGDS:

1 Open the MicroGDS document that contains the item to be
embedded.

2 Open the window definition that contains the graphics.

In a single-user drawing, you must ensure that the window
definition containing the graphics is designated as the principal
window in the document.

3 Select the item to be copied and, on the Edit menu, click Copy.

4 Start Microsoft Word and press CTRL+V.

From now on, you can edit the MicroGDS document by
double-clicking the object in Word.

Once a MicroGDS document is embedded in a Word document, the
only way to edit it is to double-click on it in Word—you cannot start
MicroGDS and load the document.
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When you embed an object, the embedded object becomes part of the
destination file and is no longer part of the source file. The embedded
information does not change if you modify the source file.

If you paste the object in an appropriate format, you can double-click
the embedded object to open it in the source program if the source
program is OLE 2 compliant.

If the file you want to use was created in a program that does not
support linked and embedded objects, you can still copy and paste
information from the file to share the information between programs.
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Use multi-user projects to enable several people to access the same
drawing data simultaneously.

The main difference between a single-user document and a multi-user
project lies in the way the drawing data is stored.

The graphical data for a multi-user project is stored in a series of layers,
and each layer is stored in a separate layer file (a .LYR file). This makes
it possible for different people to work on the same drawing by each
editing a different layer. When one person opens and begins to edit a
layer, the layer file is locked to prevent another user from editing the
file at the same time. More details about layers in multi-user projects
are given in Chapter 4, Using layers and phases.

The drawing data in a project is stored in window definitions, just as it
is for a single-user document. However, each window definition in a
project is stored in a separate window definition file (a .WND file).
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There is virtually no limit to the number of layers you can create. You
can organize the layers and window definitions into as many different
folders as necessary. For example, you could group all layers that
contain data for architects in one folder and all layers that contain data
for electricians in another.
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A multi-user project comprises a project database and one or more
project workspaces. The project database locates various project files,
including the layer files which make up the drawing. The project
workspace controls which layer files can be accessed by whom.

MicroGDS supplies a sample project called Sixhills to give you an idea
of how projects can be set up. This project is installed into your
MicroGDS Sample Drawings folder. You can use Windows Explorer to
see how the folders and drawing data are structured. If you open the
project in MicroGDS, you can use the Document Organizer to see how
MicroGDS presents the project to you.
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MicroGDS project databases can be created as MicroGDS .CPD
databases, SQL Server/MSDE (and SQL Server 2005 Express)
databases, or any other database that has an OLE DB provider which
complies to the ANSI SQL92 standard.

We do advise against using other types of database as there may be
problems with creating the database table. If you do wish to create a
project using other types of database, please contact MicroGDS support
for more information.

By default, databases will be created in Jet 4.0 (Access 2000) format.
These types of project database have the extension .CPD.

Note that you cannot create or use CPD databases if you have installed
the 64-bit version of MicroGDS on a 64-bit machine. If you do have
existing CPD databases that you want to continue to use, you might
want to consider installing the 32-bit version of MicroGDS instead.

The project database defines the locations of the files that are to be used
in the project. This includes the window definition files, layer files,
raster files, and instance object libraries. It also defines the locations of
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the style files. Style files contain the definitions of the charstyles,
linestyles, materials, lightstyles, and mnemonic definitions used in a
MicroGDS project.

The locations of the project files are defined when the project database
is created. Additional locations can be specified at a later time, and
existing locations can be changed or removed by the project manager
using the Project Administrator. The Project Administrator is available
from the MicroGDS Program menu on the Windows Start menu. For
details on how to use the Project Administrator, refer to the utility’s
online Help.

When you define the file locations, you use aliases. An alias is a way of
mapping an arbitrary name to a physical file location. This enables you
to use a name of your choice in place of specifying the full pathname,
similar to using Windows shortcuts. For example, you could map the
alias name ‘Architectural Drawings’ to the folder
c:\MicroGDS\Projects\SitePlan\Architectural. If the architectural files
are later moved to a different folder, only the pathname of the alias in
the database needs to be changed. You do not need to update it each
time one of the files is referenced.

You can use a project template when you create a project database.
Project templates provide a folder structure for holding all files related
to the project, as well as a set of styles. Templates are described on
page 344.
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The project workspace contains information relating to a project, such
as the project database to be used, the layers that are editable, and the
default locations in which to save new files. Many workspaces can be
defined for the same project, enabling different users to access different
data. A project workspace has the extension .CPJ.

For example, if you have a project to design a building, the project
database would contain all the layers relating to the building. You could
then set up different workspaces for different disciplines. All users
would be able to see the overall building plan, but designers working on
electrical data would work in the electrical workspace and have access
to wiring plans, and designers working on plumbing data would work in
the plumbing workspace and have access to piping layouts, and so on.
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When you open a project workspace in MicroGDS, data relating to the
workspace is displayed in the Document Organizer. Each tab on the
Document Organizer gives access to specific project items. For
example, the style categories are listed on the Styles tab, and the
window aliases available to the project are listed on the Window
Definitions tab.

For details about opening project workspaces and working with the
project data, see Working with project workspaces on page 356.
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MicroGDS supplies two sample project templates that you can use
(Basic.cpd and Working.cpd), or you can create your own.

The Basic and Working templates both use a MicroGDS .cpd database
file, but they could use any other type of database such as a SQL Server
database.

Before you can use a project template, you must add it to the template
list in your preferences. For details, refer to Help.

��&�#���
�)�	����&�#����

Both the Basic and the Working templates have the following structure:
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The Basic template provides only the structure for the project database.

The Working template includes some additional files:

� a project workspace file (Entire Project.CPJ)

� Layer

A layer files alias location to store the layer files (.LYR) which store
the drawing data.
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� Library

A library files alias location that you can use to store and access
object libraries. (An object library is a .MAN file that contains
objects that can be inserted into window definitions.)

� Raster

An image files alias location containing sample TIF files that can be
used to insert raster images into a drawing.

� Styles

Contains a CHARS.STY file and a LINES.STY file.

� Window

A window alias location, containing a subfolder called Frames
which provides some standard drawing frames.

When a new project database is based on a template, MicroGDS copies
this structure to the specified location. Note that any files that were not
created as part of the template are not copied.

By default, the project files are saved in the corresponding project
folders. For example, the layer files (.LYR) are stored in the Layer
folder, and the window definitions (.WND) are stored in the Window
folder. When a new style is created, if a style file of that type does not
already exist, MicroGDS automatically creates the appropriate style file
in which to store the styles. For example, LIGHTS.STY is created when
you create a new lightstyle and MATLS.STY is created when you create
a new material.

Note that project managers can manage multi-user projects using the
Project Administrator utility. The Project Administrator is available
from the MicroGDS Program menu. For details on how to use the
Project Administrator, refer to the utility’s online Help.
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The steps below summarize the basic procedure for creating new
project templates. For full details, refer to Help.
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1 Create a project database, with the alias names and style search path
that you want to use for the template.

2 Create the project workspaces, window definitions, and layers that
you want in the template.
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3 Copy any additional files that you want users of a workspace to
access, into the appropriate project subfolders. For example, you
might copy a number of raster images into a Raster location.

4 Add the project template to the template list on your Multi-user
preferences.

For details about adding project templates to the template list, refer
to Help.

When a new project database is created based on a template, MicroGDS
creates a project database with the name and in the location you specify,
based on the template. Any files and folders on the same level and
below the project database file (CPD) in the template will be copied to
the new project database. The new project database also stores the alias
names with their mapped locations, and the locations defined in the
style search path. The template can reference folders outside of this
structure, but the files within those folders are not copied to the new
project database.
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In this section, we describe how to create a MicroGDS Jet 4.0 (Access
2000) project database. This is the default format. The basic concepts
and procedures are similar for all types of project database creation. For
details about creating a project database of a different format, refer to
the Project Administrator online Help.

Before you create a new multi-user project, you should plan the
structure of the project. This will help to ensure that users of the
workspaces have access to the locations and files they require.

The structure of a project can be changed at a later date, for example, it
may be necessary to add a new folder to the style search path in the
project database. However, it is better to have the project well defined
before users begin to work with the project files. Changes to the
database (and workspaces) can be carried out by the project manager
using the Project Administrator. The Project Administrator is available
from the MicroGDS program menu on the Windows Start menu. For
details on how to use the Project Administrator, refer to the utility’s
online help.
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To create a new project, you:

� create the project database, if it does not already exist

� create the project workspaces
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1 On the File menu, click New.

The Create a New File dialog box is displayed:

2 Select ‘Project database’ and click Next.

The Create a New Project Database dialog box is displayed:
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3 From the Template list, select an existing project template on which
to base your new project.

If you do not want to use a project template, leave the selection set
to (No Template).

4 From the Database Type list, select Access 2000 (Jet 4.0).

5 In the Description box, type a short description for the project
database, if required.

The description can be read and amended using the Properties
window.

6 Click Next.

7 To specify the name of the project database:

� in the Name box, type the full path

If you type a location that does not exist, MicroGDS asks if you
wish to create it.

� or, click Browse to display a browse dialog box in which you
select the location for the project database. In the File name box,
type the name and click Open

You can set a default location in which to create a new project
database on the Multi-user tab of your user preferences.

If you do not include the .CPD extension, MicroGDS adds it
automatically.

8 Click Next.

If you based the project database on a template, the project database
is created and the Create a New Project Database dialog box is
closed. If you now want to create a project workspace:

a) On the File menu, click New.

b) In the Create a New File dialog box, select Project workspace.

c) Go to the next section Creating the project workspace.

If you did not base the project database on a template, MicroGDS
displays the Define Database Aliases dialog box.
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For example:

Aliases are the names you associate with the folders available to the
project. There are six alias types:

� layer aliases specify the folders for new layers

� window aliases specify the folders for new window definitions

� raster aliases specify the folders for accessing raster images

� library aliases specify the folders for accessing library files

� reference aliases specify the folders for accessing MicroGDS
documents that contain windows that can be used as photos
(these are optional)

� renderer aliases specify the folders for renderer files (these are
optional)

Reference and renderer aliases are optional; all other types of data
require at least one alias.

The default alias names for each file type are shown on the left side
of the dialog box; the default folder locations, which are relative to
the project database folder, are shown on the right of the dialog box.

If you accept these details, MicroGDS creates subfolders in the
project database structure with the names shown, and maps those
locations to the default alias names.

Note that the alias names are the names that you will see in the
Document Organizer.

9 You can use the Define Database Aliases dialog box to add, edit, and
remove aliases, as applicable.
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Note that if you map an alias to a network drive, the assignments
will work only for users who use the same standardized mapping of
drive letters to disks. If you do not use a standardized network
mapping system, you should specify the full network pathname
when you set up aliases.

To change the default alias name and/or location for an alias:

a) In the Define Database Aliases dialog box, select the default
alias and click Edit.

MicroGDS displays the details of the selected alias in the Alias
Editor.

b) Amend the alias name and the location to which the name refers,
as required, then click OK.

To add an alias:

a) On the Define Database Aliases dialog box, click Add.

MicroGDS displays the Alias Editor.

b) In the Name box, type the alias name.

c) Specify the location to which the alias name refers.

If the location is relative to the project database, type only the
folder name; you do not need to type in the full pathname. If you
type a location that does not exist, MicroGDS creates the
location for you.

d) From the Type list, select the type of file to which the alias
refers.

e) To allow the users of the workspace to expand an alias name to
show any subfolders in the project workspace window, select the
Expandable check box:
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f) Click OK.

The following example shows a Define Database Aliases dialog box
with the complete alias details for the project:

An absolute path is shown if you:
� type an absolute path

� browse to a location that is not relative to the project database
folder

Note that an X indicates that the alias is expandable.

10 Click Next.

If any alias folders do not currently exist, MicroGDS first asks if
you wish to create them.

MicroGDS then displays the Define Database Style Search Path
dialog box. MicroGDS uses the style search path to read and store
the style files. The default location for the style files is in the project
database folder.
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11 You can change the default folder, and add and remove folders from
the style search path as applicable.

To change a location in the style search path:

a) Double-click the entry.

b) Click the ellipses button to the right of the current entry.

The Browse for Folder dialog box is displayed.

c) Specify the new location for the style search path and click OK.

To add a location to the style search path:

a) On the Define Database Style Search Path dialog box, click Add.

b) Specify the location of the style search path and click OK.

The first location that you specify defines the folder in which styles
are updated and saved as you work. The style files in this location
are the local style files, and these contain the local styles for the
project. For example, if you create a new linestyle it will be saved in
the LINES.STY file in the location defined first. If the LINES.STY
file does not exist, MicroGDS creates the style file in this folder and
then saves the style to the file.

If you modify a style that is stored in a file in a subsequent location,
the modified version of the style is saved in the appropriate local
style file, and not in the file from which it originated.

Therefore, you would probably specify the style files that are
specific to the project first, and the additional style files second.

You can reorder the locations in the style search path using the
Move Up and Move Down buttons.
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12 Click Next.

13 To create a new workspace, select the Create a workspace check
box, then click Finish.

If you do not click the Create a workspace check box, you can create
a workspace at a later time by selecting Project workspace on the
Create a New File dialog box.
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When you create a project workspace, MicroGDS displays the Create a
New Project Workspace dialog box.

If you have just created a project database that was not based on a
template, and you selected the Create a workspace check box, the name
of the project workspace and the database are entered automatically in
the boxes.

For example:
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1 To specify the name of the project workspace:

� in the Name box, type the name for the project workspace,
including the full path if necessary

If you type a location that does not exist, MicroGDS asks if you
wish to create it.
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� or, click Browse to display a browse dialog box in which you
select the location for the project workspace, then type the name
in the File name box and click Open

Note that a default location for the project workspace can be set
on the Multi-user tab of your user preferences.

If you do not include the .CPJ extension, MicroGDS adds it
automatically.

2 In the Project Database box, specify the project database to which
the project workspace refers. You can browse for the project
database by clicking Browse.

The Connection String box is used when you create non-MicroGDS
.CPD databases.

3 In the Description box, type a short description for the project
workspace, if required.

The description can be read and amended using the Properties
window.

4 Click Next.

MicroGDS displays the Select Workspace Aliases dialog box. If you
did not create additional aliases for layers, only the default alias
name is shown.

5 Select the layer aliases for the layers that are to be editable by users
of the workspace:

� to enable all layers to be edited, select the All aliases refer to
editable data check box

� to disable users from editing specific layers, clear the All aliases
refer to editable data check box, and then select the aliases that
refer to the layer locations to be made editable
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For example:

6 Click Next.

MicroGDS displays the Select Default Aliases dialog box. For
example:

If additional aliases exist in the project database, you can choose an
alias of each type to set the default locations for the workspace.

For example, if users of this workspace are to work with structural
data, and aliases have been defined to store structural files, you can
set the structural aliases as the default aliases for those types.

Note that users of the workspace can override the default aliases for
new layers and windows, for the current work session. For details,
see Overriding default aliases on page 359.
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7 From the lists, select the default alias for each file type and click
Next.

8 In the final dialog box, select the appropriate check boxes to choose
whether to add the workspace to the Windows Start menu, and
whether to open the workspace immediately.

9 Click Finish.
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� on the MicroGDS File menu, click Open and select the file to open

� or, double-click a .CPJ file in Windows Explorer

� or, drag the file from Windows Explorer into the MicroGDS
window

The project workspace opens in the Document Organizer and becomes
the current document. If you do not have the Document Organizer
displayed, you can open it from the Window menu.

The window aliases available to the project are displayed on the
Window Definitions tab in the Document Organizer.

Each project workspace has a default window alias. The default window
alias name is shown in bold. If any window definitions have been saved
in the default window alias, the folder to which the alias refers is
expanded. For example:
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1 Ensure that the project is the current document in the Document
Organizer.

2 Press Ctrl+S, or on the File menu, click Save Project.

MicroGDS saves all new and modified window definitions and
layers. If you have any new window definitions that you have not
yet saved, MicroGDS first displays the Save Window As dialog box,
for each unsaved window.

For details about saving individual window definitions, see the next
section.
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1 Ensure that the project is the current document in the Document
Organizer.

2 On the File menu, click Close Project.

If there are any unsaved window definitions or layers in the project,
MicroGDS displays the Save Drawing dialog box for you to choose
the files that you want to save before the project closes. Click:

� Save All to save all changes and close the project

� Save None to close the project without saving any changes

� Save Marked to save selected changes and close the project

To select a change to save, click its name in the list.

� Cancel to cancel the close
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In a multi-user project, each window definition is stored in a separate
window definition file (a .WND file). The only difference between
working with a window definition in a multi-user project and working
with a window definition in a single-user document is that you must
save each window definition in a project to disk.

You can save a window definition and any layers that it references; you
can also save an existing window definition to a new name.
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1 Ensure that the window definition is the active window.

2 On the File menu, click Save Window & Layers.

The window definition and any layers that it references are saved.

However, if you are saving a new window definition, the Save
Windown As dialog box is displayed for you to specify the
window’s name.

MicroGDS opens the file location to which the default window alias
refers, and lists any existing window definitions in the dialog box.

3 In the Save Windown As dialog box, specify the location in which
you want to save the window definition.

To save the window definition to a different folder that has an alias
defined, select the alias from the Aliases list.

4 Specify the name for the new window definition file.

If you do not include the .WND extension, MicroGDS adds it
automatically.

5 Click Save.

It is recommended that you save the window inside the project
folder structure. If you save a window definition outside the project
folder structure, MicroGDS advises you that this is not
recommended and prompts you to confirm.

The next time you save the window definition, it is updated.
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1 Ensure that the window definition is the active window.

2 On the File menu, click Save Window As.

MicroGDS displays the Save Window As dialog box.

3 Specify the location and file name for the layer, as described in the
previous procedure.

4 The Save Window As dialog box includes options for you to choose
to reference the same layers as those referenced by the original
window, or to create copies of those layers instead. Click the
appropriate option.

5 Click Save.

For more details, refer to Help.
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MicroGDS creates lock files and backup files for layers (.LYR files)
and window definitions (.WND files) in the same way as it does for
MAN files.

For multi-user projects, the corresponding lock files .WN# and .LY#,
and the corresponding backup files .WN$ and .LY$ are created.

Note that template files (.MTF) and style files (.STY) are protected in a
similar way.

More details about lock files, backup files, and setting the backup
option are given in Chapter 2, Exploring MicroGDS.
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Aliases are created in a project database to define the file locations that
will be available to the project. Because any number of workspaces may
refer to the same database, there may be several aliases set up in the
database for each alias type. Default aliases are stored in each
workspace that refers to the database. For example, an Electrical
workspace would have default aliases to store and access electrical data.
This ensures that new files can be saved automatically in the
appropriate locations.

If you have permission to save new files to other locations that have
aliases defined, you can temporarily override the default aliases for new
layers and windows. For example, you can save files in a draft area
while you are making some design changes, without saving the
drawings to the live project.

Overrides are used only when you save new window definitions and
create new layers.

The default aliases are reset when you close the project workspace.
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1 Ensure that the project is the current document in the Document
Organizer.

2 Click the Layers tab or the Window Definitions tab, as appropriate.
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3 Select the alias name that you want to set as the default.

The name of the default window or layer alias is shown in bold on
the corresponding tab.

4 On the shortcut menu, click Set as Default.

The new default window or layer alias is now shown in bold instead.
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1 On the File menu, click Alias Overrides.

MicroGDS displays the Alias Overrides dialog box. For example:

2 From the Layer alias and Window alias lists, select the alias
overrides.

To reinstate the default aliases, click Reset.

3 Click OK.
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When you work with graphics in a window definition, you have access
to all the styles that are available to the project. Styles in a multi-user
project are held in external style files. The locations of these files are
defined in the project database. The first location specified in the
project database stores the local style files; these are the files in which
styles are saved as you work.

More details about setting up new projects are given on page 346.

In some organizations, access permissions to style files may be
restricted. This may be to ensure that all drawings in a project have a
uniform appearance.

If you have access permissions to the style files, you can create, modify,
and delete styles. However, if you select a style for deletion from a style
file other than the local style files, MicroGDS informs you that you
cannot delete the style.
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Note that if you do not have permission to modify the local style files,
the Save and Save As buttons on the Modify dialog boxes are
unavailable.

You can create and modify styles using the File menu and the File
toolbar buttons. You can also create and modify styles directly from the
Document Organizer.

Lightstyles and materials are far more sophisticated in MicroGDS
Collaboration than those available in MicroGDS Entry Level. For
details about the additional lightstyle and material attributes available in
MicroGDS Collaboration, refer to Chapter 20, Advanced lightstyles and
Chapter 21, Advanced materials.
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You can transfer 2D GDS drawings to MicroGDS projects, and
MicroGDS projects to GDS drawings, using the Classic GDS Transfer
utility. GDS is a product of Graphic Data Systems, Corp.

Note that before you can use the transfer utility, you must ensure that a
project is the current document in MicroGDS.

You can access the Classic GDS Transfer utility from the Applications
menu on your MicroGDS Program menu.

For details on how to transfer files between GDS and MicroGDS, refer
to the Transfer utility’s online Help.
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This chapter describes the ways in which you can customize
MicroGDS. It covers how to:

� start MicroGDS from the command line

� change your preferences and settings

� change the defaults of a document

� create and load profiles

� create and customize toolbars, commands, shortcuts, and menus

� customize the BIM environment and define new BIM components

System administrators can also set up specific configuration files to be
used by everyone at their site.
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You can start MicroGDS from a command line (or shortcut icon) by
specifying the path and program file.
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� type the path that contains the MicroGDS program

Precede each folder name by a backslash.

If any part of a path contains spaces, enclose the path in quotation
marks (”).

For example:

”D:\Program Files\Informatix\MicroGDS\microgds.exe”

If you have a licence for more than one MicroGDS product, you can use
the /option parameter to specify which MicroGDS product to run.

You can also include a path to open a specific document in MicroGDS,
and start another application to run when MicroGDS has started.

For machines running Microsoft Windows Vista and later, you can add
a language name argument to set the user interface language to a
specific language.

The following examples assume that the location of MicroGDS is
”D:\Program Files\Informatix\MicroGDS\Microgds.exe”. Each
example builds upon the previous one, to show the full command line
argument.

The order of the parameters on the command line is:

MicroGDS_path MicroGDS_option MicroGDS_document
other_application

Examples

� To specify MicroGDS Collaboration as the program to run, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option Collaboration

� To start MicroGDS Collaboration and also open the document
C:\Drawings\Building plans\Stair construction.man, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option Collaboration

”C:\Drawings\Building plans\Stair construction.man”



Chapter 17: Customizing MicroGDS 365

� To start MicroGDS Entry Level, open the Stair construction.man
document as above, and then start Notepad, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option ”Entry Level”

”C:\Drawings\Building plans\Stair construction.man” /app Notepad

� To start MicroGDS Entry Level and set the user interface language
to German, type:

”D:\Program Files\Informatix\MicroGDS\microgds.exe” /option ”Entry Level”

/language DE

If preferred, you can create a shortcut on the desktop as a fast way to
start MicroGDS. For details, refer to your Windows documentation.
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Many of the customization options for changing the way an individual
system behaves are on the Preferences dialog box. These include:

� setting the selection and background colours

� specifying the default file locations for MicroGDS support files

� setting up name assistants for objects and layers

� defining the raster editors to use when you open a raster image

� setting up snapcode and snap guide options

� specifying the linestyles and charstyles for each type of dimensions

� specifying which MicroGDS commands are to be enabled or
disabled
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1 On the File menu, click Preferences.

The Preferences dialog box is displayed.

For example:

Note that if you are using MicroGDS Entry Level, you will not have
the Renderer tab on the Preferences dialog box.

2 Make the changes you require, using any of the tabs.

For a description of each option on each tab, refer to Help.

3 Click OK to save your changes.
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Many user settings throughout MicroGDS are managed through user
preferences, just described. However, preferences and other settings can
also be controlled at other levels through the Preference Files Editor.
This gives control at user level, document level, CAD manager level,
and program level.
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Many companies will have office standards for different types of
MicroGDS items, such as layer names, colours, linestyles, and so on,
and have set up their working environment to suit. Sometimes a project
will require its own standards, such as where a client always uses a
specific set of phase colours to maintain its corporate image. As CAD
manager, the Preference Files Editor lets you set general and project
settings, allowing you to choose to override a setting on an individual
basis.

Restrictions may be set at any level to enforce its usage. This is called a
policy. For example, it might be your company policy to always display
the unit of measurement in dimensions. Where a policy is in place, any
subsequent change made to the setting’s value at any other level is
ignored. Note that settings that will be ignored due to a higher level
policy setting are shown with a pink background.

The settings and values are saved to a settings.xml files in the
appropriate location. This means that settings files can easily be copied
between machines. If you want to use a project-specific settings file
with a different project, just copy the settings file to the location of that
project.
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1 On the File menu, click Preference Files.

The Preference Files Editor is displayed.
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For example:

Use the Categories pane on the left to choose which settings to list
in the Settings pane. To list all settings, click Settings in the
Categories pane.

The Settings pane contains a number of columns. The first column
shows the name of the setting. The remaining columns correspond
to those places where the preference may be defined. To see the full
path of the settings file associated with a column, point to the
column title with the mouse pointer.

Each cell in each row shows the value of the setting, in each
possible location. The value in a cell is shown as follows:

� bold value indicates an unsaved modified value

� grey, strikethrough value indicates an unsaved deleted value

� red value indicates a policy is in place

� Where a cell is empty, this means that the settings file does not
contain an entry for the setting.
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The cell background is also significant:

� where the cell background is unshaded, you can edit its value

� where the background is grey, you cannot change its value

This is probably because you do not have write access to the file.

� where the background is pink, you may make changes to the
value but it will be ignored because an overriding policy has
been set

2 Click in the cell whose value you want to set.

For a description of each setting, refer to Help.

If the cell does not currently have a set value, the cell shows the
setting’s default value. If you have access, you can edit the content
by doing one of the following:

� type the value and press Enter

� clear or select the check box

� select the value from the list

� click  to display a dialog box in which to set the value

� press Delete to delete the value

You can also drag a value to move it to another column or copy a
value by pressing Ctrl as you drag. Note that you can drag values
only into unshaded cells.
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In general, a preference is a setting that the user can alter, and a policy
defines a setting that they cannot. Any MicroGDS setting can be
defined as policy at any level. A policy is indicated in the Preference
Files Editor by showing its value in red and when the setting is selected
the ‘Is policy’ check box is selected. Later entries for the setting have a
pink background indicating that even if it has a value, that value will be
ignored. Users also cannot switch off its status as a policy rather than a
preference.

If you have write permission to the settings file in which the setting is
stored, you can set a value to be policy or unset an existing policy.
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Whenever you create a new document, MicroGDS copies the default
colours and dimension settings from the document defaults to the
document properties.

When you save a document, the current document defaults are saved
with the document. This enables you to have different settings, in
particular different colour allocations, for your documents without
affecting the default settings.

Note that if you create a new document from a template, the document
properties saved in the template are used for the new document.
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1 On the File menu, click Document Properties.

The Document Properties dialog box is displayed.

For example:

You can change the following settings:

� Origin
The origin is the position on the drawing sheet that you use as a
point of reference. By default, this is set at the centre of the
drawing sheet.



Chapter 17: Customizing MicroGDS 371

The drawing origin is described in Chapter 2, Exploring
MicroGDS.

� Colours
In MicroGDS, each phase is allocated a colour. The colour table
displays the colours to use for the phases in all new documents.
You can specify up to 256 colours for the document.

You can also copy the colour table in an individual document to
and from the document defaults, using the ‘Copy document
colours’ buttons.

� Dimensions
You can select or clear the following options:

— Use object scale: to show linear dimensions at the scale of
the object containing the dimension

— Use international thousands separator: to use your regional
settings in metric dimension text

— Show trailing zeros: display trailing zeros in measurements
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A profile contains a collection of screen layout settings, in particular
toolbars, other control bars, dialog box locations, window sizes and
column widths.

You can create and load specific profiles to suit different working
environments. The name of the current profile is shown on a status
toolbar. The default profile is called ‘current’; MicroGDS automatically
loads this on startup until you create or load a different profile.

Your screen layout settings are saved to your ‘current’ profile when you
exit MicroGDS.

Personal profiles are stored in the same location as your personal
settings files. This is the location shown in the Preference Files Editor
when you place the mouse pointer on the column title. Note that if you
copy profiles between machines, ensure that you copy them to this
location.
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1 On the Window menu, click Profile, Define.

The Customize dialog is displayed:

Use the dialog box to:

� customize the toolbars, flyout toolbars, and status bars

� choose the viewing buttons for MicroGDS windows and the
Navigate window

� set up shortcut key assignments for commands

� customize the menus and menu bar commands

You can also create a shortcut menu that appears when you click
the right mouse button.

All settings on the Customize dialog box reflect the settings of the
profile you are defining or modifying. For example, if the active
profile includes the Axes, Query, and Section toolbars, the
corresponding check boxes would be selected in the example above.

2 Make the changes you require, using any of the tabs.

Details on how to customize a profile are given in the following
subsections.

3 Click OK to save your changes.
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1 Set up the MicroGDS window accordingly.

2 On the Window menu, click Profile, Save As.

3 In the Save Profile As dialog box, select the location into which to
save the profile from the list.

Note that access to some locations may be restricted by your CAD
manager.

4 Type the name for the new profile and click OK.
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� from the Profile list on the status toolbar, select the profile

Alternatively, on the Window menu, click Profile, Select and then
click the name of the profile to use. If there are more than 10
profiles to choose from, click More to open the Select Profile dialog
box and then locate the profile you want.

If you no longer use a particular profile, you can delete it.
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1 On the Window menu, click Profile, Delete.

2 On the Delete Profile dialog box, selection the location from which
to delete the profile.

Note that access to some locations may be restricted by your CAD
manager.

3 Select the name of the profile to delete and click OK.
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You can create and customize toolbars (and status toolbars) by adding
and removing commands and status items.

You can customize only horizontal toolbars. To change the orientation
of a toolbar, press Shift and click on the toolbar border (or on its title
bar if undocked).

Note that you cannot change the orientation of a status toolbar. It is
recommended that you do not add status toolbar items to system
toolbars, as you will not be able to change their orientation at a later
time.
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1 On the Customize dialog box, click the Toolbars tab.

The available toolbars are listed, as shown in the illustration on
page 372. Note that if you are using MicroGDS Collaboration, an
Advanced Solids toolbar is also available.

MicroGDS system toolbars have (System) after their name; status
toolbars and toolbars that you create have (User). If you have any
toolbars created by an external API program, these have
(Application) after their name.

2 Select or clear the check box next to the Toolbar name.

You can change the size for the toolbar buttons and status toolbar
settings from the button size list. The default size for toolbar buttons is
Small (standard Windows size).
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1 On the Customize dialog box, click the Toolbars tab.

2 Click New.

The New Toolbar dialog box is displayed.

3 In the Toolbar name box, type a unique name for the new toolbar
(up to 32 alphanumeric characters), and then click OK.

The toolbar is added to the list, and an empty toolbar is displayed
undocked in the MicroGDS window. For example:

To add a button to a toolbar, click the Customize tab and drag the
buttons onto the toolbar, as described in the next section.
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1 On the Customize dialog box, click the Toolbars tab.

2 Select the user toolbar or status toolbar to rename.
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3 Click Rename.

The Rename Toolbar dialog box is displayed.

4 In the Toolbar name box, type a unique name for the toolbar (up to
32 alphanumeric characters), and click OK.
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� on the Customize dialog box, click the Customize tab

The Customize tab shows the toolbar categories in the left-hand list
and the commands from the selected category in the right-hand list.

For example:

Each list in the Commands box ends with a Separator. You can use
separators to organize toolbar commands into subsets.

Explanatory text for adding and removing toolbar buttons is given at
the bottom of the Customize tab. More details are given in Help.
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1 On the Customize dialog box, click the Flyouts tab.

The names of all available toolbars are listed in the dialog box.

2 Add, remove, and reposition flyout toolbars in the same way as
when you add, remove, and reposition buttons on a standard toolbar.
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1 On the Customize dialog box, click the Status bars tab.

The Status bars tab shows the names of available status items,
organized in alphabetical order. For example:

2 Add, remove, and reposition items on a status bar using a
drag-and-drop operation.

To add a text-only setting to a toolbar, drag the Label item onto a
toolbar, and then edit its contents, as described next.

3 To change the Label text or the width of an item displayed on a
status toolbar, click Edit.
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The Edit Status Item dialog box is displayed. Until you select a
status item to edit, the boxes in the dialog box are blank.

4 Click the item on the status toolbar whose properties you want to
edit.

MicroGDS displays details for the item you clicked in the Edit
Status Item dialog box.
For example:

5 Change the label and/or the width of the item, as applicable.

The details for the item are updated dynamically on the appropriate
status toolbar.

If you change the text of a label, the width is calculated
automatically. To add additional padding between a label and a list
box, click the list box on the toolbar and then increase the width for
that item.

6 When you have finished editing status items, click Done.
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You use the View Controls tab to specify:

� the viewing buttons to display on each view of a document window
and on the Navigate window for 2D and 3D views.

The buttons you choose for a 2D view are also displayed for a print
layout view. (Note that when you switch to print layout view, any
viewing buttons for commands that are not applicable in print layout
view are unavailable.)

You also set the orientation of the buttons.

� the zoom bar

� the scroll bars

� the 3D thumbwheels
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1 On the Customize dialog box, click the View Controls tab.

The view controls are listed with check boxes for each type of view
on which they can appear:

Note that where a view control is not appropriate to the Navigate
window, no check boxes are shown.

2 Switch the zoom controls on and off by selecting and clearing check
boxes as appropriate.

3 Choose the direction of the controls for all types of view by
selecting the orientation you prefer.
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By default, a number of MicroGDS commands are assigned a shortcut
key. For example, F2 is assigned to the Window Editor, and Ctrl+C is
assigned to the Copy command.

The default shortcut key assignments are set when you install
MicroGDS. You can, however, assign shortcut keys to any MicroGDS
menu-bar command, and change existing key assignments.
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1 On the Customize dialog box, click the Shortcuts tab.

A list of the MicroGDS menu names is shown in the Commands
box.

2 To display the commands, click the menu name or the plus sign (+).

3 In the Command box, select the command to which you want to
assign a shortcut key.

Any shortcut keys that are currently assigned to the selected
command are shown in the Key box. For example:

4 In the ‘Type new shortcut key here’ box, press the keys you want to
assign to the selected command.

If the key or key combination you press is already assigned to a
different command, the name of the command is shown under
‘Assigned to’.

5 To assign the shortcut key, click Add.

MicroGDS adds the shortcut key to the Key box and assigns the new
keyboard shortcut to the selected command. If the shortcut key is
currently assigned to any other command, the assignment is
removed.
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6 To remove a shortcut key assignment, select the shortcut key in the
Key box, and click Remove.

7 If you want to return all shortcut key assignments to their original
settings, click Reset All.
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You can customize the menus and menu commands that are available
from the MicroGDS menu bar.

� 3��	����&�2������&����

1 On the Customize dialog box, click the Menus tab.

The Menu box shows two entries:

� ‘Main menu’ contains the list of MicroGDS main menu names

� ‘Context menu’ enables you to add a shortcut menu to
MicroGDS that appears when you click the right mouse button

Initially, the Context menu is empty. You can add commands to
the menu, in the same way as for the main menus as detailed
below, and then rename or remove commands as required.
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2 To customize a menu, click the plus sign next to ‘Main menu’.

The MicroGDS main menu names are listed, with each menu
command and submenu command shown below:

The ampersands (&) indicate that the next letter is underlined, to
provide a shortcut for the menu or command. This enables you to
press Alt+key as a shortcut to a menu and key as a shortcut to a
command.

To display the commands, double-click the menu name, or click the
plus sign (+) to the left.

By default, the ‘Additional entries’ box contains a menu divider and
a sub-menu item. If any custom commands have been made
available to the profile you are editing, these are also listed. How to
define custom commands is described on page 395.

3 Do any of the following:

� To move a menu or menu command, drag the item to its new
location.

If you move a default menu item, MicroGDS places a copy in
the new location and marks the original item with . Menus and
commands marked with a cross do not appear in MicroGDS. If
you want to retain the original item, press Ctrl as you drag the
item.

If you move a non-default menu item, MicroGDS marks the item
with
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� To rename a menu or menu command

a) Select the item to rename and click the mouse button.

b) Amend the name and press Enter

Note that if you change an Alt+key assignment, ensure that
the letter you assign is unique within the menu. Otherwise,
the command will not be called by the key combination.

MicroGDS marks the renamed item with

� To add a defined custom command, drag the item from the
‘Additional entries’ box to the menu location at which it should
appear

� To delete a menu or menu command, select the item and click
Delete

MicroGDS marks the item with . Note that the item is not
actually deleted, but will no longer be shown in the MicroGDS
window.

� To return a menu or command to its original state, select the item
and click Revert.
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MicroGDS provides a set of default behaviours for the BIM (Building
Information Modelling) environment. These behaviours enable you to
create BIM intelligent objects using predefined components, including
objectstyles and drawing styles.

You can customize the BIM environment in a number of ways. You can:

� create your own objectstyles

� specify your own object naming conventions

� use an object name assistant

� change the mnemonic definitions

For details about using the MicroGDS BIM intelligent objects, see
Chapter 3, Working with primitives and objects.
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An objectstyle describes the properties of an intelligent object. If you
want to change some of those properties, you can do this by changing
the value of the appropriate attribute of the object on the Properties
window. For example, you could change a single-panel door to a
double-panel door. However, if you find that you are frequently using a
particular set of attribute values, you can set these up as a new
objectstyle.

For example:

1 On the Styles tab of the Document Organizer, expand the Schemas
folder and then expand the ..\bim location.

2 Right-click the Door schema and select ‘New based upon’ from the
shortcut menu.

3 From the Mnemonic list:

a) select the ‘Operation type’ attribute and select
DOUBLE–DOOR–SINGLE_SWING from the list

b) select the ‘Overall width’ attribute and change the value to
2000mm

4 Click Save As and save the schema as ‘Double door’.

The objectstyle ‘Double door’ is now available for all appropriate
objects.
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In MicroGDS, the default naming convention for BIM intelligent
objects is to suffix the first facet of the object name with Ifc (Industry
Foundation Classes). For example, a window object is suffixed by
IfcWindow and a door object is suffixed by IfcDoor.

However, if you already have an existing naming convention for the
names for door objects, you can modify the objects for which a schema
applies using the Define/Edit Schema dialog boxes. For example,
suppose your door naming convention is Floor1:Door, you could
change the ‘Applies to’ filter for the door schemas to ‘*:Door**’ to
match this convention. MicroGDS uses this ‘Applies to’ information  to
restrict the schemas that are available as Objectstyles on the Properties
window.
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For details about defining and editing schemas, see Chapter 14, Working
with attributes and schemas.
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With the exception of a mnemonic’s Applicability, Name and Type, you
can modify any other property of BIM mnemonic definitions. For
example, you may want to change the Units of a Length mnemonic
from mm to inches. Note that if you change the Prompt of a BIM
mnemonic, your preferred name will be shown in the Properties
window for that attribute.

For details about creating and editing mnemonic definitions, see
Chapter 14, Working with attributes and schemas.
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An object name assistant is a configuration file that defines the names
that can be used for objects, in a list of rules. When you work with
intelligent objects, you can simplify the process of assigning suitable
objectstyles to new intelligent objects by assigning the objectstyle to
automatically. For more details, see Object and layer name assistants on
page 387.
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MicroGDS provides a number of BIM components such as walls, doors,
and windows. However, if you want to make an opening in a wall for an
object of your own design, then you can define your own component.

You can do this using the predefined objectstyle named UserOpening.
This might be used, for example:

� to draw a door or window yourself rather than using the  supplied
parametric objects

� to use a door or window object from a catalogue

� or to create a completely new opening, such as a curved arch for
positioning in a garden wall

The UserOpening objectstyle is not limited to making a small opening,
but could be used  to slice the whole top from a wall, say to bring it up
to a sloping roof.
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To use the UserOpening component supplied with MicroGDS, you need
access to the defined linestyles, mnemonic, and schemas that are
associated to the MicroGDS BIM components. To do this, add the
following entry to the document’s style search path:

<*MICROGDS_COMMON_APPDATA>bim

The files in this location make the intelligent objects and drawings
available.

This entry must be added to any document which includes or references
a BIM intelligent object.

The basic procedure for defining a new BIM component is:

1 Set the style search path of your document to include the bim
location (as shown above).

2 Create a new object and name it UserOpening.

3 On the Properties window, set the Objectstyle to UserOpening.

The associated UserOpening schema adds the appropriate attributes
to the Properties window. These will be shown when you draw the
object’s primitives.

4 Draw the graphics that constitute the visible representations of the
object.

These need to include each primitive that will be shown in the
various drawing styles. For example, some primitives will be shown
only in Detail view while others shown only in Perspective view.

The user opening object may also need to contain mask primitives
(an opaque, filled linestyle), for example so that certain primitives
are drawn only in 2D views.

You also need to create cutter clumps which cut through the wall to
create the opening. Cutters are removed from the wall in which the
BIM object is placed. Note that a primitive will be treated as a cutter
by assigning the appropriate attribute to it (more details are given
below.)

5 On the Properties window, assign a value to the primitive level
attribute IOIRepresentations (shown in the window as
‘Representations for primitive’) for each primitive in the object.
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You assign one or more values to define in which views the
primitive will be shown:

D the primitive will be visible in a Detail or Ceiling drawing

E the primitive will be visible in an Elevation drawing

G the primitive will be visible in a GA drawing

P the primitive will be visible in a Perspective drawing

M the primitive will be visible when its object (and no other) is

selected

The example below shows how you could assign attribute values to
the primitives of a door to show different representations of the
door:

Note that the door swing,
also drawn in red, is
assigned DG.

The door primitives have been drawn in the colours shown in the
key above, and are assigned the following IOIRepresentations
values. (If you have the monochrome printed version of this guide,
please refer to the full-colour version in the topic Defining new BIM
components in MicroGDS Help.)

If your UserOpening is solely a cutter which does not have any
graphics of its own, such as an arch, ensure that you assign a value
that will keep the primitive visible as you work on it. For example,
if you assign MP to the arch primitive, it will be visible when its
object is selected and also when in a perspective view. You could
also add a mask rectangle to the object and assign a value of G, for
example, so that you can select the object in GA drawing type.
If you do not assign a value to an IOIRepresentations attribute, then
that primitive is invisible in all drawing types.
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If a primitive does not have an IOIRepresentations attribute (for
example, if it has been deleted from the UserOpening schema), then
that primitive is visible in all drawing types.

6 On the Properties window, assign the primitive level attribute
IOICutter (shown in the Properties window as ‘Primitive is a
cutter’) to your cutter clump primitives.

This can be any value, such as True or Yes; it is simply the existence
of the attribute having a value that causes  the primitive to be treated
as a cutter

7 You can now place the object, or a copy of it, using a snap on the
wall in which to create the opening.

�-���&���&�����
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The following sections are intended for the CAD manager or system
administrator who should be experienced in setting up and maintaining
configuration files.

In MicroGDS, configuration files can be set up to control:

� the object and layer name assistants

� the settings files and search list

� the strings and corresponding scales available through the Scale list
on the status toolbar

� the strings and corresponding angles available through the Angle list
on the status toolbar

� the paper to be used for print layout views

This section also:

� describes how to add custom commands to the MicroGDS menus

� introduces you to the sample Visual Basic and Visual Basic .NET
programs supplied with MicroGDS

�()�	������#�-�
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Name assistants use configuration files to define naming standards for
layers and objects. They enable users to create layers and objects whose
names conform to the naming standards in use at their site.
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Layers and objects have separate configuration files. The files and rules
they use are almost identical. However, the object name configuration
file takes the layer names defined in the layer name configuration file
into account.

Two sample files are supplied with MicroGDS:

� assistl.cfg is the sample layer configuration file

� assisto.cfg is the sample object configuration file

These sample files are automatically specified on the Name Assistants
tab in the user’s Preferences dialog box. You can change, rename, and
move the files, but we recommend that you retain the cfg (configuration
file) extension.

If you move the files, you should also change their location defined on
the Name Assistants tab in your preferences.
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The name assistants are presented as an expanding tree structure that
enables a name to be built up. The expansion process is controlled by
the configuration file. The file contains a main group of names,
followed by a set of rules. Each rule is made up of components
separated by | characters. These components are the condition, the
expansion, the description, and an optional layer label.
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The condition controls whether or not the rule is applicable. If the name
so far built up in the dialog box matches the condition, the rule is
applicable.

The following wildcards have special meaning within the condition:

� ? matches any single character other than a colon

� * matches any number of characters, including 0, other than a colon

� ** matches any number of characters, including 0, and including a
colon

A colon is used to separate facets in object names.

Although wildcards can be very useful, use them with care. For
example, if you end a condition with an asterisk (to match any number
of characters), the condition will match itself and could cause a loop.
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The expansion is the text that is added to the name when the rule is
selected.

If you want to allow a name that ends with this text to be an acceptable,
valid name, append a tilde to the expansion text. The tilde is not
appended to the entered text.

If your drawings use or reference BIM intelligent objects, you can
associate an objectstyle with an object by appending the name of the
objectstyle in parentheses to the expansion.

In MicroGDS, the expansion for layer names in multi-user projects can
also use aliases to define the location in which a layer of a particular
name must be stored. For full details, see Chapter 16, Multi-user
projects.

&�������������


The description is the text that is displayed in the name assistant dialog
box. It identifies the expansion.

When a name is complete, if there are further applicable rules, the name
can be extended further.

Note that for object names, a single rule selection does not necessarily
correspond to a single facet in the name. The expansion must contain a
colon (:) to finish a facet.
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The layer label is optional and, if defined, is the text that is added to
any new layer that conforms to the Layer Name Assistant. The label
applies only to a the Layer Name Assistant; if added to the Object
Name Assistant, it will be ignored.

7� ���� �
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When a user creates a layer or an object, and the name assistants are
both in use, MicroGDS carries out the following procedure:

1 First, MicroGDS reads the associated configuration file and presents
the user with a list of entries defined in the file.

2 Each time the user selects an entry, the expansion text is read from
the configuration file and is added to the Name box.
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If the user expands an entry, MicroGDS reads the condition for the
entry and scans the configuration file for the expansions and lists
their descriptions.

For example:

3 This is repeated until no further name components are applicable.

When a name meets the valid naming rules, the OK button is
enabled.

In the previous example, the rule in the sample layer configuration file
that produced the name shown is:

?–|ELEV~|Elevation

and represents ‘Interior Design, Elevation’.
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The layer configuration file has two sections. The first section defines
the top-level naming structure. Each entry has only two components,
the expansion text and the description.

For example:

|ARCH–|Architectural

|ELEC–|Electrical

|STRU–|Structural

produces three layer entries in the dialog box.

The second section of the file lists the rules that define the possible
expansions of each layer.

ARCH–|WALL~|Walls

ARCH–|FLOOR~|Floors

ELEC–|POWER~|Power installation|Sockets

ELEC–|LIGHT~|Lighting installation|Lighting
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STRU–|COLUMN~|Columns

STRU–|FOUNDS~|Foundations

????–|ANNO~|Annotation

Selecting, for example, Electrical in the Layer Name dialog box inserts
the expansion text ELEC in the Name box. MicroGDS scans the
configuration file for any matching conditions and lists the descriptions
of each below, in alphabetical order.

In the example file, Annotation appears beneath each main entry. This is
because the condition matches all three main entries.

Selecting Power installation in the list inserts the expansion text
POWER in the Name box and Sockets in the Label box:

3����()�	��	��0���
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The object configuration file is similar in format to the layer
configuration file. The difference is that object names are facetted, and
the first facet in the object name is the name of the layer on which it is
valid, and the last character of the object name must be a colon (:) if it is
to be treated as completing a facet.

For example:

????–ANNO–????:|anno:~|Annotation

enables the user to create an annotation object on any layer that contains
the text —ANNO—.
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Furthermore, the rules:

ELEC–L*:|LIGHTC:~|Ceiling lights

ELEC–L*:|LIGHTW:~|Wall lights

ELEC–L*:|LIGHTE:~|External lights

mean that all objects on layers beginning with ELEC–L can have a first
facet of LIGHTC:, LIGHTW, or LIGHTE:

The rule:

ELEC–*:LIGHT?:|SPOT:~|Spotlights

means that all objects on layers beginning with ELEC–, which have a
first facet matching LIGHT?, can have a second facet of SPOT,
indicating that it represents a spotlight. The resultant object names
could be LIGHTC:SPOT:, LIGHTW:SPOT:, or LIGHTE:SPOT:

If a rule is defining the names for intelligent objects, you can specify
which objectstyle should be automatically selected on the Properties
window. For example:

IfcWallStandardCase:~(Brick-Cavity-Block)|Standard External Cavity
Wall

means that IfcWallStandardCase: is the object name, then
Brick-Cavity-Block will be set as the objectstyle when the description
Standard External Cavity Wall is selected.
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Before you create or amend a layer or object configuration file, take
some time to familiarize yourself with the format and content of such a
file. You could make a copy of one of the supplied configuration files
before making changes so that you can always go back to the default
version.

Before you set up the name assistants, plan the rules first. Take into
account that the expansion text makes up the name, and that a name can
consist of up to 256 characters.

When you write the rules, the following conventions apply:

� each rule must be written on a separate line

� condition and expansion texts are case sensitive

Although it is clearer to write the rules in a structured way, their order is
not important. MicroGDS displays the matching entries in the dialog
box in alphabetical order based on the description text.
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The object name configuration file takes the layer names defined in the
layer name configuration file into account. Therefore, if you plan to use
both layer and object name assistants the two configuration files should
correspond.
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1 Using a text editor, create or edit the relevant name assistant
configuration file.

2 Save the file to a preferred location, using a name of your choice
and preferably maintaining the cfg extension.
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1 Start MicroGDS and, on the File menu, click Preferences.

MicroGDS displays the Preferences dialog box.

2 Click the Name Assistants tab and specify the name of the
configuration file in the appropriate Configuration File box, and set
the applicability required.

For details of the applicability levels, refer to Help.
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When you start MicroGDS, the initial settings which control the look
and feel are read from two files: a settings file called settings.xml and a
profile file which has a .mprofile extension. Further files may then be
read which may make changes to the appearance and behaviour of
MicroGDS.

The files which affect this behaviour are searched for in a particular
order. Modifications may be made at each stage within the search list:

� MicroGDS first looks for a settings.xml file in the same folder as the
microgds.exe program

This file can alter some of the default values or prevent later settings
files from altering them. In general, this file should not be modified
and any future patches or repairs to your MicroGDS installation are
likely to discard any modifications.

� MicroGDS then looks in your system registry for the location of a
settings.xml file that is shared by all users who log on to your
machine, or by all users across your Windows network domain:
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— if the registry key
HKEY_CURRENT_USER\Software\Policies\Informatix\MicroGDS\11.0

exists and has a String Value of Settings, it should be a string
defining a directory

— if this key does not exist, and if registry key
HKEY_CURRENT_USER\Software\Informatix\MicroGDS\11.0 exists and
has a String Value of Settings, it should be a string defining a
directory

If neither registry value exists, MicroGDS uses a subdirectory called
Informatix\MicroGDS\11.0 in your computer’s special folder
CSIDL_COMMON_APPDATA. On Windows XP, this is typically
C:\Documents and Settings\All Users\Application Data and on
Windows Vista, this is typically C:\ProgramData.

For example:

Note that setting up these registry values are currently the only way
to configure any part of the search list. However, this can be set for
some or all machines by the system administrator using Group
Policies.

When a settings.xml file is found, MicroGDS merges configuration
instructions with the results of applying the previous file.

� MicroGDS then looks for a job-specific settings.xml file in a
CONFIG subdirectory immediately below the folder that contains
the related MicroGDS document.

For example:
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In this example, whenever Document1.MAN, Document2.MAN, or
documentA.MAN is opened in MicroGDS, its document settings are
read from the settings.xml file.

Anyone with write access to a job folder can create a CONFIG
folder. When a job-specific setting is modified in MicroGDS, the
settings.xml file is then automatically created.

� Finally, after MicroGDS has searched all the job-specific
settings.xml files, it looks in your personal directory (for example,
C:\Documents and Settings\Lesley\Application
Data\Informatix\MicroGDS 11.0\settings.xml.
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You can define custom commands that can then be added to MicroGDS.
When you define a new command, you can choose the product and
context in which it should be available. For example, you can specify
that a command is available only in MicroGDS Entry Level and then
only when the current file is single-user and there is an active window
definition. You can also specify that a command is added to a shortcut
menu that appears when you click the right mouse button.
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1 On the File menu, click Preference Files.

2 On the Preference Files Editor, locate the ‘Custom command
definitions’ setting.

You can find this setting under the General category.

3 Click the corresponding cell under the column to customize and then
click 

4 MicroGDS displays the Custom Command Definitions dialog box.

5 Do any of the following:

� To add a new custom command:

a) Click Add.

b) Select the newly added command line, and then click 

MicroGDS displays the Define Custom Command dialog
box.
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� To modify an existing custom command, select the custom
command and then click 

MicroGDS displays the Define Custom Command dialog box.

� To remove a custom command, select the custom command and
then click Remove.

6 If you are adding or modifying a custom command, specify the
command details and click OK.

For details about specifying the command details, refer to Help.

You can add any custom commands that you define to your MicroGDS
menus.
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When you change the axes’ scale on the status toolbar, MicroGDS uses
a scales file to determine the strings and corresponding scales. You
specify the scales file to be used in your File Location preferences.
Scales files have the extension .csv.

MicroGDS supplies a sample scales file called scales.csv. You can
change, rename, and move the file, but we recommend that you retain
the csv extension. If you change the location of the file, ensure that you
redefine the path in your preferences.

Scales files are in the format:

string, scale numerator, scale denominator

For example:

1:1,1,1

1:20,1,20

1:75,1,75

”1”” = 1”””,1,1

”3”” = 1‘”, 1, 4

”1”” = 1‘”, 1, 12

Note that MicroGDS uses the scales file in a number of other places.
For example, on the Photo Transform dialog box when you construct a
photo from a 2D view or a 3D parallel view. For details about working
with photos, refer to Help.

For more details on the format of the file, refer to Help.
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When you rotate the axes, graphics are drawn using the current axes’
rotation. You can change the angle of the axes, using the Angle box on
the status toolbar or the Axes Angle command, so that all new graphics
are aligned with the new angle.

When you set the angle, MicroGDS uses an angles file to determine the
strings and corresponding angles. You specify the angles file to be used
in your preferences. Angles files have the extension .csv.

MicroGDS supplies a sample angles file called angles.csv. You can
change, rename, and move the file, but you must retain the csv
extension for the file to be recognized. If you change the location of the
file, ensure that you redefine the path in your preferences.

Angles files are in the format:

string, angle value

For example:

–90,–90d

–60,–60d

–45,–45d

–30,–30d

0,0d

30,30d

45,45d

60,60d

Note that MicroGDS uses the angles file in a number of other places.
For example, when you define snap guide angles on the Snapping tab of
the Preferences dialog box.

For more details on the format of the file, refer to Help.
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The first time that you select a print layout view for a window
definition, MicroGDS displays the Page Setup dialog box for you to set
your paper size requirements. MicroGDS uses a paper sizes file to
determine the paper names and corresponding sizes. You specify the
paper sizes file to be used in your File Location preferences. Paper sizes
files have the extension .csv.
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MicroGDS supplies a sample paper sizes file called ‘paper sizes.csv’.
You can change, rename, and move the file, but we recommend that you
retain the csv extension. If you change the location of the paper sizes
file, ensure that you redefine the path in your preferences.

Paper sizes files are in the format:

name of paper, unit of measurement, paper width and height, paper
margins

ISO A4 (297 by 210 mm),mm,297,210,10,10,10,10
ISO A3 (420 by 297 mm),mm,420,297,10,10,10,10
ISO A2 (594 by 420 mm),mm,594,420,10,10,10,10
ISO A1 (841 by 594 mm),mm,841,594,10,10,10,10,DEFAULT
”ANSI A (Letter, 11 by 8.5 inches)”,inches,11,8.5,0.5,0.5,0.5,0.5
ANSI B (17 by 11 inches),inches,17,11,0.5,0.5,0.5,0.5
ANSI C (22 by 17 inches),inches,22,17,0.5,0.5,0.5,0.5

and so on.

The default paper size initially selected in the dialog box is indicated by
the word DEFAULT at the end of the definition

For more details on the format of the file, refer to Help.

When you have assigned a paper sizes file to a window definition,
MicroGDS uses the paper definition that you set up when you next
switch to print layout. The paper definition is saved with the window
definition when you save the document.

For details about print layout views, see Chapter 2, Exploring
MicroGDS.
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A number of sample Visual Basic and .NET programs are supplied with
MicroGDS. You can use them as they are, you can amend or extend
them, or you can simply look at them to give you ideas for
programming using Visual Basic or Visual Studio .NET.

You can access the programs from your MicroGDS Applications menu
on the Start menu. Each program has a corresponding document that
tells you how to use the program.
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If you use any programs regularly, you can add them to a new menu so
that they are available from the MicroGDS menu bar. Details about
adding and removing menus and commands are given in Defining
custom commands on page 395.

The sample Visual Basic programs are not a supported part of the
MicroGDS system.
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MicroGDS provides 3D commands that you can use to construct and
edit clumps. In MicroGDS Collaboration, you have access to many
more advanced 3D facilities to create and modify clumps.

This chapter shows some of the different types of clumps that you can
construct using the advanced 3D commands. Step-by-step instructions
on how to construct clumps and details about each of the clump
commands are given in Help.

For information about working with clumps and details on the 3D
facilities that are available in all MicroGDS products, see Chapter 9,
Working in 3D in Part One: Working with MicroGDS 11. You can also
refer to Help.
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MicroGDS Collaboration offers a number of additional methods for you
to create clumps. You can:

� automatically construct simple 3D clumps (using the Solid,
Construct commands)

� create clumps by revolving graphics using specified angles and
positions (using the Solid, Construct commands)

� use existing line primitives to create mesh clumps with surfaces
(using the Solid Patch and Solid Rule Surface commands)

�����
�	�������&�#��%��
����	�

MicroGDS Collaboration provides commands to generate cones,
cuboids, cylinders, and spheres.
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When you create a cone, cuboid, or cylinder, you can specify the
dimensions of the cuboid by:

� clicking the positions in the window

� typing the coordinates at the prompt bar

� or pressing Enter to enter the sizes in a dialog box

Note that X, Y and Z sizes in the dialog boxes take precedence over
snaps and coordinates. If you do not want to use exact dimensions,
ensure that the sizes are set to ‘Use Snaps’ in the dialog box.

When you create a sphere, you enter the radius for the sphere and then
place the sphere by clicking in the window or typing coordinates.

For full details on generating simple 3D graphics, refer to Help.
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As an alternative to creating clumps using the Complete Revolve
command, you can also revolve graphics:

� from one angle through to another

.���	��	�*��*��� G�*��*�����	��:=+°����������;+°

� or, from a specified position, through a specified angle about the Y
axis
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8-°
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The angle through which the graphics are revolved is measured from
the X axis.

The graphics you revolve should be in the XY plane and must not cross
the Y axis.
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With all revolve commands:

� each closed line primitive forms a solid clump

� each open line primitive forms a mesh clump

By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.

Except when revolving through 360°, if you revolve multiple, closed
line primitives that are nested, holes are created in the enclosing clump.
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You can construct a mesh clump from existing line primitives. You can:

� create a surface between two line primitives
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By default, MicroGDS creates a patched surface with evenly
distributed quadrilateral faces (as shown above). If preferred, you
can choose to create long quadrilateral faces instead.

If the line primitives are closed, the position at which you select
each primitive will define the start point of the edge. For example, if
the primitives are one above the other, select them by points that are
directly one above the other to avoid creating a twisted surface.

If the line primitives are open, MicroGDS creates the surface rule by
drawing between the start points of each line. The direction of open
line primitives is therefore important.
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� or, create a surface from three or four bounding line primitives
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Lines can be curved and they can consist of more than one line
segment.

The lines must be touching—forming a closed boundary—but they
must not be sides of a closed line primitive (for example, as created
by the Rectangle command).

If four lines were selected, a quad-face surface is generated with
points interpolated between opposite pairs of boundary lines; if three
lines were selected, a triangular-face surface is generated with points
interpolated evenly between the three boundary lines.

!�������	#�&��
MicroGDS Collaboration offers a number of additional commands for
you to edit existing clumps. You can:

� use Boolean commands to alter solid clumps

� add and edit clump faces

� change the geometry of clumps for import and export
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The Boolean operations enable you to add or subtract volumes from
clumps. The volume is the space occupied by the content of a 3D object
or primitive. You can use the Volume command on the Query menu to
measure the volume of a clump. For more details about the query
commands, see Chapter 13, Getting information.

Using the Boolean operations, you can:

� add or subtract a number of clumps from another clump (the
workpiece)

� subtract or intersect a clump with the clumps currently selected
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� check a selection of clumps for clashes, and create new graphics
along their clash lines

� create pockets in a clump, and profiles from a clump

� punch holes in a clump, and carve a shape from a clump

� slice clumps along the XY plane, and choose to remove either the
section above or below the plane

� slice clumps between the XY plane, and remove both the sections
above and below the plane

In Boolean operations, the workpiece is the clump on which
modifications will be made. The workpiece must be a solid clump. The
selection can be one or more solid clumps that are used when making
those modifications.
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When you edit the workpiece, the clumps that are being added or
subtracted must intersect the workpiece. You can:

� add solid clumps to the workpiece
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� or, subtract solid clumps from the workpiece
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By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.
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When you edit the selection, you can:

� subtract a solid clump from a selection of other solid clumps
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� create a new solid clump from the intersection between one solid
clump and a selection of other solid clumps
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By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.
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You can compare a selection of solid clumps and create new graphics
along their clash lines.
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If a clash is encountered, MicroGDS creates new graphics along the
clash lines (represented above by the thick lines). The original clumps
are automatically deselected, leaving only the new graphics selected.
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You can create a pocket in a clump, or create a profile from a solid
clump. You use an existing closed line primitive to define the shape of
the pocket or profile.

The difference between a pocket and a profile is that a pocket removes
the solid volume inside the defined outline, whereas a profile removes
the solid volume outside the defined outline.

If the line primitive is not in the XY plane, it is shadowed onto the XY
plane.
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The clump now has a pocket, carved downwards from the positive Z
direction, to a specified depth.
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By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.
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You can carve away the outside of a clump, or you can create a hole all
the way through a clump. To define the shape of the carving or hole,
you use an existing closed line primitive.
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If the line primitive is not in the XY plane, it is shadowed onto the XY
plane.
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The clump is carved downwards from the positive Z direction, to a
specified depth.
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By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the command.
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In addition to the slice command which enables you to divide a clump
into smaller, separate clumps, you can:

� divide a clump into two sections and delete either the top or the
bottom section

For example:
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In this example, the construction line was used to move the axes
accurately thereby defining the precise angle of the slice.

If you slice a solid clump, the cut surfaces are closed to make new
solid clumps. If you slice a mesh clump, the cut surfaces remain
open to create new mesh clumps.

� ‘slice between’ a clump to leave an XY section between the top and
bottom, removing both the top and bottom sections.

For example:

.���	��������� (���	��������

By default, the original graphics are replaced by the new clumps. To
retain the original graphics, press Ctrl when you select the
command.
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MicroGDS provides a number of face commands which enable you to
edit clump faces, edges, and vertices. You can:

� add a new face to or between existing clumps
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You can add a face in three ways:

— draw a face in free space

— draw a face which joins onto open edges of mesh clumps, or
spans between several mesh clumps

— bridge a gap between open edges of a single mesh clump
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� delete a clump face
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If you delete a face on a solid clump, it becomes a mesh clump. If
you delete a face from a mesh clump, the resulting clumps form one
or more mesh clumps.

� extrude one or more clump faces
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The extrusion is constrained to the last face selected. You can press
Tab to toggle between a constrained and unconstrained direction.

� merge faces by removing edges or vertices
*�	��'�����	��
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If you select an edge of a mesh clump, the edge between the faces is
removed, and the faces either side are combined. If you select a
vertex, all edges passing through the vertex are merged.

If you merge faces on a solid clump, it remains a solid clump.
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� move one or more faces
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The movement is constrained to the last face selected. You can press
Tab to toggle between a constrained and unconstrained direction.

� split a face in two or create a hole in a face

You might split a face, for example, to then extrude:
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You can split a face in two ways:

— split across a face, starting and ending on edges

— split off a closed area inside a face, creating a new nested face

� mesh (or triangulate) a face or a group of faces

You might mesh a face or surface, for example, to import or export
documents into third-party applications.
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A surface is a region of a clump that is connected to a face by
smooth edges, and which share the same material.
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The face is meshed as follows:

— if the face, or any of the faces of the surface, are not triangular,
then break all non-triangles into triangles

— if the face, or all of the surfaces, are triangular, sub-divide the
triangles into smaller triangles

The boundary of the face or surface made by the division or
sub-division is left unchanged—all splits are made within the
surface.

If a surface being meshed is adjacent to a surface that is already
triangular, the new meshing does not split sides of any adjacent
triangles.
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If you are working with documents that you import or export into
third-party applications, you may need to change some of the geometry
of clumps.

MicroGDS Collaboration provides the following commands that enable
you to prepare a document for import or export:

� Mesh Clump subdivides each face of a clump into triangular faces:
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� Quad Faces splits each face of a clump so that each face has a
maximum of four sides:

.���	� (���	

� Remove Holes removes holes from clumps by joining loops and
splitting faces:
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You access these commands on the Solid, Clump menu. For more
details on how to use the commands, refer to Help.
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Both MicroGDS Entry Level and Collaboration provide two Shaded
views as fast and simple ways of producing images from 3D models.
Shaded images appear in the current window definition. MicroGDS
Collaboration users may find this view useful for previewing an image
quickly, and for editing graphics.

For details about using the Shaded 3D view commands, refer to
Chapter 9, Working in 3D.

MicroGDS Collaboration provide a full range of 3D enhancing tools
and rendering capabilities to create realistic, sophisticated images.
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For example, you can create an object, view it in 2D and in 3D, and
render it to create a finished, photo-realistic image:
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Rendered images appear in a separate window alongside other window
definitions.

The renderer applies any materials and lighting you have set up, and
environment settings such as foreground and background shaders.

You can also add an image to the background, for example, to show a
scene through a window, or to give an impression of an outdoor scene.
These combined facilities enable you to create realistic, real-world
scenes.

In MicroGDS, although you can render any simple 3D object, rendering
a 3D object in isolated space can give very different results to rendering
the same object in a scene. This is because objects reflect the colours,
shapes, lights, and so on, of their surroundings, whereas objects in space
do not have any objects to reflect.

In the first illustration, a simple chrome sphere is shown suspended in
space. Very little reflection or light appears in the image. In the second
illustration, the sphere is part of a larger scene resulting in reflections,
shadows, colours and so on.
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For details about creating 3D graphics, and creating and assigning
materials and lights, see the following chapters and also refer to Help:

� Chapter 9, Working in 3D

� Chapter 18, Advanced 3D

� Chapter 20, Advanced lightstyles

� Chapter 21, Advanced materials

5����
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When you render a scene, the type of rendering is determined by a
number of render options.

You can render a model using simple ray-tracing or advanced global
illumination. Ray-tracing is a technique that models the path taken by
light by following rays of light as they interact with surfaces. Global
Illumination is a term for rendering with light processed for the whole
model, rather than just the visible pixels. Specifically, it deals with the
reflection and re-reflection of diffuse light. This produces soft lighting,
and a general ambience.

Look at the examples below. Notice how some surfaces in the ray traced
model are barely reached by the lighting effects, such as the floor and
any cabinets that are edge-on. Compare with the global illumination
model to see here how the light now bounces off all visible surfaces to
create truly realistic lighting:

	����	���������	����	����� 	����	���������������������������
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Two global illumination technologies are provided, which can be used
independently, but work best together.

� Radiosity

Radiosity is a physical solution to the inter-reflection of light
(radiant energy), by dividing modelled faces into triangles. Light
from the primary light sources is shot from the sources to all
triangles that it can reach without being blocked. Each triangle then
re-radiates its diffuse reflected light. The process repeats and iterates
towards a solution.

This is a global solution of the light energy throughout the whole
model, seen and unseen parts alike.

Note that radiosity alone can be very slow to produce good results.

� Final gather

Final gather adds a final stage of lighting, where each visible surface
pixel casts out rays to other surfaces (which have been lit). The
diffuse light from those end-of-ray patches becomes the gathered
diffuse lighting for the surface pixel. The calculation of lighting
values is restricted to visible points in the image. Final gather works
best when it has a radiosity solution to work from.

With appropriate radiosity and final gather settings, accurate and
well-lit images can be produced very quickly.
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It is important that you plan your lighting so that you do not
inadvertently overload the renderer with unnecessary detail. As an
example, before you place numerous lights in a large open-plan office,
and turn up the rendering quality and begin rendering, first stop and
think about what you expect from your model.

Consider whether the scene is an indoor or outdoor scene, is it a
daytime interior with light coming from outdoors or is it lit wholly
using interior lights? Since you’ll be asking for more processing for
lights, can parts of the geometry be simplified and still achieve a
reasonable effect? Will all lights be seen in full detail or can simpler
substitutes be used in far corners?

It is also worth planning the layer structure of the model so that lights
can be flipped on and off (separately from the light fixture), and placing
the basic framework of walls, ceiling, and floors on separate layers from
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the room contents. You can then make fast renderings to experiment
with different lights and see how radiosity lets the light ‘flood’ around
the room.

Interior lights use lighting objects and the built-in ‘real-world’ lights (or
custom lights).

Exterior lighting is most easily set up on the Render Environment
dialog box: the ‘weather-based’ styles built into MicroGDS provide a
number of simple scenarios which combine sun and sky lights, a basic
background and an appropriate exposure setting for outdoor scenes.
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You can render any 3D graphic, from a clump with a single face to a
complex, detailed scene. If you have not created any materials, lighting,
and so on, the renderer will use the defaults in MicroGDS.

Note that achieving the correct lighting may take several adjustments
before you are completely happy with the results, so we suggest that
you always start with the low quality render settings and make
unimportant layers invisible. Then gradually increase the settings and
bring in the rest of the model for the final rendering.

When you render an image, the image appears in a separate window at a
predetermined width and height. You can change the render image size
using the Renderer tab on the Preferences dialog box. For full details,
refer to Help.

The basic steps of rendering are given below.
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1 If necessary, on the View menu, click 3D to switch to 3D view.

2 On the Window menu, click View Parameters and select the
projection you require.

3 Use the commands on the View menu to set up the view to be
rendered.

4 To create an environment around your rendered graphics, on the
Render menu, click Edit Environment, then choose the shaders you
require.
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The environment defines the environment around the world, for
example images in front of, behind, or around the model, plus
external lighting (sun or sky), and exposure control.

For more details about each type of shader, see Setting up a
rendering environment on page 432.

5 To select rendering options, on the Render menu, click Options and
then select the settings you require.

The model is rendered using the current quality mode. Good image
quality is recommended as it produces generally high quality images
in a relatively short time.

For details about each quality mode, see Choosing a render image
quality on page 424.

To use radiosity and global illumination, select the appropriate
check box and then set up the level of detail you require.

6 On the Render Options dialog box, click Render Now.

This updates the environment, geometry, lights, and the view.

The image being rendered is displayed in a separate window, of a
size defined in your preferences. MicroGDS initially shows a
blocky, limited image, then progressively refines the image until it is
fully rendered. The progress of the rendering is displayed in the
Render Progress dialog box. The number of steps in a render varies
according to the options you have chosen.

When the Render window is open, you can double-click in the
window as a shortcut to re-rendering the image.

If you change the view associated with the Render window using the
View Parameters dialog box and apply the changes, the rendered
image is automatically re-rendered. Note, however, that the view
parameter changes are applied to the active window, therefore if the
active window is not the Render window, the image is not
re-rendered.

Depending on the complexity of the drawing, rendering may take some
time if you are using one of the high quality methods.

You can stop the renderer at any time, for example, if you want to
change the render mode, or change the size of the Render window.
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� in the Render Progress dialog box, click Cancel

� or press Ctrl+Break and click Yes at the prompt
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� click the Close button on the Render window
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Global illumination comprises radiosity and final gather:

� Radiosity is a global process which bounces light throughout the
model regardless of whether or not the light or surfaces can be seen.
Radiosity handles the repeated bouncing of light between a series of
faces until it converges to a stable solution. This does allow
subsequent renders to walk the camera through the model and use a
single Radiosity solution, but it can also mean that extensive
processing occurs on areas which never get rendered. Radiosity
alone suffers from visual artefacts where the mesh of triangles
(where the Radiosity lighting is calculated) become visible.

� Final Gather processing starts with the visible faces and gathers light
from direct and indirect sources which reaches the visible faces, but
alone it performs one bounce of light.

In conjunction with a Radiosity solution, the Final Gather gathers light
which has bounced all around the scene. Gathering light from the
Radiosity solution also makes the triangle mesh invisible.

The trick is to balance these two stages, and to apply enough analysis to
achieve good lighting, but not too much so that the renderer makes
over-long calculations.

Use the Render Options dialog box to control the image quality and
global illumination settings for rendering a scene.
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� on the Render menu, click Options

By default, the dialog box shows the basic rendering options. The
default settings here should be sufficient for most renderings. To see
the advanced options, click More.
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MicroGDS provides three image quality modes and three legacy modes.
We recommend that you choose from Preview, Good, or Best. These
qualities support the following standard rendering features:

� smooth shading

� highlights

� displacements

� environments

� shadows

� texturing

� ray tracing for mirror effects

� transparency

Preview produces fully-textured images with fairly fast rendering, but
has no anti-aliasing so patterns and object silhouettes may appear
jagged. Use Preview to render images in their early design stages.

Good produces high quality images that are suitable for many final
outputs. This quality uses anti-aliasing to remove the jagged
appearance. Good image quality is recommended as it produces
generally high quality images in a relatively short time.

Best produces very high, presentation-quality images which support a
higher level of anti-aliasing to look for sub-pixel features that might be
missed by other anti-aliasing techniques. Best quality should be used
only to generate production quality images and will slow rendering
considerably.

The first time you render an image, the renderer uses the default mode
specified in your preferences. Whenever you select a new render mode,
the mode is copied to your preferences and is used when you next
refresh the rendered image.

For more details about setting the default rendering mode, refer to Help.
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To use radiosity and final gather when you render, select the ‘Use global
illumination’ check box.

To use global illumination effectively, you should be aware of the
following:

� processing time may increase considerably

� reflected light may make the scene much brighter than traditional
renders

We recommend that you set an auto exposure option on the Render
Environment dialog box.

� all lights that support fall off should be set to Inverse Squared

To use traditional ray tracing, clear the Global Illumination check box.
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Select the scene type that matches the lighting calculations most
accurately.

Each scene type has a built-in scene size, shown in the current set units
and scale.

� Site (100m)
� Building (30m)
� Large Room (12m)
� Small Room (6m) (the default)
� Furniture (2.5m)
� Object (0.5m)

Note that these sizes are for a model at 1:1. For example, if your scene
is modelled at 1:20 the size of a Small Room would show 120m (in
your current units).

Choosing the correct scene type will help ensure that the renderer does
not attempt to scatter light inappropriately. For example, it will ensure
that 10cm light patches are not scattered across a landscape or 10m
patches across a desk scene.

You can use the Scene size box to specify an explicit size, which will
override the selected Scene type. If you type a size, the Scene type
changes to Custom.
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Type a number (between 1 and 10) to determine the accuracy of the
Advanced Lighting parameters.

This is the amount by which to adjust the lighting parameters, taking
account of the scene type or the scene size.

Usually, this is all you will need to adjust to balance between a quick,
simplistic lighting and a slow accurate lighting.

If much of the light comes from reflected sources (for example, an
interior with a small window and bright outside light), then you may
need to increase the lighting accuracy to ensure the light bounces
enough times to light the interior.
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Select the Selection box check box to limit detailed processing of
lighting to the MicroGDS selection.

Use a box around the selection, aligned with the world axes to limit
detailed processing of radiosity; simpler lighting is then used outside
this extent. We suggest that you construct wireline primitives (such as
from an unclumped cube) around the area of interest. Wireline
primitives are not themselves rendered and so are a good choice.

For example, imagine that you are rendering a work cubicle in an open
plan office with a view outside. Fit a box around the cubicle so that
complex, bounced-light lighting is used within the cubicle, while the
outdoors is limited to either final gather lighting or traditional
ray-tracing.

In a simple scene where everything is of equal priority, you would
usually clear this check box.
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Generally it is recommended that you combine a basic radiosity
solution followed by final gather from the radiosity solution, but the
progress bar may indicate that a disproportionate time is spent in one or
the other stage:

� If very little time is spent in the radiosity stage, increase the
radiosity weightings so the subsequent final gather will have a better
lighting model.



Chapter 19: Rendering graphics 427

� If too long is spent in the radiosity stage before starting the final
gather, try switching off radiosity or try one of the Advanced
rendering tips described on page 431.

Many of the values on the Render Options dialog box are fractional
weights from 0 to 1, with a default neutral weighting of 0.5 which is the
setting from the ‘Scene type’ and ‘Lighting accuracy’. Increasing an
individual weight reduces related sizes or places more calculation effort
for a single aspect of the lighting calculations, while reducing a weight
uses larger size or less effort. We suggest that you start with the default
weightings and only experiment if it seems necessary.
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To enable and use the radiosity settings when you next render, select the
‘Use radiosity’ check box.

Radiosity processing triangulates a copy of the model, scatters light
from the original light sources, and then repeatedly bounces light from
the triangles, patch to patch. Used alone it can be very slow, and the
triangulation can leave visible marks in the image.

� For indoor scenes, radiosity combined with final gather will produce
the best results.

� For outdoor scenes, final gather used alone will give the desired
results in a much faster time.

If you clear the ‘Use radiosity’ check box, no radiosity processing takes
place and any existing radiosity solution is temporarily ignored. Note,
however, that the radiosity solution is retained and can be used in later
renders by selecting the check box, provided that other changes have
not invalidated it.

The following affect only radiosity and have no effect on final gather
processing (except when a radiosity solution is made available as the
base lighting for final gather).

Bounce accuracy: defines the relative importance for the triangle mesh
and inter-triangle geometry calculations.

Completeness: defines the relative importance for the percentage
completion of the repeated bouncing of light.
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Wall thickness: specifies the distance to use as the lower limit for
slicing mesh triangles. If you have walls touching but not cutting floors
or ceilings, entering the actual thickness of walls can help, but in a large
scene this may be far too small for acceptable calculation times.

If this box is blank, ‘Wall thickness’ is determined by the ‘Scene size’
and ‘Lighting accuracy’ values. Note that unless the accuracy values are
too low, the initial mesh will not iterate down to the ‘Wall thickness’
distance, so these need to be balanced together.

Clutter size: specifies the size for the smallest light-bouncing elements,
thereby overriding the default size.

For example, if you have furniture in a large room, the lighting is
dominated by the walls and ceiling, but the furniture may draw the
attention of the processor; items smaller than the clutter size are left for
the final rendering and do not bounce light in radiosity.

If this box is blank, ‘Clutter size’ is determined by the ‘Scene size’ and
‘Lighting accuracy’ values.

You have greater control over this by attaching the
MGDSRadiosityRefinement attribute to clutter items. For more details,
refer to MicroGDS Help.
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To enable and use the final gather settings when you next render, select
the ‘Use final gather’ check box.

Final gather differs from traditional ray-traced lighting by instead of
tracing rays from surfaces to light sources, rays are fired at random to
sample the region around the face. These rays sample patches of lit
surface, which are in turn lit by the primary light sources or prepared by
radiosity processing. Even a course approximate radiosity solution can
considerably improve final gather speed and quality.

Note that final gather makes only one bounce of diffuse light, as the
light patches it samples are lit by direct lighting. Radiosity patches are
lit by light which may have bounced between several surfaces before
reaching the patch, and if these are available to final gather, it uses those
for its sampling.

You can check how the scene is being sampled by selecting the ‘Show
sampling points’ check box, described later.
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Specular gathering: defines the relative importance of the number of
extra rays scattered from glossy surfaces, to gather light for specular
highlights.

Note that gathering light from extended lit patches onto rough but
glossy surfaces can result in a noisy, speckled appearance. Although this
may be unexpected, it is correct and accurate.

Smoothness: defines the smoothness of the raw light. Low values
produce more blotchy circular patches of light.

Gathering accuracy: defines the relative importance of the ray-lengths
in final gather. (Ray-lengths are calculated from the ‘Scene size’ and
‘Lighting accuracy’.) When sampling rays fall outside existing light
patches, new patches are calculated, so reducing the patch size forces
more light patches, producing a more accurate lighting.

Diffuse gathering: defines the relative importance of the number of
rays cast to find patches of light.

Detail size: defines the average size of small details requiring lighting.
(Detail size is calculated from the ‘Scene size’ and ‘Lighting
accuracy’.)

A typical value might be the depth of narrow window-sills, or
window-frame elements.

An indication that a size is required could be when window frames, lit
from outside, show a speckled, bright lighting. This suggests that the
frame geometry is smaller than the minimum light sample, and the
frames are not being correctly lit. Note that very small detail sizes can
slow rendering.

If needed, a good size for Architectural models is 50mm.

Ambient occlusion: whenever ambient lights are used with final gather
rendering, MicroGDS automatically switches to using ambient
occlusion lighting.

With a standard ambient light, light is spread across the whole scene
but, because the amount of light is uniform and constant, this can give
the effect of flattening the image. Ambient occlusion however takes into
account how near the point being rendered is to other objects in the
scene, and occludes the amount of ambient light at that point
accordingly. This means that points close to other objects appear
slightly darker than points out in the open.
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Ambient occlusion also creates localised shadows where geometry
details meet, for example, in the corners of a room or in the small gaps
between cushions on a sofa.

You can use the following options with ambient occlusion:

� Shadow factor: controls which parts of the scene are fully lit by the
ambient occlusion light and which parts are partially lit.

At every point, final gather sampling determines a mean distance
between the shade point and the rest of the scene. Where this
distance is less than the shadow factor multiplied by the Scene Type
size, ambient occlusion illustration will fade into shadow.

� Drop-off rate: controls the rate at which the ambient occlusion
illumination drops into shadow. Smaller values see the light
reluctant to fade away; larger values will push the shadows out into
the brighter regions.

� Contrast: controls the contrast of the shadows. The darkest shadow
is the ambient occlusion scaled by the contrast. Therefore, larger
contrasts produce darker shadows.

� Bump factor: controls the appearance of displacement mapping
when lit by ambient occlusion.

A value of 0.0 switches off the effect. A value of 1.0 produces the
maximum change in colour due to the bumps. Values in between can
soften the effect, and –1.0 inverts the effect.

The default values provide good ambient lighting in most scenes.

Note that the intensity and colour for the ambient occlusion lighting are
set in the ambient lightstyle.

Handle translucency: select this check box to consider the amount of
light transmitted through surfaces with the Translucency reflectance
shader, when any of the visibility rays encounter some geometry. When
selected, light will be gathered from the translucent surface as well as
the light passing directly through it (and then bouncing round).

Show sampling points: select this check box to overlay bright green
dots at the centre of each lighting sample. This enables you to determine
whether the sampling is too low or too high in parts of the scene. The
correct balance is obtained when there is a loose scatter of points in flat
lighting areas and a denser scatter of points where the lighting varies
rapidly, such as in corners and near shadow boundaries.
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You can use the three advanced options on the Render Options dialog
box to:

� render objects in different materials as defined in a material
substitution table

This enables you to render objects in different materials without
changing the actual materials applied to the objects. You can prepare
data tables using the Material Substitution Sample Application
program.

� use the default lighting and ignore modelled lights

Simplify lights is useful when you are experimenting with viewing
the scene and getting the lights set up, but the lighting or exposure is
too bright or too dark.

Note that simplified lighting uses two lights which track the eye.
These can be very expensive to render with global illumination as
every change to the view is considered as redefining the light and
any previous saved global illumination lighting is discarded and
recalculated. For this reason, it is recommended that Simplify lights
(and any other lights that track the eye) are not used with global
illumination.

If no lights are present in the model, simplify lights is automatically
used.

� force the next render to reload the lights and geometry and
recalculate any global illumination changes if a change does not
seem to show

You would not usually use this button as the majority of changes are
detected automatically.
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� Start with ‘Lighting accuracy’ set to 1, set a sensible ‘Scene type’

size, and remove most of the small items from the scene.

If you have an external base or external buildings, select the
appropriate area and select ‘Use selection box’.

� If the render is particularly slow, cancel it, change parameters, and
restart. It is more important to get an initial impression than to get
the perfect result.
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� Look for light leakage. These indicate that:

— there is a need to split faces (use Boolean Add to add walls to
floors and ceilings)

— or the ‘Scene type’ is too large
— or that a higher ‘Lighting accuracy’ is needed

� If you have bright patches and dark corners, and want to see more
light in the corners, increase the radiosity Completeness. But do this
only if the radiosity stage is not taking overlong.

� While the scene is still fairly empty, try setting a high ‘Lighting
accuracy’ render. This can verify that the level will remove artefacts
caused by insufficient accuracy.

� Although Best ‘Image quality’ can produce outstanding results, it is
often very slow. Therefore, avoid using Best quality until you are
completely satisfied with the lighting.

� Radiosity processing on a landscape scene is generally wasted effort
as there is almost no inter-reflection to process, but the broad area
generates a large number of triangles which flood the radiosity
mesh. Final gather or even plain ray-tracing will give good results
for the landscape itself. You could use a ‘Selection box’ to just burn
radiosity within the box and omit most of the actual landscape.
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You can create an environment around the graphics in a rendered image.
The environment defines the environment around the world, for
example images in front of, behind, or around the model, plus external
lighting (sun or sky), and exposure control.

MicroGDS supplies a number of predefined schemes which you can
also use or modify as required. These are described later on page 434.

The environment is stored with the window definition from which the
image is rendered. You can copy an environment from one window
definition to another window definition in the same document.
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1 On the Render menu, click Edit Environment.

The Environment dialog box is displayed:

The dialog box stores the characteristics of the current environment.

2 To select a predefined weather-based scheme, select from the ‘Load
dialog with’ list.

3 To select a shader type, click the appropriate tab.

Details about the available shader types is given in the following
section.

4 From the Shader list, select the required shader.

5 If you want to modify the chosen shader, click the shader attribute
and modify the setting as required.

You can reset any changed attributes to their defaults by clicking
Defaults.

6 Click OK.
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1 Ensure that the window definition into which to copy an
environment is the active window.

2 On the Render menu, click Edit Environment.

3 On the Environment dialog box, click Set From.

The Select Window dialog box is displayed, listing each window
definition in the current document.
Note that if you are working with a project, the Open dialog box is
displayed in place of the Select Window dialog box.

4 Select the window definition whose environment you want to copy,
and then click OK, or double-click the window name.

The parameters in the Environment dialog box are updated to those
of the selected window.

5 On the Environment dialog box, click OK.

The environment from the selected window definition is copied to
the active window definition.
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MicroGDS supplies a number of predefined time and weather-based
schemes that you can use to create an environment. All schemes are
made up of Sun, Sky, Horizon (background shader), Exposure, and
Brighten settings. The schemes do not alter the Foreground or
Environment Map shaders.

The environments are grouped into categories: Day, Night, Twilight,
and Weather. Each scheme sets the appropriate attributes for the type of
environment selected. You can use these with their preset settings or
modify them as required. If you do not want to use a predefined
scheme, select ‘None’ from the ‘Load dialog with’ list on the
Environment dialog box. All shaders set by any time or weather scheme
revert to None.
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You can build up an environment using three different types of shader:

Foreground reduces the colour of the surface of each pixel to
produce an atmospheric scene

Background adds colour to the background that is not covered
by graphics

Environment Map maps images around the scene to represent the
environment

Sun simulates a light source that emits light from the
sun

Sky simulates a diffuse light source that represents light
from the sun which has been scattered by the
atmosphere

Exposure specifies an optional auto-exposure method to fit
the brightness to the screen

Brighten tweaks the brightness of the rendered scene

Details about these shaders are given in the following sections.
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Use foreground environment shaders to reduce the surface colour of
each pixel to produce an atmospheric scene. You can use these shaders,
for example, to simulate fog or snow:
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Foreground shaders affect only the pixels covered by graphics on the
scene. Therefore, it may be necessary to add a back-plane to some
scenes.
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3D views are tilted according to the roll angle specified in the View
Parameters dialog box. The tilting affects the display of the model and
the lighting.

Some foreground shaders work in world space which means that they
dip and tilt as the view changes. Other shaders work in image space and
are always aligned with the screen axes. This means that they cannot be
tilted.

The following foreground shaders are available:

World space

Depth Cue Produces an impression of depth by adding colour
to the rendered image dependent on the distance
from the eye position.

Fog Produces a fog effect by applying a mist across the
scene at a specified distance. Increasing the
distance moves the fog further from the eye
position.

Scaled Image Blends an image in front of the scene, using a
mask.

Snow An effect of snowflakes falling in front of the
camera. The effect is produced by two overlaid
layers of randomly dispersed snowflakes.

Screen space

Fog Light Volume fog with a varying density. Fog light
provides an atmospheric scattering of fog from
Point and Spot light sources.

Note that Spot lights should have an almost
constant angular intensity distribution and inverse
square fall-off (that is, a hard-edged illumination
cone).

Ground Fog Adds a layer of fog whose density increases closer
to the ground. Use Ground fog to create more
subtle fog-like effects.

Scattering
Medium

Adds dense particle medium which causes light
scattering. Use Scattering Medium to create a
foggy or smoky atmosphere.

None No foreground.
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Except during the early design stages, you will not usually want to
render your scene against the default black background. Use
background environment shaders to define the colour of pixels in the
image that are not covered by graphics. You can use these shaders, for
example, to create a cloudless sky with ground and a horizon:
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3D views are tilted according to the roll angle specified in the View
Parameters dialog box. The tilting affects the display of the model and
the lighting.

Some background shaders work in world space which means that they
dip and tilt as the view changes. Other shaders work in image space and
are always aligned with the screen axes. This means that they cannot be
tilted.

The following background shaders are available:

World space

Horizon A simple plain, cloudless sky with ground, and a
blend of colours at the horizon.

Link to
Environment

Displays the selected ‘Environment Map’
Environment shader as the background as well as
the environment.

This shader is for use only with the ‘Fixed Distance
Cube’ and ‘Image Cube’ environment map shaders.

Ray-traced mirror reflections will sample the
environment shader images, and show true
reflections of the outside environment.
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Screen space

Clouds A cloudy appearance. Increasing the scale makes
the clouds appear larger.

Graduated A background that interpolates between two
colours at the top and bottom of the image.

Graduated
Three Colour

A background that interpolates between three
colours at the top, middle, and bottom of the image.

Grid A background that is a grid.

Image Uses a specified image as a background.

(A description on how the image is ‘drawn’ is
given on the next page.)

None A blank, black background. This is the default.

Plain A background of a plain, uniform colour.

Scaled image Provides a background of a specified image by
scaling it to fit the view window.
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You can display an image in the background of the Render window. The
image starts from the top-left of the Render window, and is repeated
vertically if the window height is greater than the image height.
Similarly, the image is repeated horizontally if the window width is
greater than the image width.

In other words, the background image is defined in ‘window space’ (the
width and height of the window) not in ‘world space’ (the size and
orientation of the geometry).

When you use background images in ‘window space’, highly-reflective
materials, such as those using Mirror or Conductor shaders, can give
unexpected results when they reflect the background, not other
geometry. The reflective surface can appear to be slightly transparent
because the part of the background image it is ‘reflecting’ is the pixel in
‘window space’.

To avoid this, place the background image on an item of backdrop
geometry that is placed behind the model (typically, perpendicular to
the view direction). Alternatively, instead of using a background image,
use an Environment Map shader to map images around the scene, as
described next.
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You can use aliases to help locate image files used by the Renderer. The
alias is defined and managed in the same way as other aliases in
MicroGDS. However, there is also a system defined alias which is
mapped to the Renderer Textures location defined in your preferences.

If a file from the Renderer alias is selected, it is referred to in the
appropriate file name box as:

<>subfolder\file name

There are four ways of defining a file with renderer aliases: absolute
path, relative path, user-defined renderer alias, and system alias. For
more details, refer to MicroGDS Help.

For details about setting up aliases, see Chapter 2, Exploring
MicroGDS.
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Use ‘Environment Map’ environment shaders to map images around the
scene to represent the environment. Use these shaders, for example, to
create a mirror on a wall in which the reflections change depending
upon the eye position.

Environment Map shaders provide a means to environment mapping.
Environment mapping (also known as reflection mapping) creates the
illusion of mirror-like reflections without the computational overhead of
ray tracing. It does this by approximating a single level of inter-object
reflections, that are not physically accurate in the manner of ray tracing.

For example:
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Environment mapping works by describing the appearance of the
environment surrounding the graphics. Usually, it is represented as an
image or a collection of images that correspond to the visual appearance
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of the surroundings from a particular view point. A typical use of
environment mapping would be to represent a mirror on a wall, whose
appearance changes with the position of the viewer.

Additionally, environment maps are used to:

� model the reflections of remote surroundings, in which a single
environment map is applied, during the shading process, to all
surfaces that have specularly reflective properties

Typically, this global environment map will be constructed from
photographs of a real world scene.

� represent inter-reflections between specific surfaces in the model

In this case, a map would be constructed synthetically to correspond
to the environment that would be visible from the point of view of a
particular object. When applied to that object, the environment map
would approximate the reflections of other objects seen in its
surface.

The following environment shaders are available:

Auto-detect Creates an environment from a single image file,
where the image file is in one of a number of
formats. For example, the horizontal cross format
describes six faces of a cube arranged as a
horizontal cross.

Image Cube Creates an environment cube from six image files,
using a mapping that is either an infinite distance or
a fixed distance.

These image files correspond to the faces of a cube
aligned with the coordinate axes. (That is, the
images are reflected in the positive and negative X,
Y, and Z directions.)

This shader centres and sizes the image files as
specified.

None No environment map. This is the default.

Render Cube An environment shader that generates an
environment cube from the render geometry
providing simulation of inter-geometry reflections.
The environment is calculated from six rendered
images of the current geometry, one in each of the
global axes directions.
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Use the Auto-detect and Image Cube shaders to model the reflections of
surroundings; typically, this global environment map is constructed
from photographs of a real world scene. To see the effect of these
shaders, set the material reflectance shader to have ‘mirror’ properties
and set the background environment shader to Link to Environment.
You will see the background reflected in the materials with mirror type
reflectance.

Use the Render Cube shader to create an environment cube from the
render geometry. Note that for best results, you are recommended to use
mirror material reflectance shaders in preference to the Render Cube
shader. To see the effect of this shader, apply the material reflectance
shader Environment to the relevant objects.
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Use a sun environment shader to simulate a light source that emits light
from the sun. The shaders modify the colour of the surface of each pixel
to produce an atmospheric scene.

The easiest way of defining a sun shader is to select a predefined
scheme from the ‘Load dialog with’ list, at the top of the Environment
dialog box. You can use any scheme as it is specified or modify it as
required.

The following sun shaders are available:

Sun Creates a light source that simulates light from the
sun, according to time and place.

Sun + Sky Creates a twin light source that is automatically
calculated according to time and place.

Note that a sun environment is associated with the scene as a whole,
whereas a sun light is associated with an object.
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Use a sky environment shader to simulate a diffuse light source that
represents light from the sun which has been scattered by the
atmosphere.

The easiest way of defining a sky shader is to select a predefined
scheme from the ‘Load dialog with’ list, at the top of the Environment
dialog box. You can use any scheme as it is specified or modify it as
required.



442 Using MicroGDS 11

To simulate a sun and sky light source that is automatically calculated
according to time and place, use the Sun + Sky shader on the Sun tab of
the dialog box.

The following Sky shaders are available:

Ambient Creates background lighting which illuminates all
surfaces equally, regardless of orientation.

Note that ambient lights automatically defer to
Ambient Occlusion when Final Gather rendering is
used.

Environment Light Lights the scene using an ‘Environment Map’
shader.

The light values in the environment that surrounds
the scene are used to provide diffuse lighting from
outside, as if the scene were within a larger scene.

To display the selected environment as the
background (as well as the environment), use the
‘Link to Environment’ background shader.

Sky Creates a diffuse light source that represents light
from the sun which has been scattered by the
atmosphere. The source does not include light
arriving directly from the sun.

This shader can produce some subtle effects,
including accounting for the fact that some areas of
the sky are brighter than others, even on overcast
days.

Note that a sky environment is associated with the scene as a whole,
whereas a sky light is associated with an object.
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Use the exposure slider on the Environment dialog box to specify an
optional auto-exposure method to fit the brightness to the screen or file
limits.
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The following Exposure shaders are available:

Auto-exposure Fits the luminance values in the scene to the RGB
values available on screen or in a file.

You might use auto-exposure if the scene has a
large amount of contrast or a wide range of
brightness (for example, from global illumination
calculations).

Scale Calculates an auto-scaled brightness for the scene.

The calculated scale factor is used to convert the
luminance values to RGB colour values.
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Use the Brighten environment shaders to tweak the brightness of the
rendered scene. The effect is seen immediately in the render window.
You increase or decrease the brightness by dragging the sliders as
required.
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You can save a rendered image to a file of a selected type. When you
save the file, you can:

� save the image exactly as it appears in the Render window

� save the image as it would appear if it was refreshed
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1 On the Render menu, click Save As.

2 Complete the Save As dialog box with the name of the file, its type,
and the folder in which it will be saved.

If you have made any changes that would affect the rendered image, but
have not yet refreshed the image, you can use the To File command on
the Render menu to include an implicit refresh. This means you do not
have to refresh the image before you save the file.
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Note that the To File command also lets you save the file as:

� an EPix picture that you can use in Piranesi�

Extended pixel format files (EPix) contain depth, colour, and
material information for each image pixel. You can use EPix files
with Piranesi� to paint in 3D. Piranesi is a product of Informatix
Inc.

There are two types of EPix files that you can save a file as:

— standard EPix image files which have an epx file extension
— panoramic EPix image files which have an epp file extension

� a QuickTime Movie file

QuickTime is a product of Apple Computer, Inc.

�
���������
����
����&���

� 3���
��������
����
����&���

1 On the Render menu, click Print.

2 Complete the Render Print dialog box with the print size, and
number of copies you require:

� to print the image at the size shown in pixels in the image title
bar, under Print Size, click Current size

� to print the image at a customized size, under Print Size, click
New size and specify the width and height for the printed image,
using the specified units

3 If you specified a new size, select the Re-render check box if you
want to refresh the image before it is printed.

4 Click OK.

You can set the default size for printed images by specifying a new size
in your preferences. For details, refer to Help.
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Lightstyles are used when you render 3D graphics in MicroGDS
Collaboration. Lights can dramatically change the atmosphere of a
rendered scene—lighting can be subtle or dramatic, depending on the
type of scene you are creating.

Lights are also used when you view a drawing in a 3D shaded view. For
details about 3D views, see Chapter 9, Working in 3D in Part One:
Working with MicroGDS 11.

This chapter describes the additional lightstyles that you can create in
MicroGDS Collaboration, and the effects that lightstyles have when you
render 3D graphics. For details on how to add, change, modify, and
delete lightstyles, see Chapter 10, Working with lightstyles in Part One:
Working with MicroGDS 11. For details about rendering graphics, see
Chapter 19, Rendering graphics. You can also refer to Help.
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The following rendered image illustrates the use of one of the common
light types, spot lights. Several spot lights have been used to enhance
the clarity of the scene, giving an intense effect. The sample illustration
is shown here in monochrome, you can see a full-colour version in
Help. The online version also illustrates how the use of colour can give
a more realistic appearance.

You can use different types of lights to cast light in different ways. For
example, you can simulate table lamps and spotlights, and control
whether or not the light casts shadows.

A lightstyle defines the type of light and its attributes. By default,
objects have lightstyle NONE (which means ‘no lightstyle’) and
therefore do not behave as lights.

MicroGDS provides two lightstyles: DEFAULT and NONE.

� DEFAULT is based on an Eye light type. This provides a very
simple lighting model without shadows.

Note that the DEFAULT lightstyle is stored separately from any
lightstyles you create and cannot be saved, deleted, or replaced.

� NONE is not a light, but is the lightstyle automatically assigned to
all new objects; it cannot be modified.

Most objects in a drawing are not light sources, and so have a
lightstyle of NONE.
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MicroGDS Collaboration also provides a variety of built-in lightstyles,
such as halogen or fluorescent. You can choose a built-in lightstyle
using the Lightstyle dialog box. When you select a built-in style, the
Lightstyle dialog box is populated with the appropriate light type and
attributes. For example:

MicroGDS also provides two ‘simplify lights’ facilities that you can use
in a shaded view and in a rendered image. These use the default lighting
and ignore any modelled lights. Simplify lights is useful, for example,
when you are setting up the view of the model.
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In MicroGDS Collaboration, lights can be based on any of the
following types of light:

ambient illuminates all surfaces equally

area radiates light from one or more closed line primitives

distant emits parallel light as if from a very distant source, such
as sunlight

environment
light

lights the scene using an environment map shader

eye emits light from the eye position equally in all directions

goniometric emits varying amounts of light energy in different
directions

point emits light from a point equally in all directions

projector projects an image across the scene

sky creates a diffuse light source that simulates light from the
sky dome

spot emits a cone of light which is defined by the owning
object’s axes

sun creates a light source that simulates light from the sun

sun + sky creates a light source that is set by automatic control of
time and place

The light types enable you to define the lighting you would like to use
in your scene. For example, you could choose Point to emit unfocused
light in all directions. A point light is similar to an unshaded light bulb.
To focus a beam of light in a single direction towards a particular target
point, you could use a spot light.

The behaviour of a light type is defined by a number of attributes. For
example, when you create an eye light, you choose the intensity of the
light and the colour. Some light types, such as spot, have many
attributes, which include defining the angle of the cone of light, the
beam distribution, a number of shadow attributes, a location for the
source, and a direction.
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Note that the Units and Scale settings specify how to show and interpret
points and distances of the light in the Lightstyle dialog box. These
settings apply only to certain types of light.

The following sections provide a brief description of each light type.
For information on the associated attributes, refer to Help

Some additional information about how lights are handled when you
render graphics is provided in Lighting effects when rendering on
page 455.
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Ambient lights provide a general level of illumination. The position and
orientation of the object to which the light is assigned is not important,
because this type of light has no direction. The colour of an ambient
light tints the scene and can be used to complement the colour of the
main light source for the scene. It is usual to have only one ambient
light, but you may need to add additional lighting to create a well-lit
scene.

The default intensity value of 0.1 is sufficient in most situations. If you
increase this value, you should do so in small increments.

Ambient lights do not cast shadows.

Note that ambient lights automatically defer to Ambient Occlusion
when Final Gather rendering is used.
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An area light creates a light source using one or more closed line
primitives in a light object, as the radiating areas.

For simple strip lights, move the axes to the height of the light, and
construct a rectangle for the outline of the light area. The radiant surface
created from the rectangle will shine down.

For more complex shapes (for example, a glowing sphere), construct a
surface, reverse the line direction, and then construct primitives from
the clump by unclumping. Note that shapes with many vertices or
primitives will increase rendering time.

The primitives of the light source are not rendered. You can create a
glowing effect by placing a surface with a non-shadow casting,
translucency reflectance shader, in the front of the light source.
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Note that you can use the Noise Factor attribute to reduce visible
artifacts in direct rendering. Noise Factor should not be used with
global illumination as it may introduce unwanted errors.
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A distant light emits parallel light rays coming from a single, distant
source. A distant light is appropriate as the main light source for sunlit
scenes.

By default, the light is directed along the negative Z axis of the object to
which the light is assigned. You can change the direction of the lighting
using the ‘To Direction’ attribute.
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An environment light is used to light the scene using an environment
map shader.

The light values in the environment that surrounds the scene are used to
provide diffuse lighting from outside, as if the scene were within a
larger scene.

To display the selected environment as the background (as well as the
environment), use the Link to Environment background shader.

Note that you can use the Noise Factor attribute to reduce visible
artifacts in direct rendering. Noise Factor should not be used with
global illumination as it may introduce unwanted errors.

!-�

An eye light provides a light source that is directed along the line of
sight, (between the eye position and the look-at point).

The position and orientation of objects to which an eye light is assigned
is not significant.

Note that eye lights do not cast shadows.
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A goniometric light creates a light source in which the light distribution
is controlled by data in a text file.

A goniometric light source is one which can emit varying amounts of
light energy in different directions. For example, one goniometric light
could behave like a point light, another could behave like a spot light,
and another could behave in a completely different way to either. In
MicroGDS, a goniometric light gets its intensity distribution (that is,
how much light goes in any one direction) from an industry-standard
file.

Sample text files can be found on the Internet (.ies files) or downloaded
from manufacturers of light fittings.
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A point light is similar to an unshaded light bulb, or a star. Such lights
provide a light source from a point equally in all directions.

The position of the hook point of the object to which the point light is
assigned defines the position of the point source. The orientation of the
object axes is not important.

Note that the point light’s direction attribute, Location, enables you to
offset a light without moving the object’s hook point. This can be
particularly useful if your light sources are instance objects.

�
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A projector light provides a light source similar to a spot light, but
projects an image across the scene as though it were a transparency in a
slide projector. If a smaller angle of illumination is used, the projector
light also allows the effect of light passing through a stained glass
window to be modelled. A black and white image allows the light to be
‘stencilled’ which, for example, can give the effect of a window with
shadows cast by the window frame.

By default, the light is directed along the negative Z axis of the object to
which the light is assigned. The position of the hook point of the object
defines the apex of the light cone. You can use the Location and To
attributes to offset and tilt a projector light without moving the object’s
hook point. This can be particularly useful if your light sources are
instance objects.
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To project the image, the render quality mode must be set, at a
minimum, to Preview. Otherwise, the projector will cast light but will
not cast a focused image.

When you specify the location of an image file, by default, MicroGDS
first looks for the file in the Textures folder specified in your Rendering
preferences. You can also create Renderer aliases to point to additional
locations. For details about creating renderer aliases, see Chapter 17,
Customizing MicroGDS in  Part One: Working with MicroGDS 11.
You can also enter a full path, or browse to a different location, if
required. For details about setting preferences, see Chapter 17,
Customizing MicroGDS in Part One: Working with MicroGDS 11.
Refer also to Help.
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A sky light creates a diffuse light source that simulates light from the
sky dome.

Sky lights can produce some subtle effects, including accounting for the
fact that some areas of the sky are brighter than others, even on overcast
days.

The sky source is oriented relative to a scene, rather than positioned
somewhere within it.

Another way of simulating the source of the sky is to set up a rendering
environment. You can choose from a number of predefined sun and sky
schemes supplied with MicroGDS. The rendering environment is
associated with the scene as a whole, whereas a lightstyle is associated
with an object.

Sky lights do not render well without Final Gather. Rather than plain
ray-tracing, a Final Gather render with a Lighting Accuracy of 1 will
greatly improve the appearance of a sky light.

Note that sky lights can give unexpected results if the object axes to
which the light is assigned are rotated. To avoid this, it is often easier to
set sky light in the render’s environment.
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A spot light creates a cone of light. Flashlights, and car headlights are
common examples of spot lights.

The light is directed along the negative Z axis of the object to which the
light is assigned. The position of the hook point of the object defines the
apex of the light cone.

Note that you can offset and tilt a light without moving the object’s
hook point using the spot light’s direction attributes, Location and To.
This can be particularly useful if your light sources are instance objects.

The example at the end of this chapter shows you how to create and
place a spot light on a 3D image.
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A sun light creates a light source that simulates light from the sun,
according to time and place.

You can either specify the position of the sun in the sky (in terms of an
angle over the horizon and a compass direction) or specify the position
of the location on the globe (with grid references) along with a time and
date. In the latter case, MicroGDS will calculate the position of the sun
in the sky.

Another way of simulating the source of the sun is to set up a rendering
environment. You can choose from a number of predefined sun and sky
schemes supplied with MicroGDS. The rendering environment is
associated with the scene as a whole, whereas a lightstyle is associated
with an object.

Note that sun lights can give unexpected results if the object axes to
which the light is assigned are rotated. To avoid this, it is often easier to
set sun light in the environment.
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A sun + sky light creates automatic lighting, controlled by time and
place.

The actual colour of the sun and sky vary according to the type of sky,
and the altitude of the sun. Night scenes have no sun light.
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For scenes lit by Global Illumination, the default value for the sky light
quality can be used as the Final Gather process renders sky lights
smoothly. If Global Illumination is not used, you may need to increase
the quality to avoid shadow bands. Note that Final Gather is the
preferred rendering method for all sky-lit scenes.

Another way of defining the sun and sky lighting is to set up a
rendering environment. The rendering environment is associated with
the scene as a whole, whereas a lightstyle is associated with an object.
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In single-user documents, new lightstyles are stored in the document
(the MAN file). They are saved when you save the document. You can
delete any local lightstyle that is not in use in the current drawing. You
cannot delete lightstyles from a referenced LIGHTS.STY file.

In multi-user projects, new lightstyles are stored in an external style file
(LIGHTS.STY). A lightstyle is saved in the actual style file as soon as
you save the style, even if you do not save project. You can delete any
lightstyle from the local style file in the project. Note that MicroGDS
does not check to see if the lightstyle is used in other window
definitions in the project.

For details about creating, modifying, and deleting lightstyles, see
Chapter 10, Working with lightstyles in Part One: Working with
MicroGDS 11.

For details about working with projects, see Chapter 16, Multi-user
projects, in Part One: Working with MicroGDS 11.
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When you have added or modified a lightstyle, you can render the scene
to see the effects.
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1 On the Window menu, click View Parameters and select the
projection you require.

2 Use the commands on the View menu to set up the view to be
rendered.
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3 To create an environment around your rendered graphics, on the
Render menu, click Edit Environment, then choose the shaders you
require.

4 To select rendering options, on the Render menu, click Options and
then select the settings you require.

To use radiosity and global illumination, select the appropriate
check box and then set up the level of detail you require.

5 On the Render Options dialog box, click Render Now.

For further details, see Chapter 19, Rendering graphics.

You can also use the Hide Mode, Shaded, and Shade with Edges
commands on the View menu to preview your image using a shaded
view. For more details about shaded view, see Chapter 9, Working in 3D
in Part One: Working with MicroGDS 11.
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You can use the simplify lights facility to override any modelled lights
in the scene and, instead, use two lights: a point light and a distant light
(looking over the left shoulder). You can switch on simplify lights using
the Render Options dialog box.

If there are no lights in your model, MicroGDS automatically uses
simplify lights.
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Two attributes are provided with several light types to enable you to
easily position lights. These are particularly useful with light sources
that are instance objects.

� Location: the location of a light. This is a point in object axes.

� To Direction: controls the direction of the lighting. This is a vector,
relative to the object axis, to define how the light points away from
the Location point.
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The following light types provide a ‘Track Eye’ attribute which enables
the light to track the eye.

� Distant

� Goniometric

� Point

� Projector

� Spot

Track Eye works in conjunction with Location and To Direction
attributes, but based on the line-of-sight rather than the object axes.

Note that Simplify Lights uses two lights which track the eye:

� a point light, with an intensity 0.65, tracking the eye at Location
0/0/0, so that it shines from the eye point, and hard shadows
switched on

� a distant light, with an intensity of 0.65, tracking the eye at To
Direction 1/–1/–1, so that it shines from above the viewer’s left
shoulder, down and to the right, and hard shadows switched on

You switch on Simplify Lights using the Render Options dialog box.

Lights which track the eye can be very expensive to render with global
illumination as every change to the view is considered as redefining the
light and any previous saved global illumination lighting is discarded
and recalculated. For this reason, it is recommended that lights that
track the eye (including Simplify Lights) are not used with global
illumination.
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The Intensity Units attribute controls the way in which the light
intensity is measured.

By default, the units are measured in empirical (arbitrary) units.

Select a value from the list; the light intensity units available depend on
the type of light selected:

� Empirical: the light intensity is measured in arbitrary units, with 1.0
being normal screen white

All renderer lights support empirical units.
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� Real-world intensity units provide different effects for the type of
light being simulated:

— Point and spot-like lights, which radiate light from a point use
(Kilo) Lumen and (Kilo) Candela as luminous intensity, or
power they emit

— Ambient, Environment Light, and Distant lights specify
illuminance, the light incident on surfaces lit by them, using
Lux or Foot Candles

— Sky lights specify a sky-like variant on incident light, as NIT,
the intensity of the zenith, in candela per square metre

— Area lights can use either, depending on the effect you want:
� luminous emittance: light power per area of a surface (Lux or

KiloLux)

� luminous power: total light power emitted by the source (Lumen or
KiloLumen)

Area lights use Lux as emittance (light from the glowing area),
whereas distant lights use Lux as illuminance (light landing on the
ground for example).

Most real-world light intensities require some auto-exposure control
to render effectively. For details about setting auto-exposure, see
Chapter 19, Rendering graphics.

More details about real-world lights can be found on many online
reference web sites.
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By default, all materials cast shadows from those lightstyles that
support shadowing. You can turn shadows on or off for a material using
the Shadows check box on the Material dialog box. For details about
how and when to enable or disable shadowing for materials, see
Chapter 21, Advanced materials.

All light types except ambient and eye can cast shadows.

You control the shadows using the shadow attributes for each light type.
For details about the shadow attributes, refer to Help.

You can use the Shadow Type attribute to control whether the light casts
hard shadows or soft shadows. Soft shadows are best suited for light
sources that represent soft, interior lights. They do, however, use up
extra program memory, but not processing power. Hard shadows have
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straight edges and are created using ray tracing. Hard shadows are
generated when you render, therefore, they use very little additional
memory to generate.

Note that sky, and sun + sky, lights support only hard shadows.

For soft shadows, you can set the accuracy of the shadows using the
lightstyle’s Shadow Resolution attribute. Increasing the resolution
improves the accuracy of the shadow map, but requires more program
memory. Note that point lights create six shadow maps, one in each
global axis direction, and therefore use more program memory than
other light types. Distant lights span the shadow map across the whole
scene, so you may need a very high resolution to avoid artifacts.
Consider using hard shadows for outdoor scenes, in which light sources
are used to represent harsh sunlight.

You can also control the coarseness of the shadow map using the
Shadow Quality attribute, and control the shadow boundaries using the
Shadow Softness attribute.

For full details about shadows and the shadow attributes, refer to Help.
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For point, spot, area, goniometric, and projector lights, you can increase
the level of fall off to reduce the long-range effect of the light. Fall off
determines the way in which the light intensity varies with the distance
from the source. Although this is not an alternative to using shadows,
fall off can give the effect of depth and distance without using up the
program memory required by the shadow attributes.

By default, the fall off is constant in which the light intensity does not
vary with the distance from the light source. Other types of fall off are
available from the Fall Off list.

The fall off distance can be measured in the model world or in object
axes. This is controlled by the Use Object Scale light attribute. If set to
On, the distance is scaled by the actual object axes scale of the object to
which it applies. If set to Off, object scale is ignored and the distance is
measured in the model world.

For further details about using fall off, refer to Help.
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This section takes you through the steps involved in creating and
placing a spotlight on a 3D scene. For the purpose of this exercise, you
will create a simple, basic scene which you will then light by creating a
spotlight.
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1 In MicroGDS, create a new, blank document.

2 Set the scale to 1 and the units of measurement to mm.

3 Create the floor area:

a) Construct a 500 x 500mm rectangle and centre it at 0/0/0.

b) Click the Draw Extents button and then zoom out using the
zoom slider.

c) To create a surface from the rectangle, on the Solid menu, click
Clump, Create.

4 Create the cube:

a) On the Solid menu, click Construct, Cuboid.

b) Place the first corner of the cuboid at –50/–50.

c) Place the opposite corner of the cuboid at 50/50.

d) Specify the height of the cuboid by entering //200.

If you switch to 3D view, you will see that the scene is set and now
ready for lighting; switch back to 2D view.
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5 Prepare the scene:

a) Draw a short construction line using the Construct Line tool,
giving two Face snaps, for example:
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You will use the construction line when you place the spot light.

b) Move the end of the construction line 300mm in the Z direction
using the Vertex, Move, command on the Alter menu.

6 Create a new object for the light and place the hook point at 0/0.

7 Draw the spotlight object:

a) On the Construct menu, click Circle, Radius Centre.

b) Specify a radius of 30.

c) Place the circle at /

8 Switch to 3D view by clicking 3D on the View menu.

9 To position the spotlight object:

a) On the Object menu, click Reposition.

b) Move the pointer to the centre of the circle, and when the Centre
snapcode is shown, click the mouse button.

c) Place the object at the end of the construction line, using an End
snap.

The prompt bar now requests that you set the position for the X
axis. However, since the light source of a distant light is directed
along the negative Z axis of the light object, you will specify the
–Z direction instead.
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d) To position the –Z axis, press Shift+Tab.

Notice that the prompt bar now requests you for the position for
the –Z axis.

e) To direct the axis along the negative Z, use a Line snap
anywhere on the construction line.

f) The direction of the X and Y axes is not important, so press Esc
to retain their current rotations.

g) To end the command, press Esc.

10 Create a lightstyle:

a) Ensure that the spotlight object is selected.

b) On the Styles menu, click Lightstyle Modify.

c) From the Light type list, select Spot.

d) Click Save As, type a name for the lightstyle, and then click OK

e) On the Lightstyle dialog box, click Close.

11 Set the rendering environment:

a) On the File menu, click Preferences, click the Renderer tab and
set the image size to Custom Size, and then specify a width and
height for the image of 500 x 500. Click OK to close the
Preferences dialog box.

b) On the Render menu, click Edit Environment and set the
Background shader to Plain. Then change the plain colour to
Light Yellow and click OK.

c) On the Render menu, click Options.

d) From the Image quality options on the Render Options dialog
box, select Good.

e) Click Render Now

The rendered scene lit by the spotlight appears.
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Materials are used when you render 3D graphics in MicroGDS
Collaboration. A clump is ‘made of’ a material, and can also have a
different material assigned to each of its faces. For example, a cube can
be made of the material ‘wood’, and have the material ‘yellow paint’ on
some faces.

Materials in MicroGDS Collaboration have several characteristics, such
as colour, pattern, reflectance, and transparency. By using different
materials, you can create rendered scenes that are much clearer.

Materials are also used when you view a drawing in a 3D shaded view.
Note that, for materials created in MicroGDS Collaboration, many
material attributes are not used in a shaded view. For details about 3D
views, see Chapter 9, Working in 3D in Part One: Working with
MicroGDS 11.

This chapter describes the materials that you can create in MicroGDS
Collaboration. For details on how to change, modify, and delete
materials, see Chapter 11, Working with materials in Part One: Working
with MicroGDS 11. You can also refer to Help.
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MicroGDS provides one pre-defined material called DEFAULT, which
is a plain matte white colour.�Note that the DEFAULT material is stored
separately from any materials you create and cannot be saved, deleted,
or replaced.
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In MicroGDS Collaboration, materials are made up of a combination of
five types of shaders, each of which defines an aspect of the material’s
appearance:

colour shaders define the colour of the surface at any point in
space

reflectance shaders define how much light is reflected by, or refracted
through, the surface

transparency
shaders

define how light is transmitted through the surface

displacement
shaders

simulate small surface perturbations without
changing the geometry

texture space
shaders

define how the previous four shaders are wrapped
around the object

Each type of shader offers a broad range of shaders, and each shader has
a set of attributes that determine its specific behaviour. For example, if
you choose the Plain Colour shader, you then choose the colour you
wish to use. This is a very simple example. Most shader styles have
many attributes, such as the Glossy Glass Reflectance shader whose
attributes define reflection, refraction, and the degree to which these are
blurred.

You can combine one shader of each type to build up effects. For
example, you could simulate pale-blue, dimpled glass by selecting a
blue colour shader, the glass reflectance shader, and the wrapped dimple
displacement shader. You can also create detailed depth effects by
pairing a colour shader with its matching displacement shader. For
example, if you set the blue marble colour shader and the blue marble
displacement shader attributes to be the same, you will achieve a
realistic depth effect.
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Shaders can be ‘solid’ or ‘wrapped’:

� solid shaders create a constant effect over a surface and through a
solid

� wrapped shaders create an effect that is dependent on the surface
position in texture space.

For more details on texture spaces, see Texture space shaders on
page 477.

Some shaders also allow you to use image files in a material to obtain
specific textured and patterned effects. For example, with the Wrapped
Image colour shader, images are wrapped around the surfaces that are
assigned the material:
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When you choose a material that uses an image, by default MicroGDS
looks for the image in the Textures folder specified in your Renderer
preferences. You can also create Renderer aliases to point to additional
locations. For details about creating renderer aliases, see Chapter 17,
Customizing MicroGDS in Part One: Working with MicroGDS 11.

Some examples of different materials are shown below. The first
example shows the default rendered image, as it would appear before
any materials are added. In the remaining illustrations, a Wrapped Brick
displacement material is assigned to the base, and a variety of effects, in
turn, are assigned to the vase.
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The following sections give brief descriptions of each shader. For
information on the associated attributes, refer to Help.
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Every surface has a colour; a colour shader defines the colour of a
surface at any point in space. It can range in complexity from a simple
colour to a complex surface pattern. Tiled bitmap images can be applied
to define the colour; these are ideal for surfaces such as brickwork, tiles,
or carpeting.

The following solid colour shaders are available.

Birch A pattern that resembles birch wood.

Blue Marble A blue marble pattern.

Cherry A pattern that resembles cherry wood.

Chrome Simple chrome-like reflections.

Cubes A three-dimensional lattice of cubes with
alternating colours.

Fleck A pattern which has a base colour with coloured
flecks as seen in some plastics, composite
materials, or tiles.



Chapter 21: Advanced materials 467

Granite A pattern that resembles granite.

Height Band A pattern of colours specified by heights on the
object’s surface.

Maple A pattern that resembles maple wood.

Marble A veined marble pattern.

Oak A pattern that resembles oak wood.

Paving A pattern that resembles crazy paving.

Pine A pattern that resembles pine wood.

Plain A plain, uniform colour (the default).

Simple Wood A simple wood pattern. The wood grain is based
on a tree trunk centred on a given axis with
concentric rings of light and dark wood colours.

Solid Clouds A pattern of clouds.

Solid Polka A pattern of spheres embedded in a plain matrix.
Slices through the matrix have a polka-dot
appearance.

Turbulent A pattern that simulates the variations in a
turbulent medium, such as smoke or patchy fog.

Wood A wood pattern. The wood is based on a tree
trunk centred on a specified axis, the direction of
which is aligned with the object axes, with
concentric rings of light and dark wood, and
grain.

The following wrapped colour shaders are available.

Wrapped Birch
Floor

A wooden plank pattern in a finish that resembles
birch wood.

Wrapped Brick A simple brick pattern.

Wrapped Brick
Bonds

A complex brick pattern.

Wrapped Checker A chequer-board pattern using two alternate
colours.

Wrapped Colour
Blend

A pattern blending two wrapped images or two
colours together.
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Wrapped Cherry
Floor

A wooden plank pattern in a finish that resembles
cherry wood.

Wrapped Diagonal A diagonal stripe pattern using background and
stripe colours.

Wrapped Filtered
Image

A wrapped texture, filtered with a specified
colour, providing image colour mapping.

Wrapped Grid A grid pattern using background and grid colours.

Wrapped Image A wrapped texture providing image colour
mapping.

Wrapped Maple
Floor

A wooden plank pattern in a finish that resembles
maple wood.

Wrapped Oak
Floor

A wooden plank pattern in a finish that resembles
oak wood.

Wrapped Pine
Floor

A wooden plank pattern in a finish that resembles
pine wood.

Wrapped Polka A texture giving a polka-dot pattern created by
setting a grid of circles of one colour against a
background of another colour.

Wrapped Random A wrapped texture giving a random pattern using
two colours.

Wrapped Roof
Tiles

A sophisticated roof tile pattern.

Wrapped S Stripe A stripe pattern in constant s in texture space.

Wrapped T Stripe A stripe pattern in constant t in texture space.

Wrapped Textured
Brick

A sophisticated brick pattern. Each brick has a
base colour randomly assigned, and is textured
using a variation in colour around the base colour.

Wrapped Wood
Floor

A pattern that simulates wooden-plank style
patterns, such as floorboards, based on a
replication scheme.
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Reflectance shaders define how much light is reflected by the surface
towards the eye position. The result depends on the material properties
of the surface, the lighting that illuminates the surface, and the
environment that surrounds the surface.

Reflectance shaders can be thought of as defining a surface’s ‘finish’,
and are used to model properties such as matte, metal, and plastic. For
example, the Copper shader simulates copper by having metallic
properties with preset attribute values for copper.

The following reflectance shaders are available.

Aluminium Simulates aluminium. Based on the Conductor
shader, with the Refraction and Absorption values
for aluminium.

Blurred Conductor A metallic effect that supports reflection and also
blurring of reflected images.

Blurred Dielectric A glass-like effect that supports reflection and
refraction. Blurred Dielectric also supports
blurring of reflected and refracted images.

Blurred Glass A blurred glass effect that resembles frosted glass.

Blurred Mirror A blurred mirror-like effect using ray tracing that
supports reflection and blurring.

Chrome 2D A chrome-like effect suitable for shiny or highly,
polished chrome-like materials.

Chromium Simulates chromium. Based on the Conductor
shader, with the Refraction and Absorption values
for chromium.

Cobalt Simulates cobalt (a silvery-white metallic
element). Based on the Conductor shader with the
Refraction and Absorption values for cobalt.

Conductor Used for accurate simulation of metallic surface
finishes, supporting secondary mirrored views
through ray tracing. The Refraction and
Absorption attributes are constant values; the
default values given for the Refraction and
Absorption coefficients are those of silver.
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Constant A constant colour, independent of the light falling
on the surface.

Copper Simulates copper. Based on the Conductor shader
with the Refraction and Absorption values for
copper.

Dielectric An accurate simulation of glass-like materials
which have both reflective and transmissive
properties.

Note that dielectric and glass materials should be
used with solid clumps only. If you use a
dielectric or glass material with a mesh clump,
you may see unexpected results.

Environment Provides environment mapping suitable for
simulating reflective materials (such as shiny
metals) in conjunction with an environment map.

For details about environment mapping, see
Chapter 19, Rendering graphics.

Eye Light Plastic Creates a glossy plastic-like reflectance with a
fixed eye light. This shader ignores all lights in
the model and acts as if there is a single eye light.

Glass Simulates glass-like materials that have both
reflective and transmissive properties. Similar to
the dielectric shader but with simplified attributes.

Glossy Dielectric A glass-like dielectric effect that has both
reflective and transmissive properties. Secondary
mirrored and transmitted views are incorporated
by the use of ray tracing.

Glossy Glass A glass-like effect that has reflective, refraction,
and blurring properties. Secondary mirrored and
transmitted views are incorporated by the use of
ray tracing.

Glossy Metal A metallic effect that supports reflection and also
blurring of reflected images.

Glossy Mirror A mirror-like effect that has reflective properties.
Secondary mirrored views are incorporated by the
use of ray tracing.
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Gold Simulates gold. Based on the Conductor shader
with the Refraction and Absorption values for
gold.

Graphite Simulates graphite. Based on the Conductor
shader with the Refraction and Absorption values
for graphite.

Lit Appearance A shiny, mirror-like material that illuminates
itself. This can be useful for simulating self-lit
surfaces such as a backlit glass sign or a computer
screen.

Matte A dull matte-like reflectance suitable for
non-glossy materials such as brick or fabric (the
default).

Mercury Simulates mercury. Based on the Conductor
shader with the Refraction and Absorption
attributes for mercury.

Metal A specular metallic appearance suitable for many
metallic materials such as steel or brass.

Mirror A reflectance model that supports secondary
mirrored views through ray tracing. Suitable for
representing mirror-like, or polished, surface
finishes.

Multilayer Paint Simulates paint surfaces with a base colour, a
separate lacquer layer, and optional metallic
flakes.

Nickel Simulates nickel. Based on the Conductor shader
with the Refraction and Absorption values for
nickel.

Palladium Simulates palladium (a hard, white metallic
element of platinum). Based on the Conductor
shader with the Refraction and Absorption values
for palladium.
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Phong A reflectance model, conforming to the popular
Phong model, that produces a specular affect. The
intensity of the effect depends upon the eye
position in relation to both the reflecting surface
and the position of the light source. This model is
suitable for shiny or highly-polished materials
such as ceramic or glass.

Plastic Glossy plastic-like reflectance that provides a
specular effect similar to Phong. Suitable for
shiny or highly-polished materials such as plastic
or varnished surfaces.

Platinum Simulates platinum. Based on the Conductor
shader with the Refraction and Absorption values
for platinum.

Shadow Catcher Creates a transparent effect enabling shadows to
fall on hidden geometry.

Silver Simulates silver. Based on the Conductor shader
with the Refraction and Absorption values for
silver.

Translucency Simulates a matte-reflectance translucent surface
lit from behind.

Translucent Plastic Simulates a glossy plastic-like reflectance with
translucency.

Tungsten Simulates tungsten. Based on the Conductor
shader with the Refraction and Absorption values
for tungsten.

The following wrapped reflectance shaders are available:

Wrapped
Anisotropic

Creates a machined surface that has parallel
scratches or ridges, such as brushed metal.

Wrapped Circular
Anisotropic

Creates a surface with many small areas of
concentric rings of scratches or ridges repeated
over the surface.

Wrapped Mirror
Map

Creates a mirror material for which the
reflectance is variable across the surface.
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Wrapped Specular
Map

Creates a mirror reflecting effect which supports
reflection. The specular and mirror factors are
determined by image maps.

Wrapped Woven
Anisotropic

Creates a wrapped woven pattern to simulate the
directional reflectance properties of surfaces
consisting of woven threads, such as satin cloth.

Note that glass and dielectric-like materials should be used with solid
clumps only. If you use a dielectric or glass material with a mesh clump,
you may see unexpected results.
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The transparency shaders define how transparent or opaque a surface is.
They therefore determine how much light is able to pass through the
surface.

To see the effects of transparency shaders, select the Transparency
check box.

The following table describes the types of solid transparency shaders:

Eroded An effect of erosion on a surface.

Fractional A plain, uniform transparency between opaque
and transparent.

None A null transparency shader providing an opaque
finish (the default).

Plain A plain, uniform transparency to enable coloured
transparency and translucency to be simulated.

The following wrapped transparency shaders are available:

Wrapped Alpha A material of variable transparency by wrapping
an image.

Wrapped Checker A simple chequer-board transparency pattern.

Wrapped Grid A grid pattern with opaque grid lines and
transparent grid squares.
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Wrapped Image Image mapping for transparency shading. For
consistent results, it is recommended that
greyscale images are used wherever possible.

Any black areas on a bitmap image can be used as
a transparency stencil—ideal for use with scanned
images such as trees or people.

Wrapped Mask Image mapping for variable transparency shading.

Wrapped Stencil Provides colour stencilling by image mapping.

X Ray Creates X Ray-like transparency effects of
varying strengths which is adjusted by amount of
coverage.

���#�	�&���������
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Use displacement shaders to create a rough or an embossed surface.

Displacement shaders do not change the geometry of the graphic, but
the way the surface reacts to light falling upon it.

These shaders are used to represent features that would be difficult,
inefficient, or impossible, if conventional modelling techniques were
used. For example, you can use the shaders to simulate regular
indentations produced by pressed-sheet metal.

To see the effects of displacement shaders, select the Displacement
check box.

It is important to note that the displacement shaders increase rendering
time and, in some circumstances, you may be able to avoid using them.
For example, if you are viewing an object from a distance, such as an
exterior view of a building, the scale of the perturbations would be very
small. In such cases, it may not be worth using a displacement shader.

For small objects viewed close up, you can simulate the perturbations
without the cost of additional rendering time, by using a combination of
colour shaders. For more details, see Displacement effects on page 484.

Many displacement shaders have an equivalent colour shader to match
the pattern. For example, the Oak displacement shader has an
equivalent Oak colour shader in which the attributes are preset to give
the appearance of Oak wood. To obtain the best results when using
matching shaders, ensure that you set the size and scale of the pattern to
be the same in both shaders.
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The following solid displacement shaders are available.

Birch A carved, wood pattern that resembles birch
wood.

Blue Marble A raised pattern with the appearance of blue
marble.

Casting An irregular casting pattern of displacements and
indentations upon those displacements.

Cherry A carved, wood pattern that resembles cherry
wood.

Cubes A three-dimensional lattice of cubes with
alternating heights.

Granite A raised pattern that resembles granite.

Leather A raised, leather-like textured pattern.

Link to Colour A displacement pattern for the currently selected
colour shader.

Maple A carved, wood pattern that resembles maple
wood.

Marble A raised, veined pattern with the appearance of
marble.

None No displacement (the default).

Oak A carved, wood pattern that resembles oak wood.

Paving A raised pattern with the appearance of crazy
paving.

Pine A carved, wood pattern that resembles pine wood.

Rough A rough, cast metal-like finish.

Simple Wood A carved wood pattern with concentric rings of
different heights. The wood grain is based on a
tree trunk centred on a specified axis.

Solid Clouds A raised, cloudy pattern.

Solid Polka A pattern of raised or sunken spheres embedded
in a plain matrix. Slices through the matrix have a
polka-dot appearance.

Turbulent A raised pattern that resembles smoky or patchy
fog.
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Undulate An undulating surface pattern.

Wood A carved wood pattern that simulates the wood
patterns inside a tree trunk, with concentric rings
of different heights.

The following wrapped displacement shaders are available.

Wrapped Birch
Floor

A raised birch, wooden plank pattern.

Wrapped Brick A simple raised brick pattern.

Wrapped Brick
Bonds

A raised, complex brick pattern with a choice of
different brick bonding patterns.

Wrapped Bump
Map

A bump map from an image file. For consistent
results, it is recommended that greyscale images
are used wherever possible.

Wrapped Checker A raised checker pattern.

Wrapped Cherry
Floor

A raised cherry, wooden plank pattern.

Wrapped Diagonal A simple raised striped pattern.

Wrapped Dimple A regular dimpled pattern.

Wrapped Grid A raised grid pattern.

Wrapped Height
Map

A raised displacement by wrapping an image.

Wrapped Knurl A knurled pattern similar to grips used on tool
handles.

Wrapped Leather A raised, wrapped leather-like textured pattern.

Wrapped Maple
Floor

A raised maple, wooden plank pattern.

Wrapped Oak
Floor

A raised oak, wooden plank pattern.

Wrapped Pine
Floor

A raised pine, wooden plank pattern.

Wrapped Polka A raised, wrapped polka-dot pattern.

Wrapped Ripple A concentric, rippled effect in texture coordinates.
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Wrapped Roof
Shingles

A raised, roof shingles pattern.

Wrapped Roof
Tiles

A raised, sophisticated roof tile pattern.

Wrapped Rough A rough, cast metal-like finish.

Wrapped S Stripe A simple raised, striped pattern in constant s in
texture space.

Wrapped T Stripe A simple raised, striped pattern in constant t in
texture space.

Wrapped Textured
Brick

A raised, complex brick pattern.

Wrapped Tread
Plate

A tread-plate pattern of cylinders with rounded
ends producing above the surface.

Wrapped Wood
Floor

A raised pattern that simulates wooden plank style
patterns, such as floorboards, based on a
replication scheme.
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Texture space shaders are a little different to the other shaders since
their contribution to the material is less obvious.

Texture space shaders are used to wrap the effect of the other material
shader types, (colour, reflectance, transparency, and displacement) onto
the geometry. They do this by defining a two dimensional coordinate
system, or texture space within which ‘wrapped’ shaders operate.

Note that the names of wrapped shaders all begin with ‘Wrapped’ in
MicroGDS. Shaders that have names that do not begin with ‘Wrapped’
are not affected by texture space shaders.

For more details about how texture-space shaders contribute to the
material, and how to use them, refer to Help.

The following texture space shaders are available.
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Arbitrary Plane Maps all points onto a plane of arbitrary origin
and orientation. Allows asymmetric scaling of
textures. By default, it is identical to the Object Z
Plane texture space shader.

Auto Axis Selects one of the three global axes (X, Y, or Z)
whose plane is most-closely aligned with the
surface at each point.

Auto Directed
Plane

Maps along the normal vector of the face to which
the material is assigned. The orientation of the
texture depends on which way the face normal
points.

Auto Plane Maps along the normal vector of the face to which
the material is assigned. The orientation of the
texture depends on which side you are looking at
it from.

Cylindrical Maps all points in space on to a cylinder. Allows
asymmetric scaling of textures around and along
the axis of the cylinder.

Object Axis Selects one of the three local object axes whose
plane is most-closely aligned with the surface at
each point.

Object X Plane Maps all points in space onto a plane of constant
X in local, object coordinates.

Object XY Axes Selects the X or Y object axis whose plane is
most-closely aligned with the surface at each
point. The Z axis is ignored.

Object Y Plane Maps all points in space onto a plane of constant
Y in local, object coordinates.

Object Z Plane Maps all points in space onto a plane of constant
Z in local, object coordinates.

Spherical Maps all points in space on to a sphere. Allows
asymmetric scaling of textures around the sphere
in latitudinal and longitudinal directions.
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You can add new materials to make them available in your document.
When you add a material, it immediately becomes current and any
selected clumps are assigned that material. Any new clumps you create
are also assigned the current material.

Note that if you open a document in which there are missing materials,
for example, if they have been deleted, MicroGDS reports the error
conditions to the Problems dialog box. You can use the dialog box to
correct the errors by:

� changing the styles and fonts folder

� editing the style search path

� adding new materials

� 3��������&���
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1 Click the Styles tab on the Document Organizer, and then
double-click the Materials category.

2 Do one of the following:

� to create a new material based on DEFAULT, select the
Materials category and then, on the shortcut menu, click New.

� to create a new material based on an existing style, select the
material on which to base the new style from the required
location and then, on the shortcut menu, click New based upon.

� to modify an existing material, double-click the material to
modify, or on the shortcut menu, click Edit.

If you want to edit a material referenced in a style file, you can
open the style file for editing, using the shortcut menu.

The Material dialog box is displayed. Each tab on the dialog box
shows the characteristics of a type of shader.
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For example:

In MicroGDS Entry Level, the Define Colour dialog box is
displayed in place of the Material dialog box. For details about
materials in MicroGDS Entry Level, see Chapter 11, Working with
materials in Part One: Working with MicroGDS 11.

3 For each of the five shader types, click the shader you require from
the Shader list.

4 If you want to modify the attributes of the chosen shader, click the
attribute and modify the setting as required.

Note that the Display Units setting determines how to show and
interpret the measurements you give on the dialog box.

For details about the attributes for each shader, refer to Help.

You can reset shaders to their default settings by clicking the
Defaults button.
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5 To see the material in the preview area, click Preview.

You can speed up the rendered preview by selecting the Small area
check box.

For more information about the preview area, see the following
subsection Previewing a material.

6 Enable or disable shadows, displacement, or transparency, by
selecting or clearing the appropriate check boxes at the bottom of
any tabbed property sheet.

Note that, by default, all materials cast shadows from lightstyles that
support shadows. Select the Shadows check box to enable
shadowing. Clear the check box to disable shadowing, for example
for translucent materials especially one where the light source casts
soft shadows.

7 When you are happy with the shaders and their attributes, save the
material:

� to save the material with the existing name, click Save

� to save the material with a new name, click Save As, type the
name in the Style Name dialog box and click OK

The name must comply with the MicroGDS naming rules. You
cannot use the name DEFAULT.

The named material is made current and its name is shown in the Mat
box on the status toolbar.
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1 Deselect all graphics.

2 From the Mat list on the status toolbar, select the material on which
you want to base your new material.

3 On the Styles menu, click Material Modify.

4 Specify the material and then save the material, as described from
step 5 above.

�
�'�� ������&���
��#

When you are defining a material, you can preview it. You can view the
material using a choice of geometric shapes. These include Cube,
Cylinder, Sphere, and Cube & Polygon. Alternatively, you can look at
the preview using the selected primitives in the current view (which are
adjusted by applying a Zoom to Selection).
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Note that MicroGDS renders the image in the preview window using
the Good Image quality.
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1 If required, select the Small area check box on the Material dialog
box.

2 Select the graphics with which to preview the material from the list.

The graphics you select from the list are also used when you
preview materials in the Document Organizer.

3 Click Preview.

If you have made changes to the material, the preview is updated.

You can also double-click the preview area to update the preview.
The view is updated whether or not there have been any changes.
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In single-user documents, new materials are stored in the document (the
MAN file). They are saved when you save the document. You can
delete any local material that is not in use in the current document. You
cannot delete materials from a referenced MATLS.STY file.

In multi-user projects, new materials are stored in an external style file
(MATLS.STY). A material is saved in the actual style file as soon as
you save the style, even if you do not save project. You can delete any
material from the local style file in the project. Note that MicroGDS
does not check to see if the material is used in other window definitions
in the project.

For details about changing, modifying, and deleting materials, see
Chapter 11, Working with materials in Part One: Working with
MicroGDS 11.

For details about working with multi-user projects, see Chapter 16,
Multi-user projects.
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When you have added or modified a material, you can render the scene
to see the effects.
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1 On the Window menu, click View Parameters and select the
projection you require.

2 Use the commands on the View menu to set up the view to be
rendered.

3 To create an environment around your rendered graphics, on the
Render menu, click Edit Environment, then choose the shaders you
require.

4 To select rendering options, on the Render menu, click Options and
then select the settings you require.

To use radiosity and global illumination, select the appropriate
check box and then set up the level of detail you require.

5 On the Render Options dialog box, click Render Now.

For further details, see Chapter 19, Rendering graphics.

You can also use the Hide Mode, Shaded and Shade with Edges
commands on the View menu to preview your image using a shaded
view. Note that the shaded views do not take into account many of the
more sophisticated material attributes. For more details, see Chapter 9,
Working in 3D in Part One: Working with MicroGDS 11.
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You can use the Conductor reflectance shader, and the related shaders
such as Copper, Gold, and Nickel, to define metal-like materials.

These shaders use a physically-accurate model of the behaviour of
metal substances. In doing so they propagate a reflected ray to calculate
the part of the geometry or background that appears reflected in the
metal-like geometry. This provides very accurate reflections and is
necessary for small-scale, highly-reflective, metal-like objects.



484 Using MicroGDS 11

A simpler method, however, is to use Chrome 2D (for very shiny
metals), Metal, or Phong (for duller metals) reflectance shaders. These
do not reflect other parts of the scene but they do provide specular
highlights, thereby simulating the behaviour of metal.
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Highly reflective materials other than metals and mirrors, such as
varnished wooden surfaces, use the Mirror reflectance shader. By
default, this shader has the properties of a mirror and, in most cases, is
too highly reflective.

To allow the underlying colour, such as the wood, to be visible, you
should decrease the Mirror Factor and increase the Diffuse Factor. The
actual values used depend on the lighting conditions, but a Mirror
Factor of 0.1 to 0.3, and a Diffuse Factor of 0.5 to 0.7 are useful starting
values.

If your lighting includes an Ambient Light, you can also increase the
Ambient Factor. This gives the reflective surface a flat appearance and
reduces the effect of any shadows cast upon it.
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You can use the Constant reflectance shader to make the colour of a
material independent of the current lighting conditions. This is useful
for simulating the presence of lights, such as light bulbs, and for
ensuring that some geometry is permanently visible, such as image
backdrops.
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Although the displacement shaders can model small surface
perturbations on existing graphics, their use increases rendering time. In
some circumstances, you can use a combination of colour shaders to
simulate a displacement effect instead.

For example, to model a sandstone material, you could use a
combination of a Plain colour shader with a sandstone colour, and a
Rough or Wrapped Rough displacement shader. The effect appears as
points of brighter and darker shades of the sandstone colour where the
perturbations are lit less or more than the original surface would have
been.
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However, you can produce a similar effect by using the Wrapped
Random colour shader which creates a random pattern between two
defined colours. Therefore, by defining the first colour attribute as
slightly brighter than the intended sandstone colour, and the second
colour attribute as darker, a rough appearance can be achieved without
the rendering overhead of the displacement shader. This solution would
be suitable for objects viewed from a distance, but is unlikely to be
suitable for small objects viewed close up.
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3D Studio file format. 3D Studio is a registered trademark of Autodesk, Inc.

4�=
AIF (ASCII Interchange Format) is a type of drawing file format output by the
GDS CAD system. An AIF file contains objects with lines and text in named
styles, and attributes. MicroGDS can read and write AIF files.

GDS is a product of Graphic Data Systems, Corp.

�#���
An alias is a reference to a physical disk location. Aliases are used to map the
locations of objects, such as instance objects, and raster files, to arbitrary
names. An alias name is a name given to a folder so that the path to that folder
does not have to be specified in full.

�#������
A ‘jagged’ effect sometimes visible when straight lines or edges are rendered
as discrete pixels. Near-horizontal and near-vertical lines are particularly prone
to this effect.

����1�#������
Techniques used to prevent or reduce aliasing.
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An assembly object is a collection of other objects that can be used and
manipulated as a group. An assembly object does not contain any primitives of
its own.

���
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An attribute is non-graphical information that can be attached to primitives
objects in a document, such as colour, cost, name of supplier, and so on. This
information can be assigned and read by the user.
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The axes are made up of an X axis, a Y axis, and a Z axis, each of the three
being normal to the plane formed by the other two. The origin of the axes is the
point at which the axes meet. Coordinates are measured from the origin.

Many MicroGDS commands use the axes to draw and place graphics.

(�	��
����
Those regions of an image that are not covered by any of the geometric
primitives in the renderer geometry. The shading of such pixels is controlled by
the current background shader.
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The shader that calculates the colour of background pixels (those pixels not
covered by geometry). The colour is usually derived from the location of the
pixel in image space.

>�=
BIF (Binary Interchange Format) is a type of drawing file format output by the
GDS CAD system. Because BIF is a binary format, some computers have
different types of BIF files. MicroGDS can read and write BIF files from GDS
host computers, but there are some limitations with VMS.

>��
BIM (Building Information Modelling) is the process of generating and
managing building data during its life cycle. MicroGDS incorporates this
process to increase productivity in building design and construction.

(��&��
A bitmap is an image made up of pixels, stored as a collection of bits. In
monochrome, each bit corresponds to one pixel, but on colour systems, more
than one bit corresponds to each pixel. A bitmap can store colours in various
formats, for example, there are monochrome bitmaps, 16 colour bitmaps, and
256 colour bitmaps. A bitmap usually has the file extension .BMP.

MicroGDS can read and write BMP image files.

(
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An environment shader used to tweak the brightness of the rendered image.
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MicroGDS CAD vector fonts are character fonts made up of lines. Text that is
displayed in a vector font can be scaled, rotated, and drawn in perspective.

You can convert CAD vector fonts to lines using the Text, Burn In command
on the Alter menu.

You can create simple CAD Vector 6 fonts from basic line primitives. You can
create far more complex CAD Vector 7 fonts by saving the graphics to CV7
format.

CAD vector 6 font files have the extension .CV6; CAD vector 7 font files have
the extension .CV7.
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A charstyle defines the font and size in which text is drawn. You make
charstyles available to a document by adding them using the File Charstyle
Modify command. The name of the current charstyle is displayed in the Char
box on a status toolbar. The current charstyle is applied to new text. You
change the current charstyle using the status toolbar, or the Set Charstyle
command.

�#��(��
�
The Clipboard is a temporary storage area in the computer’s memory for data,
which is controlled by Windows. Any application can copy data into the
Clipboard, and this data can then be pasted into any other Windows
application.
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All 3D geometry is held in ‘clump’ format. A clump is a primitive that
comprises one or more faces. Clumps are created using the commands on the
Solid menu.
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A method of displaying images of one colour resolution at a lower colour
resolution. Although slower than ‘dithering’ it can produce more acceptable
results.

	�#��
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The range of brightness and colour values that a display can show or that an
image format can represent.
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A material shader that defines the colour of a point on the surface of a
primitive. It can be as simple as a plain colour which is applied to all points on
the surface with uniform intensity, or it may define a complex pattern such as
wood or marble.
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A material that conducts. All metals are conductors. Their opposites,
non-conductors such as plastic or glass, are called dielectrics. In MicroGDS,
conductor and dielectric are used to categorize how certain materials interact
with light.
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The current axes define:

� the origin from which absolute coordinates are measured

� the rotation at which graphics are drawn

� the scale at which graphics are drawn, and at which measurements are
reported
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The current layer is the layer on which new objects are added. When you
create a new layer it becomes the current layer. You can make any other layer
the current layer by double-clicking an editable phase by which it is
referenced.

	�
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The current object is the object to which new primitives are added. When you
start a new object it becomes the current object. You can make any other object
the current object by selecting it.

	�
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The current position is either the last snapped position or the last point entity
hovered over. The location of the current position is indicated by a small circle.
It is from this point that relative coordinates are measured.
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A cutter is a MicroGDS line primitive or clump primitive that is used to punch
a hole through solid clump primitives. The cutter itself is removed from the
resulting clump.
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The data source is used to point to the place where the data in an external
database is stored. The specification of a data source depends on the selected
provider.

!
DDE (Dynamic Data Exchange) is a Windows convention for linking data
between applications. Links between the source and the destination programs
are set up, so that when the data is modified by one program, it can be
automatically updated in the other.

������	�����
A technique for enhancing the depth information in an image (see foreground
shader).
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See conductor.
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A mode of light obeying Lambert’s Law, which states that light striking a
surface is scattered with equal intensity in all directions, that intensity being
proportional to the angle of the incident light. Surfaces where the diffuse term
is dominant have a matte appearance.
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A material shader that simulates the effects of small surface perturbations. It is
also known as ‘bump mapping’.

�����
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Dithering is a method used to increase the colour depth on video monitors with
limited colours.

��	�&���
In MicroGDS, a document is a single-user document or a multi-user project. A
document has a unique file name by which it can be retrieved. By default, a
single-user document has the extension .MAN; a multi-user document has the
extension .CPJ.

You can also work with other types of documents in MicroGDS. For example,
style documents, template documents, and font documents. You can use and
reference any of these documents within your MicroGDS documents.
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�
� ���
The term drawing is used in MicroGDS in a general sense. That is, it describes
a piece of paper on screen which has lines and text drawn on it.

�
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The drawing origin is the position on your drawing sheet that you use as a
point of reference. You can change the drawing origin using the Document
Properties command on the File menu. You can set the axes so that their origin
is at the drawing origin.

�
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The drawing sheet is the area on which you can draw in MicroGDS. It has a
fixed paper size of 100,000 km square, at a scale of 1:1.

�
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A drawing style is a window–based schema that contains attributes and a
reference to a .NET assembly. The drawing style is associated with a specific
view and can be used to control the appearance of an object.

�=
DWF (Drawing Web Format) are compact format files developed by Autodesk
for publishing CAD data on the web.

MicroGDS can read and write DWF files.

��
DWG (Drawing Web Format) files are the native file format for AutoCAD�.

Autodesk have not fully documented DWG format, therefore, Informatix
cannot guarantee the MicroGDS DWG translators. DWG files basically
contain everything in the drawing that are put in a MAN file in MicroGDS.

You can publish MicroGDS drawings to DWG format.

AutoCAD is a product of Autodesk, Inc.

A=
DXF (Drawing eXchange Format) is a CAD data file format developed by
Autodesk for enabling data interoperability between AutoCAD� and other
programs. MicroGDS can read and write DXF files.

AutoCAD is a product of Autodesk, Inc.
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Graphics are editable if the phase in which they are displayed has an editing
status of Editable, and if there are no editing restrictions.

!�=
Enhanced Metafile (EMF) are image files that provide true device
independence.

You can think of the picture stored in an enhanced Metafile as a ‘snapshot’ of
the screen taken at a particular moment. This snapshot maintains its
dimensions no matter where it appears on a printer, a plotter, the desktop, or in
the client area of any application.

You can publish MicroGDS drawings to EMF format.
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A render library entity that supports environment mapping. Environment maps
are composed of six separate images, each representing one of the six
orthogonal directions in world space.

��'�
��&����&������
Also known as reflection mapping, this is a technique that creates an illusion of
mirror-like reflections on the surface of objects. It can simulate either the
reflections of a surrounding environment lying at some remote distance from
the objects being rendered, or inter-object reflections.

!��"
EPix is an Extended PIXel format file containing depth, colour, and material
information for each image pixel. You can use EPix files with Piranesi� to
paint in 3D. Piranesi is a product of Informatix Inc.

�"����
�������

An environment shader that specifies an optional auto-exposure method to fit
the brightness to the screen or file limits.

�-����������
The eye position is the observer’s position in space. The eye position and
look-at point together define the direction of viewing across the scene (the line
of sight).
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0�	��
A facet is a straight-line segment or face used to draw a portion of a curved
path or surface. You specify the number of facets to be created.

0���#������

Final gather adds a final stage of lighting, where each visible surface pixel
casts out rays to other surfaces (which have been lit). The diffuse light from
those end-of-ray patches becomes the gathered diffuse lighting for the surface
pixel. The calculation of lighting values is restricted to visible points in the
image.

0�
��
����������

An environment shader used to simulate atmospheric effects such as fog and
depth cueing.

�#�(�#��##�&�������
A term for rendering with light processed for the whole model, rather than just
the visible pixels. Global illumination deals with the reflection and
re-reflection of diffuse light. This produces soft lighting and generation
ambience. Global illumination encompasses the radiosity and final gather
technologies.

�����(#�
Graphics are hittable if the phase in which they are displayed has an editing
status of Hittable; or if the phase has an editing status of Editable and there are
editing restrictions.

����������
An object’s hook point can be thought of as the ‘handle’ of the object and can
be used, for example, to pick up and place the object at an exact point in the
window definition.

��'�
����
An information box that pops up when an item is being hovered over. Details
about the hovered over item are shown in the information box.

��	#������#���
An inclusion list is a list of object names (often containing wildcards). Every
phase in a document can have an inclusion list, which is a list of objects that
can be seen in the phase. Inclusion lists are a means of sub-dividing detail on a
layer and showing it in different phases.
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������	���()�	�
An instance object is a reference to an object in another document. An instance
object does not contain graphics of its own in the current document, but is
linked to the original object in the document in which it is stored.

@�!�
JPEG (Joint Photographic Experts Group) (or JPG) is the name of the
committee that designed the standard image compression algorithm. JPEG is
designed for compressing digital images of ‘natural’, real-world scenes.

MicroGDS can read and write JPEG image files.

#�-�

Graphical data is stored on a series of layers in a document. A layer holds
objects and attributes. A window definition references graphics on a layer.

In a single-user document, layers are stored in the MAN file; in a multi–user
project, layers are stored in separate LYR files.

#������-#�
A lightstyle defines the type of light an object casts. You make lightstyles
available to a document by adding them using the File Lightstyle Modify
command. The name of the current lightstyle is displayed in the Light box on a
status toolbar. The current lightstyle is applied to new clumps.

You change the current lightstyle using the status toolbar, or the Set Lightstyle
command. Most objects do not act as lights, and do not have lightstyles
assigned to them.

#�����0������
The line of sight is the line between the observer’s position in space (the eye
position), and the point at which the observer is looking (the look-at point), in
a 3D view.

#�����
�&���'�
A line primitive is a joined up string of vertices. The vertices can be joined up
with straight lines or circular arcs. Every line primitive has a linestyle which
determines what the line looks like.
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#�����-#�
A linestyle is made up of strokes. Each stroke can define the thickness, the fill,
or pattern in which lines are drawn. You make linestyles available to a
document by adding them using the File, Linestyle Modify command. The
name of the current linestyle is displayed in the Line box on a status toolbar.
The current linestyle is applied to new primitives. You change the current
linestyle using the status toolbar, or the Set Linestyle command.

#������&(�

A unique identifier assigned to every primitive, object, and layer.

#���1��������
The look-at point is the point at which the observer is looking. The eye
position and look-at point together define the direction of viewing across the
scene.

�4;�0�#�
A MAN file stores all the graphics and related data for a MicroGDS
single-user document. Local styles can be stored in the MAN file. (Styles can
also be accessed from external style files.) A MAN file can be opened only by
one person at a time.

&���
��#
A material defines the surface appearance of clumps. You make materials
available to a document by adding them using the File Material Modify
command. The name of the current material is displayed in the Mat box on a
status toolbar. The current material is applied to new clumps. You change the
current material using the status toolbar, or the Set Material commands.

&��&���	
A mnemonic defines the type of data that an attribute will store. Attributes are
non-graphical information associated with items in a document.

��<�0�#�
A MOV file is a QuickTime Object or Panorama Movie file. MOV files
created in MicroGDS can be viewed using QuickTime Movie players version
3.0 or later.

QuickTime is a product of Apple Computer, Inc.
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&�#��1���

Multi-user in MicroGDS is based on a system of projects. The drawing data is
stored in a separate file for each layer (LYR files). Users open window
definitions (WND files), which access the layer files. Each user can have one
or more window definitions open at a time.

��&������������
Name assistants use configuration files to define the naming conventions for
object names and layer names. You can use your user preferences to specify
whether the name assistants suggest or enforce the conventions defined in the
file, as required.

��
&�#��"��
The normal axes are the default axes when you create a new document. The
scale is set to 1, and the angle is set to 0. Their position represents the drawing
origin, unless it is moved. The point is 0 on the X, Y and Z axes (coordinates
0/0/0) and is the point from which the coordinates are measured.

�()�	�
In its simplest form, an object is a collection of graphics. In MicroGDS, there
are several types of objects:

� plain objects which contain only primitives

� intelligent objects which can contain line primitives and attribute data, or
just attribute data

� instance objects which do not contain graphics of their own, but have a link
to a source object in the document in which they are stored

� assembly objects which can contain plain objects, instance objects, and
other assembly objects

Each object has a name and a set of axes associated with it. An object is held
totally on one layer.

�()�	���"��
Each object has its own set of object axes. When you create a new object, you
place the origin. The origin defines the object’s hook point. The rotation and
scale of the set axes defines the initial rotation and scale of the object axes.
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�()�	���-#�
An objectstyle defines a set of attributes that describe the intelligence of an
object. Each attribute defines a property of the object, such as the thickness or
material of a wall layer.

The objectstyle of an object is shown on the Properties window. To change the
objectstyle that is assigned to an object,  select the object and then select the
objectstyle from the list.

�6!
An OLE object is an ‘Object Linked or Embedded’ object. You use linked and
embedded objects to share information between Windows programs.

You can use a linked object or an embedded object to add data, created in any
program that supports linked and embedded objects, to a file in another
application. For example, you can embed or link MicroGDS graphics or views
in other applications. Similarly, you can embed or link data from other
applications in MicroGDS documents with the Paste Special command.

����
A path is a section of a line primitive. To define a path, you specify two
positions on the primitive. If the primitive is closed, MicroGDS finds the
shortest route between the points along the primitive.

�=
PDF (Portable Document Format) is an open file format created by Adobe
Systems. PDF is used for representing two-dimensional documents in a device
independent and resolution independent fixed-layout document format.

Adobe is either a registered trademark or trademark of Adobe Systems
Incorporated in the United States and/or other countries.

MicroGDS can publish drawings to PDF format.

�����
A phase is a view onto a layer. It defines the editing status of the objects on a
layer, and the colour in which they are shown.

You can specify which graphics on the layer are included in the phase. You can
also define overrides that display all graphics referenced in a phase in a
particular linestyle, charstyle, or strength.
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�������
�&���'�
A photo primitive is a ‘snapshot’ of the graphics in one window definition that
are displayed within another window definition.

The link from the photo primitive to the window definition is live. Therefore,
if the graphics in the window definition are modified, the photo contents are
immediately updated with the change.

You can convert photo primitives to lines using the Photo, Burn In command
on the Alter menu.

��"�#
Images and displays are composed of arrays of pixels, which are rectangular
‘picture elements’ (hence the name). In a monochrome image, each pixel has
an ‘on’ or ‘off’ state. Pixel values for colour images are represented by RGB
(red, green, blue) values.

�;�
Portable network graphics (PNG) is an extensible file format for the lossless,
portable, well-compressed storage of raster images. Indexed-colour, greyscale,
and true-colour images are supported, plus an optional alpha channel and
gamma information.

MicroGDS can read and write PNG image files.

��#�	-
A policy defines a setting that cannot be edited. Any MicroGDS setting at any
level can be defined as policy. If a value is given to that setting later in the
search list, it will not alter the value for that setting and will be ignored. For
example, if a policy is set which defines the location of your font files at
domain level, any location later set at job or user level is ignored.

�
�&���'�
A primitive is a graphics item such as a line or an item of text. Primitives are
grouped together into objects. A primitive can be part of only one object.

�
��	���#� ���� 
The principal window is a window definition in a single-user document
(usually, a MAN file). It is the window definition MicroGDS displays when the
document is opened.
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By default, the principal window is the first window definition created in a
document. You can designate another window definition to be the principal
window, using the Document Organizer.

�
����#�-���
A print layout shows how the graphics will look when you print the window
definition. You can set a paper size, orientation, and margins to be used for the
layout. You can also draw and edit the graphics in a print layout view.

�
�	���
�#������

A procedural shader is a shader that is generated by repeating a defined
pattern, such as bricks or dots.

�
�0�#�
A profile defines the look-and-feel of the MicroGDS workspace. You can
create and load profiles to suit different methods of working. For example, you
might have one profile that loads a set of 2D drawing tools and hides all 3D
related items and another that is specifically 3D based.

�
�)�	�
A project in MicroGDS is the entire set of files relating to a project. This
includes the project database, all project workspaces referring to the project
database, all window definitions using data identified by the project database,
and all layer files.

�
�)�	������(���
The database used by a project to locate the project’s data. A single project
database can be shared by several project workspaces.

�
�)�	����&�#���
A project template is a pre-defined set of parameters that can be used when
setting up new projects. Templates provide a database structure, and can create
aliases, layers, window definitions, raster files, and instance object libraries for
you. It can also define the style search path.

�
�)�	�� �
����	�
The project workspace is the file opened in order to work with data in a
multi-user project. The project workspace defines the project database to be
used, the layers within the project that are editable, and various configuration
options.
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�
�'���

A database provider is the name that identifies a particular OLE DB plug-in
used to access data in a specific type of database. For example,
Microsoft.OLEDB.Jet.4.0 is used to access data in a Microsoft Access
database.


�������-
A physical solution to the inter-reflection of light (radiant energy) which
divides modelled faces into triangles. Light from the primary light sources is
shot from the sources to all triangles that it can reach without being blocked.
Each triangle then re-radiates its diffuse reflected light. The process repeats
and iterates towards a solution.


����

A raster file is an image file composed of an array of pixels (a bitmap). Raster
files can be inserted into a MicroGDS document.


�-��
�	���
A rendering technique in which the colours are computed by tracing imaginary
rays of light through a scene. It can be used to create photo-realistic rendering
effects, such as mirror reflections and refractions.


�0#�	���	�������

A material shader which models the interaction of light with a surface, and in
particular, how much light is reflected towards the viewer. A reflectance shader
can be thought of as defining the ‘finish’ of a surface. Reflectance shaders can
be used to model the reflectance properties that simulate the effects of a
surface which is composed of specific types of material, such as plastic or
metal.


�0
�	����
The change in direction of light as it crosses the boundary between two
transmitting media.


����
���
The complete process of producing an image from a model. This comprises
two major stages: visibility determination and shading.

�	�#�
The current scale is the scale at which you are drawing. You set this by
selecting from the Scale list on a status toolbar, or typing in the box.
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When you create a new object, MicroGDS stores the scale at which it was
drawn. You can use the Measure commands to measure the real world size of
objects, and their size at the set scale. You can change the object scale using
the Object Scale command.

�	��&�
A schema indicates which layers, objects, and windows the specified
mnemonics are intended to be used with.

Mnemonics for graphics-based attributes that are referenced by a schema are
shown in the Properties window for the selected graphics, and in the Window
Editor for window-level mnemonics.

���&���
A line segment is the section of line that lies between two vertices. It can be
straight or curved; a curved segment cannot span more than 180 degrees.

���������0�#��
The settings files store all the parameters related to the set-up of your
MicroGDS system. For example, the frequency of automatic backups is stored
here. You define many settings using the File Preferences command. Further
files may then be read which may make changes to the appearance and
behaviour of MicroGDS.

�����

A shader is a function that calculates some aspect of the rendering
environment. Shaders are categorised into the classes to which they are
applicable, for example, Background shader, Material Reflectance shader.

�������
Part of the rendering process that calculates the colour and intensity of a pixel.

����#�1���
���	�&���

In single-user documents all the drawing data is stored in a single file, usually
in a MAN file. Styles, window definitions, and colours are stored in the file.
Styles can also be accessed from external style files. A single-user document
can be opened only by one person at a time.
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�D��0�#��
SKP format files are produced from SketchUp drawings. You can open and
import SKP files in MicroGDS.

SketchUp is a trademark of Google, Inc.

��-������

An environment shader used to simulate a diffuse light source that represents
light from the sun which has been scattered by the atmosphere.

����	���
MicroGDS uses snapcodes to snap exactly to points on the graphics or to an
orthogonal direction.

�����������
Snap guides are temporary lines that are displayed whenever you are prompted
for a position in a command. Snap guides help you position and align graphics
more precisely.

��#���(�

A split bar separates the window into two panes. You can change the size of
the panes by dragging the split bar.

��-#��0�#�
A style file is a single-user document saved with a .STY extension. Style files
enable users to share styles across different documents.

���������

An environment shader used to simulate a light source that emits light from the
sun. The shader modifies the colour of the surface of each pixel to produce an
atmospheric scene.

�<�
SVG is a vector file format and web development language based on XML.
Graphics saved to SVG file format can be zoomed and scaled without loss of
quality across various platforms and devices.

You need an SVG Viewer to view SVG graphics.

SVG file format was created in cooperation of the World Wide Web
Consortium(W3C) and its members.

You can publish MicroGDS drawings to SVG format.
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345�4�9�
�3�4:
An image format for bitmap images, using 24 bits per pixel, developed by
Truevision Inc.

You can insert TGA images into MicroGDS as raster files.

��&�#���

A template can automatically create graphics and styles in a new document.
For example, a template could include a standard frame, or a company logo.
Templates are stored in MTF files.

��"���
�&���'�
A text primitive is a block of text. A text primitive has a charstyle and a
justification point. If you change the size of a text primitive, it changes size
about its justification point. There are nine possible justification points
positioned in a 3 by 3 grid around the text.

��"��
��&������
A technique for rendering fine surface details on an object without explicitly
modelling the geometry. A two-dimensional image (a texture map) is projected
onto the surface of an object. Texture maps can be either a
procedurally-defined function or an image (scanned or pre-computed). Texture
mapping makes use of both texture space shaders and colour shaders.

��"��
�����	�
A two-dimensional coordinate system used to map a wrapped shader onto the
surface of a primitive.

��"��
�����	�������

A material shader which defines the texture space to be used by wrapped
shaders. Texture space shaders differ from other types of shaders in that they
do not directly affect the final intensity of a pixel.

37=�0�#�
GDS 3D Things file.
GDS is a product of Graphic Data Systems, Corp.

3�=,3�==
Tag Image File Format. This is a widely-used, general-purpose data format for
the interchange of images.

MicroGDS can read and write TIF image files.
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�
�����
��	-������

Defines the transparency of a surface and thus how much light can pass
through it. Transparency shaders use filters, that define the colour of light
passing through the surface; and stencils, which define the presence of this
light.

3
��3-���0����
TrueType fonts are the scalable fonts supplied by the Windows environment.
They are indicated by a  symbol in the Font dialog box. MicroGDS can use
TrueType fonts as the basis of its charstyles. TrueType fonts provide an
excellent method of displaying text if the output device in use is driven through
a Windows printer driver.

MicroGDS can also use OpenType fonts, which is an extended version of

TrueType, indicated by a  symbol in the Font dialog box. OpenType retains
TrueType’s basic structure but also adds many intricate data structures for
prescribing typographic behaviour.

�����
MicroGDS can deal with several types of units, both metric and imperial. You
select which units you want to use with the Set Units command and you can
choose the number of decimal places to which you want numbers displayed.
However, no matter how many decimal places are set, MicroGDS stores
coordinates internally to 15 significant figures. You can still enter coordinates
with more decimal places than you have set.

'�
��"
A vertex is a point where two line segments join (often, although not always, at
a corner), or the point at the end of a line. You can use the Vertex snapcode to
snap to a vertex.

'�� 
A view comprises the extent of the visible window and the quality settings for
that window. There are three types of view—two dimensional, three
dimensional, and print layout.

� in a 2D view, you can choose the extents of the normal XY plane you want
to see in a rectangular box

� in a 3D view, you can choose the eye position, the look-at point, and the
type of projection you want to work with
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� in a print layout view, you choose a paper size, orientation, and margins for
the layout

You can display more than one view of a particular document. For example,
you may want to have two views zoomed into different parts of a window
definition. Views onto the same window definition are updated simultaneously.

'�� ��"����
The view extent is the current view onto the drawing sheet.

 ���� ���0�������
A window definition provides a view onto the graphical data in a document. It
stores information about how the graphical data is presented, such as details of
phases and views. You can create multiple window definitions in a document.

You can have several window definitions open at a time. Each window
definition can have a zoom bar, scroll bars, and a set of viewing buttons.

In a single-user document, window definitions are stored in the MAN file; in a
multi-user project, window definitions are stored in separate WND files.

����� ��0����
Each Windows operating system comes with a number of standard Windows
fonts. Fonts are also frequently included with printers and others may be
installed as part of a program installation. You can use any Windows font when
you create and modify charstyles.

You can convert Windows fonts to lines using the Text, Burn In command on
the Alter menu.

�;
A WND file is a saved window definition in a multi-user project. The
graphical data is stored in layer files (LYR). The WND file references the
graphics in the LYR files.

A�6
XML (extensible markup language) is a basic syntax for expressing structure
in data. XML can be used on a wide variety of platforms and read by a wide
variety of applications.

XML was developed by an XML Working Group formed under the auspices of
the World Wide Web Consortium (W3C).
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3
���&�
������
�	��� #����&����

3
���&�
��
Microsoft, Windows, Microsoft Vista, Visual Basic and Visual Studio
are either registered trademarks or trademarks of Microsoft Corporation
in the United States and/or other countries.

AutoCAD is a product of Autodesk, Inc.

Adobe is either a trademark or registered trademark of Adobe Systems
Incorporated in the United States and/or other countries.

3D Studio is a registered trademark of Autodesk, Inc., in the United
States and/or other countries.

QuickTime is a trademark of Apple Inc.

LightWorks is a registered trademark of LightWork Design Ltd.

Real World Textures Copyright (c) 1997 John Warburton.

Targa is a trademark of Truevision, Inc.

DWGdirect (c) 2007 by Open Design Alliance Inc. All rights reserved.

Other product names mentioned in this help may be trademarks, and
they are used for identification purposes only.
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4	��� #����&����
Piranesi is from an original concept by Simon Schofield and Paul
Richens, at the Martin Centre for Architectural and Urban Studies,
Cambridge University, U.K.

The following acknowledgements are for the use of DWGdirect, JPEG,
LibTiff, LightWorks, OpenEXR, PNG, and zlib within MicroGDS.

����
�	�

DWGdirect includes libraries provided by the Freetype Project.
DWGdirect can be configured to use the Freetype Project libraries for
font rendering and other font-related tasks.

@�!�

MicroGDS is based in part on the work of the Independent JPEG
Group. The JPEG library is copyright (c) 1991–1998, Thomas G. Lane.

6�(3�00

Copyright (c) 1988–1997 Sam Leffler

Copyright (c) 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names
of Sam Leffler and Silicon Graphics may not be used in any advertising
or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED ’AS–IS’ AND WITHOUT WARRANTY OF ANY KIND,

EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY

WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY

SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY

KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA

OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,

AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION

WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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6������
��

Portions copyright 1990–2008, 2009 LightWork Design Ltd.

����!A5�95:��&����0�
&��

Copyright (c) 2002, Industrial Light & Magic, a division of Lucas
Digital Ltd. LLC All rights reserved.

�;��5�0�
��	��6�(
�
-

Libpng version 1.0.24 – January 3, 2007
Copyright (c) 1998 – 2007 Glenn Randers–Pehrson
(Version 0.96 Copyright (c) 1996, 1997 Andreas Dilger)
(Version 0.88 Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42,
Inc.)

2#�(

Copyright (c) 1995–2005 Jean-loup Gailly and Mark Adler.
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Numbers
2D switching views, 221

3 point projections, 228

3D

coordinates, 134

line of sight, 229

projections, 228

switching views, 221

XY plane, 230

3DS files, 328

A
acknowledgements, 508

adding

assembly objects, 79

attributes, 322

charstyles, 195

layers, 114

lightstyles, 260, 454

linestyles, 158

materials, 276, 479, 482

menus, 380

mnemonics, 313

multi-user projects, 346

objects, 68

schemas, 315

shortcut keys, 379

text, 208

toolbars, 374, 375

advanced lighting, 426

AIF files, 328

aliases, 27
default, 355
layer name assistant, 121
overriding, 359
renderer, 439

aligning
text, 213
views, 149

altering graphics, 91
ambient lights, 257, 449
angle, axes, 148
angles file, customizing, 397
area lights, 449
assembly objects

about, 78
closing, 80
creating, 79
dissolving, 80
opening, 80

assigning
attributes, 319
shortcut keys, 379

assistl.cfg, 388
assisto.cfg, 388
attributes, 309

adding, 322
assigning values, 319
copy link, 324
copying, 324
filtering objects, 325
hidden, 314
layer level, 313
mnemonics, 313
object level, 313
primitive level, 313
reference level, 313
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removing, 321
schemas, 315
secondary annotation, 215, 326
types, 314
window level, 313

ATTRS.STY, saving styles, 25
axes, 145

3D, 219
angle, 148
centring, 149
changing the scale, 150
hiding, 146
moving, 42, 147
normal, 145, 149
of objects, 151
origin, 42
restoring, 151
rotating views, 149
saving, 151
scale, 44, 150
showing, 146
spinning, 148
with cut and copy, 153

B
background

environment, 437
images, 438

backup files, 36, 359
basic lighting, 425
Basic, project template, 344
BIF files, 328
BIM environment, customizing, 382
BIM objects

creating, 84
defining, 384
drawing, 85
drawing styles, 82
modifying, 86
objectstyles, 84
style search path, 82
using, 81

BLANK linestyle, 155

BMP files, 333
Boolean operations, 407
boxing text, 209
brighten, environment, 443
burn in instance object, 78
button size, toolbars, 374
buttons

justification, 214
toolbars, 12
viewing, 50
x, y, z, 142

ByPhase, colour, 101

C
CAD administration, 387
cancelling

commands, 21
positions, 20
rendering, 423

Cartesian coordinates, 135
centring axes, 149
changing

default view, 54
document properties, 370
principal window, 40
text width, 213
toolbar button size, 374
view parameters, 226

CHARS.STY, saving styles, 25
charstyles, 191

accessing, 193
adding, 195
built-in, 192
changing, 197
changing globally, 198
copying, 207
creating, 195
current, 197
DEFAULT, 156, 192
deleting, 207
fonts, 202
margins, 205
MicroGDS, 192
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modifying, 206
naming, 196
objects, 74
outline, 206
phase override, 200
printing, 296
properties, 201
respecting colours, 108
saving style files, 25
scale, 204
spacing, 205

Clipboard
and axes, 153
cutting graphics, 89
linking data, 337
pasting graphics, 89

clipped view, 241
cloning layers, 118
closing

assembly objects, 80
documents, 37
projects, 357
renderer, 423
window definitions, 40

clump primitives, 58
clumping graphics, 238
clumps

Boolean operations, 407
carving, 410
clashing, 409
constructing, 232
creating, 238, 404
editing, 407
exporting, 415
facets, 232
generating, 404
importing, 415
mesh, 406
pockets, 410
profiles, 410
punching, 410
quad faces, 416

removing holes, 416
slicing, 239, 411
smoothing, 240
triangulate, 415

co-ordinate space, 169
colour shaders, 466
colours

graphics, 94
phases, 107
precedence, 94
printing, 296
resetting, 96
strokes, 169

command line, 364
commands

accessing, 20
assigning shortcuts, 379
cancelling, 21
changing on toolbars, 373
creating toolbars, 374, 375
flyout toolbars, 376
repeating, 21
selecting from toolbars, 12
undoing/redoing, 21
using, 20

configuration files, sample files, 388
constraining distances, 137
converting

files, 327
instance objects to primitives, 78
photos to primitives, 61
text to primitives, 246

coordinates, 130
3D, 222
Cartesian, 135
Polar, 136
precision, 133
principles, 130
shortcuts, 138
units of measurement, 132
with snapcodes, 138
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copying
attributes, 324
charstyles, 207
graphics, 153
layers to a window definition, 117
lightstyles, 264
linestyles, 189
linked data, 324
materials, 285
objects between layers, 119
phases, 112
primitives, 88
rendering environments, 434

CPD files, 347
CPJ files, 353
creating

assembly objects, 79
BIM components, 384
charstyles, 195
clumps, 230, 404
cones, 404
cuboids, 404
cylinders, 404
documents, 33
flyout toolbars, 376
format definition file, 306
layer configuration files, 392
layers, 114
lightstyles, 260, 454
linestyles, 158
materials, 276, 479, 482
menus, 380
mesh clumps, 406
mnemonics, 313
multi-user projects, 346
object configuration files, 392
objectstyles, 383
phase filters, 109
plain objects, 68
pockets, 410
primitives, 67
profiles, 371, 410

project databases, 347
project templates, 345
project workspaces, 353
raster primitives, 334
rendering environments, 433
saved views, 53
schemas, 315
simple 3D graphics, 404
spheres, 404
strokes, 165
STY files, 25
surfaces, 406
templates, 24
text primitives, 208
toolbars, 374, 375
window definitions, 38

current
angle, 148
axes, 145
charstyle, 197
layer, 101
lightstyle, 262
linestyle, 161
material, 279
position, 131
scale, 150

customizing
angles file, 397
menus, 380
paper sizes file, 397
scales list, 396
shortcut keys, 379
status toolbars, 373
toolbars, 373
user preferences, 366

cutting graphics, 90, 153

D
DDE format, 337
decimal, places, 133
DEFAULT

charstyle, 156, 192
lightstyle, 255, 446
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linestyle, 155
material, 274, 464

default
aliases, 355, 359
layer name, 99

default view, setting, 54
defining BIM components, 384
deleting

charstyles, 207
layers, 119, 125
lightstyles, 264, 454
linestyles, 190
materials, 286, 482
strokes, 166

deselecting graphics, 63
Dialogue window, 303
dimensions, 217
displacement shaders, 474, 484
displacing graphics, 234
dissolving assembly objects, 80
distant lights, 257, 450
docking

status toolbars, 13
windows, 11

document
defaults, 370
properties, 370

Document Organizer, 16, 29
documents

closing, 37
creating, 33
exporting, 331
importing, 329
MicroGDS, 23
non-MicroGDS files, 328
opening, 9, 35
problems, 36
publishing, 332
saving, 37
views, 45, 53
window definitions, 38

dotted view, 241

drawing
in 3D, 222
origin, 43
primitives, 67
sheet, 42

drawing styles, 82
duplicating layers, 118
DWF files, 328
DWG files, 328
DXF/DWG mapping tables, 332

E
editable phases, 106
editing

clump faces, 412
clumps, 407
file labels, 301
graphics, 91
hidden attributes, 314
instance objects, 76
linked objects, 77
phases, 102
raster images, 335
restricting, 91, 106, 162, 198
selections of clumps, 409
text, 212
workpieces, 408

embedding objects, 340
ending commands, 21
entering positions, 127

combining methods, 138
coordinates, 130
snapcodes, 128

entity mapping tables, 332
environment

background shaders, 437
environment map shaders, 439
exposure shaders, 442
foreground shaders, 435
sky shaders, 441
sun shaders, 441

environment light lights, 450
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environment map
brighten shaders, 443
environment, 439

environments
copying, 434
creating, 432
rendering, 433

EPX files, 333, 444
equations, 134
errors, 36
exiting MicroGDS, 55
exporting

clumps, 415
window definitions, 331

exposure, environment, 442
extruding graphics, 233
eye lights, 258, 450

F
faces

assigning materials, 282
checking the material, 283
editing clumps, 412
smoothing, 240
splitting, 415

facets
object names, 70
setting faces, 232

fall off, shadows, 458
files

backups, 36, 359
converting, 327
exporting, 331
importing, 329
labels, 301
lock files, 359
LY#, 359
LY$, 359
MA#, 36
MA$, 36
non-MicroGDS files, 328
opening, 35
printing, 291, 293

publishing, 332
WN#, 359
WN$, 359

filtering
graphics, 91
phases, 109

filtering objects, 72, 325
final gather, 420
final gather options, 428
fixing positions, 142
flyout toolbars, 14, 376
fonts, 202
foreground environment shaders, 435
format definition file, 306

G
geometry, rendering co-planar, 239
global illumination, 423
glossary, 487
goniometric lights, 451
graphics

altering, 91
attributes, 97
clumping, 238
copying, 87
copying between layers, 119
cutting, 90
deleting, 90
deselect all, 63
displacing, 234
editing, 91
extruding, 233
measuring, 302
moving, 87
moving between layers, 119
pasting, 90
positioning, 127
properties, 300
rendering, 421
retrieving deletions, 90
revolving, 237, 405
rotating views, 149
scale, 44
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select all, 63
slicing, 239
smoothing, 240
sweeping, 236
tapering, 234, 235

graphics window, 3D views, 222
greeking text, 215
grid, 142

H
hidden

attributes, 314
views, 241

Hide modes, 241
hiding/showing

axes, 146
grid, 142
toolbars, 12
view controls, 53

hittable phases, 106
hook point, 69
hover highlight button, 18
hover highlighting, 64
HTML Help, 5

I
image files

light projector, 452
mapping to material, 465

images, 3D views, 243
importing

clumps, 415
files, 329

in-line equations, 134
inclusion lists, 100

filtering objects, 325
phases, 109

information bar, 18
inserting

objects, 73, 74
raster images, 334

instance objects, 75
burn in, 78
editing, 76
inserting, 74
read-only, 76

intelligent objects
See also BIM objects
about, 81
creating, 84
drawing, 85
modifying, 86

Internet Explorer, 5
invisible phases, 107

J
JPG files, 333
justifying text, 213

L
labels, 301

layers, 114
phases, 113
windows, 105

layer
configuration file, 390
name assistant, 121
name assistants, 31

layer-level attributes, 313
layers, 99

changing, 101
cloning, 118
copy to window definition, 117
copying objects, 119
creating, 114
default, 99
deleting, 119, 125
duplicating, 118
finding, 116
in projects, 120
labels, 114
link numbers, 120
locking, 120
maximum in project, 121
moving objects, 119
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naming, 115
naming using aliases, 121
overriding aliases, 359
owner, 123
previewing, 115
renaming, 115
saving, 358
unique names, 115, 330
updating, 123

lighting
advanced, 426
basic, 425
considerations, 420

lighting-independent materials, 484
lights

ambient, 257, 449
area, 449
distant, 257, 450
environment light, 450
eye, 258, 450
goniometric, 451
point, 451
projector, 451
rendering, 455
sky, 452
spot, 453
sun, 453
sun + sky, 453
types, 256, 448
using image files, 452

LIGHTS.STY, saving styles, 25
lightstyles, 255, 445

accessing, 258
adding, 260, 454
copying, 264
current, 262
DEFAULT, 255, 446
deleting, 264, 454
modifying, 263
naming, 262
NONE, 255, 446
objects, 74

properties, 448
rendering, 454, 455
saving style files, 25
shading a scene, 265
shading an image, 455
shadows, 457

shaded views, simplified lighting, 266
line of sight in 3D, 229
line primitives, 58
LINES.STY, saving styles, 25
linestyle strokes

co-ordinate space, 169
colours, 169
creating, 165
defining, 167
deleting, 166
drawing order, 187
filled, 176
offset, 168
patterns, 170
phasing, 175
reordering, 166
respecting colours, 108
symbols, 166
thickness, 170
types, 168
use for snapping, 170
vertex, 186

linestyles, 155
accessing, 157
adding, 158
BLANK, 155
built-in, 156
changing, 161
changing globally, 162
copying, 189
creating, 158
creating strokes, 165
current, 161
DEFAULT, 155
deleting, 190
deleting strokes, 166
drawing order, 187
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masked, 188
MicroGDS, 156
modifying, 189
naming, 160
objects, 74
phase override, 164
phasing, 175
printing, 296
reordering strokes, 166
saving style files, 25
strokes, 155, 167

linked data, 324
linking objects, 337
listing objects, 304
loading, profiles, 371
lock files, 36, 359
LY# files, 359
LY$ files, 359

M
MA# files, 36
MA$ files, 36
MAN files, 23
material shaders, 464

colour, 466
displacement, 474
reflectance, 469
texture space, 477
transparency, 473

material substitution, 431
materials, 273, 463

accessing, 274
adding, 276, 479, 482
changing globally, 280
copying, 285
creating, 479
current, 279
DEFAULT, 274, 464
deleting, 286, 482
lighting independent, 484
modifying, 285
naming, 278
objects, 74

of selected face, 283
phase override, 282
previewing, 481
reflective, rendering, 484
rendering, 483
saving style files, 25
setting faces, 282
shaded views, 463
shading a scene, 287
shading an image, 483
shadows, 481
types, 464
using image files, 465

MATLS.STY, saving styles, 25
measuring graphics, 302
menu bar, 12
menus, customizing, 380
mesh clumps, 231
metals, rendering, 483
MicroGDS

documentation, 4
exiting, 55
fonts, 203
linestyles, 156
profiles, 11
starting, 9
terminology, 487
updates, 3
website, 3

Microsoft Internet Explorer, 5
Mini Window Editor, 16
mnemonics

accessing, 311
creating, 313
in secondary annotation, 215
levels of, 313
naming, 318
saving style files, 25
types, 314

modifying
charstyles, 206
lightstyles, 263
linestyles, 189
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materials, 285
mnemonics, 315
schemas, 318
text, 212

moving
around documents, 45
axes, 42, 147
objects between layers, 119
primitives, 88
toolbars, 13

MTF files, 24
multi-user projects

closing, 357
creating, 346
creating the database, 347
creating the workspace, 353
deleting layers, 125
layer aliases, 121
number of layers, 121
opening a workspace, 356
project templates, 344
saving, 357
saving layers, 358
saving window definitions, 358
Sixhills sample project, 342
style files, 360
transferring files, 361

N
name assistants, 71

sample files, 388
setting up, 387
using, 31

names, aliases, 27
naming

BIM components, 70
BIM objects, 84
charstyles, 196
intelligent objects, 70, 84
layers, 115
lightstyles, 262
linestyles, 160
materials, 278

mnemonics, 318
objects, 70
schemas, 318

Navigate window, 51
NONE, lightstyle, 255, 446
normal axes, 145, 149

O
object

name assistant, 31
reset scale and rotation, 152

object configuration file, 391
object list, 97, 304
object schedule, 97, 305
object-level attributes, 313
objects, 57, 61

assembly, 78
axes, 70, 151
burn in, 78
changing colours, 94
clumping, 238
copying between layers, 119
creating, 68
cutting, 90
deleting, 90
displacing, 234
editing, 77, 91
embedding, 340
extruding, 233
facets, 70
filtering, 72
highlight feedback, 64
hook point, 69
inserting, 73
instances, 75
intelligent, 81
linking, 337
listing, 304
moving between layers, 119
naming, 70
querying, 302
renaming, 72
replacing, 90
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reporting, 97
scale, 70, 150
schedule, 305
selecting, 62
styles, 74
superimposing, 91
sweeping, 236
tapering, 234, 235

objectstyles, 84
creating, 383

OLE, 337, 339
OLE primitives, 58
opening

assembly objects, 80
backup files, 36
Dialogue window, 304
different file formats, 328
Document Organizer, 29
documents, 9, 35
problems, 36
project workspace, 356
Properties window, 300
raster images, 336
restoring views, 55
saved views, 54
window definitions, 39

origin, hook point, 69
overriding

aliases, 359
charstyles, 111, 200
fading, 112
linestyles, 111, 164
materials, 111, 282

P
paper sizes file, 47

customizing, 397
parametric objects. See BIM objects
pasting graphics, 90
phases

See also layers
charstyle override, 200
colours, 107

copying, 112
editable, 106
editing status, 106
fading, 112
filtering, 109
hittable, 106
inclusion lists, 100
invisible, 107
label, 113
linestyle override, 164
list, 104
material override, 282
overrides, 111
removing, 113
reordering, 106
screen display only, 109
selecting, 105
using primitive colours, 108
using style colours, 108
visible, 107

photo primitives, 59
plotting. See printing
PNG files, 333
point lights, 451
Polar coordinates, 136
policies, setting up, 369
positions

cancelling, 20
current, 131
entering, 127
fixing, 142
pointer, 18

Preference Files Editor, 368
preferences, 22

changing, 366
saving, 366

previewing
charstyles, 194
layers, 115
lightstyles, 259
linestyles, 158
materials, 276, 481

primitive-level attributes, 313
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primitives, 57
changing colours, 94
constructing, 67
converting text, 246
copying, 88
cutting, 90
deleting, 90
displacing, 234
drawing, 67
drawing order, 187
editing, 91
extruding, 233
highlight feedback, 64
line, 58
moving, 88
querying, 302
selecting, 62
window photo, 59

principal window, 24
setting, 40

print layout views, 45
customizing paper sizes, 397
photos, 60

printer setup, 290
printing

charstyles, 296
colours, 296
dithering, 296
enlarging the scale, 295
fitting to paper, 295
linestyles, 296
monochrome, 296
multiple views, 293
raster images, 290
rendered image, 444
single views, 291
Windows devices, 289

problems button, 19
Problems dialog box, 36
profiles, 11

creating, 371
loading, 371

project databases, 342
creating, 347

project templates, 344
samples, 344

project workspaces, 343
closing, 357
creating, 353
default aliases, 355
opening, 356
overriding aliases, 359
saving, 357
styles files, 360

projections, 228
projector lights, 451
projects

See also multi-user projects
Sixhills sample project, 342

prompt bar, 19
properties

BIM objects, 84
charstyles, 201
lightstyles, 448
linestyle strokes, 168

Properties window, 17, 66, 300
publishing, window definitions, 332

Q
quality modes, rendering, 424
Quality settings, with linestyles, 161, 197
Quality window, 45
querying, properties, 302
quitting

commands, 21
MicroGDS, 55

R
radiosity options, 427
radiosity processing, 420
raster images, 333

3D views, 242
editing the image, 336
editing the path, 335
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inserting, 334
printing, 290
updating the image, 336

raster primitives, 58
ray tracing, 419
read-only

documents, 36
objects, 76

redoing commands, 21
reference data, 215
reference-level attributes, 313
referencing objects, aliasing, 27
reflectance shaders, 469

constant, 484
metal materials, 483
mirror, 484

reflective shaders, rendering, 484
removing

attributes, 321
clump holes, 416
phases, 113
shortcut keys, 379

renaming
layers, 115
objects, 72
toolbars, 374
views, 54
window definitions, 40

render options, 423
renderer aliases, 439
renderer window

changing the size, 421
closing, 423

rendering, 417
cancelling, 423
co-planar geometry, 239
environment shaders, 432
final gather, 420, 428
force update, 431
image quality, 424
lighting, 455
lightstyles, 454

materials, 483
metals, 483
planning lighting, 420
predefined schemes, 434
previewing materials, 481
printing an image, 444
radiosity, 420, 427
saving an image, 443
simplify lights, 431
technologies, 419
tips, 431

repeating commands, 21
resizing windows, 11
restoring, axes, 151
restoring views, 55
restricting editing

charstyles, 198
linestyles, 162
materials, 280
objects, 91

revolving graphics, 237, 405
rotating

axes, 147
views, 149

S
samples, project templates, 344
saved views, creating, 53
saving

axes, 151
documents, 37
layers, 358
preferences, 366
profiles, 371
projects, 357
rendered image, 443
STY files, 25
style files, 25
views, 54
window definitions, 358

scale, axes, 44
scales file, customizing, 396
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scaling
axes, 150
charstyles, 204
enlarging when printing, 295
fonts, 202
objects, 70, 150

schedule, object details, 305
schemas

accessing, 311
creating, 315
naming, 318
saving style files, 25

SCHEMAS.STY, saving styles, 25
scrolling

2D views, 49
3D views, 222

secondary annotation, 215, 326
section views, 245
select material from face, 280
selecting

all graphics, 63
instance objects, 76
objects, 62
phases, 105
primitives, 62

selection properties, 300
SETEDIT button, 18
setting

editing restrictions, 91
face materials, 282
policies, 369
preferences, 22
the default view, 54
the principal window, 40

settings files, managing, 393
shaded view, 241
shaders

colour, 466
displacement, 474
environment, 432
materials, 464

reflectance, 469
texture space, 477
transparency, 473

shading clumps
lightstyles, 265, 455
materials, 287, 483

shadows
fall off, 458
hard, 458
lightstyles, 457
soft, 458

shortcut
keys, 379
menus, 103

showing views, 54
showing/hiding

axes, 146
grid, 142
toolbars, 12
view controls, 53

simplified lights, shaded views, 266
simplify lights, 431
SketchUp files, 328
sky, environment, 441
sky lights, 452
snap guides, 140
snap guides button, 19
snapcodes, 128

in hidden view, 242
with coordinates, 138

solid clumps, 231
solid shaders

colour, 466
displacement, 475

specifying positions, 127
spinning the axes, 148
spot lights, 453
starting MicroGDS, 9
status toolbars, 14

customizing, 373
docking, 13
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style files, 25
access permissions, 360
opening, 35

style search paths, 26, 82
styles, in multi-user projects, 360
sun, environment, 441
sun  + sky lights, 453
sun lights, 453
superimposing objects, 91
switching

documents, 29
layers, 101
views, 45

system administration, 387

T
templates, 24

MAN files, 24
opening, 35
projects, 344

text
boxing, 209
changing the width, 213
dimensions, 217
editing, 212
greeking, 215
height, 204
justifying, 213
primitives, 191
reference data, 215
typing, 208
width, 204

texture space shaders, 477
TGA files, 333
THF files, 329
TIF files, 333
toolbars

button size, 374
creating, 374, 375
customizing, 373
flyouts, 14, 376

moving, 13
orientation, 13
renaming, 374
showing/hiding, 12

trademarks, 507
transferring GDS files, 361
transparency shaders, 473

U
undoing commands, 21
units

coordinates, 132
setting, 45, 133

updates, MicroGDS, 3
updating

instance objects, 77
layers, 123
raster images, 336

URL, Informatix, 3
user preferences, 365, 366

V
view controls, 53, 377
view extent, changing, 48
view parameters, 226
viewing buttons, 50
viewing dialogue activity, 303
views

clipped, 241
default view, 54
dotted, 241
hidden, 241
modes in 3D, 242
opening, 54
parameters, 45
print layout, 45
renaming, 54
restoring, 55
saving, 54
sections, 245
shaded, 241
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switch to XY plane, 230
switching, 45
toggling 2D and 3D, 221
wireline, 241

views, multiple, printing, 293
views, single, printing, 291
visible phases, 107
Visual Basic, sample programs, 398

W
weather based rendering, 434
website, 3
wheel mouse support, 48
wildcards, 72
window

label, 105
layout, 11
MicroGDS, 10

window definitions
closing, 40
copying layers into, 117
creating, 38
exporting, 331
in MAN files, 24
multi-user projects, 341
opening, 39
overriding aliases, 359
principal window, 40

publishing, 332
renaming, 40
saving, 358

Window Editor, 102
window extent, 42
window photo primitives, 58, 59
window quality, 45
window-level attributes, 313
windows, resizing and docking, 11
wireline view, 241
WN# files, 359
WN$ files, 359
Working, project template, 344
wrapped shaders

colour, 467
displacement, 476
reflectance, 472
transparency, 473

X
x, y, z buttons, 142
XY plane

3D view, 230
Dot snapcode, 129

Z
Z=0 button, 18
zooming, 49

3D views, 222


